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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
EMC M&R components from the EMC Update server to the Module Repository on the
Centralized Management (CM) server. In a multi-server environment, the downloaded
modules are distributed to all of the remote servers managed by the CM server.


Configuring server settings for online updates
Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click Configuration > Online Update .


4. Ensure that you are on the Settings tab.


5. By default, online update uses the EMC Online Support username and password
specified under Configuration > EMC Support. If you want to use different credentials,
click Override Support Credentials. These credentials are used only for online update.


6. Click the  icon to test connectivity to the update server.


The  icon indicates that connectivity to the server has been established.


The  icon indicates that connectivity to the server failed.


7. Click Save.


Enabling the online update task
Enable the Online Update task to download the latest updates from the EMC Update
server automatically.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Enable.


Note


By default, this task is set to run once everyday at 12AM. You can customize the task
schedule by editing the configuration file.
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Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Run Now.


Online Update Status
The Online Update Status tab indicates whether or not the last online update check was
successful, provides the date and time of the last successful check, and lists any updates
that are available for download.


Figure 1  Online Update Status


If a major update of the EMC M&R platform is detected, the Status tab includes a Major
Update Status section that describes the version that is available, provides a link to the
upgrade documentation, and includes a Start Download button.
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Figure 2  Online Update Status with a major version update detected


Downloading a major update
You can use Online Update to download a major version of the EMC M&R platform. You
should only download a major version if you intend to immediately complete the full
upgrade process.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click Configuration > Online Update.


4. Click the Status tab.


5. Click Start Download. When the download is finished, the Download State will change
from "Not Downloaded" to "Complete."


6. Complete the upgrade process as described in the upgrade documentation.


Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.


The History tab also allows you to search the download history for a particular component
name or version number.


Disabling the online update task
You can disable the Online Update task if you prefer to manually download the updates
from the EMC Update server.


Procedure


1. Click Administration.
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2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Disable.
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Update SolutionPacks and other components
Learn how to update SolutionPacks and other components that Online Update has
downloaded from the EMC Update server to the Module Repository on the Centralized
Management (CM) server.


Refer to the Automate the Download of Updates article for details about Online Update.


The product provides several options for updating SolutionPacks and other components:


l Update all of the SolutionPacks and other components with a single click


l Update all of the SolutionPacks with a single click


l Update all of the other components with a single click


l Update individual SolutionPacks or other components


The update process detects if any manual edits were made to the SolutionPack files. If a
manually edited file is compatible with the new version of the SolutionPack, it will be
reused and the system will display a message to let you know. If a manually edited file is
not compatible with the new version of the SolutionPack, the system will back up the file
and display a warning message that indicates the name and location of the incompatible
file. The system does not check files that were not were not included with the
SolutionPack.


Update all SolutionPacks and other components
You can update all of your installed SolutionPacks and other components with a single
click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Update All Components button in the top-right corner of the page.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update all SolutionPacks
You can update all of your installed SolutionPacks with a single click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Select All button located below the SolutionPacks table, and then click the
Update button.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update all other components
You can update all of your other installed components with a single click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Select All button located below the Other Components table, and then click
the Update button.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update individual SolutionPacks or other components
You can easily update individual SolutionPacks or other components.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2.
In the SolutionPacks table or the Other Components table, click the update icon 
for the SolutionPack or component that you want to update.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.
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Overview
Learn how to install and configure the SolutionPack for Acme Packet SBC. You can
monitor and report on Acme Packet devices for performance and utilization information
as well as view the inventory of all devices and session metrics.


Use these guidelines in the following sections to prepare your environment for
installation of the SolutionPack for Acme Packet SBC.


l Use support information to verify that prerequisite software is installed in your
environment.


l Check that your EMC M&R network configuration has the minimum requirements to
run reports.


l Manage licenses for the SolutionPack


Support
This table lists the prerequisite support for this SolutionPack.


Device Version


EMC Watch4net 6.3


Acme Packet Net-Net 9200 X


Acme Packet Net-Net 4500 X


Acme Packet Net-Net 4000 Series SBC X


Acme Packet Net-Net 3820 X


Acme Packet Net-Net 3800 X


License management
You can evaluate features in the SolutionPack Center using 30-day temporary licenses
included with EMC M&R software. If you install or plan to use the SolutionPack for longer
than 30 days, contact EMC Online Support for permanent license files.


If you have an existing permanent license or a temporary license that requires updating,
use the license upload feature in EMC M&R Centralized Management. Both permanent
and temporary licenses are distributed in .zip files.


The EMC M&R license name is either EMC M&R for Acme Packet SBC or ReportPack for
Acme Packet SBC. If either license is present, the system will use it.


Installation
Review this information before beginning the installation.


l Make sure you review and perform the prerequisites outlined in the first chapter.


l Perform the installation with administrative privileges on the EMC M&R User
Interface.
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Logging in to Centralized Management
Log in to Centralized Management to perform operations that affect all servers.


Procedure


1. Point your browser to the URL.


For example, http://<Frontend-hostname>:58080/centralized-
management


2. Log in.


a. Type the login credentials.


The default username is admin and the default password is changeme.


b. Click Sign In.


After you finish


Note


You are automatically logged off after four hours.


Installing the SolutionPack
After you log in as an administrator, you can install this SolutionPack from Centralized
Management.


Before you begin


Core modules must be up-to-date in all servers because not all module dependencies are
validated during the SolutionPack installation or update process.


Core modules are modules that are not installed by a SolutionPack. Examples of core
modules include webapps, module-manager, license-manager, java, mysql, backend,
tools, and so forth. Update these core modules: Databases, Backends, Frontends,
Miscellaneous (except Blocks). The recommended module update order varies. Refer to
the EMC Watch4net Installation and Configuration Guide for information on module
update order for multiple hosts or single host deployments.


Procedure


1. Log in and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select SolutionPack Center.


5. Select the Acme VoIP SolutionPack on the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Collector, and Reports list boxes.


c. Click Next.
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8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.After installation is complete, verify the SolutionPack version number along with
SolutionPackBlock information. Select Centralized Management > SolutionPacks >
Acme VoIP.


Adding devices for monitoring
After installation, you must manually add devices for monitoring.


Before you begin


Procedure


1. Create the collector. In the EMC M&R console, navigate to Device discovery >
Collectors > Add New Collector.


2. Add a device for collection. Navigate to Device discovery > Devices > Add New Device.


a. In Main Parameters, enter the name of the device and IP address.


b. Configure SNMP Credentials by adding a collector that was previously created.


c. Select appropriate Acme Capabilities.


Repeat this procedure until all desired devices are added.


3. Distribute device(s). Navigate to Device discovery > Dashboard, and then click on
Distribute all approved devices with Capabilities on all enabled collectors.


Log files
Information on the log files for this SolutionPack follows.


This SolutionPack does not have Acme Packet SBC-specific log files. Logging for the
SolutionPack is part of the Generic SNMP collector:<APG_install>/Collecting/
Collector-Manager/Generic-SNMP/logs.


Configuring the user process limits for the Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The EMC M&R platform installed on a server running Red Hat Enterprise Linux 6,
CentOS Linux 6.


l The name specified for the user account during the installation.
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Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. Type the following commands from the bin directory of the installation to restart the
services:


./manage-modules.sh service stop all


./manage-modules.sh service start all


After restarting, check the status of services, enter: ./manage-modules.sh service
status all


5. Type the following command to verify the changes:


su apg -c 'ulimit -n -u'


Installing a SolutionPack Center Upgrade
Periodically, updates of the SolutionPacks are available in a .zip file called
SolutionPackCenter Update on EMC Online Support. This .zip file contains a README file
that describes the changes made to each SolutionPack and individual
<solution>.pkg files for installing each update.


Before you begin


l Install the required license file to enable your SolutionPack.


l Ensure any Domain Managers that supply data to the SolutionPack are installed and
configured.


l Make sure you have a login with root, APG, or system administrator privileges to
perform this task. The user apg is the account that the EMC M&R platform application
uses instead of root.


l Update the core modules in all servers before you update or install a SolutionPack
after upgrading your base installation.


Core modules are modules that are not installed by a SolutionPackBlock. Examples of
core modules include webapps, module-manager, license-manager, java, mysql,
backend, tools, and so forth. Update these core modules: Databases, Backends,
Frontends, Miscellaneous (except Blocks). Since the recommended module update order
varies, refer to the Module Update Order section for the multiple hosts or single host
deployments. Also, the EMC Watch4net Centralized Management Guide provides more
information.


Examples of modules that are installed with SolutionPackBlocks include collector-
manager, event-processing-manager, and collector or event components.


Procedure


1. Locate the EMC M&R downloads area on EMC Online Support.
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a. Go to https://support.emc.com.


b. Click Support by Product.


c. Type Watch4net in the Find a Product field, and then click the arrow next to it.


d. Click Downloads.


The Downloads for Watch4net page appears.


2. Download the latest SolutionPackCenter Update to a local directory.


For example: SolutionPackCenter Update <month> <year>


3. Browse to Administration > Centralized-Management > Packages Management and
click Upload.


4. Browse to the SolutionPackCenter Update .zip file and click OK.


After you finish


Update the SolutionPackBlocks after installing the SolutionPack update. Browse to
Administration > Centralized Management > SolutionPacks > SolutionPack Center and
install the SolutionPack.


You can confirm the SolutionPack version number by browsing SolutionPacks in the left
panel.


Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall that
SolutionPack from the server.


Procedure


1. Log in with administrator credentials for EMC M&R platform and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select the SolutionPack that you want to uninstall in the Installed SolutionPacks
screen.


5. In the Properties area, click Trashcan icon for each instance of the SolutionPackBlock
and click Remove.


Viewing SolutionPack reports
You can view your reports from the EMC M&R console.


Before you begin


After installing the SolutionPack, access the EMC M&R User Interface.
Procedure


1. Point your web browser to http://[serverIP:port]/APG.


An example default URL is http://localhost:58080/APG.


2. On the login screen, enter your EMC M&R username and password, and click Sign In.


3. View SolutionPack reports by expanding Report Library > Your SolutionPack Name.
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SolutionPack for Acme Packet SBC Reports
A list of "out-of -the box" reports available with this SolutionPack appears in the table
that follows.


You can drill-down on some top-level reports to view sub-level reports with specific
metrics related to objects in the top-level report.


Top-level
reports


Description


CPU Usage % Lists the CPU Utilization (%) for each polled device.


Memory Usage
%


Lists the Physical Memory Utilization (%) for each polled device.


Global active
Sessions NB


Displays the total instant number of Global Concurrent Sessions as of report
generation time.


Inventory Displays the inventory for all devices that are Acme Packet Net-Net capable
including:


l Routers: number of routers


l Interfaces: number of couple routers / interfaces


l KPIs: number of Key Performance Indicators (KPI) polled by APG for each
object


Router Summary This report lists all Acme devices with their global performance information.
Click a device to get a full summary of the performance of that device


Realms
Performance


Includes:


l Realm Sessions Active: The active sessions report includes the sum of the
number of active inbound realm sessions and the number of active
outbound realm sessions.


l Realm Sessions Rejected: The Realm Sessions Rejected Ratio is calculated
as a percentage of the sum of realm rejected (outbound and inbound)
indicator that identify the total number of sessions rejected (outbound
and inbound) due to insufficient bandwidth divided by the sum of total
realm number of sessions.


l Realm Sessions ASR%: This report displays the Answered to Seizures
Ratio (ASR). This ratio is calculated as a percentage of total number of
answered realm sessions by total number of seizured realm sessions


Sessions
Performance


Includes:


l Sessions Active: This report displays the total active sessions by device.
The total active sessions by device is the sum of active sessions for all
sessions. The active sessions is the sum of the number of active inbound
sessions and the number of active outbound sessions.


l Sessions Rejected: This report displays the total active sessions by device
which equals the sum of active sessions for all sessions. Active sessions
equals the sum of the number of active inbound sessions and the number
of active outbound sessions.
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Top-level
reports


Description


l Sessions ASR %: The report displays the Answered to Seizures Ratio (ASR)
The ratio is calculated as a percentage of total number of answered
sessions by total number of seizures sessions


l Registration Statistics


Report metrics
The SolutionPack software uses report metrics to gather information from your ACME
Packet SBC devices for monitoring and report creation.


This table lists metrics for the SolutionPack.


Metric type Table Metric name W4n Collection
Mode


ACME Session InboundActionNSEPSession SNMP


apCombinedSessionAgentStatsTable InboundActive SNMP


OutboundActive


TotalInbound


InboundRejected


TotalOutbound


OutboundRejected


Seizures


Answered


apSigRealmStatsTable InboundActive SNMP


OutboundActive


TotalInbound


InboundRejected


TotalOutbound


OutboundRejected


Seizures


Answered


Rfactor


ACME-
RESOURCES


apSysTable ArpUtilization SNMP


ContactCount


CurrentLoad


GatewayCount
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Metric type Table Metric name W4n Collection
Mode


H323Count


MessagesRejected


NatUtilization


CurrentUtilization CPU


CurrentUtilization Memory


Health


SessionCount


CallCount


apEnvMonFanStatusTable SNMP


apEnvMonPhyCardStatusTable SNMP


apEnvMonPowerSupplyStatusTable SNMP


apEnvMonTemperatureStatusTable SNMP


SSL certificates
Generally, EMC products are distributed with a self-signed SSL certificate. If you receive
an SSL certificate error or a blank pane when you are attempting to access content served
by a data source, resolve the issue by doing one of the following procedures.


SSL certificate error examples on page 30 provides a list of sample errors.


Temporary resolution
Accept the certificate exception temporarily: Troubleshooting an SSL certificate error:
Accepting the exception on page 30.


Permanent resolution
Add an SSL certificate to your truststore to permanently prevent the exceptions from
appearing.


You can: Perform:


Install the self-signed SSL certificate
that is provided with the EMC product
using an Internet Explorer browser.


Installing a self-signed SSL certificate from an
Internet Explorer browser on page 30


Install the self-signed SSL certificate
that is provided with the EMC product
using a Chrome or Firefox browser.


1. Export the self-signed SSL certificate to
save it to the export location: Exporting an
SSL certificate from an Internet Explorer
browser on page 32


2. Importing an SSL certificate into your
truststore on page 31


Import an exported SSL certificate that
you or another administrator prepared.


Importing an SSL certificate into your
truststore on page 31
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If you need to prepare an SSL certificate to share with other users, use: Exporting an SSL
certificate from an Internet Explorer browser on page 32.


SSL certificate error examples
The SSL certificate error or a blank pane appears because the certificate is self-signed
and it is not added as an exception or into the truststore yet. For example, if you are
attempting to access content served by a data source, a blank pane appears when you
select views under SolutionPacks.


Chrome error examples


This site's security certificate is not trusted!


Or, a blank pane.


Firefox error example


This Connection is Untrusted


Internet Explorer error examples


There is a problem with this website's security certificate.


Content was blocked because it was not signed by a valid security 
certificate.


Troubleshooting an SSL certificate error: Accepting the exception
An SSL certificate error appears in your browser.


To resolve this issue,


Procedure


l Accept the exception.


Steps may vary for your browser. For example, for Internet Explorer, click Continue to
this website (not recommended).


This temporary solution causes the exception to be ignored for the current browser
session, but the exception reappears if you open another browser tab or window.


Installing a self-signed SSL certificate from an Internet Explorer browser
Install the self-signed SSL certificate that is provided with the EMC product to prevent
certificate exception errors.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Click Continue to this website (not recommended) in the browser window.


2. Click the red Certificate Error indicator next to the address bar.


3. In the Untrusted Certificate window, select View certificates.


4. In the Certificate dialog box, in the General tab, click Install Certificate.


5. Follow the instructions in the Certificate Import Wizard.


a. Select the Place all certificates in the following store setting to add the certificate
to your truststore.
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6. In the Certificate dialog box, in the General tab, click OK.


After you finish


Refresh the browser window.


Importing an SSL certificate into your truststore
Import an SSL certificate into your truststore to prevent certificate exception errors.


Procedure


l Import the certificate using one of the following procedures:


n Importing an SSL certificate in Chrome on page 31


n Importing an SSL certificate in Firefox on page 31


n Importing an SSL certificate in Internet Explorer on page 31


Importing an SSL certificate in Chrome
For Chrome, use this procedure to import the certificate into your truststore.


The following procedure is for Chrome version 28.0.1500.95. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Settings > Show advanced settings.


2. Scroll down and select HTTP/SSL > Manage Certificates.


3. In the Trusted Root Certification Authorities tab, click Import.


4. Follow the instructions in the Certificate Import Wizard to import the certificate.


5. Click OK in Internet options.


6. Refresh the browser window.


Importing an SSL certificate in Firefox
For Firefox, use this procedure to import the certificate into your truststore.


The following procedure is for Firefox version 23.0. The steps may vary slightly depending
on your browser version.


Procedure


1. Go to Firefox > Options > Options.


2. Click Advanced.


3. In the Certificates tab, click View Certificates.


4. Click Import.


5. Locate the certificate file and click Open.


6. Click Save.


7. Click OK in Certificate Manager.


8. Refresh the browser window.


Importing an SSL certificate in Internet Explorer
For Internet Explorer, use this procedure to import the certificate into your truststore.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.
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Procedure


1. Go to Tools > Internet options.


2. In the Content tab, click Certificates.


3. Select the Trusted Root Certification Authorities tab.


4. Click Import.


5. Follow the instructions in the Certificate Import Wizard to import the certificate.


6. Click OK in Internet options.


7. Refresh the browser window.


Exporting an SSL certificate from an Internet Explorer browser
Use this procedure to export a self-signed SSL certificate, so that you can either import
the resulting exported certificate into your truststore or share it with other users.


The following procedure is for Internet Explorer version 10.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Access the host for which you want to export the SSL certificate from the browser.


For example: https://<myHostname>.emc.com
2. Select Continue to this website (not recommended) in the There is a problem with


this website's security certificate window.


3. Click the red Certificate Error indicator next to the address bar.


4. In the Untrusted Certificate window, select View certificates.


5. In the Certificate dialog box, select the Details tab and ensure that the Show field is
set to All. Click Copy to File.


6. In the Certificate Export Wizard,


a. Click Next in the Welcome screen.


b. Click Next to accept the default DER encoded binary X.509 setting in the Export File
Format screen.


c. Browse to the location where you want to save the certificate.


d. Specify the certificate file name and click Save.


e. In the File name field, ensure that the location and the certificate file name are
correct. Click Next.


f. Click Finish.


g. Click OK when The export was successful appears.


7. In the Certificate dialog box, click OK in the Details tab.


8. Share the resulting exported SSL certificate with other users to use.
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Overview
Learn how to install and configure the SolutionPack for Alcatel-Lucent 5620 SAM (Service
Aware Manager). This SolutionPack collects data from the Alcatel-Lucent 5620 Service
Aware Manager platform. This platform offers element, network, and service management
for advanced Layer 2 and Layer 3 network solutions and services based on the Alcatel-
Lucent's Carrier Ethernet and the IP/MPLS Service Routing portfolio.


SolutionPack for Alcatel-Lucent 5620 SAM offers the following:


l Highly scalable solutions supporting active and standby Alcatel-Lucent SAM
architectures


l Powerful dashboards


l Topology data and device statistics collected from Alcatel-Lucent equipment


l Accurate real-time service-oriented views for operations, engineering, and customers


l Provisioning and statistics within the MPLS infrastructure integrated with other
managed networks and equipment


l Report data based on the following:


n Customers and Services


n MPLS, Tunnels, and VRE


n Performance, Health, and OAM probes


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
Alcatel-Lucent 5620 SAM-O collector


The collector for Alcatel-Lucent 5620 SAM communicates with the Alcatel-Lucent SAM-O
module via the Statistic Log Subscription using the Java Messaging Service (JMS). The
Alcatel-Lucent 5620 SAM-O collector does the following:


l Sends XML requests to the Alcatel-Lucent SAM-O module.


l Subscribes to the JMS event for request completion.


l Fetches the response file to process it.


Supported devices
Alcatel-Lucent 5620 SAM release 11


Alcatel-Lucent 5620 release 11 (SAM-O module)


Main reports
Generic Device Performance (such as CPU and memory)


Physical and Logical Interface Performance


Multiprotocol Label Switch (MPLS) and Label-Switched Paths (LSPs) & Virtual Routing and
Forwarding (VRF) Measurements


Service Access Points (SAPs)
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Service Tunnel Traffic (SDPs)


Class of Forwarding Measurements


Ingress and Egress Traffic Details


Service Level Agreement (SLA)


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Performing prerequisite installation tasks
This SolutionPack requires that you verify that the Alcatel-Lucent 5620 SAM environment
is ready for the installation.


Procedure


1. Verify the Alcatel-Lucent 5620 SAM-O Module is configured and running.


2. Verify the FTP or SFTP server is running on the Alcatel-Lucent 5620 SAM server with
valid permissions to the server folder, which stores the log files. These permissions
enable the Alcatel-Lucent 5620 SAM-O collector to retrieve log files from the Alcatel-
Lucent 5620 SAM server.


3. During the installation, you are asked for details about the Alcatel-Lucent 5620 SAM
server, such as user name, password, and SAM-O Module port number. Contact the
Alcatel-Lucent 5620 SAM administrator for these details.


Installing the SolutionPack for Alcatel-Lucent 5620 SAM


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.
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4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Fill out the form with details for the Alcatel-Lucent 5620 SAM server and click Install.


7. Select the Administration Web-Service Instance as the default and click Next.


8. Wait until the installation is complete and then click OK.


9. Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After you install the SolutionPack for Alcatel-Lucent 5620 SAM, you must perform certain
tasks.


Procedure


1. Copy the samOss.jar file from your Alcatel-Lucent 5620 SAM installation to your
EMC M&R Stream collector lib folder.


For example, copy /opt/5620sam/client/nms/lib/SAM_11_0_R1/
samOss.jar to /opt/APG/Collecting/Stream-Collector/alcatel-
sam5620/lib/samOss.jar


2. Change the ownership on the jar file in the Stream collector path.


For example, chown apg:apg /opt/APG/Collecting/Stream-Collector/
alcatel-sam5620/lib/samOss.jar


3. Start the collector by going to Centralized Management > Collecting > Collector-
Manager::alcatel-sam5620 > Start.


4. Check the logs at /opt/APG/Collecting/Collector-Manager/alcatel-
sam5620/logs


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Searching for metrics in the database on page 37


l Running a scheduled task to import data into reports on page 37
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l What to do if the Collector-Manager does not start on page 38


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.
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For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


What to do if the Collector-Manager does not start


Error message shown in log file
If you see this type of error message in the log files, verify the samOss.jar file from the
Alcatel-Lucent 5620 SAM installation is correctly installed in the EMC M&R server. See 
Performing post installation tasks on page 36.


SEVERE   -- [2014-12-01 02:19:22 EST] -- StreamCollector::start(): 
Error while starting com.watch4net.apg.ubertext.parsing.retriever.StreamRetrieverException: 
Error while creating JMS context for source jnp://hostname:1099
at com.watch4net.apg.ubertext.parsing.retriever.JMSListenerRetriever
$JMSConnection.<init>(JMSListenerRetriever.java:404)
at com.watch4net.apg.ubertext.parsing.retriever.JMSListenerRetriever
$JMSConnection.<init>(JMSListenerRetriever.java:329)
at 
com.watch4net.apg.ubertext.parsing.retriever.JMSListenerRetriever.startAutomaticRetrieving(JM
SListenerRetriever.java:127)
at 
com.watch4net.apg.ubertext.parsing.DataRetriever.startAutomaticRetrieving(DataRetriever.java:
227)
at com.watch4net.apg.ubertext.collector.Collecting.scheduleCollecting(Collecting.java:148)
at com.watch4net.apg.ubertext.collector.StreamCollector.start(StreamCollector.java:129)
at 
com.watch4net.apg.v2.collector.CollectorManagerImpl.startComponents(CollectorManagerImpl.java
:601)
at com.watch4net.apg.v2.collector.CollectorManagerImpl.start(CollectorManagerImpl.java:665)
at com.watch4net.apg.v2.collector.Bootstrap.serviceStart(Bootstrap.java:91)
at com.watch4net.apg.v2.collector.Bootstrap.main(Bootstrap.java:140)
at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method)
at sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.java:62)
at sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:43)
at java.lang.reflect.Method.invoke(Method.java:483)
at com.watch4net.apg.module.plugin.service.Bootstrap.main(Bootstrap.java:59)
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Overview
Learn how to install and configure the SolutionPack for Aruba Wi-Fi. This SolutionPack
provides the performance reports for the Aruba Wi-Fi controller, station, and Access
Points. It collects and interprets data across multiple Aruba devices and performs
resource grouping and mathematical calculations to help you evaluate performance.


This SolutionPack helps you:


l Check the number of stations connected to your controller in real-time.


l View all controllers, access points, ESSIDs, and radio through its inventory.


l Verify the access point efficiency by monitoring the transmitted packets, bandwidth,
and signal-to-noise ratio, which demonstrates gains and lets you fine tune the device
configuration for better results.


l Monitor the Aruba routers in real-time and pro-actively optimize the availability of
your services.


l Understand the access point activity to see which AP device is being used the most,
such as the peaks and busy hours of the device.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u1 and later


Data collection method
SNMP collector


Supported devices
Aruba 3000 Series


Aruba 6000 Series


Supported MIBs
WLSX-SWITCH-MIB.mib


RFC1213-MIB.mib


Main reports
CPU Utilization for each device


Association (average/minimum)


Controller Summary of all devices managed in terms of number of access points,
Availability %, CPU Utilization %, and access points bandwidth


Inventory of controllers, Extended Service Set Identifications (ESSID), access points,
access point groups, and users


Performance Scorecard of association, ESSIDs, station, access point, access point
groups, and radio summary


Situations to Watch, including the Top-5 Users Currently Connected (by Access Points),
the Top-5 Currently High Bandwidth (by Stations), and the Top-5 Moving Users reports
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Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Follow these steps to install the SolutionPack for Aruba Wi-Fi and perform Aruba device
discovery.


Procedure


1. Log in to Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select the SolutionPack for Aruba Wi-Fi in the Browse and Install SolutionPacks
screen.


4. Read the summary information and click Install.


5. Select the Administration Web-Service Instance as the default and click Next.


6. In the SNMP Masks wizard, click Install.


7. Wait until the installation is complete for both SNMP Masks and Report and then click
OK.


8. Under Collecting, click Administration > Device Discovery.


9. On the Device Discovery page, click Collectors.


10.Create a new collector by accepting all the default options.


11.Click Device and add the Aruba device to be discovered.


a. Type the IP address, the SNMP community string, and assign the collector that you
previously created.


b. Select all Aruba capabilities to be discovered and any other capabilities.
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12.Select the Aruba device that you just added and click Approve.


13.From the Dashboard:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


14.Select Centralized Management > SolutionPack to verify the installedSolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.
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Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>
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5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Avaya Aura. This SolutionPack
reports on health statistics for the Avaya Aura Communication Manager call servers. The
metrics are collected using SNMP for host statistics and call services.


In additon this SolutionPack:


l Reports on health statistics for the Avaya Aura Communication Manager call servers.
Metrics are Collected via SNMP for host statistics, and call services.


l Provides inventory views for Network Regions, and phone end points, as well as
registration status. This information is collected via SSH/SAT connections to the ACM
<Perl>.


l Provides reports for MOS per phone call. This is collected via CDR (Call Detail
Records). You must configure ACM CDR destination to W4N Text Collector, and RTCP
(Real Time Communication Protocol) (Perl- based listener, IIRC).


Use these guidelines to prepare your environment for installation of the SolutionPack for
Avaya VoIP.


l Verify that prerequisite software is installed in your environment. Support
information on page 46


l Check that your EMC M&R network configuration has the minimum requirements to
run reports.


l Set up your Avaya Aura environment on page 47.


n Enable Call Detail Records (CDR) on page 47


n Configure RTCP monitoring on page 53


After setting up your environment:


l Manage SolutionPack licenses on page 55.


l Install the SolutionPack for Avaya VoIP on page 56 (first-time installations)


Support
Before installing this SolutionPack, review version support information.


Verify that prerequisite software is installed in your environment.


Software Version


Watch4net 6.3 or higher installed on Red Hat LINUX or Windows


Perl (Linux) 5.8.8 or higher


Strawberry Perl (Windows) 5.18.2


Net-SSH (Linux only) Net-SSH2-0.48
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Set up Avaya CDR and RTCP
Before installing your SolutionPack you must configure your Avaya Aura environment to
work with EMC M&R.


Avaya Aura CDR and RTCP monitoring must be configured so that Watch4net can
communicate with your environment and generate Avaya Aura SolutionPackreports.


Enabling Call Detail Records (CDR)
In order for the SolutionPack for Avaya Aura to provide a full range of call metrics, you
must configure the Avaya PBX so that Call Detail Records (CDRs) are sent to the IP
address of the Watch4net Server.


Follow the steps in the following sections to configure CDR for Avaya Aura.


Procedure


1. Add node names.  on page 47


2. Add an IP CDR service.  on page 48


3. Set CDR system parameters.  on page 49


4. Enable intra-switch CDRs. on page 50


5. Enable trunk groups.  on page 51


6. Configure 10-Digit Plus dial plans. on page 51.


After you finish


For additional details on performing any of these procedures, refer to Configure CDR
Monitoring, Avaya document 100059519, available on the Avaya website: http://
www.avaya.com.


Adding node names for CDR monitoring
With this procedure, you can configure the AVAYA device to send data to the EMC M&R
instance where the SolutionPack is installed.


Follow these steps to add a new node for CDR monitoring. Make sure you have login
credentials with proper administrative rights to make this configuration.


Procedure


1. Use an SSH client to open a terminal and connect to the ACM (Aura Communication
Manager).


a. Type: ssh <username>@<ACM FQDN> and then press Enter.


b. Enter password.


c. Enter terminal type: vt100.


d. At the prompt, enter sat.


e. Enter terminal type: W2KTT.


2. Execute this command: change node-names ip.


change node-names ip                                         Page 
1 of 2
                             IP NODE NAMES
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    Name               IP Address            Name             IP 
Address
clan1                 10.1.10.21
clan2                 10.1.10.22
default               0.0.0.0
medpro1               10.1.10.31
medpro2               10.1.10.32
procr                 10.1.10.9
vall                  10.1.10.41
prognosis             10.1.10.105      


3. Complete the following fields: Name: Add a name, then IP Address: Add the IP
address of the host where Watch4net is running.


4. Press Esc + e to save and exit.


NAT Environment: In the case of a NAT environment the IP Address should be set to the
Public IP address assigned to the IP Telephony Manager Monitoring server.


Note


If the PBX has an S85xx or S87xx series Media Server, then ensure that a valid node
name for the CLAN board exists as well. If it has an S8300 series Media Server, then
ensure that a valid node name for the PROCR also exists.


Adding IP CDR Service for CDR Monitoring
Use this procedure to define the CDR link.


Procedure


1. Execute the command: change ip-services.


 change ip-services                                            
Page 1 of 4
                               IP SERVICES
 Service      Enabled       Local      Local       Remote       
Remote
Type                      Node       Port        Node         Port
CDR1                       clan1       0         prognosis      
50000


2. To define a primary CDR link, enter the following details: 


l Service Type: CDR1 - If CDR1 already exists, add a new destination by
defining the Service Type to CDR2 (or as appropriate).


l Local Node: clan1 - Add the node name for the CLAN (S85xx or S87xx series)
or PROCR (S8300 series).


Note


Execute list node-names ip all command to view the node name that refers to


the ACM IP Address.


l Local Port: 0 - The Local Port is fixed to 0 as Avaya Communication Manager
initiates the CDR link.


l Remote Node: - This is the name you specified in change node-names ip
step 3 in the previous section (Adding node names for CDR monitoring).


l Remote Port: - Set port to 5001. This is the port where the SolutionPack
listens for the CDR data. With multiple Avaya hosts, all send data to the same port
on the SP host.
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3. Disable the Reliable Session Protocol (RSP) from the CDR link by setting the
Reliable Protocol field to n.


4. Use Esc n to get to the SESSION LAYER TIMERS page. Set the value for the CDR
you used in the previous screen for the Reliable Protocol to n. For example:


                                 
                           SESSION LAYER TIMERS
 Service   Reliable    Packet Resp    Session Connect   SPDU   
Connectivity Type     Protocol      Timer         Message Cntr     
Cntr      Timer
CDR1          n          30            3                3         
60


5. Press Esc + e to save and exit.


Setting CDR System Parameters for CDR Monitoring
The CDR SYSTEM PARAMETERS form of the Avaya SAT program should be set up with the
required parameters for the type of calls to track and format the CDR data.


Procedure


1. Execute the command: change system-parameters cdr


 change system-parameters cdr                                    
Page 1 of 1
                          CDR SYSTEM PARAMETERS
Node Number: (Local PBX ID)                      CDR Date Format: 
month/day
  Primary Output Format: unformatted      Primary Output Endpoint: 
CDR1
Secondary Output Format:                Secondary Output Endpoint:
           Use ISDN Layouts? n                 Enable CDR Storage 
on Disk? n
       Use Enhanced Formats? n    Condition Code 'T' For 
Redirected Calls: n
     Use Legacy CDR Formats? y                Remove # From Called 
Number? n
Modified Circuit ID Display? n                           Intra-
switch CDR? y
                Record Outgoing Calls Only? n     Outg Trk Call 
Splitting? y
Suppress CDR for ineffective Call Attempts? y       Outg Attd Call 
Record? y
    Disconnect Information in Place of FRL? n      Interworking 
Feat-flag? n
Force Entry of Acct Code for Calls Marked on Toll Analysis Form? n
                                    Calls to Hunt Group - Record: 
member-ext
Record Called Vector Directory Number Instead of Group or Member? n
Record Agent ID on Incoming? n       Record Agent ID on Outgoing? y
     Inc Trk Call Splitting? n
  Record Non-Call Assoc TSC? n          Call Record Handling 
Option: warning
      Record Call-Assoc TSC? n  Digits to Record for Outgoing 
Calls: dialed
   Privacy - Digits to Hide: 0              CDR Account Code 
Length: 15


2. Edit the information. The following settings are recommended:


l CDR Date Format: month/day


l Primary Output Format: unformatted


l Primary Output Endpoint: CDR1
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The following parameters define the type of calls that will be recorded and what data will
be included in the record.


l Use Legacy CDR Formats? y Specifies the use of the Avaya Communication Manager
3.x (legacy) formats in the CDR records produced by the system.


l Intra-switch CDR: y If CDRs are required for intra-PBX calls, then the Intra-switch
CDR? option must be set to y . This setting allows call records for internal calls
involving specific stations. Those stations must be specified in the INTRA-SWITCH-
CDR form.


l Record Outgoing Calls Only? n Allows incoming trunk calls to appear in the CDR
records along with the outgoing trunk calls.


l Outg Trk Call Splitting? y Allows a separate call record for any portion of an outgoing
call that is transferred or conferenced.


l Inc Trk Call Splitting? n Disallows a separate call record for any portion of an incoming
call that is transferred or conferenced.


This is the recommended PBX setting, although setting n to all options is also possible.
By using these recommended settings CDRs will be sent for most types of calls
(conference calls, transfers, attendant) and intra-switch. Unless there is a requirement for
any other particular option, the default should be n.


Enabling Intra-switch CDRs
CDRs are usually only sent when calls are made through a trunk. In the case of an Intra-
switch call (for example, a call that goes to another phone directly connected to the PBX),
a CDR will not be sent unless Intra-switch CDR has been enabled. Intra-switch CDRs are
only available if enabled for specific extensions.


Before you begin


If the Intra-switch CDR field is set to y on Page 1 of the CDR SYSTEM PARAMETERS form,
then the INTRA-SWITCH CDR form also needs to be updated to define the extensions that
will be subjected to call detail recording.


Procedure


1. Execute the command: change intra-switch-cdr.


 change intra-switch-cdr                                         
Page 1 of 3
                               INTRA-SWITCH CDR
 
                                Assigned Members: 6    of 4000 
administered
  Extension         Extension           Extension          
Extension
  3001
  3002
  3003
  3004
  3005
  3006


2. In In the Assigned Members field, enter the individual extensions for usage
tracking with the CDR records.
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Enabling trunk groups for CDR monitoring
Enabling trunk groups is not required for configuring the SolutionPack, however if you do
not configure them you will not get trunk group-related traffic statistics.


For each trunk group where CDR records are required, verify that CDR reporting is
enabled.


Procedure


1. Execute the command: change trunk-group<n> (where <n> is the trunk group
number.


change trunk-group 1                                           
Page 1 of 21
                                TRUNK GROUP
Group Number: 1                 Group Type: isdn            CDR 
Reports: y
  Group Name: Bondi H.323              COR: 1     TN: 1           
TAC: 501
   Direction: two-way     Outgoing Display? y       Carrier 
Medium: H.323
 Dial Access? n             Busy Threshold: 255     Night Service:
Queue Length: 0
Service Type: tie                Auth Code? n       TestCall ITC: 
rest
                     Far End Test Line No:
TestCall BCC: 4


2. Make sure that the CDR Reports field is set to y.


3. Repeat for all trunk groups to be reported.


CDR monitoring for 10 Digit Plus dial plans
You can optionally configure 10 Digit Plus dial plans for CDR.


Options include:


l Configure the Avaya PBX Custom Fields. Use this procedure when no other
customized CDR system parameters have been specified for any other purposes on
the Avaya PBX


l Including with other customized formats. Use this procedure if existing customized
CDR system parameters are already configured on the Avaya PBX for the Billing Server
or other CDR applications.


Configuring Avaya PBX custom fields
There are two options when configuring 10 Digit Plus dial plans for CDR.


Procedure


1. Use an SSH client to open a terminal and connect to the ACM (Aura Communication
Manager).


a. Type: ssh <username>@<ACM FQDN> and then press Enter.


b. At the prompt, type: sat and then press Enter.


c. Select terminal type, and press Enter to generate a command prompt.


2. Execute the command: change system-parameters cdr
3. Set the Output Format to customized. For example:


change system-parameters cdr                                    
Page 1 of 1
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                          CDR SYSTEM PARAMETERS
Node Number: (Local PBX ID)                      CDR Date Format: 
month/day
  Primary Output Format: customized       Primary Output Endpoint: 
CDR1
Secondary Output Format:                Secondary Output Endpoint:
           Use ISDN Layouts? n                 Enable CDR Storage 
on Disk? n
       Use Enhanced Formats? n    Condition Code 'T' For 
Redirected Calls: n
...


4. Go to page 2 of the CDR System Parameters form (Esc - n) and specify the customized
CDR parameters as shown in the following code.


                            CDR SYSTEM PARAMETERS
   Data Item - Length         Data Item - Length         Data Item 
- Length
 1: time             - 4   17: ins              - 3   
33:                -
 2: duration         - 4   18: ixc-code         - 4   
34:                -
 3: cond-code        - 1   19: bcc              - 1   
35:                -
 4: code-dial        - 4   20: ma-uui           - 1   
36:                -
 5: code-used        - 4   21: res_flag         - 1   
37:                -
 6: dialed-num       - 15  22: tsc_flag         - 1   
38:                -
 7: calling-num      - 15  23: null             - 1   
39:                -
 8: acct-code        - 15  24:                  -     
40:                -
 9: auth-code        - 13  25:                  -     
41:                -
10: frl              - 1   26:                  -     
42:                -
11: in-crt-id        - 3   27:                  -     
43:                -
12: out-crt-id       - 3   28:                  -     
44:                -
13: feat-flag        - 1   29:                  -     
45:                -
14: attd-console     - 2   30:                  -     
46:                -
15: in-trk-code      - 4   31:                  -     
47:                -
16: node-num         - 2   32:                  -     
48:                -
                             Record length = 103
 


Configuring other customized formats
Follow the procedure to configure the Avaya PBX and for other customized formats .


Procedure


1. Use an SSH client to open a terminal and connect to the ACM (Aura Communication
Manager).


a. Type: ssh <username>@<ACM FQDN> and then press Enter.


b. At the prompt, type: sat and then press Enter.


c. Select terminal type, and press Enter to generate a command prompt.


2. Execute the command: change system-parameters cdr
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3. Set the Output Format related to IP Telephony Manager to customized. For example:


change system-parameters cdr                                    
Page 1 of 1
                          CDR SYSTEM PARAMETERS
Node Number: (Local PBX ID)                      CDR Date Format: 
month/day
  Primary Output Format: customized       Primary Output Endpoint: 
CDR1
Secondary Output Format:                Secondary Output Endpoint:
           Use ISDN Layouts? n                 Enable CDR Storage 
on Disk? n
       Use Enhanced Formats? n    Condition Code 'T' For 
Redirected Calls: n
...


Go to page 2 of the form (Esc - n) and specify at least the following parameters:


l time (4)


l duration (4) or sec-dur (4)


l cond-code (1)


l code-used (4)


l dialed-num (15)


l calling-num (15), plus in-trk-code (4), or calling-num (15), plus in-trk-code (4), plus
in-crt-id (3)


These minimum parameters are required and must be added to the custom settings
page along with the minimum field lengths as specified. You can also include
additional parameters as shown in Standard Custom Format on page 51.


Configuring RTCP Monitoring
In order for the SolutionPack for Avaya Aura to receive RTCP data necessary to create
SolutionPack reports, the Avaya PBX needs to be configured to send the reporting data to
the IP address of the VoIP Monitor server


Procedure to set up RTCP.


Procedure


1. Set up the PBX on page 53


2. Set up network regions on page 54


3. Set up Avaya voice stream Monitoring on page 54


4. After configuring RTCP on page 55


Setting up the PBX
Perform these tasks to setup your PBX to work with the SolutionPack software.


Before you begin


Make sure you have login credentials with proper administrative rights to make this
configuration.


Procedure


1. Use an SSH client to open a terminal and connect to the ACM (Aura Communication
Manager).


a. Type: ssh <username>@<ACM FQDN> and then press Enter.


SolutionPack for Avaya Aura Summary Sheet


Configuring RTCP Monitoring     53







b. At the prompt, type: sat and then press Enter.


c. Select terminal type, and press Enter to generate a command prompt.


2. Execute the command: change system-parameters ip-options
3. In the RTCP MONITOR SERVER section of the code, input the following values:


l Set the Default Server IP Address to the IP address of the VoIP Monitor server.


l Set the Default Server Port to 5005.


l Set the Default RTCP Report Period (secs) to 5.


4. When finished press Esc+e to submit the changes.


Setting up network regions
After you set up the VoIP Monitor IP address on the Avaya PBX, configure the associated
network regions IP addresses. You can configure either a default setting or add individual
IP addresses for each region.


Procedure


1. Execute the command: change ip-network-region <n>, where <n> is the IP
network region number to be monitored.


2. Set the RTCP Reporting Enabled? field to y (yes) and the Use Default Server
Parameters? field to y (yes).


Only one RTCP MONITOR SERVER can be configured per IP network region.


3. Repeat Step 2 for all IP network regions that are required to be monitored, and then
press Esc+e to submit the changes.


Results


The RTCP changes are implemented immediately for all calls, including those already in
progress.


Setting up Avaya voice stream monitoring
Voice stream data settings direct voice stream RTCP information to VoIP Monitor.


To monitor voice stream data for Avaya SIP Phones, edit these settings in the Avaya
46xxsettings.txt file.


Procedure


1. Edit SET RTCPMON <ip_address> and insert the <ip_address> of the VoIP
Monitor server.


2. Edit SET RTCPMONPORT <port_number> and set the port number of the port
used to send RTCP information to the IP address of the VoIP Monitor server, as
specified in the RTCPMON statement. When possible use the default setting 5005.


3. Edit SET RTCPMONPERIOD <n> where <n> specifies the time interval in seconds
when the system sends RTCP monitoring reports (5-30 seconds, with the default of 5).
Use the default.


SolutionPack for Avaya Aura Summary Sheet


54 Service Assurance Suite 9.4  SolutionPack Articles







After configuring RTCP Monitoring
After you set the default RTCP monitoring, make sure that you set all phone network
regions to use the default RTCP server.


Procedure


1. To set all phone network regions to use the default RTCP server use the change ip-
network-region <n> command (n = network region) from the Avaya CM command
console, and make sure that all phone network regions use the default RTCP server.


2. Use the these Avaya CM Native console commands to display and configure
additional phones, IP addresses and network regions as needed.


Command Result


list ip-interface all Lists IP interfaces/network regions


display ip-network-region <n> Displays ip network region configuration.


change ip-network-region <n> Change configuration for network region <n>


list registered-ip-stations List of registered ip stations


list station Avaya stations list


License management
You can evaluate features in the SolutionPack Center using 30-day temporary licenses
included with EMC M&R software. If you install or plan to use the SolutionPack for longer
than 30 days, contact EMC Online Support for permanent license files.


If you have an existing permanent license or a temporary license that requires updating,
use the license upload feature in EMC M&R Centralized Management. Both permanent
and temporary licenses are distributed in .zip files.


l Permanent licenses do not have expiration dates and may be associated with a host
ID.


l Temporary licenses have expiration dates and are not associated with a host ID.
When temporary licenses expire, the module license checks fail and the modules
stop working. For example, the collector modules stop collecting new information
and, if the front-end module fails, you cannot access the User Interface.


The SolutionPack license name is either SolutionPack for Avaya or ReportPack for Avaya.
The system will use either license.


Installation
Review this information before beginning the installation.


l Make sure you review and perform the prerequisites outlined in the first chapter.


l Perform the installation with administrative privileges on the EMC M&R User
Interface.
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Logging in to Centralized Management
Log in to Centralized Management to perform operations that affect all servers.


Procedure


1. Point your browser to the URL.


For example, http://<Frontend-hostname>:58080/centralized-
management


2. Log in.


a. Type the login credentials.


The default username is admin and the default password is changeme.


b. Click Sign In.


After you finish


Note


You are automatically logged off after four hours.


Installing the SolutionPack
Using the EMC M&R console, install the SolutionPack.


Before you begin


Make sure you review requirements and complete relevant procedures described in 
Installation Workflow, and have your credentials for Avaya Aura Communication Manager
and EMC M&R on hand.


Procedure


1. Log in to EMC M&R with root privileges.


For example, http://Frontend-hostname:58080/APG
2. Select Administration.


3. Select Centralized Management in the Administration tree.


4. Select SolutionPack Center.


5. Select Avaya Aura Communication Manager in the Browse and Install SolutionPacks
screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Accept the default name, avaya-voip-acm, in the Instance name field.


b. Select the EMC M&Rserver that will host the data collector in the Data collection
list box.


c. Select the EMC M&R server to host the reports in the Reports list box.


d. Click Next.


8. Accept the default values for the Data Collection and Alerting on Data Collection
panes.
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9. Enter the server addresses, root credentials, and path to the Perl executable directory
for the Avaya VoIP-specific configuration. The default Perl path for Windows: C:
\strawberry\perl\bin and for Linux : /usr/bin
After installing the SolutionPack, you can click the Device Discovery link in the post
install message window, and follow this link to configure SNMP monitoring for the
Avaya Call Managers you provided during SolutionPack installation. Alternatively you
can add the devices later by accessing the Device Discovery module from
Administration window. Follow these steps:


a. Create a collector (if you have not already created one). Navigate to Device
Discovery > Collectors > Add New Collector.


b. Add a device to Watch4net: Navigate to Administration > Modules > Device
Discovery > Devices > Add New Device, and then configure the name of the device
and IP address as part of Main parameters.


Note


Make the Device Type CallManager, otherwise data for Avaya Health reports will


not be displayed in the console.


c. Configure SNMP Credentials.


d. Add the previously created collector.


e. Select appropriate Avaya capabilities for AVAYA-SERVER, GENERIC-
INTERFACES, GENERIC-SYSUPTIME.


f. Distribute: navigate to Device Discovery > Dashboard and then click distribute
all approved devices with Capabilities on all enabled
collectors.


After you finish


Allow four to five polling cycles to pass before viewing reports.


Note


If data for CDR reports does not appear, verify whether the CDR Link established
successfully by executing the status cdr-link command from SAT terminal. Link


state should be up.


sample output :
                                CDR LINK STATUS
                   Primary                      Secondary


       Link State: up                           down
Number of Retries:                              ÿÿÿÿ
      Date & Time: 2014/02/06 03:46:08          2014/01/16 10:08:20
  Forward Seq. No: 0                            0
 Backward Seq. No: 0                            0
CDR Buffer % Full:   0.00                         0.00
      Reason Code: OK                           Maintenance busy


2. If Link state is down, then execute "test cdr-link primary long" 
command from SAT terminal to test primary cdr link. Test 215 should 
PASS.
   Sample Output :
                                          TEST RESULTS


Port        Mtce Name   Alt. Name        Test No.  Result           
Error Code
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            PRI-CDR                      213       PASS
            PRI-CDR                      215       PASS


If the Test 215 = fail, verify:


l Watch4Net server is reachable from ACM


l CDR Listener is running on Watch4Net Server on port 5001(default)


Starting the CDR and RTCP Listeners
After Installing the Solution Pack, start the CDR and RTCP listeners.


Procedure


1. For LINUX, go to <APG_HOME>/Collecting/Text-Collector/avaya-voip-
acm/conf/scripts.


l ./avayaListeners.sh start – This option starts both RTCP and CDR listener


l ./avayaListeners.sh status - This option shows the status of the listeners in the
system.


l ./avayaListeners.sh stop - This option stops the listeners.


l ./avayaListeners.sh install – This option runs the listeners as a start option
mentioned above addition to install the listeners into System startup so that it
starts automatically when the system gets restarted / rebooted.


Note


As you run the above script with parameter start and install, two additional script files
are generated. They are runAvayaCDRListener.sh and


runAvayaRTCPListener.sh. These are actual files to start the listeners created


by this script.


2. For Windows: Goto <APG_HOME>/Collecting/Text-Collector/avaya-
voip-acm/conf/scripts, and run avayaListeners.bat to start the listeners
using the command: Cmd> avayaListeners.bat .


Note


As you run the batch file, two additional batch files are generated. They are
runAvayaCDRListener.bat and runAvayaRTCPListener.bat. Use these


files to start the listeners created by this batch file.


To start the listeners automatically on the system restart, add these scripts separately
as 2 tasks in Task Scheduler. This step is carried out after running the
avayaListeners.bat. The procedure follows:


a. Go to Start->All Programs -> Accessories -> System Tools -> Task Scheduler


b. Select Action-> Create Task


c. Add the name of the task to be created under General Tab.


d. Select Run whether or not the user is logged on.


e. Select Run with highest privileges.


f. Go to the Triggers tab.
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g. Add New Trigger.


h. Select Begin the Task as At Startup.


i. In advanced settings, select Enabled.


j. Go to the Actions tab.


k. Select New action.


l. Select Action as Start a Program.


m. In Settings section below in the same tab, Select Program Script – select the
runAvayaRTCPListener.bat from conf/scripts folder


n. Go to last tab Settings and deselect Stop the task if it runs longer
than option.


o. Click OK.


Repeat these steps to create a task with different name for the
runAvayaCDRListener.bat script. With Step m, you need to select the
runAvayaCDRListener.bat file.


Log files
Information on the log files for this SolutionPack follow.


Log files for the SolutionPack for Avaya Aura are located in: <APG_installdir>/
Collecting/Collector-Manager/avaya-voip-acm/logs.


Since this SolutionPack also uses Generic SNMP collector, the log files for this collector
appear in <APG_install>/Collecting/Collector-Manager/Generic-SNMP/
logs.


Configuring the user process limits for the Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The EMC M&R platform installed on a server running Red Hat Enterprise Linux 6,
CentOS Linux 6.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.
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4. Type the following commands from the bin directory of the installation to restart the
services:


./manage-modules.sh service stop all


./manage-modules.sh service start all


After restarting, check the status of services, enter: ./manage-modules.sh service
status all


5. Type the following command to verify the changes:


su apg -c 'ulimit -n -u'


Installing a SolutionPack Center Upgrade
Periodically, updates of the SolutionPacks are available in a .zip file called
SolutionPackCenter Update on EMC Online Support. This .zip file contains a README file
that describes the changes made to each SolutionPack and individual
<solution>.pkg files for installing each update.


Before you begin


l Install the required license file to enable your SolutionPack.


l Ensure any Domain Managers that supply data to the SolutionPack are installed and
configured.


l Make sure you have a login with root, APG, or system administrator privileges to
perform this task. The user apg is the account that the EMC M&R platform application
uses instead of root.


l Update the core modules in all servers before you update or install a SolutionPack
after upgrading your base installation.


Core modules are modules that are not installed by a SolutionPackBlock. Examples of
core modules include webapps, module-manager, license-manager, java, mysql,
backend, tools, and so forth. Update these core modules: Databases, Backends,
Frontends, Miscellaneous (except Blocks). Since the recommended module update order
varies, refer to the Module Update Order section for the multiple hosts or single host
deployments. Also, the EMC Watch4net Centralized Management Guide provides more
information.


Examples of modules that are installed with SolutionPackBlocks include collector-
manager, event-processing-manager, and collector or event components.


Procedure


1. Locate the EMC M&R downloads area on EMC Online Support.


a. Go to https://support.emc.com.


b. Click Support by Product.


c. Type Watch4net in the Find a Product field, and then click the arrow next to it.


d. Click Downloads.


The Downloads for Watch4net page appears.


2. Download the latest SolutionPackCenter Update to a local directory.


For example: SolutionPackCenter Update <month> <year>


3. Browse to Administration > Centralized-Management > Packages Management and
click Upload.


SolutionPack for Avaya Aura Summary Sheet


60 Service Assurance Suite 9.4  SolutionPack Articles







4. Browse to the SolutionPackCenter Update .zip file and click OK.


After you finish


Update the SolutionPackBlocks after installing the SolutionPack update. Browse to
Administration > Centralized Management > SolutionPacks > SolutionPack Center and
install the SolutionPack.


You can confirm the SolutionPack version number by browsing SolutionPacks in the left
panel.


Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall that
SolutionPack from the server.


Procedure


1. Log in with administrator credentials for EMC M&R platform and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select the SolutionPack that you want to uninstall in the Installed SolutionPacks
screen.


5. In the Properties area, click Trashcan icon for each instance of the SolutionPackBlock
and click Remove.


Viewing SolutionPack reports
You can view your reports from the EMC M&R console.


Before you begin


After installing the SolutionPack, access the EMC M&R User Interface.
Procedure


1. Point your web browser to http://[serverIP:port]/APG.


An example default URL is http://localhost:58080/APG.


2. On the login screen, enter your EMC M&R username and password, and click Sign In.


3. View SolutionPack reports by expanding Report Library > Your SolutionPack Name.


Avaya Reports
This list includes the "out-of -the box" reports available with this SolutionPack.


Some top-level reports include additional sub-level reports with specific metrics related
to the top-level report.


l CPU Utilization for System %


l CPU Utilization for Calls %


l CPU Utilization %


l Avaya Health


l Busy Calls


n Data
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n Media


n Service


n Total


n Voice


l Calls completed


n Data


n Media


n Service


n Total


n Voice


l Other Reports


n Alarm Occurrences


n Number of Connections to Switch


n More Reports


– Registered Phone Summary


– Port Network Summary


– Avaya CDR Reports - Call Data Records (Call Detail and Duration)


– Avaya RTCP Reports - RTCP Summary Report (all network with Source of the
call)


– Media Gateways


– Network Region Report


– Occupancy Summary Report


– Occupancy - Reports time 000 till 2300 - for last 24 hours


– Calls Summary Report


– Connections Summary Report


– Idle Occupancy Report


– Trunk Group Report


– Trunk Group Inventory Report


– Trunk Group Member Report


Metrics for Avaya VoIP
Report metrics are used to create various reports within the SolutionPack. Metrics gather
information on values such as switch name, product ID, RTCP Monitoring IPV4 address,
Trunk Group number, and many more listed in this table.


Table 1 Report metrics


Group Metrics Details of the Metric Mode of Collection in
APG


IP Phones


extension Extension Text-Collector
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Table 1 Report metrics (continued)


Group Metrics Details of the Metric Mode of Collection in
APG


set_type Model /Type Text-Collector


product_id Product ID Text-Collector


station_ip IP Address Text-Collector


product_release Software Release Version of the
Phone


Text-Collector


gatekeeper_ip Gatekeeper's IP Address Text-Collector


ACM Processor Occupancy Summary


meas_hour Measurement Hour (0000, 0100,
0200,0300…2300)


Text-Collector


switch_name Switch Name Text-Collector


date Date of the collected information Text-Collector


static_occ Static Occurrence Text-Collector


cm_occ CM Occurrence Text-Collector


sm_occ SM Occurrence Text-Collector


idle_occ Idle Occurrence Text-Collector


total_calls Total no of calls Text-Collector


tandem_calls Total no of tandem calls Text-Collector


total_conn Total Connections Text-Collector


intcom_atmpts Internal Communication attempts Text-Collector


inc_atmpts Incoming attempts Text-Collector


out_atmpts Outgoing attempts Text-Collector


pnet_atmpts Port Networking attempts Text-Collector


Network Region Information


Region Network Region number Text-Collector


Name Name of the NR Text-Collector


ipv4PortNum IPV4 Port Number Text-Collector


rtcpMonIPv4 RTCP Monitoring IPV4 address Text-Collector


rptPeriod Report Period Text-Collector


udpMinPort UDP port allocated Minimum Text-Collector


udpMaxPort UDP port allocated Maximum Text-Collector


codecStatus CODEC Status Text-Collector


Port Network Data


portnetwork Port Network Number Text-Collector
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Table 1 Report metrics (continued)


Group Metrics Details of the Metric Mode of Collection in
APG


major No of Major alarms Text-Collector


minor No of Minor alarms Text-Collector


Warning No of Warning alarms Text-Collector


CarrierlocA Carrier Location A Text-Collector


CarrierlocB Carrier Location B Text-Collector


pnctrlActive Port Network Controller Active Text-Collector


pncontrolStdby Port Network Controller Standby
Status


Text-Collector


Trunk Group Status and Monitoring


TrunkGroupNo Trunk Group Number Text-Collector


Size Size of the TG Text-Collector


Active Status of the TG Text-Collector


QueueSize Queue Size Text-Collector


Waiting No of waiting calls in that TG Text-Collector


tac Trunk Access Code Text-Collector


tgtype TG Type Text-Collector


group_name TG Name Text-Collector


mem_numbers Number of members in that TG Text-Collector


cor COR (Class of Restriction) Text-Collector


cdr CDR (Call Data Record) Text-Collector


CDRData


Date Date of the call monitored Text-Collector


Time Time of the call monitored Text-Collector


To Extension To Text-Collector


From Extension From Text-Collector


Duration Duration of the call Text-Collector


MediaGatewayInfo


number Media Gateway Number Text-Collector


gwname Gateway Name Text-Collector


gwserial GW Serial Number Text-Collector


gwtype GW Type Text-Collector


gwip GW IP address Text-Collector
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Table 1 Report metrics (continued)


Group Metrics Details of the Metric Mode of Collection in
APG


gwnrnet_region Network Region to which the
Gateway belongs


Text-Collector


gwregd GW Registration Status Text-Collector


firmware_ver Firmware Version of the GW Text-Collector


hardware_vintage Hardware Vintage Version Text-Collector


clan_ipaddress CLAN IP Address Text-Collector


RTCPData


station-ip IP Address Text-Collector


packet-type Packet Type (SR, RR, SDES etc.) Text-Collector


ssrc SSRC - Source of the call Text-Collector


lastseq Last Sequence Number Text-Collector


lsr Last SR Received Text-Collector


dlsr Delay value from the Last SR
received


Text-Collector


time Time of the monitoring data Text-Collector


jitter Jitter Text-Collector


frlost Fraction Lost Text-Collector


packlost Packet Lost Text-Collector


MoS Computed based on Latency,
PacketLost,Jitter


Formula


R-Factor Computed based on Latency,
PacketLost,Jitter


Formula


OtherACMDatacollectedatACMlevel


sysUpTime Uptime SNMP-Collector


g3connectState Availability SNMP-Collector


g3connectTimeUp Uptime SNMP-Collector


g3connectAttempts Attempts SNMP-Collector


g3connectSuccess Success SNMP-Collector


g3connectRequests DataRequests SNMP-Collector


g3connectResponses DataResponses SNMP-Collector


g3connectErrors DataErrors SNMP-Collector


g3connectQueued DataQueued SNMP-Collector


g3healthMajor AlarmsMajor SNMP-Collector


g3healthMinor AlarmsMinor SNMP-Collector
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Table 1 Report metrics (continued)


Group Metrics Details of the Metric Mode of Collection in
APG


g3healthWarning AlarmsWarning SNMP-Collector


g3healthTrkBusy TrunksBusy SNMP-Collector


g3healthStnBusy StationsBusy SNMP-Collector


g3healthOthBusy OthersBusy SNMP-Collector


g3healthLogins ActiveLogins SNMP-Collector


g3healthStaticOcc CurrentUtilization SNMP-Collector


g3healthCallpOcc CurrentUtilization SNMP-Collector


g3healthSysMgmtOcc CurrentUtilization SNMP-Collector


g3healthIdleOcc CpuIdle SNMP-Collector


g3pnchealthPncAMajor AlarmsMajor Port Network
Controller A


SNMP-Collector


g3pnchealthPncAMinor AlarmsMinor Port Network
Controller A


SNMP-Collector


g3pnchealthPncAWarning AlarmsWarning Port Network
Controller A


SNMP-Collector


g3pnchealthPncBMajor AlarmsMajor Port Network
Controller B


SNMP-Collector


g3pnchealthPncBMinor AlarmsMinor Port Network
Controller B


SNMP-Collector


g3pnchealthPncBWarning AlarmsWarning Port Network
Controller B


SNMP-Collector


g3stamediaAlarmMajor AlarmsMajor SNMP-Collector


g3stamediaAlarmMinor AlarmsMinor SNMP-Collector


g3stamediaAlarmWarning AlarmsWarning SNMP-Collector


g3stamediaBusyOutTrunks TrunksBusy SNMP-Collector


g3stamediaBusyOutStations StationsBusy SNMP-Collector


g3stamediaH248LinksDown H248LinksDown SNMP-Collector


g3stamediaH248LinksUp H248LinksUp SNMP-Collector


g3stamediaNbrLogins ActiveLogins SNMP-Collector


g3callratedataNumCalls CallCompleted SNMP-Collector


g3callratedataBsyCalCmpl BusyCallCompleted SNMP-Collector


g3callratevoiceNumCalls CallCompleted SNMP-Collector


g3callratevoiceBsyCalCmpl BusyCallCompleted SNMP-Collector


g3callratesrvNumCalls CallCompleted SNMP-Collector


g3callratesrvBsyCalCmpl BusyCallCompleted SNMP-Collector
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Table 1 Report metrics (continued)


Group Metrics Details of the Metric Mode of Collection in
APG


g3callratemediaNumCalls CallCompleted SNMP-Collector


g3callratemediaBsyCalCmpl BusyCallCompleted SNMP-Collector


g3callratetotalNumCalls CallCompleted SNMP-Collector


g3callratetotalBsyCalCmpl BusyCallCompleted SNMP-Collector


SSL certificates
Generally, EMC products are distributed with a self-signed SSL certificate. If you receive
an SSL certificate error or a blank pane when you are attempting to access content served
by a data source, resolve the issue by doing one of the following procedures.


SSL certificate error examples on page 30 provides a list of sample errors.


Temporary resolution
Accept the certificate exception temporarily: Troubleshooting an SSL certificate error:
Accepting the exception on page 30.


Permanent resolution
Add an SSL certificate to your truststore to permanently prevent the exceptions from
appearing.


You can: Perform:


Install the self-signed SSL certificate
that is provided with the EMC product
using an Internet Explorer browser.


Installing a self-signed SSL certificate from an
Internet Explorer browser on page 30


Install the self-signed SSL certificate
that is provided with the EMC product
using a Chrome or Firefox browser.


1. Export the self-signed SSL certificate to
save it to the export location: Exporting an
SSL certificate from an Internet Explorer
browser on page 32


2. Importing an SSL certificate into your
truststore on page 31


Import an exported SSL certificate that
you or another administrator prepared.


Importing an SSL certificate into your
truststore on page 31


If you need to prepare an SSL certificate to share with other users, use: Exporting an SSL
certificate from an Internet Explorer browser on page 32.


SSL certificate error examples
The SSL certificate error or a blank pane appears because the certificate is self-signed
and it is not added as an exception or into the truststore yet. For example, if you are
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attempting to access content served by a data source, a blank pane appears when you
select views under SolutionPacks.


Chrome error examples


This site's security certificate is not trusted!


Or, a blank pane.


Firefox error example


This Connection is Untrusted


Internet Explorer error examples


There is a problem with this website's security certificate.


Content was blocked because it was not signed by a valid security 
certificate.


Troubleshooting an SSL certificate error: Accepting the exception
An SSL certificate error appears in your browser.


To resolve this issue,


Procedure


l Accept the exception.


Steps may vary for your browser. For example, for Internet Explorer, click Continue to
this website (not recommended).


This temporary solution causes the exception to be ignored for the current browser
session, but the exception reappears if you open another browser tab or window.


Installing a self-signed SSL certificate from an Internet Explorer browser
Install the self-signed SSL certificate that is provided with the EMC product to prevent
certificate exception errors.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Click Continue to this website (not recommended) in the browser window.


2. Click the red Certificate Error indicator next to the address bar.


3. In the Untrusted Certificate window, select View certificates.


4. In the Certificate dialog box, in the General tab, click Install Certificate.


5. Follow the instructions in the Certificate Import Wizard.


a. Select the Place all certificates in the following store setting to add the certificate
to your truststore.


6. In the Certificate dialog box, in the General tab, click OK.


After you finish


Refresh the browser window.
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Importing an SSL certificate into your truststore
Import an SSL certificate into your truststore to prevent certificate exception errors.


Procedure


l Import the certificate using one of the following procedures:


n Importing an SSL certificate in Chrome on page 31


n Importing an SSL certificate in Firefox on page 31


n Importing an SSL certificate in Internet Explorer on page 31


Importing an SSL certificate in Chrome
For Chrome, use this procedure to import the certificate into your truststore.


The following procedure is for Chrome version 28.0.1500.95. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Settings > Show advanced settings.


2. Scroll down and select HTTP/SSL > Manage Certificates.


3. In the Trusted Root Certification Authorities tab, click Import.


4. Follow the instructions in the Certificate Import Wizard to import the certificate.


5. Click OK in Internet options.


6. Refresh the browser window.


Importing an SSL certificate in Firefox
For Firefox, use this procedure to import the certificate into your truststore.


The following procedure is for Firefox version 23.0. The steps may vary slightly depending
on your browser version.


Procedure


1. Go to Firefox > Options > Options.


2. Click Advanced.


3. In the Certificates tab, click View Certificates.


4. Click Import.


5. Locate the certificate file and click Open.


6. Click Save.


7. Click OK in Certificate Manager.


8. Refresh the browser window.


Importing an SSL certificate in Internet Explorer
For Internet Explorer, use this procedure to import the certificate into your truststore.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Tools > Internet options.


SolutionPack for Avaya Aura Summary Sheet


Importing an SSL certificate into your truststore     69







2. In the Content tab, click Certificates.


3. Select the Trusted Root Certification Authorities tab.


4. Click Import.


5. Follow the instructions in the Certificate Import Wizard to import the certificate.


6. Click OK in Internet options.


7. Refresh the browser window.


Exporting an SSL certificate from an Internet Explorer browser
Use this procedure to export a self-signed SSL certificate, so that you can either import
the resulting exported certificate into your truststore or share it with other users.


The following procedure is for Internet Explorer version 10.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Access the host for which you want to export the SSL certificate from the browser.


For example: https://<myHostname>.emc.com
2. Select Continue to this website (not recommended) in the There is a problem with


this website's security certificate window.


3. Click the red Certificate Error indicator next to the address bar.


4. In the Untrusted Certificate window, select View certificates.


5. In the Certificate dialog box, select the Details tab and ensure that the Show field is
set to All. Click Copy to File.


6. In the Certificate Export Wizard,


a. Click Next in the Welcome screen.


b. Click Next to accept the default DER encoded binary X.509 setting in the Export File
Format screen.


c. Browse to the location where you want to save the certificate.


d. Specify the certificate file name and click Save.


e. In the File name field, ensure that the location and the certificate file name are
correct. Click Next.


f. Click Finish.


g. Click OK when The export was successful appears.


7. In the Certificate dialog box, click OK in the Details tab.


8. Share the resulting exported SSL certificate with other users to use.
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Overview
Learn how to install and configure the SolutionPack for Blue Coat PacketShaper. This
SolutionPack monitors most Blue Coat PacketShaper devices to provide real-time views
of your wide area network traffic, including the top ten busiest WAN traffic classes. It
reports on inbound and outbound traffic classifications and shows historical data for
periods ranging from an hour, day, week, month, or a customized time slot.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIB
BLUECOAT-PACKETSHAPER-MIB


Supported devices
This SolutionPack can collect data from any Blue Coat PacketShaper device that supports
the BLUECOAT-PACKETSHAPER-MIB.


Main reports
Top 10 Traffic Classes Chart, inbound and outbound traffic (bit/s)


View Global Statistics


View Traffic Per Classes


CPU Utilization


Memory Available


Availability of Devices


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.
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Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.
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a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


On the Main parameters tab, make sure you specify Probe for Device Type.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


SolutionPack for Blue Coat PacketShaper Summary Sheet


74 Service Assurance Suite 9.4  SolutionPack Articles







l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.
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For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for BGP (Border Gateway Protocol).
This SolutionPack provides analytics on BGP routers and neighbors, traffic on links, and
exception reports on down or flapping links. BGP is the core routing protocol of the
Internet. It maintains the table of IP networks that designates network reachability among
autonomous systems (AS).


BGP neighbors, or peers, are established by manual configuration between routers to
create a TCP session on port 179. The BGP speaker periodically sends 19-byte keep-alive
messages to maintain the connection, which is every 60 seconds by default.


The SolutionPack for BGP tracks the following information:


l Overall BGP traffic (peaks may indicates abnormal activity such as high route
changes.


l All disconnect BGP sessions or flapping sessions (session duration that averages
less than one hour).


l All properties and statistics per BGP neighbor.


l All properties and statistics per BGP router.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIB
BGP4-MIB


Supported devices
This SolutionPack can collect data from any BGP-enabled device that supports BGP4-MIB.


Main reports


BGP Traffic
Shows the overall BGP traffic.


Exception: Flapping (or disconnected) BGP Neighbors
Lists all disconnect BGP sessions or flapping sessions (session duration averaging
less than one hour).


View per BGP Neighbors
Displays all properties and statistics per BGP neighbor.


View per BGP Routers
Shows all properties and statistics per BGP router.
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Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.
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Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


SolutionPack for BGP Summary Sheet


80 Service Assurance Suite 9.4  SolutionPack Articles







2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Check Point Firewall. This
SolutionPack provides unified monitoring of all the Check Point devices distributed in a
network with firewall capabilities. It collects and interprets data across multiple Check
Point devices, and performs resource grouping and mathematical calculations to
generate performance information.


The SolutionPack for Check Point Firewall helps you do the following:


l Verify the traffic accept by the firewall and check how many packets are dropped by
the firewall.


l See the number of connections over time.
l Monitor the Check Point routers in real-time and pro-actively, so you optimize your


services availability.
l Understand your devices activity, to know which Check Point device has the most


traffic by application, for example when devices reach peak loads.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R version
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
CHECKPOINT-MIB.mib


RFC1213-MIB.mib


Supported devices
Check Point 2200 appliances


Check Point 4000 appliances


Check Point Firewall-1


Main reports


Session Failure %
Shows a Session Failure graph over a period of time for each polled firewall.


Firewall CPU Usage %
Shows a CPU Usage graph over a period of time for each polled firewall.


Firewall with Most Connections
Provides a TopN Firewall graph showing a firewall with the highest number of
connections over a selected time period.


Firewall Summary
Provides summaries of the Availability %, CPU Usage %, Session Load %, and
Number of Connections of firewall devices.


Inventory
Displays the inventory (count only) of the Cisco Firewall network.
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Performance Scorecard
Reports on firewall hardware availability for memory, CPU, interface, units, disk, and
power.


Situations to Watch
Displays critical and major interface errors, such as half open connections and
session bottlenecks, for each polled firewall.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


l Make sure you know the name, IP address, SNMP port, and the community string of
the firewall device.


l Verify the firewall is configured to allow network access to the SNMP port.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.
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c. Click Next.


8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.After the installation is complete, select Centralized Management > SolutionPack to
verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


On the Main parameters tab, make sure you specify Firewall for Device Type.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.
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c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.
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5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Cisco Firewall. This SolutionPack
provides unified monitoring of all the Cisco ASA/PIX devices distributed in the network.


The SolutionPack for Cisco Firewall enables you to do the following:
l Verify the load session both for IKE Phase 1 and IPSec Phase 2 VPN tunnels.
l Verify the firewall efficiency by monitoring the packet rate and connections, so you


can demonstrate gains and fine-tune your device configuration.
l Monitor the Cisco ASA/PIX devices in real-time to pro-actively optimize your services


availability.
l Understand your device activity, for example, listing which Cisco ASA opens the most


firewall connections, as well as activity peak times and more.
l Collect and interpret data across multiple Cisco ASA devices to perform resource


grouping and mathematical calculations making performance information readily
available.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
CISCO-CRYPTO-ACCELERATOR-MIB.mib


CISCO-IPSEC-FLOW-MONITOR-MIB.mib


OLD-CISCO-INTERFACES-MIB.mib


CISCO-FIREWALL-MIB.mib


CISCO-REMOTE-ACCESS-MONITOR-MIB.mib


Supported devices
Cisco ASA 5500 Series


Cisco PIX 500 Series


Main reports


Session Failure %
Shows a Session Failure graph over a period of time for each polled firewall.


Firewall CPU Usage %
Shows a CPU Usage graph over a period of time for each polled firewall.


Firewall with Most Connections
Provides a TopN Firewall graph showing a firewall with the highest number of
connections over a selected time period.


Firewall Summary
Provides summaries of the Availability %, CPU Usage %, Session Load %, and
Number of Connections of firewall devices.
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Inventory
Displays the inventory (count only) of the Cisco Firewall network.


Performance Scorecard
Reports on firewall hardware availability for memory, CPU, interface, units, disk, and
power.


Situations to Watch
Displays critical and major interface errors, such as half open connections and
session bottlenecks, for each polled firewall.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


l Make sure you know the name, IP address, SNMP port, and the community string of
the firewall device.


l Verify the firewall is configured to allow network access to the SNMP port.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.
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b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.After the installation is complete, select Centralized Management > SolutionPack to
verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


On the Main parameters tab, make sure you specify Firewall for Device Type.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.
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b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.
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3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.


SolutionPack for Cisco Firewall Summary Sheet


94 Service Assurance Suite 9.4  SolutionPack Articles







CHAPTER 9


SolutionPack for Cisco VoIP Summary Sheet


l Overview............................................................................................................... 96
l Support.................................................................................................................96
l License management............................................................................................ 96
l Setting up Cisco CDRs........................................................................................... 97
l Performing additional prerequisite configuration...................................................97
l Installation............................................................................................................98
l Logging in to Centralized Management..................................................................98
l Installing the SolutionPack....................................................................................98
l Creating CDR database schema.............................................................................99
l Editing Tomcat files............................................................................................... 99
l Configuring the user process limits for a Linux installation.................................. 100
l Installing a SolutionPack Center Upgrade............................................................ 100
l Uninstalling a SolutionPack.................................................................................102
l Viewing SolutionPack reports..............................................................................102
l Reports............................................................................................................... 102
l Metrics................................................................................................................103
l SSL certificates................................................................................................... 117


SolutionPack for Cisco VoIP Summary Sheet     95







Overview
Learn how to install and configure the SolutionPack for Cisco VoIP. This SolutionPack
reports on voice quality, availability and VoIP performance and provides status and
metrics for service level measurement.


The SolutionPack enables administrators to identify and resolve issues and avoid the risk
of VoIP service degradation or outages. Additionally the SolutionPack:


l Measures voice quality-establishes voice quality trends over time and helps
troubleshoot VoIP calls for failures and quality deterioration.


l Helps optimize resources-identifies usage, reduces or increases capacity.


l Delivers real-time insight-views performance at a glance or in-depth.


Before beginning your installation, review these sections for pre-requisite information:


l Configure Cisco CDRs on page 97


l Performing additional prerequisite configurations on page 97


l Upgrading an existing SolutionPack on page 25


Support
Review the prerequisite support information before installing the SolutionPack.


This SolutionPack is supported on Watch4net version 6.3 and above. The following
devices are supported:


Product Version


Cisco Unified Communications Manager
(CUCM)


6.0 and above


Cisco Universal Gateways AS5xxx Series


Cisco Integrated Services Routers 1861 Series, 2800/2900 Series,
3800/3900/3900E Series


License management
You can evaluate features in the SolutionPack Center using 30-day temporary licenses
included with EMC M&R software. If you install or plan to use the SolutionPack for longer
than 30 days, contact EMC Online Support for permanent license files.


If you have an existing permanent license or a temporary license that requires updating,
use the license upload feature in EMC M&R Centralized Management. Both permanent
and temporary licenses are distributed in .zip files.


The EMC M&R license name is either EMC M&R SolutionPack for Cisco VoIP CUCM or
ReportPack for Cisco VoiP. The system will use either license.
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Setting up Cisco CDRs
Complete this procedure to configure your Cisco Call Manager device to save CDR/CMR
data so that EMC M&R can generate your SolutionPack reports.


Before you begin


You need administrator access to Cisco Unified Communications Manager and Cisco
Unified Serviceability.


Procedure


1. Log on to your Cisco Unified Communications Manager Administration page with
Administrative privileges.


2. From the drop-down menu on the top of the window, select Cisco Unified
Serviceability, and then click Go .


3. On the Service Parameter page, go to Tools > CDR Management.


4. Click Add new, and provide the FTP details.


For example,


           FTP Host/Destination (VM host IP) : 10.9.13.175
           User (VM host user) : root
           Password (VM host password): dangerous
           Protocol : SFTP
           Directory on ftp server(CUCMs will dump CDR/CMR data in 
this directory): /root/w4n/cisco-voip/cdr
           Resend on Failure : TRUE
           
           For unix Directory Path would be like /root/w4n/cisco-
voip/cdr/
           For windows Directory Path would be like /
cygdrive/c/w4n/cisco-voip/cdr/
          (Note: CUCM does not understand C:\ so you need to 
provide cygwin path for windows.)
 


5. Make sure you activate the service for Cisco CDR located at Tools > Control Centre
Network Services.


Performing additional prerequisite configuration
Before installing your SolutionPack perform these additional tasks on your Cisco call
managers and gateways that require polling.


Procedure


1. Enable SNMP on all call managers and gateways that require polling.


2.
Note


Refer to the following Cisco website for information on this step as well as step 3: 
http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/devguide/9_1_1/
axl.html#wp1054628


Enable AXL for the call managers that require polling.


3. Obtain the CUCM DB schema version to be used with AXL requests.


4. Enable CDRs to send data to the billing server which can be the same server as
Watch4net.
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Make sure the user 'apg' has the correct CDR permissions so that it can access the
CDR repository on the billing server.


Installation
Review this information before beginning the installation.


l Make sure you review and perform the prerequisites outlined in the first chapter.


l Perform the installation with administrative privileges on the EMC M&R User
Interface.


Logging in to Centralized Management
Log in to Centralized Management to perform operations that affect all servers.


Procedure


1. Point your browser to the URL.


For example, http://<Frontend-hostname>:58080/centralized-
management


2. Log in.


a. Type the login credentials.


The default username is admin and the default password is changeme.


b. Click Sign In.


After you finish


Note


You are automatically logged off after four hours.


Installing the SolutionPack
After you log in as an administrator, you can install this SolutionPack from Centralized
Management.


Before you begin


l Core modules must be up-to-date in all servers because not all module dependencies
are validated during the SolutionPack installation or update process.


Core modules are modules that are not installed by a SolutionPack. Examples of core
modules include webapps, module-manager, license-manager, java, mysql, backend,
tools, and so forth. Update these core modules: Databases, Backends, Frontends,
Miscellaneous (except Blocks). The recommended module update order varies. Refer to
the EMC Watch4net Installation and Configuration Guide for information on module
update order for multiple hosts or single host deployments.


Procedure


1. Log in and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select SolutionPack Center.
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5. Select the Cisco VoIP SolutionPack on the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Collector, and Reports list boxes.


c. Click Next.


8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.After installation is complete, verify the SolutionPack version number along with
SolutionPackBlock information. Select Centralized Management > SolutionPacks >
Cisco VoIP.


Creating CDR database schema
After installation you must manually create the schema for the CDR database.


Procedure


1. Verfiy that datastore service started. If not start it: <APG>/bin/manage-modules.sh
service status datastore Default.


2. Copy the content of voip-setup-db.ddl under [APG]/Event-processing/
APG-Datastore-Writer/[instance_name]/ddl.


3. Execute the script datastore-client.sh or (cmd for Windows) under [APG]/
bin/ and paste the content of the ddl file at the prompt line.


4. Restart the event-processing-manager.


Editing Tomcat files
After editing the schema for the CDR database, edit these Tomcat files and configure the
connection to the CDR database.


Procedure


1. Edit following tomcat file: [APG]/Web-Servers/Tomcat/[instance_name]/
conf/server.xml. Add the following definition to the section where the
connections to the DBs are defined. Add it above the following line Defines the
connection to the Events Archive database for APG Datastore.


<Resource name="jdbc/FLOW-TF-VOIP" auth="Container" 
type="javax.sql.DataSource" maxActive="10"
                                maxIdle="10" 
validationQuery="SELECT 1" testOnBorrow="false" 
testWhileIdle="true"
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timeBetweenEvictionRunsMillis="10000" 
minEvictableIdleTimeMillis="60000" maxWait="10000"
                                username="admin" 
password="changeme" 
driverClassName="com.watch4net.x100.jdbc.Driver"
                                removeAbandoned="true" 
removeAbandonedTimeout="60" logAbandoned="true"
                                url="jdbc:x100://localhost:48443/
Databases/APG-Datastore" />


2. Edit [APG]/Web-Servers/Tomcat/[instance_name]/conf/Catalina/
localhost/APG.xml. Add the following definition to the section where the
connections to the DBs are defined. Add the definition above the <!-- emc
prosphere --> line: <ResourceLink name="jdbc/FLOW-TF-VOIP:
{ mapping=FLOW-CISCO-CDR.xml, table= CISCO_VOIP_CUCM_CDR}"
global="jdbc/FLOW-TF-VOIP" type="javax.sql.DataSource" />


3. Restart the Tomcat service.


Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack Center Upgrade
Periodically, updates of the SolutionPacks are available in a .zip file called
SolutionPackCenter Update on EMC Online Support. This .zip file contains a README file


SolutionPack for Cisco VoIP Summary Sheet


100 Service Assurance Suite 9.4  SolutionPack Articles







that describes the changes made to each SolutionPack and individual
<solution>.pkg files for installing each update.


Before you begin


l Install the required license file to enable your SolutionPack.


l Ensure any Domain Managers that supply data to the SolutionPack are installed and
configured.


l Make sure you have a login with root, APG, or system administrator privileges to
perform this task. The user apg is the account that the EMC M&R platform application
uses instead of root.


l Update the core modules in all servers before you update or install a SolutionPack
after upgrading your base installation.


Core modules are modules that are not installed by a SolutionPackBlock. Examples of
core modules include webapps, module-manager, license-manager, java, mysql,
backend, tools, and so forth. Update these core modules: Databases, Backends,
Frontends, Miscellaneous (except Blocks). Since the recommended module update order
varies, refer to the Module Update Order section for the multiple hosts or single host
deployments. Also, the EMC Watch4net Centralized Management Guide provides more
information.


Examples of modules that are installed with SolutionPackBlocks include collector-
manager, event-processing-manager, and collector or event components.


Procedure


1. Locate the EMC M&R downloads area on EMC Online Support.


a. Go to https://support.emc.com.


b. Click Support by Product.


c. Type Watch4net in the Find a Product field, and then click the arrow next to it.


d. Click Downloads.


The Downloads for Watch4net page appears.


2. Download the latest SolutionPackCenter Update to a local directory.


For example: SolutionPackCenter Update <month> <year>


3. Browse to Administration > Centralized-Management > Packages Management and
click Upload.


4. Browse to the SolutionPackCenter Update .zip file and click OK.


After you finish


Update the SolutionPackBlocks after installing the SolutionPack update. Browse to
Administration > Centralized Management > SolutionPacks > SolutionPack Center and
install the SolutionPack.


You can confirm the SolutionPack version number by browsing SolutionPacks in the left
panel.
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Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall that
SolutionPack from the server.


Procedure


1. Log in with administrator credentials for EMC M&R platform and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select the SolutionPack that you want to uninstall in the Installed SolutionPacks
screen.


5. In the Properties area, click Trashcan icon for each instance of the SolutionPackBlock
and click Remove.


Viewing SolutionPack reports
You can view your reports from the EMC M&R console.


Before you begin


After installing the SolutionPack, access the EMC M&R User Interface.
Procedure


1. Point your web browser to http://[serverIP:port]/APG.


An example default URL is http://localhost:58080/APG.


2. On the login screen, enter your EMC M&R username and password, and click Sign In.


3. View SolutionPack reports by expanding Report Library > Your SolutionPack Name.


Reports
This reports table includes the "out-of -the box" reports available with this SolutionPack.


You can drill-down on some top-level reports to view sub-level reports with specific
metrics related to the objects in the top-level report.


Report Description


Devices Health - All
Devices


Includes health information for all gateways and call manager devices per
cluster - drill down on a device for metrics such as CPU usage, average
used memory, availability, interface usage and statistics.


UC Environment
Inventory


Lists all call managers per cluster as well as their availability.


Call Overview Displays important information per cluster including:


l Call overviews


l Disconnected calls and their root cause


l Calls Quality (Qos and MoS)


l Calls statistics and more.


SolutionPack for Cisco VoIP Summary Sheet


102 Service Assurance Suite 9.4  SolutionPack Articles







Report Description


CUCM Reports Call Manager reports include reports per cluster on licensing, services,
cluster health, phones, route pattern, trunks and media resources. Drill
down on any device for more metrics and reports.


Gateway Reports Gateway reports per cluster on gateway trunk utilization, trunk statistics,
trunks availability and more.


Metrics
Report metrics are used to create SolutionPack reports. Metrics are used to gather
information for monitoring or reporting on your Cisco devices.


Table 2 Metrics group 1


Source Properties Name


VOIP-CISCO-
XML-
CCSERVICES


part =>ServiceName Status =>ServiceStatus (%)


partdesc =>ReasonCodeString


datagrp=ControlCenterServices
(hard Coded)


devtype=CallManager(hard Coded)


entity=ControlCenter(hard Coded)


parttype=ControlCenter(hard Coded)


type=Services(hard Coded)


ip (taken from context file)


VOIP-CISCO-
XML-
CCSERVICES


part => ServiceName Service UpTime=>UpTime(s)


partdesc =>ReasonCodeString


datagrp=ControlCenterServices
(hard Coded)


devtype=CallManager(hard Coded)


entity=ControlCenter(hard Coded)


parttype=ControlCenter(hard Coded)


type=Services(hard Coded)


ip (taken from context file)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco MGCP Gateways-
RT(hard Coded)


Channel Status=>BRIChannelsActive(Nb)


devtype=Gateway MGCP(hard
Coded)
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Table 2 Metrics group 1 (continued)


Source Properties Name


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


part=>Name


type=BRI(hard Coded)


entity=PSTN Trunk(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco MGCP Gateways-
RT(hard Coded)


Channel Status=>FXOPortsActive(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


part=>Name


type=FXO(hard Coded)


entity=Gateway(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco MGCP Gateways-
RT(hard Coded)


Channel Status=>FXSPortsActive(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


part=>Name


type=FXS(hard Coded)


entity=Gateway(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco MGCP Gateways-
RT(hard Coded)


Channel Status=>PRIChannelsActive(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


part=>Name


type=PRI(hard Coded)


entity=PSTN Trunk(hard Coded)
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Table 2 Metrics group 1 (continued)


Source Properties Name


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco MGCP Gateways-
RT(hard Coded)


Channel Status=>T1ChannelsActive(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


part=>Name


type=T1CAS(hard Coded)


entity=PSTN Trunk(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco CTIManager-RT(hard
Coded)


CTI Active
Connections=>CTIConnectionActive(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=CTI Device(hard Coded)


part=>Name


entity=CallManager(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco Lines-RT(hard Coded) ActiveLines=>Value(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=Lines(hard Coded)


part=>Name


entity=CallManager(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco H323-RT(hard Coded) Calls Active=>CallsActive(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=H323Device(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco H323-RT(hard Coded) Video Calls Active=>VideoCallsActive(Nb)


devtype=CallManager(hard Coded)


SolutionPack for Cisco VoIP Summary Sheet


Metrics     105







Table 2 Metrics group 1 (continued)


Source Properties Name


ip (taken from context file)


parttype=H323Device(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco SIP-RT(hard Coded) Calls Active=>CallsActive(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=SIPDevice(hard Coded)


part=>Name


type=SIP Trunk(hard Coded)


entity=IP Trunk(hard Coded)


VOIP-CISCO-
XML-
PERFMON-RT


datagrp=Cisco SIP-RT(hard Coded) Video Calls Active=>VideoCallsActive(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=SIPDevice(hard Coded)


part=>Name


type=SIP Trunk(hard Coded)


entity=IP Trunk(hard Coded)


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP BRI
Device(hard Coded)


Calls
Attempted=>OutboundBusyAttempts(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=BRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP BRI
Device(hard Coded)


Calls Completed=>CallsCompleted(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)
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Table 2 Metrics group 1 (continued)


Source Properties Name


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=BRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP BRI
Device(hard Coded)


Signaling Status=>DatalinkInService(%)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=BRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP FXO
Device(hard Coded)


Calls
Attempted=>OutboundBusyAttempts(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=Gateway(hard Coded)


parttype=MGCPDevice(hard Coded)


type=FXO(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP FXO
Device(hard Coded)


Calls Completed=>CallsCompleted(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=Gateway(hard Coded)


parttype=MGCPDevice(hard Coded)


type=FXO(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP FXO
Device(hard Coded)


Port Status=>PortStatus(%)
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Table 2 Metrics group 1 (continued)


Source Properties Name


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=Gateway(hard Coded)


parttype=MGCPDevice(hard Coded)


type=FXO(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP FXS
Device(hard Coded)


Calls
Attempted=>OutboundBusyAttempts(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=Gateway(hard Coded)


parttype=MGCPDevice(hard Coded)


type=FXS(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP FXS
Device(hard Coded)


Calls Completed=>CallsCompleted(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=Gateway(hard Coded)


parttype=MGCPDevice(hard Coded)


type=FXS(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP FXS
Device(hard Coded)


Port Status=>PortStatus(%)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=Gateway(hard Coded)


parttype=MGCPDevice(hard Coded)


type=FXS(hard Coded)


part=>Name
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Table 2 Metrics group 1 (continued)


Source Properties Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP PRI
Device(hard Coded)


Calls
Attempted=>OutboundBusyAttempts(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=PRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP PRI
Device(hard Coded)


Calls Completed=>CallsCompleted(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=PRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP PRI
Device(hard Coded)


Signaling Status=>DatalinkInService(%)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=PRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP T1 CAS
Device(hard Coded)


Calls
Attempted=>OutboundBusyAttempts(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)
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Table 2 Metrics group 1 (continued)


Source Properties Name


parttype=MGCPDevice(hard Coded)


type=T1CAS(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP T1 CAS
Device(hard Coded)


Calls Completed=>CallsCompleted(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


entity=PSTN Trunk(hard Coded)


parttype=MGCPDevice(hard Coded)


type=T1CAS(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco H323(hard Coded) Calls Attempted=>CallsAttempted(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=H323Device(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco H323(hard Coded) Calls Completed=>CallsCompleted(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=H323Device(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco H323(hard Coded) Video Calls
Completed=>VideoCallsCompleted(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=H323Device(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco SIP(hard Coded) Calls Attempted=>CallsAttempted(Nb)
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Table 2 Metrics group 1 (continued)


Source Properties Name


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=SIPDevice(hard Coded)


entity=IP Trunk(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco SIP(hard Coded) Calls Completed=>CallsCompleted(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=SIPDevice(hard Coded)


entity=IP Trunk(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco SIP(hard Coded) Video Calls
Completed=>VideoCallsCompleted(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


parttype=SIPDevice(hard Coded)


entity=IP Trunk(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP Gateways(hard
Coded)


Channels Count=>BRISpansInService(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


entity=PSTN Trunk(hard Coded)


type=BRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP Gateways(hard
Coded)


Channels Count=>FXOPortsInService(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)
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Table 2 Metrics group 1 (continued)


Source Properties Name


parttype=MGCPDevice(hard Coded)


entity=PSTN Trunk(hard Coded)


type=FXO(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP Gateways(hard
Coded)


Channels Count=>FXSPortsInService(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


entity=PSTN Trunk(hard Coded)


type=FXS(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP Gateways(hard
Coded)


Channels Count=>PRISpansInService(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


entity=PSTN Trunk(hard Coded)


type=PRI(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco MGCP Gateways(hard
Coded)


Channels Count=>T1SpansInService(Nb)


devtype=Gateway MGCP(hard
Coded)


ip (taken from context file)


parttype=MGCPDevice(hard Coded)


entity=PSTN Trunk(hard Coded)


type=T1CAS(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco CallManager(hard
Coded)


HeartBeat=>CallManagerHeartBeat(Nb)
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Table 2 Metrics group 1 (continued)


Source Properties Name


devtype=Call
Manager(hard
Coded)


ip (taken from context file)


entity=CallManager(hard Coded)


parttype=CallManager(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco CallManager System
Performance(hard Coded)


Expected
Delay=>AverageExpectedDelay(ms)


devtype=CallManager(hard Coded)


ip (taken from context file)


entity=CallManager(hard Coded)


parttype=CallManager(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco CallManager System
Performance(hard Coded)


Calls Rejected Due To ICT
Throttling=>CallsRejectedDueToThrottling(
Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


entity=CallManager(hard Coded)


parttype=CallManager(hard Coded)


part=>Name


VOIP-CISCO-
XML-
PERFMON


datagrp=Cisco CallManager System
Performance(hard Coded)


Calls Rejected Due To Generic
Throttling=>CallThrottlingGenericCounter
3(Nb)


devtype=CallManager(hard Coded)


ip (taken from context file)


entity=CallManager(hard Coded)


parttype=CallManager(hard Coded)


part=>Name


SolutionPack for Cisco VoIP Summary Sheet


Metrics     113







Table 3 Metrics group 2


Metric name Unit Description


ActivePhones Number
(Nb)


Number of phones connected to, and actively in
communication with, (via keep-alives), the Call
Manager.


InActivePhones Nb Number of phones registered with, but has lost
contact with the Call Manager. Phones lose contact
with the Call Manager if the Call Manager does not
rece i ve any keep-alives.


ActiveGateways Nb Number of gateways configured with the Call Manager
and actively in communication (via keep-alives) with
the Call Manager.


InActiveGateways Number of gateways that are registered with the Call
Manager but have lost contact with the Call Manager.
The gateways are said to have lost contact with the
Call Manager if the Call Manager does not receive any
keep-alives.


RegisteredPhones Nb Number of phones that are registered and actively in
communication with the local Call Manager.


UnregisteredPhones Nb Number of phones that are unregistered or have lost
contact with the local Call Manager.


RejectedPhones Nb Number of phones whose registration requests were
rejected by the local Call Manager.


RegisteredMediaDevices Nb Number of media devices that are registered and
actively in communication with the local Call
Manager.


UnregisteredMediaDevices Nb Number of media devices that are unregistered or
have lost contact with the local Call Manager.


RejectedMediaDevices Nb Number of media devices whose registration requests
were rejected by the local Call Manager.


RegisteredCTIDevices Nb Number of CTI devices that are registered and actively
in communication with the local Call Manager.


UnregisteredCTIDevices Nb Number of CTI devices that are unregistered or lost
contact with the local Call Manager.


RejectedCTIDevices Nb Number of CTI devices with registration requests
rejected by the local Call Manager.


RegisteredVoiceMailDevices Nb Number of voice messaging devices that are
registered and actively communicating with the local
Call Manager.


UnregisteredVoiceMailDevices Nb Number of voice messaging devices that are
unregistered or lost contact with the local Call
Manager.


RejectedVoiceMailDevices Nb Number of voice messaging devices with registration
requests rejected by the local Call Manager.
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Table 3 Metrics group 2 (continued)


Metric name Unit Description


PartiallyRegisteredPhones Nb Number of phones that are partially registered with
the local Call Manager.


Status (CallManager) Current status of the Call Manager. A Call Manager is
Up if the SNMP Agent received a system Up event from
the local CCM - status values include:


1. · Unknown: Current status of the Call Manager is
Unknown


1. · Up: Call Manager is running and able to
communicate with other Call Managers


1. · Down: Call Manager is down or the Agent is
unable to communicate with the local Call
Manager.


Availability (Phone) % Availability of the phone. The availability of the phone
changes from Unknown to Registered when the phone
registers with the local CCM.


Availability (Line Extension) % Represents the % availability of the phone line.


Availability (Gateway) % Status of the gateway. The Gateway status changes
from Unknown to Registered when the Gateway
registers with the local CCM.


Status (Gateway) % D-Channel status of the gateway. Status values
include: active(1): The D-Channel is up inActive(1):
The D-Channel is down unknown(3): The D-Channel
status is unknown notApplicable(4): The D-channel
status is not applicable for this gateway.


Availability (Trunk Gateway) % The state of the trunk. The trunk status changes from
Unknown to Up when it registers with the local CCM.
Status values include: Unknown: state of trunk is
unknown up: Up and running. Idle with no calls. busy:
Trunk in busy state down: Trunk down


Availability (Media Device) % Status of the Media Device. The status changes from
unknown to registered after registration with the local
CCM.


Availability (CTI Device) % The status of the CTI Device. CTI Device status
changes from unknown to registered after registration
with local CCM.


Availability (Voice Mail) % The table containing a list of all voice messaging
devices that attempted registration with the local Call
Manager (minimum of one attempt).


Availability (H323) % The H323 device registration status with the
gatekeeper. The status changes from unknown to
registered when the H323 device successfully
registers with the gatekeeper. Status values include:
notApplicable: The registration status is not
applicable for this H323 device. unknown: The
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Table 3 Metrics group 2 (continued)


Metric name Unit Description


registration status of the H323 device with the
gatekeeper is unknown. registered: H323 device
successfully registered with gatekeeper. unregistered:
H323 device no longer registered with gatekeeper
rejected: Registration request from H323 device
rejected by gatekeeper.


CardState % DSP subsystem might reset DSP card to recover from
fatal error condition. After the DSP card resets
successfully, the object cdspCardResourceUtilization
and cdspCardLastHiWaterUtilization reset to 0. If the
fatal error persists in this object after card is reset,
card should be replaced. - offLine - DSP card is in off-
line maintenance state.


ResourceUtilization % Indicates the percentage of current DSP resource
utilization of the card. Utilization is a ratio of number
of busy DSP resources (for handling calls,
transcoding, voice compression, and so on) to the
total available DSP resources.


Availability (DSP Module) % The current operational state of the DSP. Values
include: normal: DSP operates normally. shutdown:
DSP shut down due to fatal error. congested: DSP
does not accept call because the DSP buffer is full.
failed: DSP failed.


TotalChannels (DSP Module) Nb Total number of channels in the DSP. Value is
predetermined by the DSP functionality upon
initialization. Value of 0 indicates Channelized DSP
mode is turned off.


ActiveChannels (DSP Module) Nb Number of channels that are used by active calls to
process media stream. The value is incremented after
the reserved DSP channel enters call connection state
and is decremented after the call disconnects.


isdnOperStatus % The current call control state for the port. Values
include: idle(1): B channel is idle. No current call or
call attempt. connecting(2): Current connection
attempt (outgoing call). connected(3): Incoming call
being validated. active(4): Call active on the interface.


isdnSignalingStatus % Object used to create and delete rows in the
isdnSignalingTable.


VOIPSuccessCalls Nb Number of completed calls to this peer.


VOIPFailCalls Nb Number of failed call attempts to this peer since
system startup.


VOIPAcceptCalls Nb Number of calls from this peer accepted since system
startup.
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Table 3 Metrics group 2 (continued)


Metric name Unit Description


VOIPRefuseCalls Nb Number of calls from this peer refused since system
startup.


SSL certificates
Generally, EMC products are distributed with a self-signed SSL certificate. If you receive
an SSL certificate error or a blank pane when you are attempting to access content served
by a data source, resolve the issue by doing one of the following procedures.


SSL certificate error examples on page 30 provides a list of sample errors.


Temporary resolution
Accept the certificate exception temporarily: Troubleshooting an SSL certificate error:
Accepting the exception on page 30.


Permanent resolution
Add an SSL certificate to your truststore to permanently prevent the exceptions from
appearing.


You can: Perform:


Install the self-signed SSL certificate
that is provided with the EMC product
using an Internet Explorer browser.


Installing a self-signed SSL certificate from an
Internet Explorer browser on page 30


Install the self-signed SSL certificate
that is provided with the EMC product
using a Chrome or Firefox browser.


1. Export the self-signed SSL certificate to
save it to the export location: Exporting an
SSL certificate from an Internet Explorer
browser on page 32


2. Importing an SSL certificate into your
truststore on page 31


Import an exported SSL certificate that
you or another administrator prepared.


Importing an SSL certificate into your
truststore on page 31


If you need to prepare an SSL certificate to share with other users, use: Exporting an SSL
certificate from an Internet Explorer browser on page 32.


SSL certificate error examples
The SSL certificate error or a blank pane appears because the certificate is self-signed
and it is not added as an exception or into the truststore yet. For example, if you are
attempting to access content served by a data source, a blank pane appears when you
select views under SolutionPacks.


Chrome error examples


This site's security certificate is not trusted!


Or, a blank pane.
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Firefox error example


This Connection is Untrusted


Internet Explorer error examples


There is a problem with this website's security certificate.


Content was blocked because it was not signed by a valid security 
certificate.


Troubleshooting an SSL certificate error: Accepting the exception
An SSL certificate error appears in your browser.


To resolve this issue,


Procedure


l Accept the exception.


Steps may vary for your browser. For example, for Internet Explorer, click Continue to
this website (not recommended).


This temporary solution causes the exception to be ignored for the current browser
session, but the exception reappears if you open another browser tab or window.


Installing a self-signed SSL certificate from an Internet Explorer browser
Install the self-signed SSL certificate that is provided with the EMC product to prevent
certificate exception errors.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Click Continue to this website (not recommended) in the browser window.


2. Click the red Certificate Error indicator next to the address bar.


3. In the Untrusted Certificate window, select View certificates.


4. In the Certificate dialog box, in the General tab, click Install Certificate.


5. Follow the instructions in the Certificate Import Wizard.


a. Select the Place all certificates in the following store setting to add the certificate
to your truststore.


6. In the Certificate dialog box, in the General tab, click OK.


After you finish


Refresh the browser window.


Importing an SSL certificate into your truststore
Import an SSL certificate into your truststore to prevent certificate exception errors.


Procedure


l Import the certificate using one of the following procedures:


n Importing an SSL certificate in Chrome on page 31


n Importing an SSL certificate in Firefox on page 31
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n Importing an SSL certificate in Internet Explorer on page 31


Importing an SSL certificate in Chrome
For Chrome, use this procedure to import the certificate into your truststore.


The following procedure is for Chrome version 28.0.1500.95. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Settings > Show advanced settings.


2. Scroll down and select HTTP/SSL > Manage Certificates.


3. In the Trusted Root Certification Authorities tab, click Import.


4. Follow the instructions in the Certificate Import Wizard to import the certificate.


5. Click OK in Internet options.


6. Refresh the browser window.


Importing an SSL certificate in Firefox
For Firefox, use this procedure to import the certificate into your truststore.


The following procedure is for Firefox version 23.0. The steps may vary slightly depending
on your browser version.


Procedure


1. Go to Firefox > Options > Options.


2. Click Advanced.


3. In the Certificates tab, click View Certificates.


4. Click Import.


5. Locate the certificate file and click Open.


6. Click Save.


7. Click OK in Certificate Manager.


8. Refresh the browser window.


Importing an SSL certificate in Internet Explorer
For Internet Explorer, use this procedure to import the certificate into your truststore.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Tools > Internet options.


2. In the Content tab, click Certificates.


3. Select the Trusted Root Certification Authorities tab.


4. Click Import.


5. Follow the instructions in the Certificate Import Wizard to import the certificate.


6. Click OK in Internet options.


7. Refresh the browser window.
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Exporting an SSL certificate from an Internet Explorer browser
Use this procedure to export a self-signed SSL certificate, so that you can either import
the resulting exported certificate into your truststore or share it with other users.


The following procedure is for Internet Explorer version 10.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Access the host for which you want to export the SSL certificate from the browser.


For example: https://<myHostname>.emc.com
2. Select Continue to this website (not recommended) in the There is a problem with


this website's security certificate window.


3. Click the red Certificate Error indicator next to the address bar.


4. In the Untrusted Certificate window, select View certificates.


5. In the Certificate dialog box, select the Details tab and ensure that the Show field is
set to All. Click Copy to File.


6. In the Certificate Export Wizard,


a. Click Next in the Welcome screen.


b. Click Next to accept the default DER encoded binary X.509 setting in the Export File
Format screen.


c. Browse to the location where you want to save the certificate.


d. Specify the certificate file name and click Save.


e. In the File name field, ensure that the location and the certificate file name are
correct. Click Next.


f. Click Finish.


g. Click OK when The export was successful appears.


7. In the Certificate dialog box, click OK in the Details tab.


8. Share the resulting exported SSL certificate with other users to use.
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Overview
Learn how to install and configure the SolutionPack for Cisco Wi-Fi. This SolutionPack
monitors and creates reports for the most common Cisco Wi-Fi Access Points. It reports
on Controllers and Access Points that include inventory views, real-time performance
views, and historical performance.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u1 and later


Data collection method
SNMP collector


Supported MIBs
All CISCO Aironet Wi-Fi Access Points support these MIBs:


l CISCO-DOT11-IF-MIB.my


l CISCO-DOT11-QOS-MIB.my


l IEEE802dot11-MIB.my


l CISCO-AAA-SERVER-MIB.my


l CISCO-IETF-DOT11-QOS-MIB.my


Main reports
Total Number of Clients


Controller Summary:


l Number of Clients By Controller (over time)


l Cisco Wireless Association Statistics


Total Number of Clients


Controller Summary


Inventory:


l Access Point Distribution among Controllers


l Access Point Inventory by Controller


l Cisco Wireless Inventory


Performance Scorecard:


l Access Point Availability among Wi-Fi Controllers


l Cisco AAA (Authentication Authorization Accounting)


l Cisco Lightweight Wireless Access Point Performance


l Cisco Lightweight Wireless Access Point Controller performance (LWWAP)


l Cisco Wireless Access Point MAC Statistics


l Cisco Wireless Access Point QoS
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l Users Currently Connected


Situations to Watch:


l Possible Misallocated Access Points (SNR vs. Number of Clients)


l Rogue Access Point


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing the SolutionPack


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC support website http://support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the Watch4net Installation and Configuration Guide provides for more
information.


Follow these steps to install the SolutionPack for Cisco Wi-Fi and perform Cisco device
discovery.


Procedure


1. Log in to Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select the SolutionPack for Cisco Wi-Fi in the Browse and Install SolutionPacks
screen.


4. Read the summary information and click Install.


5. Select the Administration Web-Service Instance as the default and click Next.


6. In the SNMP Masks wizard, click Install.


7. Wait until the installation is complete for both SNMP Masks and Report and then click
OK.


8. Under Collecting, click Administration > Device Discovery.


9. On the Device Discovery page, click Collectors.


10.Create a new collector by accepting all the default options.


11.Click Device and add the Cisco device to be discovered.


a. Type the IP address, the SNMP community string, and assign the collector that you
previously created.
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b. Select all Cisco capabilities to be discovered and any other capabilities.


12.Select the Cisco device that you just added and click Approve.


13.From the Dashboard:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


After you finish


After the installation is complete, select Centralized Management > SolutionPack to verify
the installed SolutionPack


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn to install and configure the SolutionPack for EMC Network Configuration Manager
(NCM). This SolutionPack provides a wide spectrum of reports regarding NCM application
servers and device servers. It enables you to quickly determine the inventory and assets,
compliance, and all changes being made to any NCM application servers.


Technical specifications


SolutionPack version
1.2.1.0


Compatible EMC M&R versions
6.3.x and later


Compatible NCM version
NCM 9.3 and later


Data collection methods
SQL collector


XML collector


Remote Shell collector


Main reports


Change Detail Report
Requires msa-user login credentials to NCM EDAA (EMC Data Access API) to retrieve
and view configuration differences from devices managed by NCM.


Job Reporting
The Active Job List and Historical Job List nodes have been enhanced to have an Error
Description column that displays errors associated with each job.


Deployment Topology
Provides information about different Application Servers . Each Application server
node displays details about associated Database and Device Servers.


Sites
Provides device-specific information for each site.


Views
Provides different views of device-specific information.


Certificate monitoring
This is a monitoring and alerting report showing expired certificates These
certificates govern the communication between the Application Server and Device
Server and between the User Interface and Application Server. You must renew
certificates before they expire or NCM will stop functioning.


Device Change Report


User Change Report


PCI DSS 1.1


PCI DSS 1.2


PCI DSS 2.0
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DISA STIG 1.1


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Prerequisites
These are the prerequisites for installing the SolutionPack:


l Setting the IP address of the EMC M&R server on page 129


l Setting the collector heap memory size on page 130


Setting the IP address of the EMC M&R server
After you install the Network Configuration Manager, you must configure the IP address of
the EMC M&R server.


Procedure


l Follow these steps to set the IP address of the EMC M&R server:


Operating
system


Steps


Linux 1. Open the <Product directory>/db/controldb/data/
pg_hba.conf file for editing.


2. Add this line at the end of the pg_hba.conf file: host all
all <EMC M&R IP address>/32 md5


3. Save and exit the pg_hba.conf file.


4. Type service controldb restart to restart the controldb
service.


Windows 1. Open the <Product directory>/db/controldb/data/
pg_hba.conf file for editing.


2. Add this line at the end of the pg_hba.conf file: host all
all <EMC M&R IP address>/32 md5


3. Save and exit the pg_hba.conf file.


4. Navigate to Start > Administrative Tools > Services >
NCM_Controldb to restart the controldb service.


SolutionPack for EMC Network Configuration Summary Sheet


Where to find the latest SolutionPack software     129



http://support.emc.com

http://support.emc.com





Setting the collector heap memory size
For Linux servers, set the collector heap memory size to run the SolutionPack reports.


Before you begin


To determine the collector heap memory size for a network, see the section on Hardware
requirements for running reports.


Procedure


1. Open the /opt/APG/Collecting/Collector-Manager/
<your_instance>/conf/unix-services.properties file.


2. Set the collector heap memory value for the network.


3. Update the collector by running /opt/APG/bin/ ./manage-modules service
install <collector_instance>.


4. When The service <your_collector_instance> is about to be
stopped appears, type Yes.


5. When Updating service <your_collector_instance>...
[ updated ] appears, restart the service by typing /opt/APG/bin/ ./manage-
module service restart <collector_instance>.


Hardware requirements for running reports
Verify that your network configuration has the minimum requirements for running the
SolutionPack reports.


This table lists the minimum requirements for running reports. For example, to run a
report for a small network, the EMC M&R server must have a 3Ghz dual CPU with 16GB
RAM running on a 15K RPM disk.


Network
size


EMC M&R
architec-
ture type


EMC
M&R
server


Total
devices


Raw
metrics


Data
growth
(MB/
hour)


Data
growth
(GB/
hour)


Data
storage
(days)


Min
disk
space
(GB)


Recom-
mended
disk
config


Polling
period
(secs)


Collector
heap
memory


Small
<1000
servers


Single
server


3Ghz dual
CPU


16GB RAM


15K RPM
disk


1000 24,000 4.8 0.1152 90 61 RAID 10


15K RPM


900 3GB


Small to
Medium
<5000
devices


Single
server


3Ghz dual
CPU


16GB RAM


15K RPM
disk


5000 120,00
0


24 0.576 90 102 RAID 10


15K RPM


900 4GB


Medium
<15000
devices


Single
server


3Ghz
quad CPU


32GB RAM


15K RPM
disk


15000 360,00
0


72 1.728 90 206 RAID 10


15K RPM


900 8GB
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Network
size


EMC M&R
architec-
ture type


EMC
M&R
server


Total
devices


Raw
metrics


Data
growth
(MB/
hour)


Data
growth
(GB/
hour)


Data
storage
(days)


Min
disk
space
(GB)


Recom-
mended
disk
config


Polling
period
(secs)


Collector
heap
memory


Medium
to Large
<25000
devices


Single
server


3Ghz
quad CPU


32GB RAM


15K RPM
disk


25000 600,00
0


120 2.88 90 310 RAID 10


15K RPM


900 8GB


Large
<35000
devices


Single
server


3Ghz
quad CPU


64GB RAM


15K RPM
disk


35000 840,00
0


168 4.032 90 413 RAID 10


15K RPM


900 12GB


Very
Large
<50000


Single
server


3Ghz
quad CPU


64GB RAM


15K RPM
disk plus
SSD for
BE/DB


50000 1,200,0
00


240 5.76 90 569 RAID 10


15K RPM
for OS
and
W4net
plus
multiple
SSD disks
for BE/DB


900 14GB


Above
50K
devices
(multi-
NCM)


Distributed
(collectors
and
BE/DB)


Contact
EMC
Support


100000 2,400,0
00


480 11.52 90 1087 Contact
EMC
Support


Contact
EMC
Support


Contact
EMC
Support


Installing the SolutionPack for EMC Network Configuration
Manager


To view data from Network Configuration Manager, install the SolutionPack for EMC
Network Configuration Manager in the EMC M&R platform.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC support website http://support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide
provides for more information.


l The Network Configuration Manager is installed and running.


l You have root login credentials for the Network Configuration Manager.
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l The SolutionPack for EMC Network Configuration Manager license is uploaded to the
EMC M&R platform.


l The EMC M&R platform is updated to 6.4 or higher.


Procedure


1. Log in to the EMC M&R server with root privileges.


For example, http://Frontend-hostname:58080/APG
2. Select Administration.


3. Select Centralized Management in the Administration tree.


4. Select SOLUTIONPACK CENTER.


5. Select the EMC Network Configuration Manager in the Browse and Install
SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Accept the default name, emc-ncm, in the Instance name field.


b. Select the EMC M&Rserver that will host the data collector in the Data collection
list box.


c. Select the EMC M&R server to host the reports in the Reports list box.


d. Click Next.


8. Accept the default values for the Data Collection and Alerting on Data Collection
panes.


9. Enter the server addresses and root credentials in the Server Configuration pane for
combination (Combo server) or distributed (Device server) NCM deployments.


10.To collect information from the NCM database:


a. Type the fully qualified System IP address or host name, the root user account, and
password.


b. Type the NCM System administrator user name (for example, sysadmin) and
password.


c. Type the NCM database IP address or hostname.


d. Type the NCM database port number or accept the default port 5435 .


e. Type the name to identify the NCM database in EMC M&R in the NCM instance
name field or accept the default name.


f. Type the NCM database password.


11.Set the polling interval for data collection in the Configure Collector Advanced
Settings pane.


12.Click Next and select the gateway and the administration web-service instance or
accept the default values.


13.Select Install to install the SolutionPack.


After you finish


Allow four to five polling cycles to pass before viewing reports.
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Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l Changing the NCM EDAA password needed to access Change Details reports on page
133


l Troubleshooting Change Details report certificate errors in Chrome on page 134


l Troubleshooting Change Details report certificate errors in Firefox on page 134


l Troubleshooting Change Details report certificate errors in Internet Explorer on page
134


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


l Troubleshooting a broken connection between NCM and EMC M&R on page 136


Changing the NCM EDAA password needed to access Change Details reports
Each user who wants to see the configuration changes in the NCM Change Details reports
needs to log in to a separate URL with the NCM EDAA (EMC Data Access API) user name
and password. Use this procedure to change the NCM EDAA password.


The Change Details reports contain the configuration differences and audit trails for
devices managed by NCM. These reports require access to an external URL. The external
web application is hosted on the NCM EDAA (also called MSA) tomcat server in your NCM
deployment. The default user login is msa-user. The EMC Smarts Network Configuration
Manager Security Configuration Guide provides default password information. To allow
authentication to this application, a CAS authentication server is deployed along with
ncm-msa service. When you try to access the web application URL, the UI prompts you for
the username and password. To change the password:


Procedure


1. Run [Product directory]/tools/password-change.pl.


2. Choose msa-user and change the password.


3. Restart vcmaster service.
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Troubleshooting Change Details report certificate errors in Chrome
A certificate error displays when connecting to the Change Details report from EMC M&R
(Watch4net) in the SolutionPack for EMC Network Configuration Manager.


Procedure


1. Type the URL for the Change Details report in a separate tab (This is the login to the
NCM EMC Data Access API (EDAA) and the default login is msa-user).


An SSL error message displays.


2. Click Proceed.


3. Launch the Change Details report from the SolutionPack navigation tree.


Troubleshooting Change Details report certificate errors in Firefox
A certificate error displays when connecting to the Change Details report from EMC M&R
(Watch4net) in the SolutionPack for EMC Network Configuration Manager.


Before you begin


Use Firefox as the recommended browser for viewing reports in the EMC M&R
(Watch4net) SolutionPack for EMC Metwork Configuration Manager.


Procedure


1. Type the URL for the Change Details report in a separate tab (This is the login to the
NCM EMC Data Access API (EDAA) and the default login is msa-user).


A certificate error message displays.


2. Add the Change Details report exception to the Firefox browser.


3. Launch the Change Details report from the SolutionPack navigation tree.


Troubleshooting Change Details report certificate errors in Internet Explorer
A certificate error displays when connecting to the Change Details report from EMC M&R
(Watch4net) in the SolutionPack for EMC Network Configuration Manager.


Note


Firefox is the recommended browser for viewing reports in the EMC M&R (Watch4net)
SolutionPack. If the problems with Internet Explorer persist, try using a different browser.


Procedure


1. Type the URL for the Change Details report in a separate tab (This is the login to the
NCM EMC Data Access API (EDAA) and the default login is msa-user).


2. Enable the browser to display blocked content.


3. Launch the Change Details report from the SolutionPack navigation tree.


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.


Troubleshooting a broken connection between NCM and EMC M&R
You can analyze the SolutionPack for EMC Network Configuration Manager logs in EMC
M&R to troubleshoot a broken connection.


Procedure


1. Log in to the EMC M&R server.


2. Go to the /opt/APG/Collecting/Collector-Manager/
<ncm_instance_name>/logs directory to view the log files.


For Linux, navigate to your emc-ncm instance and check the log files, /opt/APG/
Collecting/Collector-Manager/<emc-ncm-instance-name>/logs/
collecting-0-0.log
For Windows, navigate to C:\Program Files\APG\Collecting\Collector-
Manager\<emc-ncm-instance-name>\logs\collecting-0-0.log
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Overview
Learn how to install and configure the SolutionPack for EMC Smarts. This SolutionPack
notifies your operators of real-time network events and displays the root-cause and
impact of the event. Historical event data is available as well.


The SolutionPack for EMC Smarts collects performance and availability metrics from your
Smarts domain managers and displays them in Dashboard reports.


When the SolutionPack for EMC Smarts is configured to work with Service Assurance
Manager, the network operator can view and manage notifications from the EMC M&R
Operations interface.


When the SolutionPack for EMC Smarts is configured to work with the IP Configuration
Manager, the administrator can maintain IP polling and threshold settings from the EMC
M&R Administration interface. The article, How to Maintain IP Manager Settings, provides
more information.


Technical specifications


SolutionPack version
2.1.1


Compatible EMC M&R version
6.5u1 and later


Data collection method
Smarts collector


Main reports
Reports display in Report Library > EMC Smarts.


Events
Lists events from networks monitored by EMC Smarts domain managers.


Domain Manager Health
Provides health-related metrics for networks monitored by EMC Smarts domain
managers.


ESM Performance
Provides performance metrics for the EMC Smarts Server Manager.


IP (AM-PM)
Provides availability and performance metrics for IP networks monitored by EMC
Smarts domain managers.


ACM Performance
Provides performance metrics for the EMC Smarts Application Connectivity Manager.


Additional reports display in these tabs:


l Dashboards > Network


l Explore > Network


l Operations > Network


By default, the SolutionPack for EMC Smarts uses the Smarts discovery associated with a
Presentation Service Assurance Manager (SAM). When you configure the SolutionPack to
link to the Presentation SAM server and to its Broker, the SolutionPack connects to the
domain managers through the host:port/DM_name settings. Notifications from SAM


SolutionPack for EMC Smarts Summary Sheet


138 Service Assurance Suite 9.4  SolutionPack Articles







display in the Notification List in the EMC M&R User Interface. Device details from
underlying Smarts domain managers connected to that Broker display in other EMC M&R
reports.


Alternatively, you may connect the SolutionPack for EMC Smarts directly to the underlying
Smarts domain managers.


Here are examples of the statistics collected by the SolutionPack for EMC Smarts:


l IP Availability Manager (AM)/Performance Manager (PM) (statistics on network
devices and links)


l Server Performance Manager (SPM)/EMC Server Manager (ESM) (statistics on UNIX
and Windows servers, physical and virtual servers and applications)


l Application Connectivity Monitor (ACM) (statistics on transaction response time and
availability


l Service Assurance Manager (SAM) (historical view of SAM notifications)


l SAM (real-time view of SAM notifications)


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installation steps


Installing the SolutionPack for EMC Smarts


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC support website http://support.emc.com.


l Ensure the core modules, such as the Module-Manager, are up-to-date on all servers
since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R Installation and Configuration Guide for more
information.


l Ensure you have installed and configured the Presentation Service Assurance
Manager (SAM) server with Notification Cache Publishing enabled.


l Ensure you have enabled security settings to allow interoperability with EMC M&R by
setting these flags in the runcmd_env.sh file:


Flag Value


SM_ALLOW_LEGACY_CRYPTO= TRUE
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Flag Value


SM_TLS_PROTOCOLS= +TLSv1.1


l Ensure these services associated with the Presentation SAM installation are running:


Service name Description of feature


ic-broker Broker connected to Presentation SAM server


ic-sam-server-pres Presentation SAM with Notification Cache Publishing


smarts-tomcat Smarts EDAA and Notification Cache (hosted by Tomcat server)


smarts-rabbitmq Notification Exchange (Rabbit MQ)


smarts-elasticsearch Storage/Search engine used by the Notification Cache


l Obtain the login credentials and the Fully Qualified Domain Names (FQDN) for the
servers where Smarts Broker, Smarts EDAA, and Presentation SAM servers are
running.


l Review the article, How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts,
for additional configuration procedures.


Follow these steps to install the SolutionPack for EMC Smarts.


Procedure


1. Log in to Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select SolutionPack for EMC Smarts in the Browse and Install SolutionPacks screen.


4. Read the summary information and click Install.


5. Accept the default instance name or type a new name.


One SolutionPack for EMC Smarts instance may be configured for each Presentation
SAM server.


6. Select which server each component will be installed on.


The recommended servers are:


l Data Collection--Collector


l Database--Primary Backend


l Events--Primary Backend


l Reports--Front End


7. Click Next and complete the field entries for the Data collection, Database, Events,
and Reports screens.


Click the question mark icon to access field-level help. (Actual screens and version
numbers will vary from the examples shown in this article.)


l Data collection setup when installing SolutionPack for EMC Smarts on page 141


l Event datastore when installing SolutionPack for EMC Smarts on page 141


l Report setup when installing SolutionPack for EMC Smarts on page 142


8. Click Install after you complete the last screen.


The installation process begins.
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9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.After installation is complete, select Centralized Management > SolutionPack to verify
the installed SolutionPack.


After you finish


Perform these post-installation tasks:


l For Windows environments only, configure the Domain Manager Health collection
package. (No additional configuration is required for EMC Smarts domain managers
running on Linux platforms.)


l Enable Event processing by configuring the APG.xml file.


l If you chose Datastore as the Database Type in the Events list box, you must also
configure the server.xml and the Datastore database schema in order for event
processing to work.


l Set up non-administrator roles and assign users to these roles.


l If using the IP Configuration Manager, set the polling and thresholds values. The
article, How to Manage IP Settings, provides more information.


Data collection setup when installing SolutionPack for EMC Smarts


Accept the default settings or configure custom data collection settings.


l In the Collection list box, you can accept the default Smarts Discovery option to
connect the SolutionPack to the Smarts Broker, Service Assurance Manager, and the
underlying Smarts domains. You can filter domains for data collection by selecting,
Do you want to configure advanced settings.


l If you choose Smarts collector instead of Smarts Discovery, you can
collect topology data from individual Smarts domain managers by configuring their
credentials.


Figure 1  Data Collection example


Event datastore when installing SolutionPack for EMC Smarts
You can choose the database that will hold active and inactive (archived) event data
coming from the underlying Smarts domain managers. The MySQL database can hold
both active and inactive (archived) event data. If you choose Datastore as the
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Database Type, MySQL will still hold active event data, but Datastore will hold the
inactive (archived) event data.


New installations of the SolutionPack for Smarts should choose the Datastore option
as the Database Type. Do not enable the option, Do you want to configure advanced
settings, because this is used when migrating archived event data and that is not
applicable to new installations.


Note


Deployments that used MySQL as the Events database in earlier versions of Watch4net


may want to use the default MySQL entry when updating SolutionPackBlocks. After


migration or update processes have successfully completed, you can change the entry to
use Datastore as the database for inactive (archived) events.
If you are updating the SolutionPackBlocks and you choose Datastore as the Database
Type, do not enable the option, Do you want to configure advanced settings. First, ensure
you have successfully installed the SolutionPack for EMC Smarts and performed the post-
installation steps. Then return to the Events setup screen to migrate the event data using
the Do you want to configure advanced settings option.


The event data migration procedures are in the article, How to migrate archived events after
updating the EMC Smarts SolutionPack.


Figure 2  Events setup example


Report setup when installing SolutionPack for EMC Smarts


In the Report list box, you must specify


l EMC M&R Tomcat Hostname—Enter in the Fully Qualified Domain Name (FQDN) of
your EMC M&R Frontend server. For example, if your EMC M&R Frontend server is at
http://www.example.com:58080/APG, type, www.example.com here.


n Ensure you added the parameter, SM_CAS_SERVER, to the runcmd_env.sh file
in the Presentation SAM server. The hostname portion of the URL entry for
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SM_CAS_SERVER has to match the hostname in the EMC M&R Tomcat Hostname
field. Use only the Fully Qualified Domain Name (FQDN). Do not use the IP
address.


l Smarts EDAA hostname or IP address—Enter the Fully Qualified Domain Name (FQDN)
of your EMC Smarts EDAA Hostname. For example, if your EMC Smarts EDAA
Hostname is at http://www.example.com:8080/, type www.example.com
here.


l Presentation SAM configuration—Type the name of the Presentation SAM Server that
was started with the Notification Cache Publishing option. (This is the domain name,
such as INCHARGE-SA-PRES. Do not enter the service name, such as ic-sam-
server-pres.)


l Use Smarts Configuration Manager—Select this checkbox if you plan to use EMC
M&R and the SolutionPack for EMC Smarts to manage IP Settings such as polling and
thresholds. Specify the name of the Configuration Manager in the Configuration
Manager field if it does not use the default name. If you are enabling this feature after
you have already installed the SolutionPack for EMC Smarts, click Reconfigure to
apply the new settings.


If you enabled the security configuration checkbox (HTTPS enabled for
Watch4net and Smarts), you must adjust the port settings to reflect your security
configuration.


Figure 3  Report setup example


Post-installation steps


Database types for storing event data
Complete the post-installation configuration steps for the type of database (MySQL or
Datastore) that holds the archived event data.


Depending upon which Database Type you choose, you must edit the APG.xml and
server.xml files in order for your reports to point to the correct database. If you switch
from one database to another after you install the SolutionPack, you must adjust the
entries in these files so the reports will continue to display archived event data properly.
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l If you choose MySQL as the Database type, Configuring MySQL as the archived event
database for SolutionPack for EMC Smarts on page 144


l If you choose Datastore as the Database type, Configuring Datastore as the archived
event database for SolutionPack for EMC Smarts on page 144 and Configure the
Datastore database schema on page 146


Configuring MySQL as the archived event database for SolutionPack for EMC Smarts
If you select MySQL as the Database Type for Events when you installed the SolutionPack
for EMC Smarts, you must edit APG.xml before using the SolutionPack.


Before you begin


Obtain the hostnames or IP addresses of the servers where the databases and Default
Tomcat servers are running. When you edit configuration files, replace the italic text
shown in the examples with the actual host name or IP address. For example, for
Tomcat::Default-hostname-or-IP replace hostname-or-IP with the Tomcat default server
hostname or IP address.


Procedure


1. Edit APG.xml.


a. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers
(1) > Tomcat::Default-hostname-or-IP, expand the Configuration files and edit conf
\Catalina\localhost\APG.xml.


b. Uncomment the Resource Links in this section, <!-- emc-smarts-events
for MySQL -->, so MySQL is used as the database for both active and inactive
(archived) events.


 <!-- emc-smarts-events for MySQL -->


<ResourceLink name="jdbc/FLOW-RPE2-ARCH:{ mapping=FLOW-
RPE2.xml, table=events_archive }" global="jdbc/FLOW-EVENTS" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-RPE2-LIVE:{ mapping=FLOW-
RPE2.xml, table=events_live }" global="jdbc/FLOW-EVENTS" 
type="javax.sql.DataSource" />


2. Restart the Tomcat service to make the change effective.


Configuring Datastore as the archived event database for SolutionPack for EMC Smarts
If you select Datastore as the Database Type for Events when you installed the
SolutionPack for EMC Smarts, you must edit server.xml and APG.xml files before
using the SolutionPack.


Before you begin


Obtain the hostnames or IP addresses of the servers where the databases and Default
Tomcat servers are running. When you edit configuration files, replace the italic text
shown in the examples with the actual host name or IP address. For example, for
Tomcat::Default-hostname-or-IP replace hostname-or-IP with the Tomcat default server
hostname or IP address.


Procedure


1. Edit server.xml file.


a. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers
(1) > Tomcat::Default-hostname-or-IP, expand the Configuration files and edit conf
\server.xml.
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b. Uncomment the section starting with <!-- Defines the connection to
the Events Archive database for APG Datastore. -->


<!-- Defines the connection to the Events Archive database for 
APG Datastore. -->
<Resource name="jdbc/FLOW-DS-EVENTS" auth="Container" 
type="javax.sql.DataSource" maxActive="10" maxIdle="10" 
validationQuery="SELECT 1" testOnBorrow="false" 
testWhileIdle="true" timeBetweenEvictionRunsMillis="10000" 
minEvictableIdleTimeMillis="60000" maxWait="10000" 
username="admin" password="changeme" 
driverClassName="com.watch4net.x100.jdbc.Driver" 
removeAbandoned="true" removeAbandonedTimeout="60" 
ogAbandoned="true" url="jdbc:x100://localhost:48443/Databases/
APG-Datastore/Default" />


2. Edit APG.xml.


a. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers
(1) > Tomcat::Default-hostname-or-IP, expand the Configuration files and edit conf
\Catalina\localhost\APG.xml.


b. Comment the Resource Links in this section, <!-- emc-smarts-events for
MySQL -->, so MySQL will not be used as the database for archived events.


 <!-- emc-smarts-events for MySQL -->
<!-- 
<ResourceLink name="jdbc/FLOW-RPE2-ARCH:{ mapping=FLOW-
RPE2.xml, table=events_archive }" global="jdbc/FLOW-EVENTS" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-RPE2-LIVE:{ mapping=FLOW-
RPE2.xml, table=events_live }" global="jdbc/FLOW-EVENTS" 
type="javax.sql.DataSource" />
-->


c. Uncomment the Resource Links in this section, <!-- emc-smarts-events
for datastore -->.


<!-- emc-smarts-events for datastore  -->
<ResourceLink name="jdbc/FLOW-RPE2-ARCH:{ mapping=FLOW-
RPE2.xml, table=events_archive }" global="jdbc/FLOW-DS-EVENTS" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-RPE2-LIVE:{ mapping=FLOW-
RPE2.xml, table=events_live }" global="jdbc/FLOW-EVENTS" 
type="javax.sql.DataSource" />


3. Restart the tomcat service to make the change effective.


4. Start the Datastore service.


a. If starting from Centralized Management, navigate to Physical Overview and select
the Backend server hosting the Datastore database. Start the APG-
Datastore:Default service.


b. If using CLI commands, navigate to the installation bin folder (for
example, /opt/APG/bin) and issue the commands, ./manage-modules.sh
service start datastore Default (for Linux) or manage-
modules.cmd service start datastore Default (for Windows).


After you finish


You must also configure the Datastore database schema the first time you choose
Datastore as the Database Type when installing the EMC Smarts SolutionPack. Configure
the Datastore database schema on page 146
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Configure the Datastore database schema


You must configure the Datastore database schema before you can load event data.


Before you begin


If you selected Datastore as the Database Type when installing the EMC Smarts
SolutionPack, you must load a database schema to enable the Event Processing
Manager.


Inactive (archived) events are written to the Datastore database. Active events are written
to the MySQL database.


Procedure


1. Log in to the host running EMC M&R.


2. Connect to the Datastore with this command, /<INSTALL_DIR>/APG/bin/
datastore-client


3. From the prompt, copy and paste in the contents of /<INSTALL_DIR>/APG/
Event-Processing/APG-Datastore-Writer/emc-smarts/ddl/ds-
event-x100.sql
This creates the schema.


4. Start the Event Processing Manager service.


a. If starting from Centralized Management, navigate to Physical Overview and select
the Backend server hosting the Datastore database. Select Event-Processor-
Manager::emc-smarts and click Start to start the service.


Replace the instance name with one from your deployment if different from emc-
smarts.


b. If using CLI commands, navigate to the installation bin folder (for
example, /opt/APG/bin) and issue ./manage-modules.sh service
start event-processing-manager emc-smarts (for Linux) or manage-
modules.cmd service start event-processing-manager emc-
smarts (for Windows).


Replace the instance name with one from your deployment if different from emc-
smarts.


5. Verify the schema loaded properly by issuing this command from the datastore-client
command prompt: sql> select count(* ) from events_archive;
In the resulting output, you will see something similar to 1 row. For example, query:
0.01 sec; total: 0.01 sec


Configure icStats helper for EMC Smarts health collection
Additional configuration is required to enable Smarts Health data collection for EMC
Smarts domains running on Windows. Metrics for the processor, memory, and other
domain information cannot be collected until icStats helper is set up.


EMC Smarts health collection is now part of the emc-smarts-collect package, installed as
part of the SolutionPack for EMC Smarts.
Configure the icStats helper for EMC Smarts domains running on Windows platforms. (No
additional configuration is required for EMC Smarts domains running on Linux platforms.)


Procedure


1. Obtain plist.exe from http://technet.microsoft.com/en-us/sysinternals/
bb896682.aspx
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2. Install plist.exe in the PATH statement for each Windows host.


Set role restrictions for non-administrator users of SolutionPack for Smarts
If you want additional user roles, such as oper (operator), or profiles configured in your
Presentation SAM server, you must set role restrictions after installing the SolutionPack
for Smarts.


The default role is assigned to administrator. Add additional roles as needed.


Procedure


1. From Administration > Roles, click New Role.


2. Click Modules & Restrictions Access and expand the Smarts module.


3. Add an existing smarts profile (such as oper-profile or default-profile) and
click Save.


4. From Administration > Users, create a new user and assign them the role.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Hide unused entries in the navigation tree
You can hide default entries in the navigation tree if you have not installed the products
that populate them with data.


Before you begin


The default EMC M&R platform displays nodes such as Operations, Explore, Dashboards,
and Planning in the navigation tree. Other product suites that also use EMC M&R as their
platform display entries under these nodes by default. However, no data populates these
entries unless you are using those products. The SolutionPack for EMC Smarts populates
data in the Network block under Operations, Explore, and Dashboards.


Procedure


1. To hide entries in the navigation tree, click Edit Mode from the EMC M&R User
Interface.


2. Find the storage-related blocks in the list and select, Always Hide.


Do not hide the Network block under the Operations, Explore, or Dashboards nodes.
The Network block contains all of the SolutionPack for EMC Smarts views and reports.
The Planning node is not used by the SolutionPack for EMC Smarts.
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Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson eNodeB. This
SolutionPack is a mobile network management solution designed to generate reports
that show key metrics and key performance indicators (KPIs) for Ericsson eNodeB nodes.
It provides real-time and historical performance reports.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
Stream collector


Main reports


Dashboard
Shows snapshots of key performance indicator (KPI) reports. You can drill down into
these individual KPI reports per eNodeB and per cell:


l Inventory of network elements monitored by this SolutionPack


l Session Setup Success Rate (KPI)


l eNodeB Availability (KPI)


l Throughput (DL/UL KPIs)


l Intra-Freq Handover Success Rate (KPI)


l Drop Rate (KPI)


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Performing prerequisite installation tasks
This SolutionPack requires that the performance management (PM) data from eNodeB
nodes be locally available on the EMC M&R server hosting the Stream collector. You must
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ensure the Operations Support System-Radio and Core (OSS-RC) can push the PM data
files to the EMC M&R server.


This procedure includes a task for sending the PM files from the OSS-RC to the EMC M&R
server. Contact the OSS-RC administrator about where the PM files are stored and how
they are processed.


Procedure


1. Verify the SFTP or FTP server is running on the EMC M&R server where the Stream
collector resides.


2. Verify that connectivity exists between the EMC M&R server and the OSS-RC server.


3. Configure OSS-RC to push the raw PM data files on a regular time interval to this
default directory on the EMC M&R server: <install directory>/Collecting/
Stream-Collector/<SP-name>/IncomingData/
Here is an example of the name of a PM file:
A20140710.0545+0300-0600+0300_SubNetworkONRM_RootMo,SubNetwo
rkLTERAN,MeContextABC123_statsfile.xml.


You can override the default directory during the SolutionPack installation.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.
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9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After installing the SolutionPack, you must perform certain tasks.


Procedure


1. If you selected Move as the Post processing action during the installation, which
keeps all processed performance management XML files, make sure you have a
maintenance task running on the server that periodically deletes these files. You can
do this manually or by scheduling Cron jobs.


2. If using the default directory to store the performance management XML files, verify
that the apg user has read/write permissions on it.


3. If not using the default directory, make sure the directory that you are using to store
the performance management XML files is on a valid partition and that the apg user
has read/write permissions on it. If using another user, make sure that user is in the
same UNIX permissions group as the apg user.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


SolutionPack for Ericsson eNodeB Summary Sheet


154 Service Assurance Suite 9.4  SolutionPack Articles







3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the ReportPack for Ericsson IMS CSCF (Call Session
Control Function). This SolutionPack monitors all signaling from end-users to services
and other networks in the IP Multimedia Subsystem and provides comprehensive
performance information about CSCF.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Performance measurement data
The SolutionPack for Ericsson IMS TSP monitors and collects performance measurement
data for this SolutionPack. If you want to generate the reports that show this data, make
sure you install the SolutionPack for Ericsson IMS TSP.


Main reports
Summary Active Users / Registrations


Summary Failed Registrations


Summary Active Sessions


Summary CSCF Session Establishment in Busy Hour


Summary Dropped Sessions


Summary IMS-AKA Successful Authentications


Summary IMS-AKA Failed Authentications


Summary Accounting Requests


TSP – CSCF


CSCF:


l CSCF Registrations


l CSCF Sessions


l Emergency Sessions


l IMS AKA Authentication


l Session Initiator Protocol (SIP) traffic


l Diameter (Cx - Rf)


Equipment-Related Measurements:


l Summary of Equipment Related Measurement


l CPU Load (Maximum and Average %) of each Processor and System
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l Disk Usage per IO Processor


l IPv4 Statistic per Interface


l Memory Usage (Used, Free, and Maximum %) of each Processor and System


l Cluster and Processor Uptime


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/cscf
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/cscf
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.


Node, performance category, default file name pattern and 3GPP
format


You can change the default file name pattern.
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The Ericsson IMS Metrics File provides a complete listing of the expected counters for each
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.


Table 4 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default file name pattern 3GPP format


CSCF Cscf A20.*_Cscf nPMF
32.401v5.0


CSCF Cscf2 A20.*_Cscf2 nPMF
32.401v5.0


CSCF CscfSipServer A20.*_CscfSipServer nPMF
32.401v5.0


CSCF CscfSipClient A20.*_CscfSipClient nPMF
32.401v5.0


TSP IPv4_MeassurementJob A20.*cscf.*_IPv4.* nPMF
32.401v5.0


TSP Diameter A20.*cscf.*_Diameter.* nPMF
32.401v5.0


TSP PlatformMeassures A20.*cscf.*_PlatformMeasures.* oPMF
32.401v5.0


TSP IPv6_MeassurementJob A.*cscf.*_IPv6.* nPMF
32.401v5.0


TSP OamProvision-
Meassurement


A20.*cscf.*_OamProvisioning.* nPMF
32.401v5.0


Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.
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4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:
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Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.
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2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson IMS HSS SLF (Subscriber
Locator Function). The Home Subscriber Server (HSS) is the central IMS user database
that stores all IMS subscription information. The SolutionPack for Ericsson IMS HSS SLF
reports on the information in the HSS, including user registration and user subscription.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Performance measurement data
The SolutionPack for Ericsson IMS TSP monitors and collects performance measurement
data for this SolutionPack. If you want to generate the reports that show this data, make
sure you install the SolutionPack for Ericsson IMS TSP.


Main reports
Diameter (Cx):


l IMS Number of Protocol Errors and Permanent Failures per HSS, SLF


l IMS Number of Sent / Received Requests


l IMS Number of Sent / Received Answers


l IMS Number of Sent / Received Unsuccessful Answers


l IMS Number of Incoming / Outgoing Discarded Messages


HSS


SLF:


l SLF Overall Summary


l IMS SLF Number of Users


l Redirected Correct Answers Per Destination Server (per Node)


l Number of Dx Answers with the DIAMETER_ERROR_USER_UNKNOWN (per CSCF)


l Number of Dx Answers with the DIAMETER_REALM_NOT_SERVED


l IMS SLF Dx-Query Attempts (per second) per CSCF


l IMS SLF Dx-Query Answer Success (per second) per CSCF


Equipment-Related Information:


l CPU Load (Max, Avg) % each processor and system


l DiskUsage per IO processor


l IPv4 Statistic per Interface
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l Memory (Used, Free, Max) % each processor and system


l ProcessorUptime per processor


l TSPClusterUptime


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/hss_slf
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/hss_slf
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.


Node, performance category, default file name pattern and 3GPP
format


You can change the default file name pattern.


SolutionPack for Ericsson IMS HSS SLF Summary Sheet


Where to find the latest SolutionPack software     167



http://support.emc.com

http://support.emc.com





The Ericsson IMS Metrics File provides a complete listing of the expected counters for each
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.


Table 5 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default file name pattern 3GPP format


HSS-
SLF


ISM A20.*_HSS-ISM nPMF
32.401v5.0


HSS-
SLF


SLF A20.*_HSS-SLF nPMF
32.401v5.0


HSS-
SLF


SDA A20.*_HSS-SDA nPMF
32.401v5.0


TSP IPv4_MeassurementJob A20.*hss.*_IPv4.* nPMF
32.401v5.0


TSP Diameter A20.*hss.*_Diameter.* nPMF
32.401v5.0


TSP PlatformMeassures A20.*hss.*_PlatformMeasures.* oPMF
32.401v5.0


TSP IPv6_MeassurementJob A.*hss.*_IPv6.* oPMF
32.401v5.0


TSP OamProvision-
Meassurement


A20.*hss.*_OamProvisioning.* nPMF
32.401v5.0


Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:
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./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.
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2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson IMS IPWorks. Ericsson
IPWorks delivers centrally managed Domain Name System (DNS), Telephone Number
Mapping (ENUM), and Dynamic Host Configuration Protocol (DHCP) services for mobile
and wireline IP networks.


This SolutionPack collects and reports on data related to the ENUM & DNS functions in an
IMS network as well as equipment related measurements such as CPU and memory
utilization, disk capacity, system load, and interface statistics.


Technical Specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Main reports
IPWorks (ENUM / iDNS):


l Summary Total Number of DNS queries


l Summary Number DNS Query Requests [per second]


l Summary Number ENUM Requests [per second]


l Summary Number of ENUM Requests


l Summary Number of MAP Queries


l Summary Statistic per Location


IPWorks (ENUM / iDNS):


l DNS


l ENUM


l ERH


Equipment-Related Measurement per Storage Server (dnsst):


l CPU


l Memory


l Disk


l System Load


l Interface


Equipment-Related Measurement per Protocol Server (idns):


l CPU


l Memory
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l Disk


l System Load


l Interface


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/ipworks
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/ipworks
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.


Node, performance category, default file name pattern and 3GPP
format


You can change the default file name pattern.


You can change the default file name pattern.
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The Ericsson IMS Metrics File provides a complete listing of the expected counters for each
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.


Table 6 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default file name pattern 3GPP format


IPWorks Platform .*_PLATFORM.* oPMF 32.401v5.0


IPWorks ENUM .*_ENUM.* oPMF 32.401v5.0


IPWorks DNS .*_DNS.* oPMF 32.401v5.0


IPWorks DHCP .*_DHCPv4.* oPMF 32.401v5.1


IPWorks AAA .*_AAA.* oPMF 32.401v5.2


IPWorks CLF .*_CLF.* oPMF 32.401v5.3


IPWorks PMAL .*_PMAL.* oPMF 32.401v5.4


Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'
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Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.
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Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson IMS Media Resource
Function Processor (MRFP). The Media Resource Function Processor is a subsystem of the
Media Resource System (MRS) in the IP Media Subsystem (IMS). The SolutionPack for
Ericsson IMS MRFP reports on the MRFP functionality of MRS.


This SolutionPack reports on the following:


l Performance of the various MRS resources such as MRFP services, VMRFP (Visited
Media Resource Function Processor), MRFP Association, Interactive Messaging, and
the IP system.


l Performance of overall MRFP functions such as MRFP audio and multimedia sessions.


l Performance of the related equipments such as plug-in units, IP interfaces, Gigabit
Ethernet, Ethernet Switch module ports, and Et Resource.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Main reports
Resources:


l MRFP Services


l MrfpFunctions


l Vmrfp


l MrfpH248Association


l MS Processing


l Interactive Messaging


l IP Oam


l IP System


Equipment-Related Measurements:


l PluginUnit


l EtResource


l IPinterface


l GigabitEthernet


l EthernetSwicthModulePort
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Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/mrfp
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/mrfp
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.


Node, performance category, default file name pattern and 3GPP
format


You can change the default file name pattern.


The Ericsson IMS Metrics File provides a complete listing of the expected counters for the
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.
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Table 7 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default File name pattern 3GPP format


MRS MRFP A20.*\.xml oPMF 32.401v5.0


Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.
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Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson IMS Multimedia
Telephony Application Server (MTAS). The SolutionPack for Ericsson IMS MTAS monitors
the Multimedia Telephony Application Server (MMTel AS), the Scheduled Conference
Application Server (Conf AS), and the Service Centralization and Continuity Application
Server (SCC AS).


The following describes the severs monitored by this SolutionPack:


l MMTel AS provides multimedia telephony service and supplementary services
according to 3GPP standards and service creation interfaces.


l Conf AS offers scheduled conference services according to 3GPP standards.


l SCC AS provides centralized services (ICS) and single radio voice all continuity (SR-
VCC) according to 3GPP standards.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Performance measurement data
The SolutionPack for Ericsson IMS TSP monitors and collects performance measurement
data for this SolutionPack. If you want to generate the reports that show this data, make
sure you install the SolutionPack for Ericsson IMS TSP.


Main reports
Summary MMTEL AS Number of Simultaneous Sessions


Summary MMTel AS Simultaneous Sessions in Busy Hour


Summary SCC AS Number of Mobile Service Simultaneous Sessions


Summary SCC AS Mobile Service Simultaneous Sessions in Busy Hour


Summary MTAS Initial Registrations (per second)


Summary MTAS Initial De-registration (per second)


Summary ASR per CSCF


Summary CPS


Summary SCC AS (SRVCC) Invocation Attempts (per second)


Summary MTAS Number of SIP Requests (per second)


Summary MTAS Number of Charging Requests (per second)


TSP – MTAS:


l MMTel-AS
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l SCC-AS


l MRFC


l XDMS (Ut) - Interface


l IMS ADA Authentications (USIM)


l Diameter (Rf - Sh)


l Equipment-Related Measurements


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/mtas
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/mtas
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.
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Node, performance category, default file name pattern and 3GPP
format


You can change the default file name pattern.


The Ericsson IMS Metrics File provides a complete listing of the expected counters for each
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.


Table 8 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default file name pattern 3GPP format


MTAS MtasCDiv .*_MtasCDiv.* nPMF 32.401v5.0


MTAS MtasCharging .*_MtasCharging.* nPMF 32.401v5.0


MTAS MtasComBarring .*_MtasComBarring.* nPMF 32.401v5.0


MTAS MtasConf .*_MtasConf.* nPMF 32.401v5.0


MTAS MtasFcd .*_MtasFcd.* nPMF 32.401v5.0


MTAS MtasFunction .*_MtasFunction.* nPMF 32.401v5.0


MTAS MtasH248 .*_MtasH248.* nPMF 32.401v5.0


MTAS MtasHold .*_MtasHold.* nPMF 32.401v5.0


MTAS MtasIdPres .*_MtasIdPres.* nPMF 32.401v5.0


MTAS MtasMmt .*_MtasMmt.* nPMF 32.401v5.0


MTAS MtasMrfc .*_MtasMrfc.* nPMF 32.401v5.0


MTAS MtasXdms .*_MtasXdms.* nPMF 32.401v5.0


MTAS MtasQos .*_MtasQos.* nPMF 32.401v5.0


MTAS MtasScc .*_MtasScc.* nPMF 32.401v5.0


MTAS MtasShInterface .*_MtasShInterface.* nPMF 32.401v5.0


MTAS MtasSip .*_MtasSip.* nPMF 32.401v5.0


MTAS MtasSrvcc .*_MtasSrvcc.* nPMF 32.401v5.0


MTAS MtasSubsData .*_MtasSubsData.* nPMF 32.401v5.0


MTAS MtasTraf .*_MtasTraf.* nPMF 32.401v5.0


MTAS MtasLicenses .*_MtasLicenses.* nPMF 32.401v5.0


TSP IPv4_MeassurementJob A.*_IPv4.* nPMF 32.401v5.0


TSP Diameter .A.*_Diameter.* nPMF 32.401v5.0


TSP PlatformMeassures .A.*_PlatformMeasures.* oPMF 32.401v5.0


TSP IPv6_MeassurementJob A.*_IPv6.* oPMF 32.401v5.0


TSP OamProvision-Measurement A.*_OamProvisioning.* nPMF 32.401v5.0
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Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.
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5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson IMS ServiceOn Integrator
(SOI). The SolutionPack for Ericsson IMS SOI reports on SOI performance information in
the IP Multimedia subsystem (IMS). It measures request counts and response time and
transactions per second from the SOI to other interfaces.


This SolutionPack reports on the following:


l Application data


l Service provider data


l Service SIP Business data


l Service Over Service Provider data


l SOM data


l Lictor data


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Main reports
Overall Summary


Application/System


Lictor


Service (overall-system)


Service over Service Provider


Service SIP-Business


SOM


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.
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Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/soi
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/soi
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.


Node, performance category, default file name pattern and 3GPP
format


You can change the default file name pattern.


The Ericsson IMS Metrics File provides a complete listing of the expected counters for the
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.


Table 9 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default file name pattern 3GPP format


SOI ims-ems-activation C20.*ims-emsactivation.xml PM 3GPPXML TS
32.435
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Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.
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5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson IMS Telecom Server
Platform (TSP). The SolutionPack for Ericsson IMS TSP monitors and collects performance
measurement data, such as disk usage, IPv4 statistics, CPU load, cluster and system
uptime, and diameter related measurements. The SolutionPack for Ericsson IMS CSCF,
the SolutionPack for Ericsson IMS MTAS, and the SolutionPack for Ericsson IMS HSS SLF
use this data to for their reports.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u2 and later


Data collection method
XML collector


All metrics are parsed through 3GPP standard xml files.


Main reports
The SolutionPack for Ericsson IMS TSP does not produce its own reports. It collects the
following information for the SolutionPack for Ericsson IMS CSCF, the SolutionPack for
Ericsson IMS MTAS, and the SolutionPack for Ericsson IMS HSS SLF:


l CPU load


l Disk usage


l IPv4 statistic


l Memory usage


l Processor and cluster uptime


l Diameter related measurements


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Collecting performance parameters
Before installing a SolutionPack, you must perform certain steps to ensure the
SolutionPack is able to collect performance parameters from various IMS components.
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These parameters are transferred in 3GPP-compliant XML files from IMS to the EMC M&R
host using SFTP.


Before you begin


Review the configuration options for the XML collector in the APG-Text-Parsing-Library.pdf
file located in the <Install_Dir>/APG/Doc directory of the EMC M&R host.


Procedure


1. Create a directory in the EMC M&R host for collecting performance data.


For example: /opt/IMS/incoming/tsp
2. On the directory that you just created, change the permissions to apg.


For example: # chown -R apg:apg /opt/IMS/incoming/tsp
3. Configure the OSS-RC, EMS (Element Management System), mediation node, or other


to push the 3GPP-compliant XML files (i.e., Ericsson Report Output Files (ROP)) to the
directory created in step 2.


These 3GPP-compliant XML files are listed in the section called Node, Performance
category, Default filename pattern and 3GPP format.


4. Verify the periodic transfer of the 3GPP-compliant XML files is set accordingly. If your
SolutionPack is set to look for updates every five minutes (the default), make sure
SFTP is invoked every five minutes as well.


5. SFTP the 3GPP-compliant XML files into the directory that you just created.


Node, performance category, default tile name pattern and 3GPP
format


The Ericsson IMS Metrics File provides a complete listing of the expected counters for each
file pattern type. This spreadsheet is available on the EMC support website http://
support.emc.com.


Table 10 Node, Performance Category, Default file name pattern and 3GPP Format


Node Performance category Default file name pattern 3GPP format


TSP-
CSCF


IPv4_MeassurementJob A20.*cscf.*_IPv4.* nPMF
32.401v5.0


TSP-
CSCF


Diameter A20.*cscf.*_Diameter.* nPMF
32.401v5.0


TSP-
CSCF


PlatformMeassures A20.*cscf.*_PlatformMeasures.* oPMF
32.401v5.0


TSP-
CSCF


IPv6_MeassurementJob A.*cscf.*_IPv6.* nPMF
32.401v5.0


TSP-
CSCF


OamProvision-
Meassurement


A20.*cscf.*_OamProvisioning.* nPMF
32.401v5.0


TSP-
HSS


IPv4_MeassurementJob A20.*hss.*_IPv4.* nPMF
32.401v5.0


SolutionPack for Ericsson IMS TSP Summary Sheet


Node, performance category, default tile name pattern and 3GPP format      207



http://support.emc.com

http://support.emc.com





Table 10 Node, Performance Category, Default file name pattern and 3GPP Format  (continued)


Node Performance category Default file name pattern 3GPP format


TSP-
HSS


Diameter A20.*hss.*_Diameter.* nPMF
32.401v5.0


TSP-
HSS


PlatformMeassures A20.*hss.*_PlatformMeasures.* oPMF
32.401v5.0


TSP-
HSS


IPv6_MeassurementJob A.*hss.*_IPv6.* nPMF
32.401v5.0


TSP-
HSS


OamProvision-
Meassurement


A20.*hss.*_OamProvisioning.* nPMF
32.401v5.0


TSP-
MTAS


IPv4_MeassurementJob A.*_IPv4.* nPMF
32.401v5.0


TSP-
MTAS


Diameter A.*_Diameter.* nPMF
32.401v5.0


TSP-
MTAS


PlatformMeassures .A.*_PlatformMeasures.* oPMF
32.401v5.0


TSP-
MTAS


IPv6_MeassurementJob A.*_IPv4.* nPMF
32.401v5.0


TSP-
MTAS


OamProvision-
Meassurement


A.*_OamProvisioning.* nPMF
32.401v5.0


Configuring the user process limits for a Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The installed on a server running Red Hat Enterprise Linux 6, CentOS Linux 6, or SUSE
Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all
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./manage-modules.sh service start all
5. To verify the changes, type su apg -c 'ulimit -n -u'


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.
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Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson MGW (Media Gateway).
This SolutionPack is a mobile network management solution designed to generate
reports that show key metrics and key performance indicators (KPIs) for Ericsson MGW. It
presents real-time and historical performance reports.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
Stream collector


Supported version
Ericsson MGW R12


Main reports


MGW Summary
Displays all managed objects, the average processor load %, the media stream
utilization rate %, and the KPI dashboard.


MGW Availability
Displays detailed information about the accessibility of the MGW nodes (aggregated
and per node).


MGW Processor Load
Displays detailed information about the processor load of the MGW nodes
(aggregated and per node).


MGW Traffic Load (Erlang)
Displays detailed information about the current traffic load in Erlang of the MGW
nodes (aggregated and per node).


GCP Availability
Displays detailed information about the GCP (Gateway Control Protocol) link
availability (aggregated and per node).


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.
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Performing prerequisite installation tasks
This SolutionPack requires that the performance management (PM) data from the MGW
nodes be locally available on the EMC M&R server hosting the Stream collector. You must
ensure the Operations Support System-Radio and Core (OSS-RC) can push the PM data
files to the EMC M&R server.


This procedure includes a task for sending the PM files from OSS-RC to the EMC M&R
server. Contact the OSS-RC administrator about where the PM files are stored and how
they are processed.


Procedure


1. Verify the SFTP or FTP server is running on the EMC M&R server where the Stream
collector resides.


2. Verify that connectivity exists between the EMC M&R server and the OSS-RC server.


3. Configure OSS-RC to push the raw PM files to this default directory on the EMC M&R
server: <install directory>/Collecting/Stream-Collector/<SP-
name>/Incomingdata/
Here is an example of the name of a raw PM file: A*.*-2100_SVMGW267:1.xml.


You can override the default directory during the SolutionPack installation.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.
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c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After installing the SolutionPack, you must perform certain tasks.


Procedure


1. If you selected Move as the Post processing action during the installation, which
keeps all processed performance management XML files, make sure you have a
maintenance task running on the server that periodically deletes these files. You can
do this manually or by scheduling Cron jobs.


2. If using the default directory to store the performance management XML files, verify
that the apg user has read/write permissions on it.


3. If not using the default directory, make sure the directory that you are using to store
the performance management XML files is on a valid partition and that the apg user
has read/write permissions on it. If using another user, make sure that user is in the
same UNIX permissions group as the apg user.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.
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2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson RNC (Radio Network
Controller). This SolutionPack is a mobile network management solution designed to
generate reports that show key metrics and key performance indicators (KPIs) for Ericsson
RNC. It presents real-time and historical performance information.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
Stream collector


Supported version
Ericsson RNC CXP9014711/7_R11UA05


Main reports


Accessibility:
Call Setup Success Rate (RNC)


Call Setup Success Rate (CELL)


CS Setup Success Rate (CELL)


PS Setup Success Rate (CELL)


Iu Setup Success Rate


CN paging to UE in URA State


RNC Sending Paging Failure Rate


UTRAN Paging to UE in URA State


RNC Type 1 Paging Attempt Success Rate


RNC Type 2 Paging Attempts (CELL)


RRC Setup Success Rate (CELL)


RRC Terminating Success Rate (CELL)


HSDPA Access Failure Rate


Availability:
Cell Availability Summary


R99 RNC Availability
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Capacity:
RNC Main Processor Load


Average Users HS


Average Users Ps Data


Average Users Speech


Power Limit Failure


Mobility
Cell Update Success Rate


HSDPA Cell Change SR


Successful RL Addition Source Best Cell Speech


URA Update Success Rate


Retainability:
HSDPA Drop Rate


RAB Drop Rate


RRC Drop Ragte Speech


Traffic:
Traffic Speech


Traffic AMR


Traffic AMR-WB


Traffic CS57


Traffic CS64


Traffic PS Interactive


Traffic PS Interactive DCH/FACH


Traffic PS EUL


Traffic PS HS


Traffic PSSTR HS


RNC PS Stream


RNC PS Stream 128


PS Data Average Total Throughput UL


PS Data Average Total Throughput DL


PS Data Average Throughput Net


HS Data Average Throughput Net


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.
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This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Performing prerequisite installation tasks
This SolutionPack requires that the performance management (PM) data from RNC be
locally available on the EMC M&R server hosting the Stream collector. You must ensure
the Operations Support System-Radio and Core (OSS-RC) can push the PM data files to
the EMC M&R server.


This procedure includes a task for sending the PM files from OSS-RC to the EMC M&R
server. Contact the OSS-RC administrator about where the PM files are stored and how
they are processed.


Procedure


1. Verify the SFTP or FTP server is running on the EMC M&R server where the Stream
collector resides.


2. Verify that connectivity exists between the EMC M&R server and the OSS-RC server.


3. Configure OSS-RC to push the raw PM data files on a regular time interval to this
default directory on the EMC M&R server: <install directory>/Collecting/
Stream-Collector/<SP-name>/Incomingdata/
Here is an example of the name of a raw PM file:
A20140915.2115+0100-2130+0100_SubNetwork=XXXX_RootMo,SubNetw
ork=XXXXXX,MeContext=XXXXXX_statsfile.xml.


You can override the default directory during the SolutionPack installation.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


SolutionPack for Ericsson RNC Summary Sheet


222 Service Assurance Suite 9.4  SolutionPack Articles



http://support.emc.com

http://support.emc.com

http://support.emc.com

http://support.emc.com





5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After installing the SolutionPack, you must perform certain tasks.


Procedure


1. If you selected Move as the Post processing action during the installation, which
keeps all processed performance management XML files, make sure you have a
maintenance task running on the server that periodically deletes these files. You can
do this manually or by scheduling Cron jobs.


2. If using the default directory to store the performance management XML files, verify
that the apg user has read/write permissions on it.


3. If not using the default directory, make sure the directory that you are using to store
the performance management XML files is on a valid partition and that the apg user
has read/write permissions on it. If using another user, make sure that user is in the
same UNIX permissions group as the apg user.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37
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l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.
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For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Ericsson SGSN (Serving GPRS
Support Node). This SolutionPack is a mobile network management solution designed to
generate reports that show key metrics and key performance indicators (KPIs) for Ericsson
SGSN nodes. This enables you to understand the functioning of the SGSN nodes and their
packet core network.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
Stream collector


Supported versions
Ericsson SGSN R13A


Ericsson SGSN R10A


Main reports


KPI Dashboard
Provides detailed information on the key performance indicators affecting the overall
functionality of the SGSN node. These KPIs are categorized into Accessibility,
Retainability, Traffic, and Subscriber information. Several reports display valuable
information on the SGSN and packet core network functionality.


Components Overview
Reports on the SGSN node and its components. Each SGSN node has various
components that produce metrics, and both are shown in this report. It also provides
detailed information on the performance of the SGSN node.


Inter SGSN RAU Failure Ratio
Displays the Routing Area Update (RAU) failure rate across SGSNs. RAU is performed
whenever the mobile device is in motion.


Attach Failure Ratio
Shows the GPRS GSM failure of attaches. When a 2G or 3G user cannot access the
packet data service, it displays in this key performance indicator.


Number of SAU
Provides the number of Simultaneously Attached Users (SAU), and indicates the
probable load on the SGSN. The higher the number of SAU, the more the load.


Top-N Reports
Shows the Top-5 SGSN and Top-5 Routing areas in terms of various key performance
indicators, such as the Top-5 SGSN with Number of SAUs, Top-5 Routing Areas with
most Attach Failures, and Top-5 Busiest SGSNs.


Metrics and Measurement Inventory
Lists all the metrics and KPIs generated by an SGSN. This report is similar to the
Components Overview report.
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SGSN Mobility Management
Lists all the Mobility management KPIs, such as RAU failures and Paging Failures.


SGSN Traffic Management
Lists all the Traffic management KPIs, such as instance Total Uplink, Total Downlink,
and Number of PDP.


SGSN Accessibility Management
Lists all the Accessibility management KPIs, such as instance Attach failure, RAB
establishment failure, and PDP Context Activation Failure.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Performing prerequisite installation tasks
This SolutionPack requires that the performance management (PM) data from the SGSN
nodes be locally available on the EMC M&R server hosting the Stream collector. You must
ensure the Operations Support System-Radio and Core (OSS-RC) can push the PM data
files to the EMC M&R server.


This procedure includes a task for sending the PM files from the OSS-RC server to the
EMC M&R server. Contact the OSS-RC administrator about where the PM files are stored
and how they are processed.


Procedure


1. Verify the SFTP or FTP server is running on the EMC M&R server where the Stream
collector resides.


2. Verify that connectivity exists between the EMC M&R server and the OSS-RC server.


3. Configure OSS-RC to push the raw PM data files on a regular time interval to this
default directory on the EMC M&R server: <install directory>/Collecting/
Stream-Collector/<SP-name>/Incomingdata/
Here is an example of the name of a raw PM file:
A20140914.1145+0100-20140914.1200+0100_Meas_SS7_all_13A_LGSG
SN03.145.xml.


You can override the default directory during the SolutionPack installation.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
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Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After installing the SolutionPack, you must perform certain tasks.


Procedure


1. If you selected Move as the Post processing action during the installation, which
keeps all processed performance management XML files, make sure you have a
maintenance task running on the server that periodically deletes these files. You can
do this manually or by scheduling Cron jobs.


2. If using the default directory to store the performance management XML files, verify
that the apg user has read/write permissions on it.


3. If not using the default directory, make sure the directory that you are using to store
the performance management XML files is on a valid partition and that the apg user
has read/write permissions on it. If using another user, make sure that user is in the
same UNIX permissions group as the apg user.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:
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Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.
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2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Huawei iManager M2000. This
SolutionPack monitors the performance of the mobile network managed by Huawei
iManager M2000.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
Stream collector


Main reports


Topology Map:
Topology Map for 3G By Cell


Topology Map for 3G By Station


Accessibility:
Accessibility Success Rate


SDCCH Congestion by Cell


Retainability:
Call Drop Rate by Cell


Mobility:
Handover Success Rate


Traffic Integrity:
2G Data Avg Throughput Downlink


2G Data Avg Throughput Uplink


3G Data Avg Throughput Downlink


3G Data Avg Throughput Uplink


Availiability:
2G Cell Downtime


3G Cell Downtime


Utilization:


2G Site Utilization


3G Site Utilization


CE Utilization


Simultaneous Data Users
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Situations to Watch:
Call Drop Rate


Cell Down Time


Handover Success Rate


SDDCH Congestion


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Performing prerequisite installation tasks
This SolutionPack requires that the performance management (PM) data from Huawei
iManager M2000 be locally available on the EMC M&R server hosting the Stream
collector. You must ensure Huawei iManager M2000 can push the PM data files to the
EMC M&R server.


This procedure includes a task for sending the PM files from Huawei iManager M2000 to
the EMC M&R server. Contact the Huawei iManager M2000 administrator about where the
PM files are stored and how they are processed.


Procedure


1. Verify the SFTP or FTP server is running on the EMC M&R server where the Stream
collector resides.


2. Verify that connectivity exists between the EMC M&R server and Huawei iManager
M2000.


3. Configure Huawei iManager M2000 to push the raw PM data files on a regular time
interval to this default directory on the EMC M&R server: <install directory>/
Collecting/Stream-Collector/<collector instance name>/data/
Here is an example of a raw PM file name: pmresult_67109379_*.csv.


You can override the default directory during the SolutionPack installation.


4. Verify that the required counters are enabled on Huawei iManager M2000 EMS
(Element Management System). These counters are listed in the SolutionPack for
Huawei iManager M2000 Counter Prerequisites.


Determining the format of the performance data
The Huawei iManager M2000 formats the data in the performance management files
based on the counter ID (numerical representation), the counter name or the counter
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description. For the Stream collector to correctly parse the metrics in these files, you must
indicate the format of these PM files during the SolutionPack installation.


The Huawei iManager M2000 creates one performance management CSV file for each
counter group ID. This table shows the performance properties for Counter Group
ID:-67109381.


Counter ID Counter name Counter description


67189749 IRATHO.AttRelocPrepOut
CS


Number of Preparation Attempts for CS Outgoing Inter-
RAT Handover for Cell


67189755 IRATHO.SuccOutCS Number of Successful CS Outgoing Inter-RAT Handovers
for Cell


Procedure


1. Using a text editor, open one of the performance management CSV files.


2. In the column header after Reliability, check for these formats. The italicized text
shows the actual format example.


Format Example


Counter ID Result Time,Granularity Period,Object
Name,Reliability,"67202488"


Counter name Result Time,Granularity Period,Object
Name,Reliability,"VS.HSUPA.16QAM.UtilizeTimePermillage"


Counter description Result Time,Granularity Period,Object
Name,Reliability,"AR3010A:Mean Number of
Dynamically Configured Channels(SDCCH)
(900/850/810 band)"


You are asked for this format when you install the SolutionPack.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.
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3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After installing the SolutionPack, you must perform certain tasks.


Procedure


1. If you selected Move as the Post processing action during the installation, which
keeps all processed performance management XML files, make sure you have a
maintenance task running on the server that periodically deletes these files. You can
do this manually or by scheduling Cron jobs.


2. If using the default directory to store the performance management XML files, verify
that the apg user has read/write permissions on it.


3. If not using the default directory, make sure the directory that you are using to store
the performance management XML files is on a valid partition and that the apg user
has read/write permissions on it. If using another user, make sure that user is in the
same UNIX permissions group as the apg user.


Setting up sectorized cell views on geo maps
You can provide views of the individual cells, which are the sectors of a cellsite, on the
geo maps in this SolutionPack. To do this, you customize a default property tagging filter
and edit an existing sample CSV file according to your specifications. The information you
enter into this filter processes the properties that you specify in the CSV file to enrich the
views on the geo maps.


Procedure


1. Navigate to Centralized Management.


2. Under Logical Overview, click Collecting.


3. Select the Property-Tagging-Filter for the Huawei iManager M2000 instance. For
example: Property-Tagging-Filter::huawei-m2000 <server>


You can also modify the property tagging filter using the Data Enrichment functionality
in Centralized Management. For more information, see the online help in the EMC
M&R platform.
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4. Click Configuration Files in the blue bar.


5. Select conf/property-tagging-filter_m2000.xml.


6. Click Edit to add these required key properties and provide processing instructions for
the CSV file:


l device


l siteid


l sitename


l sitetype: indoor or outdoor


l celltype: 2G, 3G, or 4G


l location: latitude and longitude of the site location


l azimuth: orientation of the cell/sector


l radius: approximate radius of coverage


l beamwidt: beam width view of the cell/sector


For instructions on customizing this property tagging filter, click doc/APG-
Property-Tagging-Filter.pdf under Documentation.


7. Under Configuration Files, do one of the following:


l To add locations based on the cell ID, edit the sample file M2000-cellid-
map.csv to meet your requirements, and then click Save.


l To add locations based on the device, edit the sample file M2000-device-
map.csv to meet your requirements, and then click Save.


The following shows sample entries for this type of CSV file:


device,siteid,sitename,sitetype,celltype,location,azimuth,radius,be
amwidt
31071,EN107,Enma Mall,Indoor,3G,24.1298 56.5743,90,25000,120
31074,EN107,Enma Mall,Indoor,3G,33.1298 40.5743,210,25500,120
31072,EN107,Enma Mall,Indoor,3G,26.1298 50.5743,330,25500,120


After the next polling cycle, you will see sectorized cell views on the geo maps.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.
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Alerts
This SolutionPack generates alerts when specific thresholds are reached in the mobile
network. These alerts cover the areas of accessibility, retainability, mobility, and
utilization.


Accessibility alerts


Alert KPI used in computation Major
threshold


Message of major
threshold


Minor
threshold


Message of minor
threshold


Access
Failure by
Chanel
Element
Congestion
Rate


("VSRABFailEstabCSULCECong' +
'VSRABFailEstabCSDLCECong') /
('VSRABAttEstabAMR')


Rate is
greater than
2%


Access failure
by channel
element
congestion rate
is more than 2%
for PROP.devtype
and PROP.cellid
and PROP.network
at PROP.siteid
PROP.location


Rate is
greater than
1%


Access failure
by channel
element
congestion rate
is more than 1%
for PROP.devtype
and PROP.cellid
and PROP.network
at PROP.siteid
PROP.location


Access
Failure by
Code
Congestion
Rate per Cell


('VSRABFailEstabCSCodeCong') /
('VSRABAttEstabAMR')


Rate is
greater than
2%


Access failure
by code
congestion rate
per cell is more
than 2% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Rate is
greater than
1%


Access failure
by code
congestion rate
per cell is more
than 1% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Access
Failure by
Power
Congestion
Rate per Cell


(name=='VSRABAbnormRelAMR') /
( name=='VSRABNormRelAMR' +
name=='VSRABAbnormRelAMR') *
100


Rate is
greater than
2%


Access failure
by power
congestion rate
per cell is more
than 2% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Rate is
greater than
1%


Access failure
by power
congestion rate
per cell is more
than 1% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


SDCCH
Congestion
by Cell


('K3001:Failed SDCCH Seizures due
to Busy SDCCH')/('K3000:SDCCH
Seizure Requests')


Rate is
greater than
2%


SDCCH congestion
rate is greater
than 2% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Rate is
greater than
1%


SDCCH congestion
rate is greater
than 1% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


TCH
Congestion
by Cell


('K3021:Failed TCH Seizures due to
Busy TCH (Signaling Channel)' +
'K3011A:Failed TCH Seizures due to
Busy TCH (Traffic Channel)') /


Rate is
greater than
2%


TCH congestion
rate is greater
than 2% for
PROP.devtype and


Rate is
greater than
1%


TCH congestion
rate is greater
than 1% for
PROP.devtype and
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Alert KPI used in computation Major
threshold


Message of major
threshold


Minor
threshold


Message of minor
threshold


('K3020:TCH Seizure Requests
(Signaling Channel)' + 'K3010A:TCH
Seizure Requests (Traffic Channel)')


PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Retainability alerts


Alert KPI used in computation Major
threshold


Message of major
threshold


Minor
threshold


Message of minor
threshold


Call Drop -
SDCCH for
tracking
calls


(name=='VSRABAbnormRelAMR') /
( name=='VSRABNormRelAMR' +
name=='VSRABAbnormRelAMR') * 100


Rate is
greater than
2%


Call drop rate
more than 2% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Rate is
greater than
1%


Call drop rate
more than 1% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Call Drop -
TCH for
tracking
call drop
rates in
the
network


('K3023:Successful TCH Seizures
(Signaling Channel)' +
'K3013A:Successful TCH Seizures
(Traffic Channel)' +
'K3013B:Successful TCH Seizures in
TCH handovers (Traffic Channel)' )


Rate is
greater than
2%


Call drop rate
more than 2% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Rate is
greater than
1%


Call drop rate
more than 1% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Mobility alerts


Alert KPI used in computation Major
threshold


Message of major
threshold


Minor
threshold


Message of minor
threshold


Handover
Success
Rate - GSM
to UTRAN
Cell
Selection
Lost Rate


('RRCAttConnEstabIRATCelRes' -
'RRCSuccConnEstabIRATCelRes') /
('RRCAttConnEstabIRATCelRes')


Rate is less
than 85%


Hand over
success rate is
less than 85%
for PROP.devtype
and PROP.cellid
and PROP.network
at PROP.siteid
PROP.location


Rate is less
than 90%


Hand over
success rate is
less than 90%
for PROP.devtype
and PROP.cellid
and PROP.network
at PROP.siteid
PROP.location


Handover
Success
Rate - GSM
to UTRAN
Cell
Selection
Success
Rate


('RRCSuccConnEstabIRATCelRes')/
('RRCAttConnEstabIRATCelRes')


Rate is less
than 50%


Hand over
success rate is
less than 50%
for PROP.devtype
and PROP.cellid
and PROP.network
at PROP.siteid
PROP.location


Rate is less
than 60%


Hand over
success rate is
less than 60%
for PROP.devtype
and PROP.cellid
and PROP.network
at PROP.siteid
PROP.location
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Utilization alerts


Alert KPI used in computation Major
threshold


Message of major
threshold


Minor
threshold


Message of minor
threshold


3G Site
Utilization -
HS User
Utilization


(VSHSDPAUEMeanCell /
64.0) * 100


Utilization is
greater than
95


3G Site
utilization has
crossed 95% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Utilization is
greater than
90


3G Site
utilization has
crossed 90% for
PROP.devtype and
PROP.cellid and
PROP.network at
PROP.siteid
PROP.location


Adding new metrics in the collector
The SolutionPack supports some metrics that are not part of the installation. This sample
procedure shows you the steps to follow when adding these new metrics to the Stream
collector.


This sample procedure adds new metrics to the counter names VS.AttCellUpdt.RLFail,
VS.FailCellUpdt.RLFail.NoReply and VS.SuccCellUpdt.RLFail, which are in counter group ID
67109382 . These metrics are listed in the SolutionPack for Huawei iManager M2000
Counter Prerequisites spreadsheet.


Procedure


1. Back up the original collector and parser files. For example: huawei-collecting-
name.xml to huawei-collecting-name.xml.bak and huawei-
parsing.xml to huawei-parsing.xml.bak.


2. Search for the counter name VSAttCellUpdtRLFail (without '.' ) in huawei-
collecting-name.xml.


3. If found in huawei-collecting-name.xml, uncomment the following lines:


<values required="false"context-key=VS.AttCellUpdt.RLFail;">
<name>VSAttCellUpdtRLFail</name>
<unit>Nb</unit>
</values>


4. If not found in huawei-collecting-name.xml, do the following:


a. Check the contents of the counter group ID 67109382. For example: cat
pmresult_67109382_30_201302201600_201302201630.csv


Result Time,Granularity Period,Object 
Name,Reliability,"VS.AttCellUpdt.RLFail","VS.FailCellUpdt.RLFail
.NoReply","VS.SuccCellUpdt.RLFail"
,Minutes,,,none,none,none
2013-02-20 16:00,30,"RNC/BSC6900UCell:Label=PO230A1, 
CellID=32301",Reliable,0,0,0
2013-02-20 16:00,30,"RNC/BSC6900UCell:Label=PO430B2, 
CellID=32305",Reliable,0,0,0
2013-02-20 16:00,30,"RNC/BSC6900UCell:Label=PO430B1, 
CellID=32302",Reliable,0,0,0
2013-02-20 16:00,30,"RNC/BSC6900UCell:Label=PO230A2, 
CellID=32304",Reliable,0,0,0


b. Match one of the above object name patterns with an object name in this table.
The Stream collector extracts required performance management data from the
object name. The object type is the logical grouping of the counter group IDs.
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PM file name example Object name example Object type


pmresult_67109379_*.csv RNC/BSC6900UCell:Label=PO230A1 obj1


pmresult_67109377_*.csv


pmresult_67109381_*.csv


pmresult_67109471_*.csv


pmresult_67109391_*.csv


pmresult_67109365_*.csv


pmresult_67109367_*.csv


pmresult_67109368_*.csv


pmresult_67109369_*.csv


pmresult_67109372_*.csv


pmresult_67109373_*.csv


pmresult_67109376_*.csv


pmresult_67109385_*.csv


pmresult_67109390_*.csv


pmresult_67109420_*.csv RNC/BSC6900UMTSFunction:RNC obj2


pmresult_67109421_*.csv


pmresult_67109446_*.csv


pmresult_67109473_*.csv


pmresult_67109519_*.csv RNC/CNOPERATOR:CNNAME=0, CNINDEX=0 obj3


pmresult_67109516_*.csv "RNC/DPU:SRN=0, SN=9, BT=DPUB"
AND


"BSC/DPU:Slot No.=11, Subrack No=0,
Subsystem No.=0"


obj4


pmresult_50331652_*.csv RM190/NodeB:RM190/MocID:2/
Operator:-1


obj5


pmresult_1275069419_*.csv BSC/GCELL:LABEL=RML190A, CellIndex=0,
CGI=42601006F076D


obj6


pmresult_1275072526_*.csv


pmresult_1275072528_*.csv


pmresult_1275072525_*.csv


pmresult_1275072527_*.csv


pmresult_1275071435_*.csv


pmresult_1275072618_*.csv


mresult_1275071427_*.csv


pmresult_1275071429_*.csv


pmresult_1275072018_*.csv BSC/BSCRPT:BSC
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c. Since the object name pattern RNC/BSC6900UCell:Label=PO230A1 matches
one that is of obj1 type, search for <hardcoded-properties
key="hwobjid">obj1</hardcoded-properties>


d. Add these values to the metrics:


<values required="false" context-key=VS.AttCellUpdt.RLFail >
<name> VSAttCellUpdtRLFail </name>
<unit>Nb</unit>
</values>
<values required="false" context-
key=VS.FailCellUpdt.RLFail.NoReply >
<name>VSFailCellUpdtRLFailNoReply</name>
<unit>Nb</unit>
</values>
<values required="false" context-key=VS.SuccCellUpdt.RLFail >
<name>VSSuccCellUpdtRLFail</name>
<unit>Nb</unit>
</values>


e. Save huawei-collecting-name.xml.


In this example, the performance data is formatted by the counter name. If data is
formatted by the counter ID or the counter description, you must add the metric
information to huawei-collecting-id.xml or huawei-collecting-
desc.xml, respectively, instead of huawei-collecting-name.xml.


5. Append this directory file-pattern to the huawei-parsing.xml file:


<directory file-pattern="pmresult_67109379_*.csv|
pmresult_67109377_*.csv|pmresult_ 67109382 *.csv"
recursive="true">data/</directory>


6. Save huawei-parsing.xml.


7. Restart the Stream collector.


Troubleshooting


Report display problems


l What to do if data does not appear in any topology reports on page 243


l What to do if data does not appear in any topology reports on page 243


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any topology reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. Check these feeds to the topology reports:


l http://<EMC M&R-Instance>:58083/topology/repository/
l http://<EMC M&R-Instance>:58083/topology/report/map?


device=<STATION_NAME>&devtype=Station&mapType=STATION_MAP
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l http://<EMC M&R-Instance>:58083/topology/resources/
mobilepaths/topo:MobileStation:<STATION_NAME>


4. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some topology reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. In the database, search for these metrics that are used to stretch the topology from
controller to station to cell:


l RRCAttConnEstabReg for cell-specific metric (device ->siteid) inverse connection to
station


l VSIUBDLCongTime for station-specific metric (device ->cntlr) inverse connection to
controller


l VSRRCAttConnEstabRNC for controller-specific metric


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.
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For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for ip.access nano3G Small Cell. This
SolutionPack is a mobile network management solution designed to generate reports
that show key metrics and key performance indicators (KPIs) for the ip.access nano3G
access points (cells) and the ip.access controllers. It presents real-time and historical
performance reports.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R version
6.5u1 and later


Compatible operating system
Linux


Data collection method
Stream collector


Main reports
PS Calls


CS Calls


CS Traffic Erlang


PS Drop Rate (%)


CS Drop Rate (%)


Download PS Traffic


Upload PS Traffic


RAB Establishment Success


RRC Success


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Performing prerequisite installation tasks
This SolutionPack requires that the performance management (PM) data from the
ip.access Network Orchestration System (NOS) be locally available on the EMC M&R
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server hosting the Stream collector. You must ensure ip.access NOS can push the PM
data files to the EMC M&R server.


This procedure includes a task for sending the PM files from ip.access NOS to the EMC
M&R server. Contact the ip.access NOS administrator about where the PM files are stored
and how they are processed.


Procedure


1. Verify the SFTP or FTP server is running on the EMC M&R server where the Stream
collector resides.


2. Verify that connectivity exists between the EMC M&R server and ip.access NOS.


3. Configure ip.access NOS to push the access controller (AC) and access point (AP) PM
data files to separate directories on the EMC M&R server on a regular time interval.
You are asked for these directories during the SolutionPack installation.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.
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10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Performing post installation tasks
After installing the SolutionPack, you must perform certain tasks.


Procedure


1. Make sure the directories that you are using to store the AC and AP performance
management XML files are on a valid partition and that the apg user has read/write
permissions on it. If using another user, make sure that user is in the same UNIX
permissions group as the apg user.


2. Verify that the Linux unzip command is available on the EMC M&R server where the
Stream collector resides. The Stream collector uses this command to unzip the AC and
AP PM files in order to read them.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Enriching data in access point cells
By using the Data Enrichment functionality, you can quickly tag data coming from the
SolutionPack's Collector-Manager to display in the access point cells of the reports'
tables and graphs. By default, only the device name displays in these cells but you can
define additional properties to appear in these cells, such as the customer name, the cell
ID, and the device model.


Procedure


1. Navigate to Centralized Management.


2. Click Data Enrichment > Register a new module.


3. On the Register a new module window, do the following:


a. Select the Collector-Manager server on which the SolutionPack's collection block
resides, which was set during installation.


b. Select the Collecting category.


c. Select the PTF-femto-AP module. For a default installation, the module is Collector-
Manager::ipaccess-nano3g::PTF-femto-AP.


d. Click Register.


e. Select the PTF-femto-AP module, such as Collector-Manager::ipaccess-
nano3g::PTF-femto-AP.
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The New tagging window appears. To enrich the data in the access point cells, you
can manually tag new properties or you can create and import a CSV file that
contains new properties and their values.


4. If tagging new properties:


a. Click Add new property.


b. Fill out the fields on the Create a new key window.


c. Click Save.


5. If creating a CSV file:


a. Use a format similar to this one:


device,siteid,sitename,sitetype,celltype
31071,EN107,Enma Mall,Indoor,3G
31074,EN107,Enma Mall,Indoor,3G


For more information on how property tagging works with the CSV file, see the
Property Tagging Filter Administration Guide in the /APG/Doc folder of your
installation path.


b. When you are finished creating the CSV file, click Import CSV.


c. Click Choose File to navigate to your CSV file.


d. Click Ok.


Results


After the next polling cycle, you will see the access point cells displaying the additional
data.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Juniper Firewall. This SolutionPack
collects and interprets data across multiple Juniper ASA devices, and performs resource
grouping and mathematical calculations to make performance information available.


The SolutionPack for Juniper Firewall provides unified monitoring of all Juniper firewall
devices distributed in the network. In particular, it helps you to do the following:


l Verify session load and firewall failures.


l Verify firewall efficiency by monitoring packet rate and connections to demonstrate
gains and fine-tune your device configuration for better results.


l Monitor Juniper Firewalls in real-time, pro-actively, to optimize service availability.


l Understand device activity, for example, which Juniper device opens the most firewall
connections. You can also determine peak times for traffic and other metrics.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
JUNIPER-SRX5000-SPU-MONITORING-MIB.mib


mib-jnx-chassis-alarm.txt


mib-jnx-chassis.txt


mib-jnx-js-idp.txt


SYSAPPL-MIB.mib


mib-jnx-chassis-fwdd.txt


mib-jnx-ipv6.txt


Supported devices
Juniper NetScreen Series (NS):


l NS-208


l NS-5xx Series


l NS-5200


l NS-5400


Juniper SSG Series:


l SSG5


l SSG140


l SSG320M


l SSG350M
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l SSG520M
l SSG550M


Main reports


Session Failure %
Shows a Session Failure graph over a period of time for each polled firewall.


Firewall CPU Usage %
Reports on the CPU utilization for each polled firewall.


Firewall with Most Connections
Shows a Session Failure graph over a period of time for each polled firewall.


Firewall Summary
Provides summaries of the Availability %, CPU Usage %, Session Load %, and
Number of Connections of firewall devices.


Inventory
Displays the inventory (count only) of the Juniper Firewall network.


Performance Scorecard
Reports on firewall hardware availability for memory, CPU, interface, units, disk, and
power.


Situations to Watch
Displays critical and major interface errors, such as half open connections and
session bottlenecks for each polled firewall.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


l Make sure you know the name, IP address, SNMP port, and the community string of
the firewall device.
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l Verify the firewall is configured to allow network access to the SNMP port.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.After the installation is complete, select Centralized Management > SolutionPack to
verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.
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c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


On the Main parameters tab, make sure you specify Firewall for Device Type.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Juniper QoS (Quality of Service).
This SolutionPack monitors QoS-enabled Juniper devices to help you evaluate and
improve the network performance of critical applications. You can analyze the network
class of services by monitoring how the QoS configuration affects the pattern of network
traffic through a Juniper router.


The SolutionPack for Juniper QoS helps you do the following:


l Verify whether dropped packets are due to random early detection dropping or to tail
dropping.


l Verify QoS efficiency by monitoring transmitted packets.


l Monitor the Juniper routers in real time to better optimize the availability of services.


l Analyze the activities of each device to determine the busiest time intervals and to
see which devices are dropping the most packets and at what time intervals.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
JUNIPER-CHASIS-MIB.mib


JUNIPER-COS-MIB.mib


Supported devices
Any Juniper QoS-enabled router


Juniper J Series


Juniper EX Series


Juniper M Series


Juniper MX Series


Juniper T Series


Main reports
Generic Policy Traffic Reports


Situations to Watch


Traffic Shaping Reports


Match Statements Statistics


Police Action Statistics


Precedence WRED (Weighted Random Early Detection) Statistics


QoS Statistics
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Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.
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Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.
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2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Juniper RPM (real-time
performance monitoring). This SolutionPack provides unified monitoring of all probes
running on routers and switches distributed across a network.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
JUNIPER-PING-MIB.mib


JUNIPER-RPM-MIB.mib


JUNIPER-SMI.mib


Supported devices
Juniper EX3200 ethernet switches


Juniper EX4200 ethernet switches


Juniper J series services routers


Juniper M series multiservice edge routers


Juniper MX series 3D universal edge routers


Juniper T series core routers


Juniper SRX series services gateways


Main reports
RPM Probe Performance View by Device


RPM Probe Performance View by Probe Type


Situations to Watch


Latency (ICMP or UDP Echo)


High Latency Application Connect Time (TCP connect)


Reachability (ICMP ping)


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
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Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.
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3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37
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l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.
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For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Microsoft System Center
Operation Manager (SCOM). This SolutionPack provides an integrated experience for the
management of Microsoft Windows systems and the discovery of their workloads across
platforms in the data center.


The SolutionPack for Microsoft SCOM helps you:


l Manage Windows servers and their performance


l Manage key performance indicators (KPIs)


l Manage application-related metrics


l Report on Microsoft applications and services, including Microsoft Operations
Manager (MOM), server and agents, Active Directory, DNS, SQL, and Internet
Information Services (IIS)


l Report on the main management packs of MOM


l Easily expand on new report sets per management pack


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u1 and later


Data collection method
SQL collector


Supported versions
System Center 2012 Operations Manager


System Center 2012 R2 Operations Manager


Supported Microsoft applications and services
Operations Manager


Server and agents


Active Directory


DNS


SQL 2012


IIS


User privilege requirements
An SQL or Windows user must have SELECT and CONNECT privileges on the SCOM
Operations Manager Data Warehouse Database called OperationsManagerDW.


Main reports


Microsoft Products/Microsoft System Center
Displays the health (%) of the agents with an alert meter, data access and NT service
statistics, and general information about the agents per management server


SolutionPack for Microsoft SCOM Summary Sheet


276 Service Assurance Suite 9.4  SolutionPack Articles







Microsoft Products/Microsoft Windows Operating System
Provides the OS distribution, top 10 processor consuming servers, and a complete
list of servers.


Microsoft Products/Microsoft Active Directory
Provides the established TCP connections and the LDAP client sessions per server.


Microsoft Products/Microsoft SQL
Shows user connections per database and the databases with the lowest amount of
free space.


Microsoft Products
Displays the product names, number of product instances, and the DNS and IIS data.


Managed Windows Server
Provides CPU usage %, free memory, and free page memory.


Per Operating System
Displays the server types and the number of servers.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing the SolutionPack


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC support website http://support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the Watch4net Installation and Configuration Guide provides for more
information.


Procedure


1. Log in to Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select the SolutionPack for SCOM in the Browse and Install SolutionPacks screen.


4. Read the summary information and click Install.


You can select either Simple or Advanced as the configuration mode. Simple mode
lets you select Windows authentication for database access. Advanced mode is
typically for the user who is configuring the SQL server connection using the JDBC
driver.
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5. When you select Simple as the configuration mode for the OperationsManagerDW
(SCOM Operations Manager Data Warehouse) database, set these values:


l Hostname or IP address of the database server


l Database port


l Instance name


l Choose if you want to use Windows authentication


l Username


l Password


6. When you select Advanced as the configuration mode for the OperationsManagerDW
database, set these values:


l Connection string


l Username


l Password


After you finish


After the installation is complete, select Centralized Management > SolutionPack to verify
the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l What to do when raw data continues to appear on reports on page 280


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.
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3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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What to do when raw data continues to appear on reports
If the SQL collector continues to collect unprocessed data, which appears as zeros on
reports, after three polling cycles, follow these instructions.


Procedure


1. Log in into the SQL server.


2. Execute the SELECT MAX(vPR.DateTime) AS LatestDateTime FROM
Perf.vPerfRaw AS vPR query to display the last date and time in which data was
written to the database.


3. If this is not a realtime value, check the Microsoft System Center Operation Manager
for issues.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Microsoft SQL Server. This
SolutionPack provides the unified monitoring of Microsoft SQL databases using SQL
queries targeted at servers. It provides key information for database administrators, such
as server host performance, database availability, and deadlocks. Both ViPR SRM and
Service Assurance Suite use this SolutionPack.


Technical Specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1


Supported Microsoft SQL versions
SQL Server 2008R2


SQL Server 2012


Data collection method
SQL collector


SQL commands
This SolutionPack uses these commands:


l SELECT


l CONNECT


l INSERT


l CREATE TABLE (creates temporary tables)


l EXEC (executes store procedure that lists disks and their available free space)


l DROP (removes temporary tables)


User privilege requirements
SQL authentication requires that the user be a member of the SYSADMIN group.


The Windows user account requires that the user be a member of the Guests group or the
Domain Guests group.


The Windows user account must be imported into the Microsoft SQL Server with settings
similar to these:


l Server roles of public


l Securable grants for Connect SQL, View any definitions, and View server state


The default database must be the master.


Main reports
Host Health (%), including the percentage of CPU and memory utilization of all hosts


Performance of SQL Server


Databases Overview


Performance Scorecard of storage usage, index contention, memory pressure, signal
waits, SQL server hosts performance, and user connections and logins
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Situations to Watch, including memory exceptions, SQL server locks, I/O botllenecks,
CPU bottleneck, data files out of space, and actual and forecasted SLA values


Inventory of servers, databases, data files, and objects


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing the SolutionPack


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide
provides for more information.


Procedure


1. Log in to Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select the SolutionPack for Microsoft SQL Server in the Browse and Install
SolutionPacks screen.


4. Read the summary information and click Install.


5. In the Collector field of the Select the components to install window, select the
Collector host.


6. In the Reports field, select the Frontend host.


7. Click Next.


8. Make a selection in the Data Collection field.


9. If you select Add a new Data collection, enter information for the new data collection.
In the Hostname or IP address to send data field, type localhost.


10.Leave Enable alerting on data collected selected.


11.Make a selection in the Alerting on data collection field.


If you select Add a new Alerting on data collection, type information for the new
alerting destination. In the Alerting Backend hostname or IP address field, select the
Primary Backend host.
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12.Type information to identify the SQL Server.


If you select Choose for Windows authentication instead of SQL Server
authentication, type the Windows domain name.


13.Set these values:


l Fully qualified name of the SQL server


l Port


l Username


l Password


14.Select Use advanced settings to configure polling settings.


15.Click Next.


16.In the Administration Web-Service Instance field on the Reports window, select the
Frontend host.


17.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in reports on page 284


l Running a scheduled task to import data into reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in reports


Procedure


1. Do the following to check the Collector Manager logs:


a. View /opt/APG/Collecting/Collector-Manager/microsoft-
sqlserver/logs/collecting-0-0.log.


b. Verify that the last message in the log states that a certain number of raw values
were collected using 13 SQL queries. This message indicates the collector is
working.


For example: <instance_master> collect done: 2,735 new raw
values collected in 0 seconds 527 ms using 13 SQL queries
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c. Check for any Java exceptions and warning messages.


2. If collector errors exist, do the following:


a. Ping the Microsoft SQL Server using the fully qualified domain name (FQDN).


b. Replace the current user, which is the username and password set during
SolutionPack installation to retrieve data from the Microsoft SQL sever, with a user
with SYSADMIN rights.


c. Use telnet to check if the Microsoft SQL port is accessible from the SQL collector
server.


d. Reconfigure the SolutionPack by navigating to Centralized Management >
SolutionPacks > Microsoft SQL Server.


e. Under SolutionPackBlock, click the pencil next to Collector to reconfigure the
settings.


f. To edit advanced connection settings, you may need to manually edit the SQL
collector configuration file.


3. If no errors exist and the last message in the log indicates that 13 queries were
executed, do the following:


a. Wait a minimum of three polling cycles. By default, one polling cycle is five
minutes.


b. Navigate to Centralized Management > Scheduled Tasks.


c. Under the Backend category, run backend/Default/
import_variable_status.task.


d. Refresh the reports after five minutes.


4. Make sure the Frontend is attached to the database used by the SQL collector.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.
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Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for SolutionPack for MPLS
(Multiprotocol Label Switching). This SolutionPack provides visibility into MPLS virtual
private networks (VPNs). It analyzes how MPLS VPNs are configured and utilized, from
both a real-time and historical perspective.


EMC M&R polls MPLS devices and interfaces and VRF (virtual routing and forwarding)
data to show device and tunnel performance, hot-spot problems, top ten volumes, and
MPLS inventory.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
MPLS-LSR-MIB


MPLS-VPN-MIB


Supported devices
This SolutionPack can collect data from any device that supports these MIBs:


MPLS-LSR-MIB


MPLS-VPN-MIB


Main reports


MPLS Performance by VRF and Interface
Provides insight into major MPLS interface metrics, including volume, labels,
discards, fragments, and VRF metrics, such as VRF availability and number of routes.


MPLS Inventory by VRF and Interface
Provides an inventory of the MPLS interfaces and VRFs with their corresponding
metrics and their values.


Total Routes Added and Used
Provides an overview of the added routes per VRF and labels used per MPLS
interface, in the form of a stacked chart.


TopN reports on Labels, Fragments and Discards
Provides values for Labels, Fragments and Discards of each MPLS interface.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.
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This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


SolutionPack for MPLS Summary Sheet


Installing a SolutionPack     289



http://support.emc.com

http://support.emc.com

http://support.emc.com

http://support.emc.com





2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.
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Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Optical Wavelength Services. This
SolutionPack discovers and monitors TMF864-compliant Element Management Systems.


Use this SolutionPack as one component of your Optical Transport Manager (OTM)
deployment. Other components include


l EMC Smarts 9.4 Optical Transport WDM-NG domain manager


l EMC Smarts 9.4 Service Assurance Manager


l EMC M&R 6.5u1 with SolutionPack for EMC Smarts installed


Data flow among the OTM components
The SolutionPack for Optical Wavelength Services uses a Stream Collector (SC) to poll
TMF 864-compliant Element Management Systems (EMS) at a configurable polling
interval. The information that is collected is persisted in the EMC M&R database so that
the EMC Smarts WDM-NG domain manager can retrieve the data and build topology
based on the property information. The SC makes SOAP WebService requests to the EMS
to retrieve the topology and extract information. First the authentication / login request is
sent and then the security ID is extracted. This security ID (session ID) is sent as part of
the SOAP envelope in all the subsequent calls.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Supported Element Management Systems (EMS)
TMF864-compliant Element Management Systems such as Coriant Intelligent Node
Manager SR 6.0 SP2


Data collection method


l Stream collector (for data parsing)


l Stream listener (for event processing)


Main reports
There are no reports associated with this SolutionPack. You must install the SolutionPack
for EMC Smarts to view reports and topology associated with data collected from TMF
864-compliant Element Management Systems. View Topology maps under Explore >
Network and Notifications under Operations > Notifications.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
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Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC support website http://support.emc.com.


l Ensure the core modules, such as the Module-Manager, are up-to-date on all servers
since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


l Obtain the login credentials and protocol information for the TMF864-compliant
Element Management System(s)


l Ensure all software for your EMC Smarts Optical Transport Manager deployment is
installed with services running.


Table 11 Software components required when collecting data from optical networks


Software component Purpose


EMC Smarts Optical Transport
Manager installed with WDM-NG
domain manager service


Analyzes the events collected by the SolutionPack for
Optical Wavelength Services and determines the root
cause of problems occurring in the optical network.


EMC Smarts Service Assurance
Manager installed with Notification
Cache Publishing


Converts events to notifications and sends the root cause
and impact to the SolutionPack for EMC Smarts.


SolutionPack for EMC Smarts Provides reports showing notifications and topology
collected from the optical network.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Review the default instance name and edit if needed.


You may install more than one instance of the SolutionPack. Each instance name
must be unique and connected to different Element Management Systems.


b. Select the EMC M&R servers in one or more list boxes. For example, select the
collector host in the Data collection and the backend host in the Events list boxes.
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c. Click Next.


8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


Default RabbitMQ credentials are admin and changeme when using SAM with
Notification Cache Publishing enabled.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.
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Overview
Learn how to install and configure the SolutionPack for Oracle Database.


The SolutionPack for Oracle Database monitors the status and performance of an Oracle
database. The SolutionPack gives visibility into listeners, tablespaces, versions,
connections, commits and rollbacks. You can survey the Oracle core process, such as the
SGA, and verify the hit ratio about cache, dictionary cache, latch cache, library cache, sort
and sessions.


Figure 4  SolutionPack for Oracle Database


Technical specifications


SolutionPack version
1.4


Main reports
Entire Oracle database infrastructure summary


Detailed database size


Oracle RAC view


Instances availability


Cross server KPIs
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Supported Oracle database releases


Table 12 Support for Oracle databases


Supported
Collection
Interfaces


Collector Prerequisites Port


Oracle 10 and
greater


SQL-
Collector


The appropriate JDBC driver jar file needs to be in the
folder


…/APG/Databases/JDBC-Drivers/
Default/lib
Work with your DBA to determine the appropriate JDBC
driver based on the installed version of Oracle.
Download the JDBC driver from www.oracle.com/
technetwork/database/features/jdbc
ORACLE database user credentials are required


1521
(TCP)


For details on Oracle database user credentials see the following section:


l Configuring the SolutionPack for Oracle Database with an unprivileged account on
page 300


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing SolutionPack


Before you begin


l ViPR SRM core modules must be up-to-date in all servers because not all module
dependencies are validated during the SolutionPack installation or update process.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click SolutionPacks.


4. Click SolutionPack Center.


5. Select the SolutionPack in the Browse and Install SolutionPacks window.


6. Click Install.


7. Type the instance name.


SolutionPack for Oracle Database Summary Sheet


Where to find the latest SolutionPack software     299



http://support.emc.com

http://support.emc.com





8. Assign a server for each component.


In a typical four server deployment, the recommended servers are selected
automatically.


9. Click Next.


The window displays data collection details.


10.From the Data collection drop-down menu, select existing settings that have been
specified for other components, or select Add a new data collection.


If you select Add a new data collection, type information about the data collection. In
Hostname or IP address to send data to, use localhost on port 2020, which is the
Collector host where the Load Balancer Connector is installed.


11.Leave Enable alerting on data collected checked.


12.Optionally select the Enable property import for server enrichment checkbox.


13.In the Backend configuration section, type the host information and credentials for
the Primary Backend Host.


14.Select Configure collector advanced settings to configure polling settings.


15.Click Next.


The window displays reports settings.


16.From the Web-Service Gateway drop-down menu, select existing settings that have
been specified for other components, or select Add a new Web-Service Gateway.


If you select Add a new Web-Service Gateway, type information about the web-service
gateway.


17.In Administration Web-Service Instance, select an existing instance or create a
custom instance.


18.Click Install.


19.Click Ok when the installation is complete.


20.Click Discovery Center > Devices Management.


21.Click Add new device.


22.Click Oracle Database.


23.Select the server and collector instance where you want to store the configuration
details for this device, and then enter the hostname or IP address of the host, supply
the login credentials, and specify the appropriate configuration settings.


24.Click Test to validate the credentials.


25.Click OK.


26.Click Save.


Configuring the SolutionPack for Oracle Database with an
unprivileged account


The ViPR SRM collector must connect to each instance of Oracle databases and perform
SQL queries. You can use either an administrator equivalent system account, or create a
dedicated system account for the collector. If you want to use the last option, please ask
the DBA administrator to run the following query against every instances/RAC cluster.
This will create a watch4net account with specific grants for the ViPR SRM collector.
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Procedure


1. Run the query as follows:


create user watch4net identified by <securepassword> default 
tablespace <users> temporary tablespace <temp>;
grant connect to watch4net;
grant select on V_$SYSSTAT to watch4net;
grant select on v_$filestat to watch4net;
grant select on v_$database to watch4net;
grant select on dba_data_files to watch4net;
grant select on dba_extents to watch4net;
grant select on dba_free_space to watch4net;
grant select on v_$parameter to watch4net;
grant select on v_$sgainfo to watch4net;
grant select on v_$rowcache to watch4net;
grant select on v_$librarycache to watch4net;
grant select on v_$latch to watch4net;
grant select on v_$rollstat to watch4net;
grant select on v_$dispatcher to watch4net;
grant select on v_$instance to watch4net;
grant select on v_$sesstat to watch4net;
grant select on v_$statname to watch4net;
grant select on v_$session to watch4net;
grant select on v_$sess_io to watch4net;
grant select on v_$asm_disk to watch4net;
grant select on v_$asm_diskgroup to watch4net;
grant select on v_$logfile to watch4net;
grant select on v_$log to watch4net;
grant select on dba_tablespaces to watch4net;


2. For Oracle11, you also need to run:


Begin
dbms_network_acl_admin.create_acl(
acl => 'Resolve_Access.xml',
description => 'Resolve Network Access using UTL_INADDR',
principal => 'WATCH4NET', - MUST BE IN CAPS
is_grant => TRUE,
privilege => 'resolve',
start_date => null,
end_date => null
);
end;
/
commit;
begin
dbms_network_acl_admin.assign_acl (
acl => 'Resolve_Access.xml',
host => '*',
lower_port => null,
upper_port => null);
end;
/
commit;


Results


Your dedicated account is configured.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:
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Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.
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2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Oracle MySQL Database. This
SolutionPack provides management capabilities typically found in database-centric tools
along with management support from other technologies. You can measure client activity
by reporting on data from your database tier alongside your business logic and
presentation tiers. Both ViPR SRM and Service Assurance Suite use this SolutionPack.


Technical Specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1


Supported Oracle MySQL versions
MySQL 5.1


MySQL 5.5


MySQL 5.6


User privilege requirements
This SolutionPack requires MySQL database user login privileges to collect information
from MySQL database servers running remotely.


Data collection method
The Oracle MySQL SolutionPack's sql-collector queries the
information_schema.GLOBAL_STATUS table and the
information_schema.SESSION_VARIABLES table.


Main reports
Query Cache Volume among all MySQL Databases


Number of SQL queries among all MySQL Databases


Total Current Connection


Database Health and Performance


Connection Health


Memory Health


Slave's Health


Database Performance


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
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Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing the SolutionPack


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide
provides for more information.


Procedure


1. Log in to Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select the SolutionPack for MySQL Database in the Browse and Install SolutionPacks
screen.


4. Read the summary information and click Install.


5. Edit the default instance name, oracle-mysql-database, and click Next.


6. Set these values for the MySQL database server:


l Database hostname or IP address


l Database port


l Please select the credentials


7. If you have multiple instances of the Oracle MySQL database servers in your
configuration, click + to name each server and set the values shown in the previous
step.


8. Select Administration Web-Service Instance as the default and click Install.


9. When a checkmark appears next to the Collector and the Report, click OK.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.
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Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 308


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports.


2. On the Device Discovery Dashboard, verify that all icons are green.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


4. Log in to your MySQL database and verify data is being written to the MySQL database
server. Look specifically at the data_property, data_variable, and all cache
tables:


select * from data_property;
select * from data_variable;
select * from <cache-table-name>;


5. In the MySQL database, verify the user has the required login permissions to the local
and remote MySQL servers being monitored by the SolutionPack. If not, follow these
steps to create credentials for the user:


a. Navigate to bin/mysql/ -u root -p <rootUserPassword> -P
<mysqlServerPort>


b. Type the following commands to create the credentials:


use mysql;
CREATE USER 'testuser'@'%'IDENTIFIED BY 'watch4net';
GRANT ALL ON *.* TO 'testuser'@'%';


c. Use these user credentials to log in to the local and remote MySQL database
servers from the SolutionPack.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.
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4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the Oracle MySQL database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Modules.


3. On the Metric Selection page, create the filter.


For example, to list the key_reads (the number of physical reads of a key block from
disk to the MyISAM cache), type source=='MySQL-Collector'
&&name=='key_reads' in the Filter field.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Riverbed SteelHead. This
SolutionPack provides unified monitoring of all Riverbed SteelHead appliances
distributed in a network.


The SolutionPack for Riverbed SteelHead helps you do the following:


l Verify the efficiency of traffic reduction. You can demonstrate gains and fine-tune
your device configuration for better results.


l Monitor the Riverbed SteelHead appliances in real-time to optimize the availability of
services.


l Understand your WAN traffic. You can see which applications are using the most
bandwidth and their peak utilization time period.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.5u1 and later


Data collection method
SNMP collector


Supported MIBs
steelhead_mib_653.mib


rbt_mib_708.mib


Supported devices
Riverbed SteelHead appliances 250


Riverbed SteelHead appliances 550


Riverbed SteelHead appliances 1050


Riverbed SteelHead appliances 2050


Main reports


SteelHead Appliances Summary
Shows the Riverbed SteelHead utilization, such as the processor load, the
availability over a selected time period, and the traffic compression rate per device.
When you drill down to a specific appliance, you see CPU utilization %, CPU load,
bandwidth passthrough, outgoing traffic reduction, incoming traffic decompression,
storage and memory utilization, and detailed connection information.


SteelHead With Most Connections
Displays the appliances with the most connections.


SteelHead Saving Most Traffic (KBytes/sec)
Displays the appliances that save the most WAN traffic.


Performance Scorecard
Provides a summary of appliances showing compression rate (KBytes/sec), no
compression (overhead traffic), and SteelHead datastore hits %.
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SteelHead Traffic Reports
Reports on SteelHead traffic (KBytes/sec), application traffic (KBytes/sec),
bandwidth passthrough (KBytes/sec), and SteelHead WAN links usage %.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


8. Complete the wizards screens and click Install on the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.
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10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.


c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


SolutionPack for Riverbed SteelHead Summary Sheet


314 Service Assurance Suite 9.4  SolutionPack Articles







Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.
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2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Traffic Flows. This SolutionPack
provides reports that give you a clear understanding of your IT network traffic. It
generates a wide spectrum of network traffic reports that highlight key performance
indicators (such as router CPU and processor memory used and the most active network
devices and applications) to help you better understand their impact on the network of
your data center.


Technical specifications


SolutionPack version
2.0


Compatible EMC M&R versions
6.4 and later


Support list
Netflow v5.0 and v9.0


Cisco ASA NSEL (Network Security Event Logs)


IP Flow Information Export (IPFIX) v10


Data collection method
Flow Listener


Main reports
Global, Exporter, Interface-level Reporting


TopN Reports


Conversations


Protocol and Applications


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.
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Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the EMC M&R (Watch4net) Installation and Configuration Guide for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install.


a. Type the instance name.


b. Select the servers in one or more list boxes. For example, select the server in the
Flow Database, Flow Collection, and Reports list boxes.


c. Click Next.


8. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Post installation tasks
After you install the SolutionPack for Traffic Flows, complete these tasks in the following
order.


1. Starting the Flow database on page 320


2. Creating the tables in the Flow datastore on page 320


3. Starting the Event Processing Manager on page 321
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4. Editing frontend files on page 321


5. Starting the Tomcat service on page 322


Starting the Flow database


Procedure


l To start the Flow database, execute <Install_Directory>/opt/APG/bin/
manage-modules.sh service start datastore Default


Creating the tables in the Flow datastore


Procedure


1. Follow these steps to create the tables in the Flow datastore:


Operating
system


Steps


Windows a. Navigate to APG\Event-Processing\APG-Datastore-
Writer\<instance_name>\dll.
The instance name was set during the installation of the
SolutionPack.


b. Open the setup-db.dll file and copy its contents.


c. Navigate to APG\Databases\APG-Datastore\Default
\bin.


d. Run the datastore-client.cmd script to connect to the
datastore.


e. At the SQL> prompt, press CTRL+V to paste the contents from the
buffer.


Linux a. Navigate to /opt/APG/Event-Processing/APG-
Datastore-Writer/<instance_name>/dll.
The instance name was set during the installation of the
SolutionPack.


b. Type /opt/APG/Databases/APG-Datastore/Default/bin/
datastore-client.sh < flow-setup-db.ddl.


c. To check the progress of the above command, type /opt/APG/
Databases/APG-Datastore/Default/bin/datastore-
client.sh.


A message similar to this appears:


Welcome to APG-Datastore 5.0 CLI (Ctrl+D to exit).
Connected to jdbc:x100://localhost:12345/ !
sql>


2. To view the new tables in the Flow datastore, type .tables; at the SQL> prompt.
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Starting the Event Processing Manager
By starting the Event Processing Manager (EPM), you begin traffic flow collection.


Before you begin


Before starting EPM, use the Simple Network Management Protocol (SNMP) to discover
the flow exporters, which are managed as routers, into the EMC M&R platform.


Procedure


1. To start EPM, type /opt/APG/bin/manage-modules.sh service start
event-processing-manager <instance_name>


2. To verify EPM has started, check the processing-00.log file in /opt/APG/
EventProcessing/Event-Processing-Manager/<instance_name>.


This message appears at the end of the log:


Processing manager started!
3. Ignore this warning in the log file:


WARNING -- [2013-12-16 08:13:50 EST] -- 
ComponentClassLoader::init(): Component type
EventPropertyTagger is deprecated, please update your Event-
Processing-Manager configuration to use
Event-Property-Tagger instead !


Editing frontend files


Procedure


1. Open sever.xml in /opt/APG/Web-Servers/Tomcat/Default/conf.


2. Uncomment this section to set the connection to the Traffic Flow database for the
datastore:


<!--
<Resource name="jdbc/FLOW-TF-DATA" auth="Container" 
type="javax.sql.DataSource"
  maxActive="10"
  maxIdle="10" validationQuery="SELECT 1" testOnBorrow="false" 
testWhileIdle="true"
  timeBetweenEvictionRunsMillis="10000" 
minEvictableIdleTimeMillis="60000"
  maxWait="10000"
  username="admin" password="changeme" 
driverClassName="com.watch4net.x100.jdbc.Driver"
  removeAbandoned="true" removeAbandonedTimeout="60" 
logAbandoned="true"
  url="jdbc:x100://localhost:48443/Databases/APG-Datastore" />
-->


3. Open APG.xml in /opt/APG/Web‐Servers/Tomcat/Default/conf/
Catalina/localhost.


4. Uncomment this section to provide access to the Traffic Flow data:


<!--
<ResourceLink name="jdbc/FLOW-TF-DATA:{ mapping=FLOW-TF-DATA.xml,
table=FLOW_RAW_DATA__SEQ_0_4__}" global="jdbc/FLOW-TF-DATA" 
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type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-PROTO:{ mapping=FLOW-TF-PROTO.xml,
table=FLOW_PROTOCOL__SEQ_0_4__}" global="jdbc/FLOW-TF-DATA" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-APP:{ mapping=FLOW-TF-APP.xml,
table=FLOW_APPLICATION_TOPN__SEQ_0_4__}" global="jdbc/FLOW-TF-
DATA" type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-SRCADDR:{ mapping=FLOW-TF-
SRCADDR.xml,
table=FLOW_SRCADDR_TOPN__SEQ_0_4__}" global="jdbc/FLOW-TF-DATA" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-DSTADDR:{ mapping=FLOW-TF-
DSTADDR.xml,
table=FLOW_DSTADDR_TOPN__SEQ_0_4__}" global="jdbc/FLOW-TF-DATA" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-CONV:{ mapping=FLOW-TF-CONV.xml,
table=FLOW_CONVERSATION_TOPN__SEQ_0_4__}" global="jdbc/FLOW-TF-
DATA" type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-HOSTS:{ mapping=FLOW-TF-HOSTS.xml,
table=FLOW_HOSTS__SEQ_0_4__}" global="jdbc/FLOW-TF-DATA" 
type="javax.sql.DataSource" />
<ResourceLink name="jdbc/FLOW-TF-NOSNMP:{ mapping=FLOW-TF-
NOSNMP.xml,
table=FLOW_NOSNMP__SEQ_0_4__}" global="jdbc/FLOW-TF-DATA" 
type="javax.sql.DataSource" />
-->


Starting the Tomcat service


Procedure


l To start the Tomcat service, execute /opt/APG/bin/manage-modules.sh
service restart tomcat Default


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43
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What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.
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For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for Transaction. This SolutionPack
helps you measure the performance of your network by providing transactions that return
key performance indicators.


You can execute and report on these transactions using the SolutionPack for Transaction:


l HTTP head - implements an HTTP head request over a specific URL


l HTTP - implements an HTTP request over a specific URL


l SQL-based query - executes a query against an SQL server


l TCP connect - connects to a port on a server and executes a command


l DNS query - executes a query that retrieves DNS records from a specific resolver


l FTP commands - executes the retrieve, store and delete commands


l SFTP - executes the retrieve, store and delete commands over the SSH file transfer
protocol


l LDAP - performs a search query against an LDAP server


l RADIUS - performs an authentication request against a RADIUS server


l SCRIPT - executes a custom command on a local machine


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.4u1 and later


Data collection method
Transaction Collector


Main reports
Transactions List by Type


Transactions List by Group


Transactions List by Destination (Target)


Transactions List by Source


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.
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Installing the SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If not listed, obtain a license by completing a Support Request (SR)
form, which is available on the EMC Online Support website at http://
support.emc.com. This SolutionPack requires a license for the SolutionPack for
Transaction and the Transaction Collector.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. The EMC M&R (Watch4net) Installation and Configuration Guide provides for
more information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. Select the components to install:


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Collector and Reports list boxes.


c. Click Next.


For each list box you select, a screen appears.


d. Click Next after you complete each screen.


8. When the Transaction Collector screen appears, set these values:


l Transaction Collector Host or IP: The IP address of the host where the Transaction
Collector is running.


l Transaction Collector port: The port used for communication by the Transaction
Collector.


l Transaction Collector username: The EMC M&R login name where you installed the
Transaction Collector. (This field displays admin by default.)


l Transaction Collector password: The EMC M&R password where you installed the
Transaction Collector.


l Transaction Collector instance: The instance name of the Transaction Collector,
such as generic-transaction.


If using more than one Transaction Collector instance, click + to add more credentials.


9. Click Install after you complete the last screen.


The installation process begins.
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10.Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


11.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Configuring the SolutionPack
For the SolutionPack for Transaction to retrieve and process transactions, you must
restart the Tomcat service after installation. You can also add new transaction types and
edit default transaction types.


The Administration > Modules > Transaction Collector > Configuration Management > 
interface provides an automated way for you to add and edit transaction types. You can
also use the transaction-collector.xml file to manually add and edit
transactions, as explained in the Configuration chapter of the Transaction Collector
Administration Guide. This guide is in the /APG/Doc folder of your installation path.


Note


Do not follow the instructions in the Installation chapter of the Transaction Collector
Administration Guide since the Transaction Collector and the authentication.xml file


are automatically configured during the SolutionPack for Transaction installation.


Procedure


1. To use the Transaction Collector, restart the Tomcat service by
executing /opt/APG/bin/manage-modules.sh service restart tomcat
Default


2. To add or edit a transaction, navigate to Administration > Collecting > Transaction
Collector.


The Configuration Management screen appears.


3. Click Retrieve to edit the running Transaction Collector.


4. You may, optionally, set up default entries that will populate fields in the transaction
setup by editing the Collector Properties or Default Attributes entries in the
Configuration Management navigation tree.


5. To add a new transaction, expand Transactions > Add a Transaction and select a
transaction type or group.


6. Edit the parameters and attributes. Click Save.


7. Click List to return to the Configuration Management screen, and click Push to restart
the collector with the new transaction.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.
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Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.
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Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Overview
Learn how to install and configure the SolutionPack for UPS (Uninterruptible Power
Supply). This SolutionPack provides unified monitoring of all the UPS devices distributed
in the network. It provides key reports to help you manage the performance and
availability of your backup power sources.


The SolutionPack for UPS helps you do the following:


l Maintain an accurate inventory of devices and components.


l Understand device activities.


l Plan for power source requirements.


Technical specifications


SolutionPack version
1.0


Compatible EMC M&R versions
6.3u1 and later


Data collection method
SNMP collector


Supported devices
UPS devices supporting rfc1628.mib
APC devices supporting PowerNet-MIB.mib
Data collection method
SNMP collector


Main reports


UPS Output Load
Reports on device-wide distribution of the output load.


Battery Status
Provides voltage, current, and temperature information.


Input/Output
Reports on input line metrics, such as voltage and frequency, and output line
metrics, including status, load, voltage, current, and frequency.


On Battery Stats
Shows the current status of a battery and its remaining time and capacity.


Capacity (%)
Graphs the percentage of battery capacity over a period of time.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.
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This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing the SolutionPack


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC Online Support website at http://
support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation. See the Watch4net Installation and Configuration Guide provides for more
information.


Procedure


1. Log in to the EMC M&R platform with your user name and password.


2. Select Administration.


3. Select Centralized Management.


4. Select SOLUTIONPACK CENTER.


5. Select the SolutionPack in the Browse and Install SolutionPacks screen.


6. Read the summary information and click Install.


7. In the next window, type the instance name for Reports and SNMP Masks and click
Next.


8. Select the Administration Web-Service Instance as the default and click Next.


9. In the SNMP Masks wizard, click Install. Green indicators appear next to Reports and
SNMP Masks to indicate their installations were successful.


10.Select Centralized Management > SolutionPack to verify the installed SolutionPack.


Configuring SNMP device discovery
An SNMP collector discovers the capabilities that you configure for a device. You can use
a seed file to import a list of device definitions or manually add and configure devices.


Procedure


1. Navigate to Administration in the EMC M&R platform.


2. Click Modules > SNMP Device Discovery.


A Dashboard appears where you add new SNMP collectors and devices as well as add
devices to existing SNMP collectors.


3. To add an SNMP collector, click Collectors > New Collector.


a. Specify the required information for the SNMP collector.


b. Under Import Options, select all options except Lock collector current capabilities.
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c. Click Save.


4. To upload a seed file, click Device Sources > New Seed File Device Source.


For information about defining a seed file, click Documentation on SNMP Device
Discovery – EMC M&R.


a. Type the main parameters and click Save.


b. Under the Seed File tab, click Upload new definition seed file.


c. Navigate to the seed file and click Ok.


d. Click Save.


5. To manually add devices, click Devices > New Device.


a. On the New Device window, click each tab and type the required information for
the device.


b. Click Save on each tab.


6. Select the device that you just added and click the Approve action, which is the
checkmark.


7. On the Dashboard, do the following:


a. Click Import devices from all enabled device sources.


b. Click Discover capabilities from all approved devices.


c. Click Distribute all approved devices with capabilities on all enabled collectors.


d. Click Send the generated configurations on all available collectors.


Green indicators appear on the Dashboard after successful executions of the
above functions.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 37


l What to do if data does not appear in some reports on page 37


l Viewing collector errors in the Collector-Manager log files on page 43
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What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Collecting >
Collector-Manager::<instance name> > Log Files.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Go to the Administration page.


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


SolutionPack for UPS Summary Sheet


What to do if data does not appear in any reports     335







For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the configuration error
messages.
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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
EMC M&R components from the EMC Update server to the Module Repository on the
Centralized Management (CM) server. In a multi-server environment, the downloaded
modules are distributed to all of the remote servers managed by the CM server.


Configuring server settings for online updates
Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click Configuration > Online Update .


4. Ensure that you are on the Settings tab.


5. By default, online update uses the EMC Online Support username and password
specified under Configuration > EMC Support. If you want to use different credentials,
click Override Support Credentials. These credentials are used only for online update.


6. Click the  icon to test connectivity to the update server.


The  icon indicates that connectivity to the server has been established.


The  icon indicates that connectivity to the server failed.


7. Click Save.


Enabling the online update task
Enable the Online Update task to download the latest updates from the EMC Update
server automatically.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Enable.


Note


By default, this task is set to run once everyday at 12AM. You can customize the task
schedule by editing the configuration file.
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Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Run Now.


Online Update Status
The Online Update Status tab indicates whether or not the last online update check was
successful, provides the date and time of the last successful check, and lists any updates
that are available for download.


Figure 5  Online Update Status


If a major update of the EMC M&R platform is detected, the Status tab includes a Major
Update Status section that describes the version that is available, provides a link to the
upgrade documentation, and includes a Start Download button.
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Figure 6  Online Update Status with a major version update detected


Downloading a major update
You can use Online Update to download a major version of the EMC M&R platform. You
should only download a major version if you intend to immediately complete the full
upgrade process.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click Configuration > Online Update.


4. Click the Status tab.


5. Click Start Download. When the download is finished, the Download State will change
from "Not Downloaded" to "Complete."


6. Complete the upgrade process as described in the upgrade documentation.


Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.


The History tab also allows you to search the download history for a particular component
name or version number.


Disabling the online update task
You can disable the Online Update task if you prefer to manually download the updates
from the EMC Update server.


Procedure


1. Click Administration.
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2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Disable.
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Update SolutionPacks and other components
Learn how to update SolutionPacks and other components that Online Update has
downloaded from the EMC Update server to the Module Repository on the Centralized
Management (CM) server.


Refer to the Automate the Download of Updates article for details about Online Update.


The product provides several options for updating SolutionPacks and other components:


l Update all of the SolutionPacks and other components with a single click


l Update all of the SolutionPacks with a single click


l Update all of the other components with a single click


l Update individual SolutionPacks or other components


The update process detects if any manual edits were made to the SolutionPack files. If a
manually edited file is compatible with the new version of the SolutionPack, it will be
reused and the system will display a message to let you know. If a manually edited file is
not compatible with the new version of the SolutionPack, the system will back up the file
and display a warning message that indicates the name and location of the incompatible
file. The system does not check files that were not were not included with the
SolutionPack.


Update all SolutionPacks and other components
You can update all of your installed SolutionPacks and other components with a single
click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Update All Components button in the top-right corner of the page.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update all SolutionPacks
You can update all of your installed SolutionPacks with a single click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Select All button located below the SolutionPacks table, and then click the
Update button.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update all other components
You can update all of your other installed components with a single click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Select All button located below the Other Components table, and then click
the Update button.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update individual SolutionPacks or other components
You can easily update individual SolutionPacks or other components.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2.
In the SolutionPacks table or the Other Components table, click the update icon 
for the SolutionPack or component that you want to update.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.
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Overview
Service Assurance Suite combines some of the best features of Service Assurance
Manager and EMC M&R to provide a common interface for viewing Notifications and
reports on historical events. You must install and configure EMC Service Assurance
Manager (SAM), EMC M&R, and the SolutionPack for EMC Smarts before you can view
notifications or reports from the EMC M&R Report Library.


When EMC M&R platform and the SolutionPack for EMC Smarts are deployed with Service
Assurance Manager, these features may be accessed from the EMC M&R interface:


l Notifications


l Reports showing geographical representation of Smarts network devices, physical
inventory of device groups, and a physical inventory of the IP network


l IP Configuration Manager settings such as polling and thresholds


l Discovery and topology settings for underlying domain managers


In addition, the EMC Smarts Failover System now supports failover of the services used to
communicate between Service Assurance Manager and EMC M&R platform. The EMC
Smarts Failover System User Guide provides more information.


The order in which you install SAM and EMC M&R does not matter. But the licensing and
configuration of both products must be completed and the services for both products
must be installed and running before you install the SolutionPack for EMC Smarts.


Additional information is described in these documents:


l EMC M&R Installation and Configuration Guide


l SolutionPack for EMC Smarts Summary Sheet


l How to Maintain IP Manager Settings


l Troubleshooting the Deployment of SAM, EMC M&R, and the SolutionPack for EMC Smarts


Resource allocation for SAM and EMC M&R
Ensure you dedicate resources (4CPU, 16GB) to SAM and also to the EMC M&R servers.


Typically, EMC M&R deployment is divided among different virtual machines (Backend,
Frontend, Collector, and so forth). Ensure that sufficient memory and CPU are available in
the virtual machine. Otherwise the system will fail.


Port configuration between SAM and the SolutionPack for EMC Smarts
When you install the SolutionPack for EMC Smarts, you must configure the ports between
EMC M&R and the server hosting the Smarts EDAA (EMC Data Access API) to ensure
communication across the firewalls.


The default port for the Smarts EDAA is 8080 (8443 in SSL mode). However, this port can
be configured manually. If EMC M&R (with SolutionPack for EMC Smarts) and SAM are
installed on different hosts, you must open the access to the EDAA port. Additionally, the
Smarts Collector used by the SolutionPack connects to the Smarts Domain Manager
servers via the ports they are started on. You must open a range of ports, including the
Broker, in order for data to pass between the Smarts domains and EMC M&R.
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Workflow for setting up SAM
Configure the Presentation Service Assurance Manager (SAM-PRES) server to
communicate with the SolutionPack for EMC Smarts installed on the EMC M&R platform.


During SAM installation you have a choice between two SAM services:


l EMC Smarts Service Assurance Manager Server (Notification Cache Publishing)


n Start the Presentation SAM server with the EMC Smarts Service Assurance
Manager Server (Notification Cache Publishing) service if you plan to integrate
EMC M&R with this installation. When the SAM server is started with this service,
SAM communicates with both EMC M&R and Smarts analysis domains.


l EMC Smarts Service Assurance Manager Server


n Start Aggregation-level SAM servers with the EMC Smarts Service Assurance
Manager Server service in environments with hierarchical SAM configurations.


One Presentation SAM server may be configured to work with one SolutionPack for EMC
Smarts. By default, the SolutionPack for EMC Smarts connects to the Smarts Broker.
When installing or updating the SAM software, you must enable Notification Cache
Publishing so that notifications will flow into EMC M&R. Notification Cache Publishing
enables SAM to publish its notifications to the Notification Cache. The Notification Cache
is a separate collection of components, including RabbitMQ, ElasticSearch, and two
webapps running under Tomcat (Ingestion and the Alert EDAA). Services for all of these
components must be installed and running before notifications display in the EMC M&R
User Interface.


Note


Both Smarts Web Console and the SAM Tomcat Server use the same default port (8080).
If installing both on the same machine, change the port for one of them.


1. Ensure the Presentation SAM server has been upgraded to the latest version of the
Service Assurance Suite. Select these options:


l Under Core Services, select EMC Smarts Broker if you plan to run the Broker from
the Presentation SAM server. If you run the Broker from another server, make note
of the Fully Qualified Domain Name (FQDN) of the server.


l Under Service Assurance Manager Services, select EMC Smarts Service
Assurance Manager Server (notification cache publishing)


l Under EMC Data Access API, select all of the entries:


n EMC Smarts Data Web Applications (Tomcat)


n EMC Smarts Data Web Applications (Tomcat)


n EMC Smarts Notification Exchange (Rabbit MQ)


n EMC Smarts Notification Cache (ElasticSearch)


l Enter the port for the Broker service.


2. Configure your SAM license using smarts.lic or the license server.


3. Add the parameter, SM_CAS_SERVER, to the runcmd_env.sh file in the
Presentation SAM server. SM_CAS_SERVER is the URL that identifies the EMC M&R
Tomcat server host, and it has to specify the protocol and port used to log into EMC
M&R. Example: SM_CAS_SERVER=http://
smartslin03.svtdomain.us.dg.com:58080. You must use the
SM_CAS_SERVER entry to connect to the EMC M&R server.
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Note


The entries in the Reports configuration screen of the SolutionPack for EMC Smarts
must match the values in SM_CAS_SERVER. In the example above:


l Set EMC M&R tomcat hostname or IP address to
www.smartslin03.svtdomain.us.dg.com


l Ensure EMC M&R tomcat port number matches the port specified in


SM_CAS_SERVER (58080 in the example)


l If using a secure protocol (https) in the SM_CAS_SERVER URL, ensure the HTTPS
enabled is checked


l Ensure the Frontend server in the Physical Overview uses the same naming
convention (You must use the FQDN across all field entries.)


l Use the FQDN, not the IP address, for hostnames; otherwise CAS (Central
Authentication Service) will not work properly.


4. Set the SM_TOMCAT_SERVER parameter in the runcmd_env.sh file of the
Presentation SAM server to specify the Fully Qualified Domain Name (FQDN) of the
SAM Tomcat server. Example: SM_TOMCAT_SERVER=http://<hostname.com>:
8080. This SM_TOMCAT_SERVER entry must match the name and port values in the
Smarts EDAA host name or IP address and Smarts EDAA port number fields of the
Reports configuration block in the SolutionPack for EMC Smarts.


5. Start the services. (Start the Broker service before starting the Tomcat service in your
Presentation SAM installation.)


6. Issue the sm_service show command to ensure these services associated with
the Presentation SAM installation are running:


Service name Description of feature


ic-broker Broker connected to Presentation SAM server


ic-sam-server-pres SAM server with Notification Cache


smarts-tomcat Smarts EDAA (controlled by Tomcat server)


smarts-rabbitmq Rabbit MQ


smarts-elasticsearch Elastic Search


7. When connecting to domain managers running pre-9.4 versions of Service Assurance
Suite software, add two parameters that control security settings to the
runcmd_env.sh file in the Presentation SAM server:


l SM_TLS_PROTOCOLS=+TLSv1.1
l SM_ALLOW_LEGACY_CRYPTO=TRUE


Note


When upgrading from older versions of SAM to version 9.3 or higher, you must manually
register and start the SAM Notification Cache service (INCHARGE-SA-PRES). Command
syntax for registering the SAM Notification Cache service on page 353
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Command syntax for registering the SAM Notification Cache service
After an upgrade of older SAM software to version 9.3 or higher, you must register the
SAM Notification Cache service and start it manually if you intend to use the SolutionPack
for EMC Smarts to view notifications from the EMC M&R User Interface.


Register the SAM Notification Cache service


sm_service install --force  --unmanaged  --startmode=runonce '--
name=ic-sam-server-pres' '--description=EMC Smarts Service Assurance 
Manager Server (notification cache publishing)' '/opt/InCharge/SAM/
smarts/bin/sm_server' '-n' 'INCHARGE-SA-PRES' '--config=ics' '--
port=0' '--edaa=sam-presentation/2.0' '--bootstrap=bootstrap-
amqp.conf' '--ignore-restore-errors' '--output'


sm_service show --cmdline ic-sam-server-pres


Start the SAM Notification Cache service
From the SAM/smarts/bin folder, issue the command, sm_service start ic-
sam-server-pres
Check on status of running services


sm_service show
RUNNING ic-broker
RUNNING ic-sam-server-pres
NOT RUNNING ic-mbim-server
RUNNING smarts-tomcat
RUNNING smarts-rabbitmq
RUNNING smarts-elasticsearch
NOT RUNNING ic-sam-server


Smarts ElasticSearch service syntax for manual startup


smarts-elasticsearch
/opt/InCharge/SAM/smarts/bin/sm_service install --force 
--unmanaged --startmode=runonce 
--name=smarts-elasticsearch 
--description=”EMC Smarts Notification Cache (ElasticSearch)” 
/opt/InCharge/SAM/smarts/bin/sm_elasticsearch 
--ignoreme


EMC Smarts Notification Exchange (Rabbit MQ) service syntax for manual startup


/opt/InCharge/SAM/smarts/bin/sm_service install --force 
--unmanaged --startmode=runonce
--name=smarts-rabbitmq
--description=”EMC Smarts Notification Exchange (Rabbit MQ)” 
/opt/InCharge/SAM/smarts/bin/sm_rabbitmq
--ignoreme


EMC Smarts Data Web Applications (Tomcat) service syntax for manual startup


/opt/InCharge/SAM/smarts/bin/sm_service install --force --unmanaged --
startmode=runonce 
--name=smarts-tomcat' 
--description=”EMC Smarts Data Web Applications (Tomcat)”
/opt/InCharge/SAM/smarts/bin/sm_tomcat 
--ignoreme
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Server tool limitations in the EMC M&R User Interface
Only server tools available from the Presentation SAM server may be invoked from the
EMC M&R User Interface.


In a hierarchical SAM deployment, server tools that need to be executed at the Aggregate
Sam (SAM-AGG) layer will fail if they rely on communication with an underlying Smarts
domain manager. When the server tool executes a script, it will still work at the Aggregate
SAM level (for example, the LSP Ping server tool in MPLS or the Remedy Adapter).


If your server tool is not working as expected, you may need to edit the ASL scripts to
invoke the SAM-AGG layer to work around this problem.


Workflow for setting up EMC M&R


1. Install or upgrade to the latest version of EMC M&R. The EMC M&R Installation and
Configuration Guide provides more information.


2. Start the services. For example, /opt/APG/bin/manage-modules.sh service
start all


3. New installations of EMC M&R provide a 30-day trial license for all SolutionPacks.
Ensure you obtain and install permanent licenses for SolutionPacks you plan to use
longer than 30 days.


4. Install the SolutionPack for EMC Smarts.
The article, SolutionPack for EMC Smarts Summary Sheet, provides more information.


l On the Reports page of the SolutionPack installation wizard, you must enter the
Fully Qualified Domain Name (FQDN) of the EMC M&R Tomcat server. This address
must match the entry in the SM_CAS_SERVER parameter setting in the
runcmd_env.sh file in the Presentation SAM server.


Note


Use the FQDN, not an IP address, when configuring the SolutionPack for EMC
Smarts.


l Enter the FQDN for the server hosting the Smarts EDAA.


l Accept the default values for the other fields unless your deployment has a non-
default SAM setup. For example,


n SAM Presentation server is not named INCHARGE-SA-PRES
n SAM server is using SSL


n The admin-profile in SAM has changed


l On the Reports page of the SolutionPack installation wizard, enter the Smarts
Configuration Manager domain name if you plan to manage settings for your IP
domains from the EMC M&R interface.


After installation of the SolutionPack for EMC Smarts, configure IP settings in the
Configuration Manager and push them to the remote IP domain managers. Access the
IP settings from Administration > Modules > Smarts. Additional information is
provided in this article:


l How to Maintain IP Manager Settings
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5. Create user accounts for operators in EMC M&R. The Administrator must also create
new Roles for these users and map them to existing profiles in Service Assurance
Manager (SAM).


6. Hide the ViPR SRM-related report nodes in the navigation tree if you do not plan to
install ViPR SRM. (The Smarts-related nodes are under Network in the tree.)


7. Run manual Topology import from Administration > Centralized Management >
Scheduled Tasks > Topology. Click sm-collector/import-smarts-topology and click
Run.
By default the task runs every day at midnight.


User management for SolutionPack for EMC Smarts
In order to manage notifications from the SolutionPack for EMC Smarts, the Administrator
must set up users and roles in EMC M&R that correspond to the profiles set up in Service
Assurance Manager (SAM).


In the SAM Global Manager Administration Console, the Administrator configures profiles
that define which Notifications, Actions, and Tools are available to each group of users
(for example, OPER profile and so forth).


The Administrator providing access to SolutionPack for EMC Smarts views has to create
users and roles in EMC M&R that reflect the characteristics of the SAM profiles that are in
use.


If Administrators need to restrict Notifications, Actions, or Tools available to a user in
EMC M&R, they need to define the restrictions first in the corresponding SAM profile.


Note


The Administrator should not duplicate EMC M&R users in SAM unless a user needs
access to both the SolutionPack for EMC Smarts views and classic SAM Consoles. Users
working only in EMC M&R need only the user login and role definition created in EMC
M&R.


Set role restrictions for non-administrator users of SolutionPack for Smarts
If you want additional user roles, such as oper (operator), or profiles configured in your
Presentation SAM server, you must set role restrictions after installing the SolutionPack
for Smarts.


The default role is assigned to administrator. Add additional roles as needed.


Procedure


1. From Administration > Roles, click New Role.


2. Click Modules & Restrictions Access and expand the Smarts module.


3. Add an existing smarts profile (such as oper-profile or default-profile) and
click Save.


4. From Administration > Users, create a new user and assign them the role.


SAM user profile mapping and EMC M&R role-based access


After you set up the user profiles and assign them to roles in EMC M&R, the administrator
must associate those profiles and roles with users who need to access both Service
Assurance Manager (SAM) Consoles and the EMC M&R User Interface.


Administrator profile behavior
The EMC M&R administrator role is mapped to the EMC Smarts Admin profile when the
SolutionPack for EMC Smarts is installed.
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Note


If you try to assign a SAM profile to the EMC M&R Admin user, that SAM profile will be
overwritten with the EMC M&R profile.


User profile behavior
The administrator can assign a SAM profile to an EMC M&R non-administrator user from
Administration > Modules & Restrictions Access > Smarts.


l Ensure you assign an existing SAM Profile to the user, (for example, oper-profile,
default-profile, and so forth)


l Do not assign more than one Role with a SAM Profile to a user.


Hide unused entries in the navigation tree
You can hide default entries in the navigation tree if you have not installed the products
that populate them with data.


Before you begin


The default EMC M&R platform displays nodes such as Operations, Explore, Dashboards,
and Planning in the navigation tree. Other product suites that also use EMC M&R as their
platform display entries under these nodes by default. However, no data populates these
entries unless you are using those products. The SolutionPack for EMC Smarts populates
data in the Network block under Operations, Explore, and Dashboards.


Procedure


1. To hide entries in the navigation tree, click Edit Mode from the EMC M&R User
Interface.


2. Find the storage-related blocks in the list and select, Always Hide.


Do not hide the Network block under the Operations, Explore, or Dashboards nodes.
The Network block contains all of the SolutionPack for EMC Smarts views and reports.
The Planning node is not used by the SolutionPack for EMC Smarts.


Viewing notifications from the EMC M&R User Interface
Launch Object Details from the Notifications view.


Before you begin


You can view notifications coming from the Presentation SAM server in the EMC M&R User
Interface.


Procedure


1. To view Notifications where an element name is collected, launch the Object Details
report with map, details, containment, and so forth.


2. To view Notifications with an element name that is not collected by the SolutionPack
for EMC Smarts, launch only the Details view.


The SolutionPack for EMC Smarts does not collect every class and instance that exists
in the Smarts domains. It selects "top level" classes like Routers, Switch and some of
their underlying components.
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Troubleshooting an empty notification list
After creating a new Notification List in Service Assurance Manager, the notifications are
not visible in the EMC M&R User Interface.


When you create a new Notification List in Service Assurance Manager, you must issue
this command to have notifications populate the correct reports in EMC M&R. This
command ensures notifications are re-cached so they display in the correct Notification
List.


Issue this command from the Presentation Service Assurance Manager <install_directory>
\SAM\smarts\bin folder: dmctl> invoke ICS_NLManager::ICS-NLManager
renotifyAllEvents


Creating client tools
Client tools are programs the operator invokes by right-clicking on a notification.


The default client tool, Launch EMC M&R, launches the EMC M&R home page. You can
create others by editing the SmartsTools.json file.


Note


You cannot call other scripts using client tools.


Procedure


1. To create client tools, log in to Centralized Management and expand Logical Overview
> Miscellaneous > Custom.


2. Click Webapps-Resources::Default and expand the list of Configuration files.


3. Select the checkbox for /conf/SmartsTools.json and click the pencil icon to
edit the file.


Use this file to add or modify options that appear in the Notifications Client Tools
right-click menu. You can edit the tool to launch any URI and pass in any notification
property as a parameter by surrounding it with brackets.


You must encode & characters as %26.


Column headers which are available in Notifications can be passed as arguments to
the URI. The various notification properties that can be used are Acknowledged,
Active, Category, Certainty, ClassName, ClassDisplayName, ClearOnAcknowledge,
ElementClassName, ElementName, EventText, EventName, EventState,EventType,
EventDisplayName, FirstNotifiedAt, Impact, InstanceName, IsProblem, IsRoot,
InMaintenance, LastClearedAt, LastNotifiedAt, LastChangedAt, Name, NotificationID,
OccurrenceCount, Owner, Severity, SourceDomainName, SourceEventType,
TroubleTicketID, UserDefined 1 to 20.


Example client tool:


{
         "name": "Example 1",
         "url": " http://www.emc.com/?class={ClassName}
%26source={SourceDomainName}"
        },
       


In this example, "name":"Example 1" is the name which appears on the sub-
menu for the right click action on the notification. This causes the text, "Example 1" to
display. When you right-click on a Notification, you will see Client Tools > Example 1.
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In this example, "url": " http: //www.emc.com/?class={ClassName}
%26source={SourceDomainName}" provides the URL to which a notification
attribute can be appended as a parameter. In this example, ClassName and
SourceDomainName are used. When invoked, this tool would launch, http://
www.emc.com/?class=Host&source=INCHARGE-AM-PM.


Additional files that may be used when creating client tools include conf/
common.properties and mib-browser/mib-browser.xml.


Enrich device location data in Smarts geographical maps
The Smarts geographical map (geomap) shows the location of Smarts-enabled devices in
the network. Before viewing Smarts geomaps, perform data enrichment of the device
locations to provide more details in the map.


Before you begin


Ensure device discovery has finished and devices display in the user interface before
enriching the location data. Look in the Explore > Network tree to view the discovered
devices. The Location attribute of the device object in Smarts IP Manager populates the
Device Location dropdown after discovery.


The APG-Centralized-Management-Guide, found in the /APG/Doc folder in your EMC M&R
installation, provides additional information.


Procedure


1. Register the Collector Manager module with the hostname of the EMC M&R
installation.


a. From Centralized Management > Data Enrichment, click Register for New Module.


b. Click <hostname> in the first column.


c. Click Collecting in the second column.


d. Click Collector Manager :: emc-smarts :: DataEnrichment in the third column.


Do not select any other modules from the list. They are not required for geomaps.


2. Select Collector Manager :: emc-smarts :: DataEnrichment and click geo-map-
enrichment.


The DataEnrichment property is used to enrich the values in Device Location to match
meaningful values in the smlocale column.


a. Find the columns for Device Location and smlocale.


By default the first row displays @MATCHALL for Device Location and @NULL for
smlocale.


b. Replace the default values with meaningful names, for example, *white, in Device
Location can map to White Plains, New York for the smlocale value.


Enter a valid smlocale name which will be identifiable on the geomap.


The Device Location dropdown menu displays accurate data only after device
discovery has finished. For example, typing ‘W’ displays all locations having
names with ‘W’. Typing * displays all locations.


c. Save the changes.


d. Click Update in the Save Data Enrichment window.


All values in the dropdown windows must be enriched to get all locations in the
geomap.
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To add a new row for enrichment, right-click the icon appearing in front of the row.
This gives options to Insert Before, Insert After, or Delete a row.


3. Restart the Database and Backend.


a. Go to Centralized Management > Scheduled Tasks.


b. Click Select All.


c. Uncheck the Update Online option.


d. Click Run now to restart the Database and Backend.


4. Restart the EMC M&R services.


This restarts the Collector Manager.


After some time, the Smarts Geography geomap will be uploaded to Dashboard >
Network > EMC Smarts Geography. Click the icons on the map to view devices present
at that location.


Alternate method of data enrichment using file import
Use the Import/Export function in the UI to import CSV or XLS files with Device Location
and smlocale mapping as an alternative method of enriching Smarts geomap data.


The XLS or CSV files must have two columns of values in the same order as the columns
mentioned in data enrichment. Here is an example:


Table 13 Sample data enrichment import file column layout


Device Location column data smlocale column data


white* White Plains, NY


10;PUGET SOUND;United States;REDMOND, WA;11 Redmond, Washington


*Westchester Ave* White Plains, NY


LOCATION Bangalore, India


EMC E-Labs Building 119 Bangalore, India


*Hopkinton* Hopkinton, MA


DevLab, row 2-rack 2, 44 S Broadway, 7th floor Bangalore, India


10.3.2 Delhi, India


Chicago, IL Chicago, IL


Although the value, <city>, is enough for smlocale to render points in the map, enter <city,
state> or <city,country> to avoid duplicates or conflicts. Ensure the location name is valid
because it will display in the maps report.


Map reports
A map report is basically a standard table report where each child node displays as a
point in a geographical map. You can edit the location and the name of the location as
well as the size, color, and shape of marker displayed on the map.


In Report Type on the Report Configuration tab, you select the map report from the
miscellaneous section.


You can edit the following attributes on a map report:
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l Location locates an element on the map.


l Name provides a name to a location, such as device name, region, and sitename.


l Size sets the size of the marker. The size of the marker is based on a given metric
value, such as the number of devices at the site.


l Color sets the color of the marker. The color relies on the threshold definition where
green represents no thresholds, yellow represents a major threshold, and red
represents a critical threshold.


l Marker sets the shape of the marker, such as circle, square, triangle, inverted
triangle, pentagon, and sector.


Switch between OpenStreetMap and Google Maps
OpenStreetMap is used as the default platform mapping software. Use this procedure to
configure EMC M&R to use other mapping software, such as Google Maps.


Procedure


1. To switch from OpenStreetMaps (osm) to Google Maps (google), navigate to APG/
Web-Applications/APGFrontend/APG/conf/common.properties.


a. Add these lines to common.properties:


#=========================================================
Setting for Google Maps (client-side)
#========================================================= 
apg.maps.geocode=false
apg.maps.provider=google
apg.maps.geocoder=google


b. Restart all managed module services including tomcat.


2. To switch back to OpenStreetMaps from Google Maps


a. Comment the lines of code you added to common.properties file to disable
them.


b. Restart all managed module services including tomcat.


SSL setup for SAM and EMC M&R
Adjust the port and protocol settings when enabling SSL encryption in SAM and EMC
M&R.


The procedures for SSL setup assume use of the Java Keytool. You may, optionally, use a
different encryption tool.


This keytool generates keystore files in the location where the commands are issued. For
these SSL procedures, the following assumptions are made:


1. When configuring EMC M&R (Watch4net) with CLI commands, issue the commands
from the bin folder of the installation path. For example, /opt/APG/bin or from c:
\Program Files\APG\bin.


2. When configuring Service Assurance Manager (SAM) with CLI commands, issue the
commands from the base directory path. For example, /opt/InCharge/SAM/
smarts or from c:\Program Files\InCharge\SAM\smarts.


3. Both EMC M&R and SAM installations include versions of Java. Check to ensure the
correct versions of Java are in use in both the EMC M&R server and in the SAM server.
Java is usually installed into the ...usr/bin path. (The versions may differ
between EMC M&R and SAM.)
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Workflow


1. Edit the Reports configuration settings in the SolutionPack for EMC Smarts to adjust
port and protocol settings.


2. Generate the SSL certificate for the EMC M&R (Watch4net) server where the Tomcat
server is running. The Java documentation provides details.


3. Generate the SSL certificate for the Service Assurance Manager (SAM) server where
the Tomcat server is running. The Java documentation provides details.


4. Ensure the configuration settings have been adjusted for SSL. For example, check the
SM_CAS_SERVER and SM_TOMCAT_SERVER settings in the runcmd_env.sh file in
SAM and edit the settings to add the secure port numbers and change the protocol
from http to https. (When you change runcmd_env.sh, you must stop and restart
the SAM service. For example, sm_service stop|start ic-sam-server-
pres)


5. Enable the https protocol in the server.xml files in both the SAM and EMC M&R
deployments. Add the Http11Protocol and Http11NioProtocol sections if
missing from the server.xml file.


6. Export the EMC M&R certificate and import to the SAM server.


7. Export the SAM certificate and import to the EMC M&R server.


8. Stop and start the SAM Tomcat server.


9. Restart the EMC M&R Tomcat server.


Linux SSL Setup


Enable SSL port and protocol settings in SolutionPack for EMC Smarts
When enabling SSL, you must edit the Reports configuration of the SolutionPack for EMC
Smarts and ensure use of secure port and protocol settings.


Before you begin


This procedure assumes the SolutionPack for EMC Smarts is already installed and
running. If not, the SolutionPack for EMC Smarts Summary Sheet article provides
installation instructions.


Edit the Reports configuration page to enable SSL for the SolutionPack for EMC Smarts.
Access this page from Centralized Management. Expand SolutionPacks > Infrastructure
and click EMC Smarts.


Procedure


1. Click the Pencil icon by the Reports SolutionPackBlock.


The Reports reconfiguration page appears.


2. Expand Tomcat Configuration and choose Add a new Tomcat configuration in the
dropdown box.


3. Click the checkbox for HTTPS Enabled for EMC M&R and Smarts.


4. Enter the Fully Qualified Domain Name or IP address of the EMC M&R Tomcat server.


This name must match the host name portion of the entry in SM_CAS_SERVER in the
Presentation SAM runcmd_env.sh file. Ensure consistent use of either IP address or
FQDN in all of the field entries. Do not mix the entry formats.


5. Enter the secure port for the EMC M&R Tomcat server. (Default SSL port is 58443).
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6. Expand the Smarts and Alerts EDAA Configuration and choose Add a new Smarts and
Alerts EDAA Configuration in the dropdown box.


Check the entry in the Smarts EDAA hostname or IP address field. This entry must
match the host name portion of the entry in SM_TOMCAT_SERVER in the Presentation
SAM runcmd_env.sh file.


7. Enter the secure port for the Smarts EDAA server. (Default SSL port is 8443).


8. Adjust other entries if needed and then click Reconfigure.


After you finish


Continue with the SSL certificate generation, import, and export steps. The changes will
not take effect until the Tomcat servers are restarted in both SAM and EMC M&R.


Linux: Generate the keystore file for EMC M&R
Create the keystore file for the EMC M&R host. This file stores the tomcat server's private
key and self-signed certificate.


Before you begin


Stop the EMC M&R Tomcat service. For example, opt/APG/bin/manage-
modules.sh service stop tomcat
Procedure


1. Generate the keystore: /opt/APG/Java/Sun-JRE/7.0u51/bin/keytool -
genkey -alias tomcat -keyalg RSA -keystore /opt/
APG/.keystore
a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type, yes, when asked for confirmation.


Results


This creates a keystore file inside /opt/APG folder with name .keystore. This is a
hidden file in Linux.


Linux: Editing the EMC M&R server.xml file
Edit the server.xml file to tell Tomcat server which secure port to use.


Update the https connector configuration in server.xml in this path, /opt/APG/
Web-Servers/Tomcat/Default/conf.


Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file. For example,


 <Connector port="58443" protocol="HTTP/1.1" SSLEnabled="true"
               maxThreads="150" scheme="https" secure="true"
               compression="2048" compressableMimeType="text/"
               clientAuth="false" sslProtocol="TLS" 
URIEncoding="UTF-8"
        keystoreFile="/opt/APG/.keystore" keystorePass="changeit"
               SSLDisableCompression="true" />
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Configuring SAM environment variables to support SSL
Edit the environment variables in the SAM runcmd_env.sh file to support SSL.


Before you begin


Both SM_CAS_SERVER and SM_TOMCAT_SERVER must be configured to support SSL. The
SM_CAS_SERVER environment variable is set to the URL for EMC M&R. The
SM_TOMCAT_SERVER environment variable is set to the URL for the SAM Tomcat server.


Procedure


1. Enter the secure port and protocol used to log into EMC M&R in the SM_CAS_SERVER
variable. For example, SM_CAS_SERVER=https://<cas-serverhost>:58443


2. Enter the secure port and protocol used to log into SAM Tomcat server in the
SM_TOMCAT_SERVER variable. For example, SM_TOMCAT_SERVER=https://
<smarts-tomcat-server-host>:8443


After you finish


Stop and restart the SAM service to make the changes take effect. For example:


sm_service stop ic-sam-server-pres


sm_service start ic-sam-server-pres


Linux: Generating the SAM Tomcat server keystore file and certificate
Create the Tomcat server keystore file and certificate.


Before you begin


Generate the keystore file in the home directory where you issue the command.


Procedure


1. Issue the command to generate the keystore file. For example, usr/bin/keytool
-genkey -alias tomcat -keyalg RSA
To specify a different location or filename, add the -keystore parameter followed
by the complete pathname to the keystore file. For example, $JAVA_HOME/bin/
keytool -genkey -alias tomcat -keyalg RSA -keystore /opt/
InCharge/SAM/smarts/.keystore
a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type, yes, when asked for confirmation.


Results


This creates a keystore file inside /opt/InCharge/SAM/smarts folder with
name .keystore.


Linux: Editing the SAM server.xml file
Edit the server.xml file to tell the SAM Tomcat server which secure port and protocol to
use.


Update the https connector configuration in server.xml in this path, /opt/
InCharge/SAM/smarts/tomcat/conf.
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Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file and the password. For example,


 <Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
             maxThreads="150" scheme="https" secure="true"
              keystoreFile="/opt/InCharge/SAM/smarts/.keystore" 
keystorePass="changeit"
              clientAuth="false" sslProtocol="TLS" />


3. Configure the Connector protocols in server.xml as follows. (Copy in this code if it is
missing.)


 <Connector protocol="org.apache.coyote.http11.Http11Protocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile="/opt/InCharge/SAM/smarts/.keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


<Connector protocol="org.apache.coyote.http11.Http11NioProtocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile="/opt/InCharge/SAM/smarts/.keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


Linux: Creating the trust relationship between SAM and EMC M&R
You must export and import certificates to get the SAM Tomcat server and EMC M&R
Tomcat server to trust each other.


Before you begin


First, export a certificate on the SAM server. Then import it into the EMC M&R Tomcat
server. Then export a certificate from the EMC M&R server and import it into the SAM
Tomcat server.


Procedure


1. Export a certificate from the SAM Tomcat server. For example,


$JAVA_HOME/bin/keytool -export -keystore /opt/InCharge/SAM/
smarts/.keystore -alias tomcat -rfc > SAMtomcat.cert


a. Copy SAMtomcat.cert to the host where EMC M&R Tomcat server is installed.


b. On the EMC M&R host, import the SAMtomcat.cert. For example,


$JAVA_HOME/bin/keytool -import -file SAMtomcat.cert -alias 
SAMtomcat -keystore /opt/APG/.keystore


c. Back up the original EMC M&R cacerts file.


cp /opt/APG/Java/Sun-JRE/7.0u51/lib/security/cacerts /opt/APG/
Java/Sun-JRE/7.0u51/lib/security/cacerts-SAVE    # Backup old 
cacerts file


d. Copy .keystore and rename it to cacerts.


cp /opt/APG/.keystore /opt/APG/Java/Sun-JRE/7.0u51/lib/security/
cacerts
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2. Restart Tomcat server on the EMC M&R host.


/opt/APG/bin/manage-modules.sh service restart tomcat
3. Export a certificate from the EMC M&R host. For example,


•    $JAVA_HOME/bin/keytool -export -keystore /opt/APG/.keystore -
alias tomcat -rfc > W4Ntomcat.cert


4. Copy W4ntomcat.cert to the SAM server host.


5. On the SAM server host, run this command to import a certificate copied from the EMC
M&R server host.


$JAVA_HOME/bin/keytool -import -file W4Ntomcat.cert -alias 
W4Ntomcat -keystore /opt/InCharge/SAM/smarts/.keystore


6. Copy the keystore file.


cp /opt/InCharge/SAM/smarts/jre/lib/security/cacerts /opt/
InCharge/SAM/smarts/jre/lib/security/cacerts-SAVE    # Backup old 
cacerts file


cp /opt/InCharge/SAM/smarts/.keystore /opt/InCharge/SAM/
smarts/jre/lib/security/cacerts


7. Confirm the certificates copied properly (review entries).


For SAM


/usr/bin/keytool -list -keystore /opt/InCharge/SAM/smarts/.keystore


For EMC M&R


/usr/bin/keytool -list -keystore /opt/APG/.keystore
8. Stop and start the Tomcat service on the SAM server:


a. /opt/InCharge/SAM/smarts/bin/sm_service stop smarts-tomcat
b. /opt/InCharge/SAM/smarts/bin/sm_service start smarts-


tomcat
9. Restart the EMC M&R services.


/opt/APG/bin/manage-modules.sh service restart all


Windows SSL Setup


Enable SSL port and protocol settings in SolutionPack for EMC Smarts
When enabling SSL, you must edit the Reports configuration of the SolutionPack for EMC
Smarts and ensure use of secure port and protocol settings.


Before you begin


This procedure assumes the SolutionPack for EMC Smarts is already installed and
running. If not, the SolutionPack for EMC Smarts Summary Sheet article provides
installation instructions.


Edit the Reports configuration page to enable SSL for the SolutionPack for EMC Smarts.
Access this page from Centralized Management. Expand SolutionPacks > Infrastructure
and click EMC Smarts.
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Procedure


1. Click the Pencil icon by the Reports SolutionPackBlock.


The Reports reconfiguration page appears.


2. Expand Tomcat Configuration and choose Add a new Tomcat configuration in the
dropdown box.


3. Click the checkbox for HTTPS Enabled for EMC M&R and Smarts.


4. Enter the Fully Qualified Domain Name or IP address of the EMC M&R Tomcat server.


This name must match the host name portion of the entry in SM_CAS_SERVER in the
Presentation SAM runcmd_env.sh file. Ensure consistent use of either IP address or
FQDN in all of the field entries. Do not mix the entry formats.


5. Enter the secure port for the EMC M&R Tomcat server. (Default SSL port is 58443).


6. Expand the Smarts and Alerts EDAA Configuration and choose Add a new Smarts and
Alerts EDAA Configuration in the dropdown box.


Check the entry in the Smarts EDAA hostname or IP address field. This entry must
match the host name portion of the entry in SM_TOMCAT_SERVER in the Presentation
SAM runcmd_env.sh file.


7. Enter the secure port for the Smarts EDAA server. (Default SSL port is 8443).


8. Adjust other entries if needed and then click Reconfigure.


After you finish


Continue with the SSL certificate generation, import, and export steps. The changes will
not take effect until the Tomcat servers are restarted in both SAM and EMC M&R.


Windows: Generate the keystore file for EMC M&R
Create the keystore file for the EMC M&R host. This file stores the tomcat server's private
key and self-signed certificate.


Before you begin


Stop the EMC M&R Tomcat service. For example, c:\Program Files\APG\bin
\manage-modules.cmd service stop tomcat
Procedure


1. Generate the keystore: C:\Program Files\Java\
jdk1.7.0_07\keytool.exe -genkey -alias tomcat -keyalg RSA -
keystore C:\Program Files\APG\.keystore
a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type, yes, when asked for confirmation.


Results


This creates a keystore file inside C:\Program Files\APG folder with
name .keystore.
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Windows: Editing the EMC M&R server.xml file
Edit the server.xml file to tell Tomcat server which secure port to use.


Update the https connector configuration in server.xml in this path, c:\Program
Files\APG\Web-Servers\tomcat\Default\conf.


Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file. For example,


 <Connector port="58443" protocol="HTTP/1.1" SSLEnabled="true"
               maxThreads="150" scheme="https" secure="true"
               compression="2048" compressableMimeType="text/"
               clientAuth="false" sslProtocol="TLS" 
URIEncoding="UTF-8"
        keystoreFile="C:\Program Files\APG\.keystore" 
keystorePass="changeit"
               SSLDisableCompression="true" />


Configuring SAM environment variables to support SSL
Edit the environment variables in the SAM runcmd_env.sh file to support SSL.


Before you begin


Both SM_CAS_SERVER and SM_TOMCAT_SERVER must be configured to support SSL. The
SM_CAS_SERVER environment variable is set to the URL for EMC M&R. The
SM_TOMCAT_SERVER environment variable is set to the URL for the SAM Tomcat server.


Procedure


1. Enter the secure port and protocol used to log into EMC M&R in the SM_CAS_SERVER
variable. For example, SM_CAS_SERVER=https://<cas-serverhost>:58443


2. Enter the secure port and protocol used to log into SAM Tomcat server in the
SM_TOMCAT_SERVER variable. For example, SM_TOMCAT_SERVER=https://
<smarts-tomcat-server-host>:8443


After you finish


Stop and restart the SAM service to make the changes take effect. For example:


sm_service stop ic-sam-server-pres


sm_service start ic-sam-server-pres


Windows: Generating the SAM Tomcat server keystore file and certificate
Create the Tomcat server keystore file and certificate.


Before you begin


Generate the keystore file in the home directory where you issue the command.


Procedure


1. Issue the command to generate the keystore file. For example, $JAVA_HOME\bin
\keytool -genkey -alias tomcat -keyalg RSA
To specify a different location or filename, add the -keystore parameter followed
by the complete pathname to the keystore file. For example, C:\Program Files


How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts


Windows: Editing the EMC M&R server.xml file     367







\Java\jdk1.7.0_07\bin\keytool.exe" -genkey -alias tomcat -
keyalg RSA -keystore C:\InCharge\SAM\smarts\.keystore
a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type, yes, when asked for confirmation.


Results


This creates a keystore file inside C:\InCharge\SAM\smarts\keystore folder with
name .keystore.


Windows: Editing the SAM server.xml file
Edit the server.xml file to tell the SAM Tomcat server which secure port and protocol to
use.


Update the https connector configuration in server.xml in this path, c:\InCharge
\SAM\smarts\tomcat\conf.


Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file and the password. For example,


 <Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
             maxThreads="150" scheme="https" secure="true"
              keystoreFile="C:\InCharge\SAM\smarts\keystore" 
keystorePass="changeit"
              clientAuth="false" sslProtocol="TLS" />


3. Configure the Connector protocols in server.xml as follows. (Copy in this code if it is
missing.)


 <Connector protocol="org.apache.coyote.http11.Http11Protocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile="C:\InCharge\SAM\smarts\keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


<Connector protocol="org.apache.coyote.http11.Http11NioProtocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile=”C:\InCharge\SAM\smarts\keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


Windows: Creating the trust relationship between SAM and EMC M&R
You must export and import certificates to get the SAM Tomcat server and EMC M&R
Tomcat server to trust each other.


Before you begin


First, export a certificate on the SAM server. Then import it into the EMC M&R Tomcat
server. Then export a certificate from the EMC M&R server and import it into the SAM
Tomcat server.
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Procedure


1. Export a certificate from the SAM Tomcat server. For example,


"c:\Program Files\Java\jdk1.7.0_07\bin\keytool.exe" -export –
keystore C:\InCharge\SAM\smarts\keystore -alias tomcat -rfc >  C:
\InCharge\SAM\smarts\SAMtomcat.cert


a. Copy SAMtomcat.cert to the host where EMC M&R Tomcat server is installed.


b. Import the SAMtomcat.cert into the EMC M&R host. (Copy the files manually using
Windows Explorere and CTRL+C and CTRL+V commands.) For example,


c:\Program Files\APG>"C:\Program Files\Java\jdk1.7.0_07\bin
\keytool.exe" –import -file "c:\Program Files\APG\ 
SAMtomcat.cert" -alias SAMtomcat -keystore "C:\Program Files\APG
\.keystore


c. Back up the original cacerts file before this next step.


c:\Program Files\APG>"C:\Program Files\Java\jdk1.7.0_07\bin
\keytool.exe" –import -file "c:\Program Files\APG\ 
SAMtomcat.cert" -alias SAMtomcat -keystore "C:\Program Files\APG
\.keystore


Rename file C:\Program Files\APG\Java\Sun-JRE\7.0u51\lib
\security\cacerts to C:\Program Files\APG\Java\Sun-JRE
\7.0u51\lib\security\cacerts-SAVE    # Backup old cacerts file


d. Copy .keystore located at c:\Program Files\APG\.keystore to this
location, C:\Program Files\APG\Java\Sun-JRE\7.0u51\lib
\security, and rename it to cacerts


2. Restart Tomcat server on the EMC M&R host.


/opt/APG/bin/manage-modules.sh service restart tomcat
3. Export a certificate from the EMC M&R host. For example,


o    c:\Program Files\APG>"C:\Program Files\Java\jdk1.7.0_07\bin
\keytool.exe" –export  -keystore "C:\Program Files\APG\.keystore" -
alias tomcat -rfc > "C:\Program Files\APG\W4Ntomcat.cert"


a. Copy W4ntomcat.cert to the SAM server host.


b. On the SAM server host, run these commands to import a certificate copied from
the EMC M&R server host. (Copy the files manually using Windows Explorere and
CTRL+C and CTRL+V commands.)


"C:\Program Files\Java\jdk1.7.0_07\bin\keytool.exe" -import –
file C:\InCharge\SAM\smarts\ W4Ntomcat.cert -alias W4Ntomcat –
keystore C:\InCharge\SAM\smarts\keystore


c. Back up the original cacerts file before this next step. Rename the cacerts file
located at C:\InCharge\SAM\smarts\jre\lib\security\cacerts to
C:\InCharge\SAM\smarts\jre\lib\security\cacerts-SAVE #
Backup old cacerts file


d. Copy the keystore file from C:\InCharge\SAM\smarts\keystore and
rename it to cacerts at this location C:\InCharge\SAM\smarts\jre\lib
\security\cacerts


4. Stop and start the Tomcat service on the SAM server:
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a. c:\Program Files\InCharge\SAM\smarts\bin\sm_service stop
smarts-tomcat


b. c:\Program Files\InCharge\SAM\smarts\bin\sm_service start
smarts-tomcat


5. Restart the EMC M&R services.


c:\Program Files\APG\bin\manage-modules.sh service restart all
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Overview
Use this article to help you find solutions to issues you may have with SAM, the EMC M&R
platform, and the SolutionPack for Smarts.


Log files
Log files help you diagnose issues that you may have with SAM, the EMC M&R platform,
and the SolutionPack for EMC Smarts.


SAM log files
The SAM log file names may differ depending on the domain name. You can find these
log files in SAM/smarts/local/logs.


brstart_en_US_UTF-8.log
Created by the Smarts broker.


emc-alerts-es.log
Created by the elasticsearch service. The Notifications cache uses elasticsearch to
store and index its notifications to be served by the Alerts EDAA.


INCHARGE-SA-PRES.audit
The SAM audit log.


INCHARGE-SA-PRES_en_US_UTF-8.log
The SAM server log. In this case, the log's name represents the INCHARGE-SA-PRES
domain.


rabbit@<HOSTNAME>.log
Created by the RabbitMQ service. The Notification cache uses the RabbitMQ service
to transfer notifications from SAM to the Notification cache. This log file name
depends on the host name of the SAM installation.


setup_elasticsearch.log
Created the first time you run the elasticsearch service. This service must be primed
the first time it is run, and this log records the setup results.


setup_rabbitmq.log
Created the first time that you run the RabbitMQ service. This service must be primed
the first time it is run, and this log records the setup results.


sm_serviced_en_US_UTF-8.log
Created by the sm_serviced daemon process that is responsible for running the
registered Smarts services.


Tomcat log files
These log files are generated by Tomcat and any web applications running within Tomcat.
You can find these log files in SAM/smarts/local/logs/tomcat.


alerts-edaa.log
Created by the Alerts EDAA web application. This web application exposes
notifications in the Notification cache.


alerts-ingestion.log
Created by the alerts-ingestion web application. This web application populates
notifications in to the Notification cache that come from SAM via RabbitMQ.


catalina.<date>.log
The Tomcat engine writes log messages pertaining to Tomcat.
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catalina.out
Logs the code output running under Tomcat. This output is also written to
System.out or System.err.


localhost.<date>.log
Logs information about the virtual host within Tomcat. Always check this log if you
cannot find an error in catalina.out or if something is seriously wrong.


localhost_access_log.<date>.txt
Logs the calls being made to the Tomcat server.


smarts-edaa.log
Created by the smarts-edaa web application. This web application exposes the
topology from one or more domain managers in a RESTful feed.


Status checks on services
You can verify that the services are running and performing their required tasks.


Perform status checks on services by following these procedures:


l Checking elasticsearch on page 373


l Checking the notifications exchange on page 374


l Checking the RabbitMQ configuration on page 374


l Checking Alerts EDAA on page 375


l Checking Smarts EDAA on page 375


Checking elasticsearch
The elasticsearch service, a component of the Notifications cache, is only accessible from
the local machine. Verify this service is running and serving requests.


Procedure


1. Verify elasticsearch is running by typing $ smarts/bin/sm_service show.


The expected result is: RUNNING smarts-elasticsearch


2. Verify elasticsearch is serving requests from a browser on the same machine on
Windows or using a tool like curl on Linux.


Browser example:


http://localhost:9200/_status


A page specific to the browser appears.


Linux examples:


curl -XGET http://localhost:9200/_status
curl http://localhost:9200/smarts/alert/_count


A JSON page appears indicating success and showing Smarts as one of the indices.
For example:


"_shards":{"total":10,"successful":5,"failed":0}
.
.
.
"indices":{"smarts":...
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3. If the Smarts index does not exist, the setup script has failed. Check the
setup_elasticsearch.log file. Note that after you first start elasticsearch, it
may take a few minutes before the setup script begins running.


Checking the notifications exchange
The RabbitMQ service exchanges notifications from SAM to the Notification cache. This
service is running by default and is a password-protected web-based management
interface running on port 15672.


Procedure


1. Verify RabbitMQ is running: http://<HOSTNAME>:15672/
2. Type the credentials for the RabbitMQ interface. The default values are admin for the


user and changeme for the password.


The main page shows various statistics and status information for RabbitMQ.


Checking the RabbitMQ configuration
Follow these steps to check if the RabbitMQ service was properly configured.


When you start the sm_rabbitmq script, it verifies the RabbitMQ configuration and
creates the required exchanges, queues, users, and priming message in qnameq if they
do not exist. If this script fails, check the local/logs/setup_rabbitmq.log file.


Procedure


1. Log in to the RabbitMQ interface: http://<HOSTNAME>:15672/
2. Type the credentials for the RabbitMQ interface. The default values are admin for the


user and changeme for the password.


3. Verify these exchanges are under the Exchanges tab:


l emc.smarts.notifications (of type topic)


l emc.smarts.notifications.ingestion (of type x-consistent-hash)


4. Verify these queues are under the Queues tab:


l emc.smarts.notifications.q1, the main queue for holding notifications
for ingestion


l emc.smarts.notifications.qnameq
If a high number of messages appear under emc.smarts.notifications.q1,
ingestion is either backlogged or has stopped.


One message should appear under emc.smarts.notifications.qnameq.


5. Verify these users are defined under the Admin tab, and have access to the
emc.smarts.notifications vhost:


l admin (with the administrator tag)


l ingestion


l publisher
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Checking Tomcat
Verify Tomcat is running and serving requests.


Procedure


1. Verify Tomcat is running by typing $ bin/sm_service show.


The expected result is: RUNNING smarts-tomcat


2. Verify Tomcat is serving requests from a browser: http://<HOSTNAME>:8080/


A welcome page for Tomcat Version 8.x appears.


Checking Alerts EDAA
Verify the Alerts EDAA, a component of the Notification cache, is running and connected
to elasticsearch.


Procedure


1. Verify Tomcat is running, as described in Checking Tomcat on page 375.


2. Verify alerts_edaa is running.


For example:


http://itops-qa-192.lss.emc.com:8080/alerts-edaa/msa?
alt=json&pretty=true


3. Make sure there is an entry for alerts on the page.


4. Check that the cache is connected to the elasticsearch service and has the expected
notifications.


For example:


http://itops-qa-192.lss.emc.com:8080/alerts-edaa/msa/alerts/
instances?alt=json&pretty=true


Checking Smarts EDAA
Verify the Smarts EDAA is running, connected to the broker and is able to retrieve
information from your presentation SAM.


Procedure


1. Verify Tomcat is running, as described in Checking Tomcat on page 375.


2. Verify smarts-edaa is running.


For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa?
alt=json&pretty=true


3. Make sure there are entries for the dmbroker and the presentation SAM.


4. Verify smarts-edaa is connected to the broker.


For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa/
dmbroker/types/DomainManager/instances?alt=json&pretty=true


5. Make sure there are entries for the various domains registered with the broker.


6. Verify smarts-edaa can retrieve information from your presentation SAM.
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For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa/
INCHARGE-SA-PRES/instances/SM_System::SM-System?
alt=json&pretty=true


7. Make sure you can see the properties of SM_System::SM-System.


Unable to access Smarts EDAA
If your system cannot access Smarts EDAA, follow these steps.


Procedure


1. Verify the SAM server is not using a broker from a pre-9.4 Smarts installation.


2. Verify the SAM broker is configured for Smarts EDAA access:
<SAM_base_directory>/SAM/smarts/bin> dmctl -s localhost:426/
dmbroker getI EDAAService


The expected result is: SMARTS-EDAA
3. If you made configuration changes to the broker or SAM using the runcmd_env.sh


file, do the following in this order:


a. Shutdown SAM.


b. Shutdown Tomcat.


c. Shutdown the broker.


d. Restart the broker.


e. Restart Tomcat.


f. Restart SAM.


Notification cache is empty
Follow these steps when notifications are not appearing in the Notification cache.


Before you begin


Review this before you start the troubleshooting steps.


l If alerts show up in the Alerts EDAA but not in EMC M&R, the issue is in EMC M&R.


l If you see a backup of messages in RabbitMQ, the SAM publisher is working but the
ingestion service or elasticsearch service may be failing.


l If no messages are passing through into RabbitMQ, the problem is on the SAM
publisher side.


Procedure


1. Verify all services are running, as described in Status checks on services on page 373.


2. Check that SAM has started to publish to RabbitMQ and started with --
bootstrap=bootstrap-amqp.conf.


3. Verify SAM is exposed via the EDAA and started with --edaa=sam-
presentation/2.0.


4. Under the Connections tab in the RabbitMQ web-based management interface, do the
following:
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a. Verify that there are two connections: one from RabbitMQ / Java and the other from
rabbitmq-c.


b. If RabbitMQ / Java is not present, check if Tomcat is running and view the
<SAM_base_directory>/SAM/smarts/local/logs/tomcat/alert-
ingestion.


c. If rabbitmq-c is not present and if SAM is running, check the presentation SAM log
to see if it is publishing to RabbitMQ.


5. From the host running the presentation SAM server, check if you can access the
elasticsearch database and verify the count from a browser on Windows or using a
tool like curl on Linux.


Browser example:


http://localhost:9200/smarts/alert/_count


Linux example:


curl http://localhost:9200/smarts/alert/_count


A result similar to this appears:


{"count":50002,"_shards":{"total":5,"successful":5,"failed":0}}
6. If the count is zero, check if there are any notifications in SAM.


7. From a browser, check if you can access Tomcat in the SAM server host.


For example:


http://hostname:8080
8. Verify elasticsearch is running by checking <SAM_base_directory>/SAM/


smarts/local/logs/tomcat/alert-ingestion.log
If the service was running and is now shut down or unable to process notifications, a
message similar to this may appear in the alerts-ingestion.log file:


{date} {time},{pid} INFO  'ALERTS-IN' EventConsumerService 
EventConsumerPool-1 watchdog attemps to reconnect   
 {date} {time},{pid} INFO  'ALERTS-IN' plugins EventConsumerPool-1 
[La Lunatica] loaded [], sites [] {date} {time}
 {date} {time},{pid} ERROR 'ALERTS-IN' 
ElasticsearchNodeConfigurationService EventConsumerPool-1  
 ElasticSearchNodeConfigurationService::verifyIndexing: 
ElasticSearch :   
 
SERVICE_UNAVAILABLE :org.elasticsearch.client.transport.NoNodeAvail
ableException: No node available
 {date} {time},{pid} INFO  'ALERTS-IN' transport elasticsearch[Ent]
[generic][T#8] [Ent] failed to get node info for [#transport#-1]
[inet  
 [localhost/127.0.0.1:9300]], disconnecting...  
 org.elasticsearch.transport.NodeDisconnectedException: []
[inet[localhost/127.0.0.1:9300]][cluster/nodes/info] disconnected


Stale alerts and messages appear in Notification cache
If the Notification cache contains stale alerts and messages, you can synchronize SAM
and the Notifications cache. This happens when you restart SAM with a different RPS file.


You have two options to synchronize SAM and the Notification cache:


l Stopping the SAM publisher to clear the Notification cache on page 378. This is the
recommended option because it has low impact on the system.
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l Stopping SAM to clear the Notification cache on page 378.


Stopping the SAM publisher to clear the Notification cache
This method of clearing the Notification cache has less impact on the system because
you are only stopping the SAM publisher.


Procedure


1. Stop the publisher: $ bin/dmctl -s INCHARGE-SA-PRES invoke
SM_AMQPNotificationPublisher::SM-AMQPNotificationPublisher stop


2. Clear the Notifications cache by typing these commands:


a. $ bin/sm_service stop smarts-elasticsearch


b. $ rm -rf local/repos/emc-alerts-es


c. $ bin/sm_service start smarts-elasticsearch
3. Restart the publisher: $ bin/dmctl -s INCHARGE-SA-PRES invoke


SM_AMQPNotificationPublisher::SM-AMQPNotificationPublisher start


Stopping SAM to clear the Notification cache
This method of clearing the Notification cache has a substantial impact on the system.


Procedure


1. Stop SAM: $ bin/sm_service stop ic-sam-pres
2. Clear the Notifications cache by typing these commands:


a. $ bin/sm_service stop smarts-elasticsearch


b. $ rm -rf local/repos/emc-alerts-es


c. $ bin/sm_service start smarts-elasticsearch
3. Restart SAM: $ bin/sm_service start ic-sam-pres


RabbitMQ does not start
Follow these steps to determine why the RabbitMQ service does not start.


Procedure


1. Verify RabbitMQ is NOT already running by typing sm_service show.


2. Verify the Erlang process is NOT running by typing ps -ef | grep erl.


3. If the Erlang process is running, kill it before restarting RabbitMQ.


The Erlang process may be running from a prior installation, or was started outside the
sm_service mechanism.


4. Verify the qpidd process is NOT running by typing ps -ef | grep qpidd.


5. If the qpidd process is running, kill it before restarting the RabbitMQ service.


The qpidd process runs on some Linux distributions and can conflict with RabbitMQ
by using the same port.


6. Check that no other RabbitMQ installation exists by typing ps -ef | grep rabbit.
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Tomcat does not start
Follow these steps to determine why Tomcat does not start.


Procedure


1. Verify that Tomcat is NOT already running by typing sm_service show.


Tomcat may be running from a prior install, or was started outside of the
sm_service mechanism. Also, another instance of Tomcat or another web server
may be running on the system that prevents this Tomcat instance from binding to port
8080, causing it to shut down.


2. Verify the underlying application is not already running Tomcat by typing ps -ef |
grep java.
If you see that the /opt/InCharge/SAM/smarts/tomcat/bin/
bootstrap.jar process is running, then Tomcat is likely running as well.


3. Review the messages in SAM/smarts/local/logs/tomcat/catalina.out
and SAM/smarts/local/logs/tomcat/catalina.<date>.log.


Tomcat starts but then stops
Procedure


1. Follow the steps in Tomcat does not start on page 379


2. Check if another process is running on port 8080.


This can cause Tomcat to start for a few minutes and then return to a NOT RUNNING
state.


Changing the password of the EDAA account
The Smarts EDAA logs into domains using the EDAA account _edaa. This account has the
same access privileges as the admin account as well as the ability to perform actions on
behalf of other users. To secure this account, change its default password, which is
changeme.


Procedure


1. In the install directory of each domain server accessed by Smarts EDAA, type
sm_edit conf/serverConnect.conf
By default, only presentation SAM is exposed.


2. In the serverConnect.conf file, change the encrypted default password for the
_edaa account.


For example, you can change this password:


*:_edaa:<E-1.0>94C355DA7E0EB7AADE32F80F201F70C5CCA88288443EE23CB524
9ACD10C773E1:Impersonate


to the new password:


*:_edaa:<new_password>:Impersonate
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When you save the serverConnect.conf file, sm_edit encrypts the new
password.


3. In the install directory of the SAM server hosting the Smarts EDAA, type sm_edit
conf/edaaClientConnect.conf


4. In the edaaClientConnect file, change the encrypted default password for the
_edaa account.


For example, you can change this password:


*:*:_edaa:<E-1.0>94C355DA7E0EB7AADE32F80F201F70C5CCA88288443EE23CB5
249ACD10C773E1


to the new password:


*:*:_edaa:<new_password>


When you save the edaaClientConnect file, sm_edit encrypts the new
password.


5. Stop the Smarts Tomcat hosting the Smarts EDAA by typing bin/sm_service
stop smarts-tomcat.


6. Restart the Smarts Tomcat hosting the Smarts EDAA by typing bin/sm_service
start smarts-tomcat.


7. Verify that the Smarts EDAA can access each domain.


How do I change the RabbitMQ passwords
There are three default accounts in the RabbitMQ installation: an admin account, an
account used by the SAM publisher to deliver messages into RabbitMQ, and an account
used by the ingestion process to pull messages from RabbitMQ. You can change the
password for each one of these accounts.


Follow these procedures to change the passwords of the RabbitMQ accounts:


l Changing the RabbitMQ admin password on page 380


l Changing the RabbitMQ publisher password on page 381


l Changing the RabbitMQ ingestion password on page 382


Changing the RabbitMQ admin password
The RabbitMQ admin account is used for configuring RabbitMQ and accessing
RabbitMQ's web-based management interface. It is not used by any other component of
the system except for the initial RabbitMQ setup process.


Procedure


1. Make sure the smarts-rabbitmq service was started.


2. To access the RabbitMQ web-based management interface, connect with a browser to
port 15672 on the host where RabbitMQ is installed.


For example:


http://my-pres-sam-host.example.com:15672/
3. Log in as admin using the default password of changeme.


4. If this is the first time RabbitMQ was started, make sure the first-time setup has
completed before continuing, as explained Checking the RabbitMQ configuration on
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page 374. The setup process uses the default admin/changeme login credentials to
make changes to RabbitMQ.


5. Click the Admin tab and select admin from the list of RabbitMQ login users.


6. Click Update this user.


7. Type the new password in both password fields. Do not change the Tags field.


8. Click Update User.


A message appears indicating the login failed. This is because you changed the
password for the user that is currently logged on, making the password invalid.


9. Click Log Out.


A new login form appears.


10.Type admin and the new password to confirm the password was successfully
changed.


Changing the RabbitMQ publisher password
The publisher is a component in the presentation SAM domain that sends notifications
into RabbitMQ. The RabbitMQ login for this process is publisher with the default
password of changeme. To change this password, you must update both RabbitMQ and
the SAM configuration with a new matching password.


Procedure


1. Log in to the RabbitMQ web-based management interface as admin.


2. Click the Admin tab and select publisher from the list of RabbitMQ login users.


3. Click Update this user.


4. Enter the new password in both password fields.


5. Click Update User.


6. To change the password in the SAM configuration:


a. Log in to the host where the presentation SAM is installed.


b. Type sm_edit conf/clientConnect.conf.


c. In the clientConnect.conf file, look for a line beginning with AMQP/*
It is similar to this:


*:AMQP/
*:publisher:<E-1.0>94FF41842043EDA1DE6E67FB08015B3D456752865F8B5
D7DC63F259270B36092


d. In the AMQP/*" line, replace the password field with the same password that you
entered for the RabbitMQ publisher account.


In this example, the password was set to california:


*:AMQP/*:publisher:california


e. Save clientConnect.conf and exit sm_edit.


7. Restart the publisher by connecting to your presentation SAM using dmctl.


For example:


a. $ dmctl -s INCHARGE-SA-PRES
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b. dmctl> invoke SM_AMQPNotificationPublisher::SM-
AMQPNotificationPublisher stop


Note


If the stop command hangs, verify that you entered the same password for the


RabbitMQ publisher and SAM.


c. dmctl> invoke SM_AMQPNotificationPublisher::SM-
AMQPNotificationPublisher start


8. In the RabbitMQ interface, click the Connections tab and verify the publisher is
connected.


Changing the RabbitMQ ingestion password
Alert-ingestion is a component running in Tomcat that pulls notifications from RabbitMQ
and inserts them in to the Notification cache. The RabbitMQ login for this service is
ingestion with the default password of changeme. To change this password, you
must update both RabbitMQ and the alerts-ingestion configuration with a new matching
password.


Procedure


1. Log in to the RabbitMQ web-based management interface as admin.


2. Click the Admin tab and select ingestion from the list of RabbitMQ login users.


3. Click Update this user.


4. Enter the new password in both password fields.


5. Click Update User.


6. To change the password in alerts-ingestion:


a. Stop the Smarts Tomcat service by typing sm_service stop smarts-tomcat.


b. Using a text editor, open the file smarts/tomcat/webapps/alerts-
ingestion/WEB-INF/classes/rabbitmq-config.xml.


c. Find the password line that looks like this:


<property name="password" value="changeme" />


d. Replace changeme with the new password.


In this example, the password was changed to california:


<property name="password" value="california" />


e. Restart the Smarts Tomcat service by typing sm_service start smarts-
tomcat.


7. In the RabbitMQ interface, click the Connections tab and verify alerts-ingestion is
connected. It may take a few minutes for Tomcat to start and for alerts-ingestion to
connect.
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UI cannot display alerts or Smarts topology when CAS is enabled
Follow these steps when the Central Authentication Service is enabled and the UI is
unable to display information about alerts and objects in the Smarts topology.


Procedure


1. Verify the status of the Alerts EDAA, as described in Checking Alerts EDAA on page
375.


2. Verify the status of the Smarts EDAA, as described in Checking Smarts EDAA on page
375.


3. If Tomcat is running but queries to the EDAA result in the browser hanging, type this
command on the SAM server:


cd /opt/InCharge/SAM/smarts/bin
./runcmd_env.sh


4. In the runcmd_env.sh output:


a. If SM_CAS_SERVER exists, verify this entry includes the protocol, fully-qualified
domain name of the EMC M&R host, and the port number. Make sure there is
nothing after the port number (not even a "/").


b. If the https protocol is used, make sure the port is correct for https.


c. Verify SM_TOMCAT_SERVER has an URL for Tomcat that is part of the SAM
installation.


d. Make sure localhost and 127.0.0.1 are NOT in SM_CAS_SERVER or
SM_TOMCAT_SERVER entries. These environment variables must contain URLs
that reach services from outside the host machine.


Wrong CAS host name in runcmd_env.sh
The UI informs you when you entered an incorrect Central Authentication Service host
name in the runcmd_env.sh script.


This error message appears throughout the UI when you specify an incorrect host name
for CAS in runcmd_env.sh:


java.util.concurrent.ExecutionException:com.emc.asd.mashupengine.utils
.JSONException:A JSONObject text must begin with '{' at 1 [character 
2 line 1] 


Procedure


l Specify the correct CAS host name in the runcmd_env.sh script.


Services remain registered and running after an uninstall
If you did not stop all services before performing an uninstall, the services are still
running and using ports. If you do not want to reboot your system, you must manually
stop these services to allow other services to use these ports.


An uninstall only removes those services that were configured during the installation of
the software being uninstalled. If there are services configured by a second installation
on the same host or by manually invoking sm_service install, those services are
not removed.
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Follow these procedures to stop services:


l Stopping services on Linux on page 384


l Stopping services on Windows on page 385


Stopping services on Linux
Follow this procedure if you did not stop all services before performing an uninstall. This
procedure shows you examples of how to find the process IDs of the services that you
need to stop on Linux systems.


Procedure


1. Find the process ID for elasticsearch, a Java process running
org.elasticsearch.bootstrap.ElasticSearch
For example:


root      7223 10165  0 Jun05 ?        00:11:36 /opt/InCharge/SAM/
smarts/jre/bin/java -cp /opt/InCharge/SAM/smarts/toolbox/
elasticsearch/lib/elasticsearch-0.90.7.jar:/opt/InCharge/SAM/
smarts/toolbox/elasticsearch/lib/*:/opt/InCharge/SAM/smarts/
toolbox/elasticsearch/lib/sigar/* -Xms1g -Xmx1g -Xss256k -
Djava.awt.headless=true -XX:+UseParNewGC -XX:+UseConcMarkSweepGC -
XX:CMSInitiatingOccupancyFraction=75 -XX:
+UseCMSInitiatingOccupancyOnly -XX:+HeapDumpOnOutOfMemoryError -
Delasticsearch -Des.pidfile=/opt/InCharge/SAM/smarts/local/logs/
elasticsearch.pid -Des.foreground=yes -Des.path.home=/opt/
InCharge/SAM/smarts/toolbox/elasticsearch -Des.path.data=/opt/
InCharge/SAM/smarts/local/repos -Des.path.logs=/opt/InCharge/SAM/
smarts/local/logs -Des.path.conf=/opt/InCharge/SAM/smarts/conf/
elasticsearch org.elasticsearch.bootstrap.ElasticSearch


2. Find the process ID for Tomcat, a Java process running
org.apache.catalina.startup.Bootstrap
For example:


root     12495 10165  0 Jun05 ?        00:31:17 /opt/InCharge/SAM/
smarts/jre/bin/java -Xrs -Xms1g -Xmx3g -XX:PermSize=512m -XX:
+HeapDumpOnOutOfMemoryError -classpath /opt/InCharge/SAM/smarts/
tomcat/bin/bootstrap.jar:/opt/InCharge/SAM/smarts/tomcat/bin/
tomcat-juli.jar:/opt/InCharge/SAM/smarts/local/l10n/spool:/opt/
InCharge/SAM/smarts/local/l10n:/opt/InCharge/SAM/smarts/l10n -
Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager -
Djava.util.logging.config.file=/opt/InCharge/SAM/smarts/tomcat/
conf/logging.properties -Djava.endorsed.dirs=/opt/InCharge/SAM/
smarts/tomcat/endorsed -Dsmarts.remote.broker=localhost:426 -
Dcatalina.logdir=/opt/InCharge/SAM/smarts/local/logs/tomcat -
Dcatalina.base=/opt/InCharge/SAM/smarts/tomcat -
Dcatalina.home=/opt/InCharge/SAM/smarts/tomcat -
Djava.io.tmpdir=/opt/InCharge/SAM/smarts/tomcat/temp -
Djava.awt.headless=true -Dcom.smarts.disable_ci_jni=true -
Djava.security.egd=file:/dev/./urandom -
Dcom.emc.msa.dmt.clientconnect=/opt/InCharge/SAM/smarts/conf/
edaaClientConnect.conf -Dsmarts.cas.server=https://itops-
dev-121.lss.emc.com:58443 -Dcom.smarts.incoming_protocol=1,0 -
Dcom.smarts.outgoing_protocol=1,0 -Dcom.smarts.fips_mode=FALSE -
Dsmarts.tomcat.server=https://itops-dev-120.lss.emc.com:8443 
org.apache.catalina.startup.Bootstrap --ignoreme start


3. Find the process ID for RabbitMQ, an Erlang beam process running with -s rabbit
For example:


root      7221 10165  0 Jun05 ?        00:24:03 /opt/InCharge/SAM/
smarts/toolbox/OTP/erts-5.9.3.1/bin/beam.smp -W w -K true -A30 -P 
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1048576 -- -root /opt/InCharge/SAM/smarts/toolbox/OTP -progname 
erl -- -home /root -- -pa /opt/InCharge/SAM/smarts/toolbox/
rabbitmq/ebin -noshell -noinput -s rabbit boot -sname rabbit@itops-
dev-120 -boot start_sasl -config /opt/InCharge/SAM/smarts/conf/rmq/
rabbitmq.config -kernel inet_default_connect_options 
[{nodelay,true}] -sasl errlog_type error -sasl sasl_error_logger 
false -rabbit error_logger {file,"/opt/InCharge/SAM/smarts/local/
logs/rabbit@itops-dev-120.log"} -rabbit sasl_error_logger 
{file,"/opt/InCharge/SAM/smarts/local/logs/rabbit@itops-dev-120-
sasl.log"} -rabbit enabled_plugins_file "/opt/InCharge/SAM/smarts/
conf/rmq/enabled_plugins" -rabbit plugins_dir "/opt/InCharge/SAM/
smarts/toolbox/rabbitmq/plugins" -rabbit plugins_expand_dir "/opt/
InCharge/SAM/smarts/local/repos/rmq/rabbit@itops-dev-120-plugins-
expand" -os_mon start_cpu_sup false -os_mon start_disksup false -
os_mon start_memsup false -mnesia dir "/opt/InCharge/SAM/smarts/
local/repos/rmq/rabbit@itops-dev-120" --ignoreme


4. Use the process IDs to kill these three processes: $ kill -9 7223 12495 7221


Stopping services on Windows
Follow this procedure if you did not stop all services before performing an uninstall.


Procedure


1. Access the Services Management Console to see which services are still registered
and running.


2. Stop the services from the Services Management Console.


3. Delete the SAM directory from \InCharge\SAM.


4. Manually remove the services using the command prompt tool name sc. For example:


a. sc delete ic-broker


b. sc delete smarts-tomcat


c. sc delete ic-sam-server-pres


Retrieving the current elasticsearch PID
You can monitor the resource consumption of elasticsearch using the Linux top -p
<pid> command. This procedure explains where to retrieve the current process ID of
elasticsearch.


Procedure


l To determine the current process ID of elasticsearch, view <SMARTSHOME>/local/
logs/elasticsearch.pid.


Ports that must be open between SAM and EMC M&R
Ensure that the firewall between the server hosting SAM and the servers hosting EMC
M&R (Watch4net) are open. EMC M&R collects data from the Smarts domain managers.
Configure the firewall settings to allow access across ports.


Ports in use with HTTP (no SSL encryption)


l Tomcat server in Service Assurance Manager (SAM): 8080


l Tomcat server in EMC M&R (Watch4net): 58080


l Smarts Broker: 426 (also used for SSL encryption)
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l Smarts License Server: 1744 (also used for SSL encryption)


l Elasticsearch: 9200


l RabbitMQ: 15672


Ports in use with HTTPS enabled (SSL encryption)


l Tomcat server in SAM: 8443


l Tomcat server in EMC M&R (Watch4net): 58443


l Smarts Broker: 426


l Smarts License Server: 1744
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Overview
Use the Configuration Manager in the EMC M&R UI to apply a centralized copy of
configuration settings to all IP Managers in your deployment. Configuration settings can
include: polling intervals, thresholds, device access credentials, unique tagging
identifiers for discovered topology, and discovery configuration parameters.


For deployments with multiple IP Managers, Service Assurance Suite provides the
Configuration Manager, so you can consistently maintain configuration settings. The
Configuration Manager is an optional component.


l Polling settings define the polling intervals. Polling occurs when an IP Manager
communicates with a managed device to determine the device's operational status.


l Thresholds are values that define acceptable or unacceptable levels of connectivity or
performance. The polled data is compared to the threshold values for monitoring
purposes.


l Device access settings define the credentials needed to access the managed devices.


l IP tagging defines a tag that the IP Manager uses to uniquely identify discovered
topological objects that have identical names.


l Discovery configuration settings define the discovery process that the IP Manager
performs.


The Configuration Manager feature supports the following IP Managers: IP Availability
Manager, IP Performance Manager, and the combined IP Availability and Performance
Manager.


Figure 7  Example of polling settings
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Figure 8  Example of discovery settings


Additional information is described in these documents:


l EMC M&R Installation and Configuration Guide


l SolutionPack for EMC Smarts Summary Sheet


l How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts


l Troubleshooting the Deployment of SAM, EMC M&R, and the SolutionPack for EMC Smarts


Requirements
When using the Configuration Manager in the EMC M&R UI to control your configuration
settings, ensure that you have the following components set up in your deployment:


l A valid EMC Smarts license, that includes the Configuration Manager, is installed.


l The Configuration Manager is installed and is started with the EMC Data Access API
service option (--edaa=ip/2.0).


l The SolutionPack for EMC Smarts is installed and configured with the Configuration
Manager instance name. In the Report block, under Presentation SAM Configuration
Section, select the Use Smarts Configuration Manager checkbox and specify the
name of the Configuration Manager in the Configuration Manager field if it does not
use the default name.


l You planned your configuration carefully:


n Identified the IP Managers to assign to the Configuration Manager. IP Managers
9.1 and higher are supported but there is limited backward compatibility for 9.1 IP
Managers.


n Modified the sm_service install command for the identified 9.4 and 9.3 IP
Managers to include the --edaa=ip/2.0 option (for example: sm_service
install commands for Linux on page 403 and sm_service install commands for
Windows on page 404).
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9.2 and 9.1 IP Managers do not support the service command --edaa=ip/2.0
option. For 9.1 IP Managers, the Configuration Manager does not support
discovery configuration settings, but other configuration settings are supported.
Use: Configuring EDAA mode for 9.2 and 9.1 IP Managers on page 400


n Be aware that when the Configuration Manager is connected to running IP
Managers, it by default transfers the settings and may overwrite unique settings in
the IP Managers.
If you do not want Configuration Manager to transfer the settings to the IP
Managers on the initial connection, uncheck the Config Enabled checkbox when
you add the IP Manager as a target as described in Adding an IP Manager to
Configuration Manager on page 391.


n Once you use the Configuration Manager to control configuration settings in the IP
Managers, you are no longer able to modify polling and thresholds group settings
locally in the IP Managers.


– The Configuration Manager overwrites all configuration settings in the IP
Managers.


– You can only view the polling and thresholds settings and not modify them in
the Domain Manager Administration Console.


The Topology and Discovery Filters settings remain locally defined for each IP
Manager. You can continue to modify the Topology and Discovery Filters settings
from the Domain Manager Administration Console and the EMC M&R UI.


l EMC M&R is installed and you have valid administrator credentials.


Workflow for maintaining IP Manager settings
Use the Configuration Manager to apply a centralized copy of configuration settings to all
IP Managers in your deployment.


1. Log in to the EMC M&R platform with your administrator username and password.


2. Select Administration > Modules > Smarts.


3. Select the Configuration Manager (Default: INCHARGE-CM).


l Ensure that the IP Managers are assigned.


l If not, add the IP Managers: Adding an IP Manager to Configuration Manager on
page 391


l To keep IP Managers assigned but disabled: Disabling an IP Manager from
Configuration Manager control on page 392


l To remove IP Managers: Removing an IP Manager from Configuration Manager
control on page 393


4. Click one of the following: Polling, Thresholds, Device Access, Tagging, or an IP
Manager for discovery configuration and make your configurations accordingly:


l To configure settings for a selected group: Configuring settings for a selected
group on page 393


l To configuring matching criteria: Configuring matching criteria for a selected
group on page 394


l To configure target domains: Configuring target domains for a selected group on
page 395


l To add a description: Adding a description for a selected group on page 395
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l To configure device access: Configuring device access for a selected group on
page 396


l To configure tagging: Configuring unique identifier tags for a selected group on
page 396


l To configure the discovery process: Configuring discovery settings on page 397


l To configure discovery filters: Configuring discovery filters on page 397


l To create more groups: Adding a new group on page 397


l To delete groups: Deleting a group on page 398


l To change the priority order of the groups: Changing the priority of the groups on
page 398


l To copy the configuration of a group to make a new group: Copying the
configuration of a group on page 399


5. Start the services for one or more IP Managers.
Linux: Issue the command:


/opt/InCharge/IP/smarts/bin/sm_service start <service_name>


Windows: From the application server's desktop, select Start > Administrative Tools >
Services and start the service.


IP Manager Service name


IP Availability Manager ic-am-server


IP Performance Manager ic-pm-server


IP Availability and Performance Manager ic-am-pm-server


Before you start the service, if you have not already done so, you need to issue the
sm_service install command to register the product: sm_service install
commands for Linux on page 403 and sm_service install commands for Windows on
page 404


6. Click Push Settings:


l If you changed configuration settings for one of the target IP Managers.


l After you enabled the Config Enabled attribute for a target IP Manager.


The Configuration Manager transfers the settings whenever the IP Managers connect
or are reconnected, or when you click Push Settings.


Adding an IP Manager to Configuration Manager
Add one or more IP Managers to the Configuration Manager list if they are not included.


Procedure


1. For the selected Configuration Manager, click Add Target.


2. Type the IP Manager instance name in the Element Name field (for example,
INCHARGE-AM).


3. Decide if you want to keep the following checkboxes selected:
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Checkbox Description


Config enable By default, this checkbox is selected so that the Configuration
Manager automatically transfers the configuration settings to the IP
Manager if the IP Manager is started.
If you clear the checkbox, the IP Manager is added to the
Configuration Manager list but the Configuration Manager does not
transfer the settings. Use this option if you want to control when the
Configuration Manager transfers the settings. Modifying IP settings
while Configuration Manager transfer is delayed on page 392


Reconfigure
after push


By default, this checkbox is selected so that the Configuration
Manager initiates a reconfigure action on the modified or newly-
added configuration settings in the IP Manager.
If you clear the checkbox, then you have to manually reconfigure
the IP Manager.


4. Click OK.


Disabling an IP Manager from Configuration Manager control
You can temporarily stop the Configuration Manager from sending the centralized
settings to an IP Manager without removing it from the Configuration Manager list. For
example, you can disable the transfer of settings for a specific IP Manager while you
create new groups or change settings.


Procedure


1. In the Configuration Manager list, right-click the IP Manager and select Modify
Attributes.


2. Select the Config enable checkbox to remove the checkmark.


3. Select the Reconfigure after push checkbox to remove the checkmark.


4. Click OK.


Modifying IP settings while Configuration Manager transfer is
delayed


Use this alternate approach if you want to configure groups and settings while delaying
the transfer of the settings.


Before you begin


The IP Manager is added to the Configuration Manager list but you temporarily disabled it
from the Configuration Manager.


Procedure


1. Review which groups are assigned to the IP Manager and their settings.


2. Modify the groups and their settings if necessary.


3. Right-click the IP Manager and select Modify Attributes.


4. Select the Config enable checkbox.


5. Select the Reconfigure after push checkbox.


6. Click Push Settings to transfer the settings.
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Removing an IP Manager from Configuration Manager control
One method to stop the Configuration Manager from sending the centralized settings to
an IP Manager is to permanently remove it from the Configuration Manager list. Or, if you
accidently added the incorrect IP Manager to the Configuration Manager list, you can
remove it.


Procedure


1. Clear the value for the Service Name attribute.


a. Attach the Domain Manager Administration Console to the IP Manager.


b. Press Ctrl + ALT + M.


c. Go to ICIM_Manager->ICIM-Manager.


d. Clear the value in the Service Name attribute.


e. Click Apply.


2. In the EMC M&R UI, in the Configuration Manager list, right-click the IP Manager and
select Delete.


3. Reinstall the service for the IP Manager without the --edaa option.


a. Stop the IP Manager service.


Linux: Issue the command:


/opt/InCharge/IP/smarts/bin/sm_service stop <service_name>


Windows: From the application server's desktop, select Start > Administrative
Tools > Services and stop the service.


b. Issue the sm_service install command for the IP Manager minus the --
edaa option.


c. Start the IP Manager service.


Configuring settings for a selected group
You can accept the default settings or change the settings and their parameters for a
selected group.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following choices:


l Polling


l Thresholds


l Device Access


l Tagging
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2. Select a group category from the dropdown box.


3. Select a group from the list that appears for the group category.


4. Click Settings.


The default settings are already enabled.


5. To add more settings to the group,


a. Scroll and click the Enabled checkbox for each setting that you want to apply.


b. Click Apply and Refresh.


The Configuration Manager transfers only the enabled settings.


6. To examine the parameters of each setting, click the setting.


7. To modify the setting parameters, click the setting, and modify the values as
necessary.


To restore the parameters to their default values, click Restore Defaults.


8. Click Apply to save your changes.


Configuring matching criteria for a selected group
You can configure matching criteria for a selected group. The matching criteria
determines group membership. A managed object becomes a member of the group,
when the managed object matches a group’s target class and matches all of the
attributes defined for the target class.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following choices:


l Polling


l Thresholds


l Device Access


l Tagging


2. Select a group category from the dropdown box.


3. Select a group from the list that appears for the group category.


4. Click Matching criteria to create matching criteria which determines the members of
the group.


a. Select a class attribute from the dropdown box.


b. Specify a value for the class attribute.


Value can be: Boolean, text, integers, and wildcard characters. The Value field is not
case-sensitive.


5. Click Add to add more pairs of class attributes and values.


To remove a class attribute and its value, click the Delete icon.


6. Click Apply to save your changes.
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Configuring target domains for a selected group
You can specify IP Managers for a selected group and assign the setting to specific IP
Managers. For example, you have a group of routers with a specific threshold setting and
three IP Managers monitor the routers.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following choices:


l Polling


l Thresholds


l Device Access


l Tagging


2. Select a group category from the dropdown box.


3. Select a group from the list that appears for the group category.


4. Click Target Domains to assign the setting to specific IP Managers.


5. Specify a filter in the group that you want to assign to the target IP Managers.


a. Type wildcard characters, integers, regular expressions, or an IP Manager name in
the Search By field and click Search to search for particular IP Managers or a
group of IP Managers.


b. Select one or more IP Managers from the list.


The IP Managers that you select can be a subset of the IP Managers listed under the IP
Configuration Manager. Previously enabled or disabled IP Managers (other than the
search criteria) will not be modified.


6. Click Apply to save your changes.


Adding a description for a selected group
You can create a description to identify a group.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following choices:


l Polling


l Thresholds


l Device Access
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l Tagging


2. Select a group category from the dropdown box.


3. Select a group from the list that appears for the group category.


4. Click Description and type information about the group.


5. Click Apply to save your changes.


Configuring device access for a selected group
You can configure the device access setting for a selected group. Device credentials, for
example login credentials, are used for command line interface (CLI) discovery, CLI
polling, and XML discovery.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click Device Access.


2. Select the group category Device Access Configurations from the dropdown box.


3. Select a group (for example, CLI Access Group or XML Access Group) from the list that
appears for the group category.


4. Click Settings.


The default settings are already enabled.


The Configuration Manager transfers only the enabled settings.


5. To examine the parameters of each setting, click the setting.


6. To modify the credentials, click the setting, and modify the values as necessary.


7. Click Apply to save your changes.


Configuring unique identifier tags for a selected group
You can configure an IP tag naming convention that the IP Manager uses to uniquely
identify discovered topological objects that have identical names.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click Tagging.


2. Select the group category System IP Tag Groups from the dropdown box.


3. Select a group (for example, IP Tag) from the list that appears for the group category.


4. Click Settings.


The default settings are already enabled.


The Configuration Manager transfers only the enabled settings.
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5. To create the tagging convention, click the setting, and modify the values as
necessary.


6. Click Apply to save your changes.


Configuring discovery settings
You can configure the discovery process for the IP Manager. You can specify whether the
IP Manager performs a full discovery or autodiscovery, the time intervals for discovery,
whether pending discovery is performed for candidate systems, user-defined community
strings, and SNMPV3 specifications.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the IP Managers in the Configuration Manager list.


2. Click Topology.


3. Click the checkboxes and modify the values as necessary.


4. Click Apply to save your changes.


Configuring discovery filters
You can configure discovery filters for candidate systems that the IP Manager uses during
the discovery process. The filters can include IP address ranges, System OIDs, and so on.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the IP Managers in the Configuration Manager list.


2. Click Discovery Filters.


3. Click the checkboxes and modify the values as necessary.


Use the View Extended Filter checkbox for SNMP fields and SNMPV3 specifications.


4. Click Apply to save your changes.


Adding a new group
When you are using the Configuration Manager to maintain settings for IP Managers, you
can add a new group to the group category for Polling, Thresholds, Device Access, or
Tagging.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).
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l Assign IP Managers.


Procedure


1. Click one of the following: Polling, Thresholds, Device Access, or Tagging.


2. Select a group category from the dropdown box.


The choices vary accordingly for Polling, Thresholds, Device Access, or Tagging.


3. Click Create Group.


4. Type the name of the new group and a description. Click OK.


The new group appears in the group list.


Deleting a group
When you are using the Configuration Manager to maintain settings for IP Managers, you
can delete a user-defined group or a default group from the group category for Polling,
Thresholds, Device Access, or Tagging.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following: Polling, Thresholds, Device Access, or Tagging.


2. Select a group category from the dropdown box.


The choices vary accordingly for Polling, Thresholds, Device Access, or Tagging.


3. In the group list, right-click the group and select Delete.


Changing the priority of the groups
In any group category, you can arrange the groups in a high-to-low priority. During the
matching criteria process which determines the members of a group, a candidate
member object is compared against the highest priority group first. The candidate
becomes a member of the first group for which there is a criteria match.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following: Polling, Thresholds, Device Access, or Tagging.


2. Select a group category from the dropdown box.


The choices vary accordingly for Polling, Thresholds, Device Access, or Tagging.


3. In the group list, select the group and click either Raise Priority or Lower Priority to
move the group to the appropriate position in the list.


4. Click Apply to save your changes.
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Copying the configuration of a group
When you are using the Configuration Manager to maintain settings for IP Managers, you
can create a new group by copying an existing group with its configurations, making
minimal changes, and reassigning IP Managers to it.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the following: Polling, Thresholds, Device Access, or Tagging.


2. Select a group category from the dropdown box.


The choices vary accordingly for Polling, Thresholds, Device Access, or Tagging.


3. In the group list, right-click the group to copy and select Copy Configuration.


4. Type the new group name, the description, the IP Managers to assign to it, select the
Copy Matching Criteria checkbox, and click OK.


Helper lists the configuration-enabled IP Managers.


The new group appears above the source group from which it was copied. This
ensures that the custom group settings are applied first to the IP Managers assigned
to this group and not overwritten by the default group settings.


Displaying IP Manager groups
You can view all of the groups for a specific IP Manager.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the IP Managers in the Configuration Manager list.


2. Click Groups.


Displaying IP Manager attributes
You can view all of the attributes for a specific IP Manager.


Before you begin


l Log in to the EMC M&R platform with your administrator username and password.


l Navigate to the Configuration Manager (Select Administration > Modules > Smarts.).


l Assign IP Managers.


Procedure


1. Click one of the IP Managers in the Configuration Manager list.
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2. Click Attributes.


Configuring EDAA mode for 9.2 and 9.1 IP Managers
Configure EDAA mode for the services of the older IP Managers so the IP Managers can
interact with the Configuration Manager. Older IP Managers do not support the service
command --edaa=ip/2.0 option.


Procedure


1. Edit the msa-sources.xml file located in the SAM installation in <SAM-
BASEDIR>/smarts/tomcat/webapps/smarts-edaa/WEB-INF/classes to
add entries for your IP Managers.


a. For example, add the entry key information:


<entry key="INCHARGE-AM-92" 
value-ref="MsaDMTDataSource__INCHARGE-AM-92" />


b. Add the corresponding bean id information.


<bean id="MsaDMTDataSource__INCHARGE-AM-92"
 class="com.emc.msa.dmt.dmpool.MSADMTContext">
 <property name="brokerContext" 
ref="MsaDMTDataSource__Broker" />
 <property name="dmtName" value="INCHARGE-AM-92" /> 
 <property name="dataSourceName" value="INCHARGE-AM-92" /> 
 <property name="modelName" value="ip" />
 <property name="modelVersion" value="2.0" />
 <property name="useTLS" value="true" />
 <property name="disableKeepalives" value="true" />
 <property name="lockBoxSupport" value="false" />
 <property name="excludeClasses" ref="IP-
ExcludeClassesDefault"/>
 <property name="excludeAttributes" ref="IP-
ExcludeAttrsDefault"/>
 </bean>
 


Use the full domain name as it is registered with the Broker (for example, INCHARGE-
AM-92 and not AM-92). The entry key parameter value should match the datasource
name (the domain name with which the IP Manager is started).


The value of the bean id parameter must match the value-ref parameter value.


The dmtName property value and the dataSourceName property value must match the
entry key value.


2. Open the msa-model-defaults.xml file in the <SAM-BASEDIR>/smarts/
tomcat/webapps/smarts-edaa/WEB-INF/classes/ directory. If not
commented, comment the MR_MetaObject value in the xml node with id="IP-
ExcludeClassesDefault". For example:


<!-- Start of Default Values for Provider Entries -->
 <util:list id="IP-ExcludeClassesDefault">
 <value>GA.*</value>
 <!--<value>MR_MetaObject</value> -->
 <value>ICIM_Test</value>
 <value>NasManager</value>
 <value>Topo.*</value>
 <value>Hierarchical.*</value>
 <value>VOIP.*</value>
 </util:list>
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3. Use sm_edit to open the <SAM-BASEDIR>/smarts/conf/
edaaClientConnect.conf file.


a. Add an entry for the IP Manager using the format *:<DOMAIN-
NAME>:admin:changeme .


*:INCHARGE-AM-92:admin:changeme
 ::_edaa:changeme


The account _edaa is used to log in to IP Managers 9.3 and higher.


b. Save the file.


4. Stop and start the smarts-tomcat, smarts-rabbit-mq, and smarts-elasticsearch
services.


Automatically loading settings from a running IP Manager into
the Configuration Manager


Manually transferring settings from a running IP Manager into the Configuration Manager
can be time-consuming. You can use an automated alternative, the sm_settings.pl script,
to export the settings from the IP Manager and import them into the Configuration
Manager.


Procedure


1. To export the settings from a running IP domain manager, run the script from
<BASEDIR>/IP/smarts/bin:


./sm_perl sm_settings.pl --server=<server_name> --export=<filename>


For example: ./sm_perl sm_settings.pl -s INCHARGE-AM --
export=pt_goups
The export output is written as a file to the <BASEDIR>/IP/smarts/local/logs
directory.


2. Optional, you can modify the script output to include new polling groups: Other
modifications to sm_settings.pl output on page 401


3. To import the content into the Configuration Manager, run the script from
<BASEDIR>/IP/smarts/bin:


 ./sm_perl sm_settings.pl --server=<CM_server> --import=<filename>


For example: ./sm_perl sm_settings.pl -s INCHARGE-CM --
import=pt_goups


Other modifications to sm_settings.pl output
When you use the sm_settings.pl script, you can also modify the script output to include
new polling groups, for example, before importing the content into the Configuration
Manager.


If you want add another polling group, use sm_edit from the BASEDIR/smarts/bin
directory to open the exported output file (for example, type: sm_edit
<BASEDIR>/IP/smarts/local/logs/pt_groups). Add the new group definition
under the polling category ICIM_UnitaryComputerSystem Polling Groups line. Below this
line, you see definitions for all polling groups applicable to Unitary Computer systems
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(routers, switches, etc). Add the new definition immediately after the category line or
between other definitions, as long as it is above the next category line.


l To create a new group definition, you can copy an existing group in the file and
modify it.


l Alternatively, you can run the sm_settings.pl script against an IP Manager that is not
under Configuration Manager control and that contains the desired group definition.
Then, copy and paste the group definition into the file.


In addition, after you add the group definition, type the IP Manager or multiple IP
Managers for the group. The general syntax is: config <Group Name>: DM1|DM2
Then, save the file and import it into the Configuration Manager.


If a domain name specified in a group definition is not configured as a target IP Manager
for the Configuration Manager, the IP Manager will be added as part of the import.


The settings for the newly-added Domain Managers need to be verified and then pushed
manually.


Note


Export can be run on any of the installations of IP Manager. However, to import the
settings, the file needs to be placed at SM_HOME/local/logs or SM_WRITEABLE/logs of
the server's installation folder and then import needs to be invoked from the bin folder of
the same install.


Note


Even though the Device Access groups can be imported into the IP Configuration
Manager, passwords still need to be added manually because passwords are not
exported due to security reasons. However, once the Configuration Manager pushes the
settings to the target domains, it is done through secure connection, so it can push the
credentials.


The output file contains configuration of all polling and threshold groups and settings.
Each group definition starts with config <group name> line. Group definitions are
separated from each other by blank lines. They are also organized by category. When you
add a new group, make sure that the new group definition is added under the correct
category.


Polling Group Categories
polling category CIM_FileSystem Managed FileSystems
polling category RedundancyGroup Unmanaged RedundancyGroups
polling category Interface Unmanaged Interfaces
polling category RedundancyGroup Managed RedundancyGroups
polling category Interface Managed Interfaces
polling category CIM_FileSystem Unmanaged FileSystems
polling category ICIM_ServiceAccessPoint Managed STPNodes
polling category ICIM_UnitaryComputerSystem Polling Groups
polling category CIM_LogicalDevice Unmanaged Logical Devices
polling category Port Managed Port
polling category CIM_LogicalDevice Managed Logical Devices
polling category ICIM_ServiceAccessPoint Unmanaged STPNodes
polling category Port Unmanaged Ports


Threshold Group Categories
threshold category Port Port Groups - Trunk Ports
threshold category FileSystem File Systems
threshold category ICIM_UnitaryComputerSystem System Resource Groups
threshold category WirelessControllerRedundancyGroup 
WirelessControllerRedundancyGroups
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threshold category ICIM_UnitaryComputerSystem System VLAN Tag Groups
threshold category Port Port Groups - Access Ports
threshold category TemperatureSensor TemperatureSensor
threshold category Interface Interface Groups
threshold category WirelessRadioInterface WirelessRadioInterfaceGroup
threshold category AggregatePort AggregatePortsGroup
threshold category VoltageSensor VoltageSensor


Tagging
tagging category ICIM_UnitaryComputerSystem System IP Tag Groups


CLI groups
security category ICIM_UnitaryComputerSystem Device Access 
Configurations


sm_service install commands for Linux
The sm_service install command for products that interoperate with the EMC M&R
User Interface includes additional options. Before you start the service, if you have not
already done so, you need to issue the sm_service install command from
the /opt/InCharge/IP/smarts/bin directory to register the product with the
EMC Smarts Broker.


sm_service install command for Configuration Manager
As a prerequisite, the Configuration Manager is already running.


/opt/InCharge/IP/smarts/bin/sm_service install --force  
--unmanaged 
--startmode=runonce 
--name=ic-ip-configuration-edaa 
"--description=EMC Smarts IP Configuration Manager for EDAA" 
/opt/InCharge/IP/smarts/bin/sm_server 
--name=INCHARGE-CM
--config=icf-c 
--bootstrap=bootstrap.conf 
--port=0 
--edaa=ip/2.0 
--ignore-restore-errors 
--nodx 
--output


sm_service install command for IP Availability Manager


/opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-am-server
"--description= EMC Smarts IP Availability Manager Server"
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-AM
--config=icf
--bootstrap=bootstrap-am.conf
--port=0
--edaa=ip/2.0
--ignore-restore-errors
--output


sm_service install command for IP Performance Manager


/opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-pm-server
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"--description= EMC Smarts IP Performance Manager Server"
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-PM
--config=icf
--bootstrap=bootstrap-pm.conf
--port=0
--edaa=ip/2.0
--ignore-restore-errors
--output


sm_service install command for IP Availability-Performance Manager


/opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-am-pm-server
"--description= EMC Smarts IP Availability Manager and Performance 
Manager Server"
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-AM-PM
--config=icf
--bootstrap=bootstrap-am-pm.conf
--port=0
--edaa=ip/2.0
--ignore-restore-errors
--output


sm_service install commands for Windows
The sm_service install command for products that interoperate with the EMC M&R
User Interface includes additional options. Before you start the service, if you have not
already done so, you need to issue the sm_service install command from
the /opt/InCharge/IP/smarts/bin directory to register the product with the
EMC Smarts Broker.


sm_service install command for Configuration Manager
As a prerequisite, the Configuration Manager is already running.


C:\InCharge\IP\smarts\bin\sm_service install --force
--unmanaged
--startmode=runonce
--name=ic-ip-configuration-edaa
"--description=EMC Smarts IP Configuration Manager for EDAA" 
C:\InCharge\IP\smarts\bin\sm_server.exe 
"--name=INCHARGE-CM" 
"--config=icf-c"
"--bootstrap=bootstrap.conf" 
"--port=0"
"--edaa=ip\2.0"
"--ignore-restore-errors "
"--nodx "
"--output"


sm_service install command for IP Availability Manager


C:\InCharge\IP\smarts\bin\sm_service install
--force
--name=ic-am-server
"--description= EMC Smarts IP Availability Manager Server"
--startmode=runonce
C:\InCharge\IP\smarts\bin\sm_server.exe
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"--name=INCHARGE-AM"
"--config=icf"
"--bootstrap=bootstrap-am.conf"
"--port=0"
"--edaa=ip\2.0"
"--ignore-restore-errors"
"--output"


sm_service install command for IP Performance Manager


C:\InCharge\IP\smarts\bin\sm_service install
--force
--name=ic-pm-server
"--description= EMC Smarts IP Performance Manager Server"
--startmode=runonce
C:\InCharge\IP\smarts\bin\sm_server.exe
"--name=INCHARGE-PM"
"--config=icf"
"--bootstrap=bootstrap-pm.conf"
"--port=0"
"--edaa=ip\2.0"
"--ignore-restore-errors"
"--output"


sm_service install command for IP Availability-Performance Manager


C:\InCharge\IP\smarts\bin\sm_service install
--force
--name=ic-am-pm-server
"--description= EMC Smarts IP Availability Manager and Performance 
Manager Server"
--startmode=runonce
C:\InCharge\IP\smarts\bin\sm_server.exe
"--name=INCHARGE-AM-PM"
"--config=icf"
"--bootstrap=bootstrap-am-pm.conf"
"--port=0"
"--edaa=ip\2.0"
"--ignore-restore-errors"
"--output"
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How to Set Up the EMC Smarts Server Manager for Software-
Defined Networks (SDN) Feature


The EMC Smarts Server Manager for Software-Defined Networks (SDN) feature probes the
VMware


® NSX Manager and vCenter to discover and monitor the virtual elements in your
virtual network. This feature provides end-to-end visibility into SDN-based data center
infrastructure. This article describes how to set up the EMC® Smarts® Server Manager for
Software-Defined Networks feature.


This article is for IT networking administrators.


The procedure in this article assumes that your Service Assurance Suite deployment
includes:


l EMC Smarts Server Manager (ESM) installed and operational. For example,


n The Server Manager is configured to communicate with the IP Manager.


n The Server Manager is configured with VMware read-only credentials for the
Virtual Center associated with your NSX Manager.


n The IP Manager can discover the ESX servers configured in the VMware vCenter.


l A valid EMC Smarts license with the EMC Smarts Server Manager for Software-Defined
Networks feature installed.


l Global Console installed.


l Valid VMware administrator credentials for your NSX Manager and the IP address of
the host where the NSX Manager resides.


For information about these prerequisites, consult the EMC Smarts Installation Guide for
SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers, the EMC Smarts Server Manager User
and Configuration Guide, and the EMC Smarts Release Notes for SAM, IP, ESM, MPLS, NPM,
OTM, and VoIP Managers.


Specify NSX Manager information
To configure EMC Smarts Server Manager for Software-Defined Networks, specify the NSX
Manager administrator credentials and the IP address of the host where the NSX Manager
resides.


Before you begin


EMC Smarts administrator credentials are required to access the Configure menu.


Procedure


1. Open the Service Assurance Manager Global Console attached to the Server Manager
(INCHARGE-ESM, by default).


2. In the Topology Browser Console, select Configure > Domain Manager Administration
Console.


3. Right-click the ESM server in the left pane and select Configure ESM credentials.


4. In the Configure ESM credentials dialog box, select NSX for the host type.


5. Type values in the following fields:
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Field Value


Host IP address for the NSX Manager host


User ID NSX Manager administrator user name


Password NSX Manager administrator password


6. Click Apply credential with testing.


7. Verify that your NSX credentials are accepted for the NSX Manager by checking the
status indicator in the Configure ESM credentials dialog box.


A green Passed test status indicates that the credentials are accepted for the NSX
Manager.


If the NSX credentials are not accepted, confirm that the credentials are correct and
enter them again in the Configure ESM credentials dialog box.


You can also check the log file: Verify that NSX credentials are accepted in the log
file on page 409


8. Click Close.


9. In the Domain Manager Administration Console, select your IP Manager and select
Topology > Discover All to discover vCenter and the NSX Manager. At the end of the IP
Manager discovery process, the Server Manager discovery process is automatically
started.


After you finish


After the topology for your virtual network has been discovered, to continue to monitor
and analyze your network, use the EMC M&R UI or the Service Assurance Global Console.
For information about how to use the EMC M&R UI, consult the online help.


For information about the SDN topology, consult the EMC Smarts Server Manager User and
Configuration Guide.


Verify that NSX credentials are accepted in the log file
Verify that your NSX credentials are accepted for the NSX Manager by checking your log
file.


Procedure


1. Open the Server Manager log file in the opt/InCharge/ESM/smarts/local/
logs directory.


2. Locate the credential messages.


For example, the following messages indicate that the NSX credentials are accepted:


[March 10, 2014 3:35:58 PM EDT +084ms] t@1302337856 
SM_ProtocolEngine-125 7924 IC Console - V9.3.0.0
DISC-*-CAL_FR-Credential_Util::addCredential : was called for 
credential: NSX-<IP_address>


[March 10, 2014 3:35:58 PM EDT +387ms] t@1302337856 
SM_ProtocolEngine-125 7924 IC Console - V9.3.0.0
DISC-*-CRT_CRED-Credential_Util::addCredential: Creating 
credential: NSX-<IP_address>
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How to Update the NSX Manager Administrator Credentials for
the Server Manager Configuration


If the VMware administrator changed the administrator credentials for the NSX Manager,
update the NSX Manager credentials for the Service Manager configuration.


Procedure


l Follow the instructions in Specify NSX Manager information on page 408, and then
perform a discovery (Topology > Discover All) from the Server Manager.
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How to Set Up the EMC Smarts Server Manager for Citrix
XenServer


The EMC Smarts Server Manager probes the Citrix
®


 XenServer
®


 hypervisor and XenCenter
to discover and monitor the XenServer Hypervisor and Xen Virtual Machines in your
virtual network.


This article is for IT networking administrators.


The procedure in this article assumes that your Service Assurance Suite deployment
includes:


l EMC Smarts Server Manager (ESM) installed and operational. For example,


n The Server Manager is configured to communicate with the IP Manager.


n The Server Manager is configured with Citrix read-only credentials for your
XenServer hypervisor. You should also have access to XenAPI.


n The IP Manager can discover the XenServer servers configured in the XenCenter.


l A valid EMC Smarts license for XenServer installed.


l Global Console installed.


l Valid read-only credentials for your XenServer hypervisor and the IP address of the
host where the hypervisor resides.


For information about these prerequisites, consult the EMC Smarts Installation Guide for
SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers, the EMC Smarts Server Manager User
and Configuration Guide, and the EMC Smarts Release Notes for SAM, IP, ESM, MPLS, NPM,
OTM, and VoIP Managers.


Specify XenServer information
To configure the EMC Smarts Server Manager for XenServer, specify the XenServer
hypervisor credentials and the IP address of the host where the hypervisor resides.


Before you begin


EMC Smarts administrator credentials are required to access the Configure menu.


Procedure


1. Open the Service Assurance Manager Global Console attached to the Server Manager
(INCHARGE-ESM, by default).


2. In the Topology Browser Console, select Configure > Domain Manager Administration
Console.


3. Right-click the ESM server in the left pane and select Configure ESM credentials.


4. In the Configure ESM credentials dialog box, select XenServer for the host type.


5. Type values in the following fields:


Field Value


Host IP address for the master and slave XenServer or standalone XenServer
where the individual XenServer hypervisor resides


User ID XenServer read-only user name
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Field Value


Password XenServer read-only password


6. Click Apply credential with testing.


7. Verify that your XenServer credentials are accepted for the XenServer hypervisor by
checking the status indicator in the Configure ESM credentials dialog box.


A green Passed test status indicates that the credentials are accepted for the
XenServer hypervisor.


If the XenServer credentials are not accepted, confirm that the credentials are correct
and enter them again in the Configure ESM credentials dialog box.


You can also check the log file: Verify that XenServer credentials are accepted in the
log file on page 413


8. Click Close.


9. In the Domain Manager Administration Console, select your IP Manager and select
Topology > Discover All to discover the XenServer servers. At the end of the IP Manager
discovery process, the Server Manager discovery process is automatically started.


After you finish


After the topology for your virtual network has been discovered, to continue to monitor
and analyze your network, use the EMC M&R UI or the Service Assurance Global Console.


For information about how to use the EMC M&R UI, consult the online help.


For information about the XenServer topology, consult the EMC Smarts Server Manager
User and Configuration Guide.


Verify that XenServer credentials are accepted in the log file
Verify that your XenServer credentials are accepted for the XenServer hypervisor by
checking your log file.


Procedure


1. Open the Server Manager log file in the opt/InCharge/ESM/smarts/local/
logs directory.


2. Locate the credential messages.


For example, the following messages indicate that the XenServer credentials are
accepted:


[December 3, 2014 7:27:40 AM EST +990ms] t@1262713152 
SM_ProtocolEngine-1 19488 IC Console - V9.4.0.0
DISC-*-CAL_FR-Credential_Util::addCredential : was called for 
credential: XEN-<IP_Address>


[December 3, 2014 7:27:41 AM EST +663ms] t@1262713152 
SM_ProtocolEngine-1 19488 IC Console - V9.4.0.0
DISC-*-CRT_CRED-Credential_Util::addCredential: Creating 
credential: XEN-<IP_Address>
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How to Update the XenServer Credentials for the Server Manager
Configuration


If the Citrix XenServer administrator changed the credentials for the XenServer hypervisor,
update the XenServer credentials for the Service Manager configuration.


Procedure


l Follow the instructions in Specify XenServer information on page 412, and then
perform a discovery (Topology > Discover All) from the Server Manager.
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Overview
Use this article to help you find solutions to issues you may have with SAM, the EMC M&R
platform, and the SolutionPack for Smarts.


Log files
Log files help you diagnose issues that you may have with SAM, the EMC M&R platform,
and the SolutionPack for EMC Smarts.


SAM log files
The SAM log file names may differ depending on the domain name. You can find these
log files in SAM/smarts/local/logs.


brstart_en_US_UTF-8.log
Created by the Smarts broker.


emc-alerts-es.log
Created by the elasticsearch service. The Notifications cache uses elasticsearch to
store and index its notifications to be served by the Alerts EDAA.


INCHARGE-SA-PRES.audit
The SAM audit log.


INCHARGE-SA-PRES_en_US_UTF-8.log
The SAM server log. In this case, the log's name represents the INCHARGE-SA-PRES
domain.


rabbit@<HOSTNAME>.log
Created by the RabbitMQ service. The Notification cache uses the RabbitMQ service
to transfer notifications from SAM to the Notification cache. This log file name
depends on the host name of the SAM installation.


setup_elasticsearch.log
Created the first time you run the elasticsearch service. This service must be primed
the first time it is run, and this log records the setup results.


setup_rabbitmq.log
Created the first time that you run the RabbitMQ service. This service must be primed
the first time it is run, and this log records the setup results.


sm_serviced_en_US_UTF-8.log
Created by the sm_serviced daemon process that is responsible for running the
registered Smarts services.


Tomcat log files
These log files are generated by Tomcat and any web applications running within Tomcat.
You can find these log files in SAM/smarts/local/logs/tomcat.


alerts-edaa.log
Created by the Alerts EDAA web application. This web application exposes
notifications in the Notification cache.


alerts-ingestion.log
Created by the alerts-ingestion web application. This web application populates
notifications in to the Notification cache that come from SAM via RabbitMQ.


catalina.<date>.log
The Tomcat engine writes log messages pertaining to Tomcat.
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catalina.out
Logs the code output running under Tomcat. This output is also written to
System.out or System.err.


localhost.<date>.log
Logs information about the virtual host within Tomcat. Always check this log if you
cannot find an error in catalina.out or if something is seriously wrong.


localhost_access_log.<date>.txt
Logs the calls being made to the Tomcat server.


smarts-edaa.log
Created by the smarts-edaa web application. This web application exposes the
topology from one or more domain managers in a RESTful feed.


Status checks on services
You can verify that the services are running and performing their required tasks.


Perform status checks on services by following these procedures:


l Checking elasticsearch on page 3


l Checking the notifications exchange on page 4


l Checking the RabbitMQ configuration on page 4


l Checking Alerts EDAA on page 5


l Checking Smarts EDAA on page 5


Checking elasticsearch
The elasticsearch service, a component of the Notifications cache, is only accessible from
the local machine. Verify this service is running and serving requests.


Procedure


1. Verify elasticsearch is running by typing $ smarts/bin/sm_service show.


The expected result is: RUNNING smarts-elasticsearch


2. Verify elasticsearch is serving requests from a browser on the same machine on
Windows or using a tool like curl on Linux.


Browser example:


http://localhost:9200/_status


A page specific to the browser appears.


Linux examples:


curl -XGET http://localhost:9200/_status
curl http://localhost:9200/smarts/alert/_count


A JSON page appears indicating success and showing Smarts as one of the indices.
For example:


"_shards":{"total":10,"successful":5,"failed":0}
.
.
.
"indices":{"smarts":...
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3. If the Smarts index does not exist, the setup script has failed. Check the
setup_elasticsearch.log file. Note that after you first start elasticsearch, it
may take a few minutes before the setup script begins running.


Checking the notifications exchange
The RabbitMQ service exchanges notifications from SAM to the Notification cache. This
service is running by default and is a password-protected web-based management
interface running on port 15672.


Procedure


1. Verify RabbitMQ is running: http://<HOSTNAME>:15672/
2. Type the credentials for the RabbitMQ interface. The default values are admin for the


user and changeme for the password.


The main page shows various statistics and status information for RabbitMQ.


Checking the RabbitMQ configuration
Follow these steps to check if the RabbitMQ service was properly configured.


When you start the sm_rabbitmq script, it verifies the RabbitMQ configuration and
creates the required exchanges, queues, users, and priming message in qnameq if they
do not exist. If this script fails, check the local/logs/setup_rabbitmq.log file.


Procedure


1. Log in to the RabbitMQ interface: http://<HOSTNAME>:15672/
2. Type the credentials for the RabbitMQ interface. The default values are admin for the


user and changeme for the password.


3. Verify these exchanges are under the Exchanges tab:


l emc.smarts.notifications (of type topic)


l emc.smarts.notifications.ingestion (of type x-consistent-hash)


4. Verify these queues are under the Queues tab:


l emc.smarts.notifications.q1, the main queue for holding notifications
for ingestion


l emc.smarts.notifications.qnameq
If a high number of messages appear under emc.smarts.notifications.q1,
ingestion is either backlogged or has stopped.


One message should appear under emc.smarts.notifications.qnameq.


5. Verify these users are defined under the Admin tab, and have access to the
emc.smarts.notifications vhost:


l admin (with the administrator tag)


l ingestion


l publisher
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Checking Tomcat
Verify Tomcat is running and serving requests.


Procedure


1. Verify Tomcat is running by typing $ bin/sm_service show.


The expected result is: RUNNING smarts-tomcat


2. Verify Tomcat is serving requests from a browser: http://<HOSTNAME>:8080/


A welcome page for Tomcat Version 8.x appears.


Checking Alerts EDAA
Verify the Alerts EDAA, a component of the Notification cache, is running and connected
to elasticsearch.


Procedure


1. Verify Tomcat is running, as described in Checking Tomcat on page 5.


2. Verify alerts_edaa is running.


For example:


http://itops-qa-192.lss.emc.com:8080/alerts-edaa/msa?
alt=json&pretty=true


3. Make sure there is an entry for alerts on the page.


4. Check that the cache is connected to the elasticsearch service and has the expected
notifications.


For example:


http://itops-qa-192.lss.emc.com:8080/alerts-edaa/msa/alerts/
instances?alt=json&pretty=true


Checking Smarts EDAA
Verify the Smarts EDAA is running, connected to the broker and is able to retrieve
information from your presentation SAM.


Procedure


1. Verify Tomcat is running, as described in Checking Tomcat on page 5.


2. Verify smarts-edaa is running.


For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa?
alt=json&pretty=true


3. Make sure there are entries for the dmbroker and the presentation SAM.


4. Verify smarts-edaa is connected to the broker.


For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa/
dmbroker/types/DomainManager/instances?alt=json&pretty=true


5. Make sure there are entries for the various domains registered with the broker.


6. Verify smarts-edaa can retrieve information from your presentation SAM.
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For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa/
INCHARGE-SA-PRES/instances/SM_System::SM-System?
alt=json&pretty=true


7. Make sure you can see the properties of SM_System::SM-System.


Unable to access Smarts EDAA
If your system cannot access Smarts EDAA, follow these steps.


Procedure


1. Verify the SAM server is not using a broker from a pre-9.4 Smarts installation.


2. Verify the SAM broker is configured for Smarts EDAA access:
<SAM_base_directory>/SAM/smarts/bin> dmctl -s localhost:426/
dmbroker getI EDAAService


The expected result is: SMARTS-EDAA
3. If you made configuration changes to the broker or SAM using the runcmd_env.sh


file, do the following in this order:


a. Shutdown SAM.


b. Shutdown Tomcat.


c. Shutdown the broker.


d. Restart the broker.


e. Restart Tomcat.


f. Restart SAM.


Notification cache is empty
Follow these steps when notifications are not appearing in the Notification cache.


Before you begin


Review this before you start the troubleshooting steps.


l If alerts show up in the Alerts EDAA but not in EMC M&R, the issue is in EMC M&R.


l If you see a backup of messages in RabbitMQ, the SAM publisher is working but the
ingestion service or elasticsearch service may be failing.


l If no messages are passing through into RabbitMQ, the problem is on the SAM
publisher side.


Procedure


1. Verify all services are running, as described in Status checks on services on page 3.


2. Check that SAM has started to publish to RabbitMQ and started with --
bootstrap=bootstrap-amqp.conf.


3. Verify SAM is exposed via the EDAA and started with --edaa=sam-
presentation/2.0.


4. Under the Connections tab in the RabbitMQ web-based management interface, do the
following:
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a. Verify that there are two connections: one from RabbitMQ / Java and the other from
rabbitmq-c.


b. If RabbitMQ / Java is not present, check if Tomcat is running and view the
<SAM_base_directory>/SAM/smarts/local/logs/tomcat/alert-
ingestion.


c. If rabbitmq-c is not present and if SAM is running, check the presentation SAM log
to see if it is publishing to RabbitMQ.


5. From the host running the presentation SAM server, check if you can access the
elasticsearch database and verify the count from a browser on Windows or using a
tool like curl on Linux.


Browser example:


http://localhost:9200/smarts/alert/_count


Linux example:


curl http://localhost:9200/smarts/alert/_count


A result similar to this appears:


{"count":50002,"_shards":{"total":5,"successful":5,"failed":0}}
6. If the count is zero, check if there are any notifications in SAM.


7. From a browser, check if you can access Tomcat in the SAM server host.


For example:


http://hostname:8080
8. Verify elasticsearch is running by checking <SAM_base_directory>/SAM/


smarts/local/logs/tomcat/alert-ingestion.log
If the service was running and is now shut down or unable to process notifications, a
message similar to this may appear in the alerts-ingestion.log file:


{date} {time},{pid} INFO  'ALERTS-IN' EventConsumerService 
EventConsumerPool-1 watchdog attemps to reconnect   
 {date} {time},{pid} INFO  'ALERTS-IN' plugins EventConsumerPool-1 
[La Lunatica] loaded [], sites [] {date} {time}
 {date} {time},{pid} ERROR 'ALERTS-IN' 
ElasticsearchNodeConfigurationService EventConsumerPool-1  
 ElasticSearchNodeConfigurationService::verifyIndexing: 
ElasticSearch :   
 
SERVICE_UNAVAILABLE :org.elasticsearch.client.transport.NoNodeAvail
ableException: No node available
 {date} {time},{pid} INFO  'ALERTS-IN' transport elasticsearch[Ent]
[generic][T#8] [Ent] failed to get node info for [#transport#-1]
[inet  
 [localhost/127.0.0.1:9300]], disconnecting...  
 org.elasticsearch.transport.NodeDisconnectedException: []
[inet[localhost/127.0.0.1:9300]][cluster/nodes/info] disconnected


Stale alerts and messages appear in Notification cache
If the Notification cache contains stale alerts and messages, you can synchronize SAM
and the Notifications cache. This happens when you restart SAM with a different RPS file.


You have two options to synchronize SAM and the Notification cache:


l Stopping the SAM publisher to clear the Notification cache on page 8. This is the
recommended option because it has low impact on the system.
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l Stopping SAM to clear the Notification cache on page 8.


Stopping the SAM publisher to clear the Notification cache
This method of clearing the Notification cache has less impact on the system because
you are only stopping the SAM publisher.


Procedure


1. Stop the publisher: $ bin/dmctl -s INCHARGE-SA-PRES invoke
SM_AMQPNotificationPublisher::SM-AMQPNotificationPublisher stop


2. Clear the Notifications cache by typing these commands:


a. $ bin/sm_service stop smarts-elasticsearch


b. $ rm -rf local/repos/emc-alerts-es


c. $ bin/sm_service start smarts-elasticsearch
3. Restart the publisher: $ bin/dmctl -s INCHARGE-SA-PRES invoke


SM_AMQPNotificationPublisher::SM-AMQPNotificationPublisher start


Stopping SAM to clear the Notification cache
This method of clearing the Notification cache has a substantial impact on the system.


Procedure


1. Stop SAM: $ bin/sm_service stop ic-sam-pres
2. Clear the Notifications cache by typing these commands:


a. $ bin/sm_service stop smarts-elasticsearch


b. $ rm -rf local/repos/emc-alerts-es


c. $ bin/sm_service start smarts-elasticsearch
3. Restart SAM: $ bin/sm_service start ic-sam-pres


RabbitMQ does not start
Follow these steps to determine why the RabbitMQ service does not start.


Procedure


1. Verify RabbitMQ is NOT already running by typing sm_service show.


2. Verify the Erlang process is NOT running by typing ps -ef | grep erl.


3. If the Erlang process is running, kill it before restarting RabbitMQ.


The Erlang process may be running from a prior installation, or was started outside the
sm_service mechanism.


4. Verify the qpidd process is NOT running by typing ps -ef | grep qpidd.


5. If the qpidd process is running, kill it before restarting the RabbitMQ service.


The qpidd process runs on some Linux distributions and can conflict with RabbitMQ
by using the same port.


6. Check that no other RabbitMQ installation exists by typing ps -ef | grep rabbit.
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Tomcat does not start
Follow these steps to determine why Tomcat does not start.


Procedure


1. Verify that Tomcat is NOT already running by typing sm_service show.


Tomcat may be running from a prior install, or was started outside of the
sm_service mechanism. Also, another instance of Tomcat or another web server
may be running on the system that prevents this Tomcat instance from binding to port
8080, causing it to shut down.


2. Verify the underlying application is not already running Tomcat by typing ps -ef |
grep java.
If you see that the /opt/InCharge/SAM/smarts/tomcat/bin/
bootstrap.jar process is running, then Tomcat is likely running as well.


3. Review the messages in SAM/smarts/local/logs/tomcat/catalina.out
and SAM/smarts/local/logs/tomcat/catalina.<date>.log.


Tomcat starts but then stops
Procedure


1. Follow the steps in Tomcat does not start on page 9


2. Check if another process is running on port 8080.


This can cause Tomcat to start for a few minutes and then return to a NOT RUNNING
state.


Changing the password of the EDAA account
The Smarts EDAA logs into domains using the EDAA account _edaa. This account has the
same access privileges as the admin account as well as the ability to perform actions on
behalf of other users. To secure this account, change its default password, which is
changeme.


Procedure


1. In the install directory of each domain server accessed by Smarts EDAA, type
sm_edit conf/serverConnect.conf
By default, only presentation SAM is exposed.


2. In the serverConnect.conf file, change the encrypted default password for the
_edaa account.


For example, you can change this password:


*:_edaa:<E-1.0>94C355DA7E0EB7AADE32F80F201F70C5CCA88288443EE23CB524
9ACD10C773E1:Impersonate


to the new password:


*:_edaa:<new_password>:Impersonate
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When you save the serverConnect.conf file, sm_edit encrypts the new
password.


3. In the install directory of the SAM server hosting the Smarts EDAA, type sm_edit
conf/edaaClientConnect.conf


4. In the edaaClientConnect file, change the encrypted default password for the
_edaa account.


For example, you can change this password:


*:*:_edaa:<E-1.0>94C355DA7E0EB7AADE32F80F201F70C5CCA88288443EE23CB5
249ACD10C773E1


to the new password:


*:*:_edaa:<new_password>


When you save the edaaClientConnect file, sm_edit encrypts the new
password.


5. Stop the Smarts Tomcat hosting the Smarts EDAA by typing bin/sm_service
stop smarts-tomcat.


6. Restart the Smarts Tomcat hosting the Smarts EDAA by typing bin/sm_service
start smarts-tomcat.


7. Verify that the Smarts EDAA can access each domain.


How do I change the RabbitMQ passwords
There are three default accounts in the RabbitMQ installation: an admin account, an
account used by the SAM publisher to deliver messages into RabbitMQ, and an account
used by the ingestion process to pull messages from RabbitMQ. You can change the
password for each one of these accounts.


Follow these procedures to change the passwords of the RabbitMQ accounts:


l Changing the RabbitMQ admin password on page 10


l Changing the RabbitMQ publisher password on page 11


l Changing the RabbitMQ ingestion password on page 12


Changing the RabbitMQ admin password
The RabbitMQ admin account is used for configuring RabbitMQ and accessing
RabbitMQ's web-based management interface. It is not used by any other component of
the system except for the initial RabbitMQ setup process.


Procedure


1. Make sure the smarts-rabbitmq service was started.


2. To access the RabbitMQ web-based management interface, connect with a browser to
port 15672 on the host where RabbitMQ is installed.


For example:


http://my-pres-sam-host.example.com:15672/
3. Log in as admin using the default password of changeme.


4. If this is the first time RabbitMQ was started, make sure the first-time setup has
completed before continuing, as explained Checking the RabbitMQ configuration on
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page 4. The setup process uses the default admin/changeme login credentials to
make changes to RabbitMQ.


5. Click the Admin tab and select admin from the list of RabbitMQ login users.


6. Click Update this user.


7. Type the new password in both password fields. Do not change the Tags field.


8. Click Update User.


A message appears indicating the login failed. This is because you changed the
password for the user that is currently logged on, making the password invalid.


9. Click Log Out.


A new login form appears.


10.Type admin and the new password to confirm the password was successfully
changed.


Changing the RabbitMQ publisher password
The publisher is a component in the presentation SAM domain that sends notifications
into RabbitMQ. The RabbitMQ login for this process is publisher with the default
password of changeme. To change this password, you must update both RabbitMQ and
the SAM configuration with a new matching password.


Procedure


1. Log in to the RabbitMQ web-based management interface as admin.


2. Click the Admin tab and select publisher from the list of RabbitMQ login users.


3. Click Update this user.


4. Enter the new password in both password fields.


5. Click Update User.


6. To change the password in the SAM configuration:


a. Log in to the host where the presentation SAM is installed.


b. Type sm_edit conf/clientConnect.conf.


c. In the clientConnect.conf file, look for a line beginning with AMQP/*
It is similar to this:


*:AMQP/
*:publisher:<E-1.0>94FF41842043EDA1DE6E67FB08015B3D456752865F8B5
D7DC63F259270B36092


d. In the AMQP/*" line, replace the password field with the same password that you
entered for the RabbitMQ publisher account.


In this example, the password was set to california:


*:AMQP/*:publisher:california


e. Save clientConnect.conf and exit sm_edit.


7. Restart the publisher by connecting to your presentation SAM using dmctl.


For example:


a. $ dmctl -s INCHARGE-SA-PRES
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b. dmctl> invoke SM_AMQPNotificationPublisher::SM-
AMQPNotificationPublisher stop


Note


If the stop command hangs, verify that you entered the same password for the


RabbitMQ publisher and SAM.


c. dmctl> invoke SM_AMQPNotificationPublisher::SM-
AMQPNotificationPublisher start


8. In the RabbitMQ interface, click the Connections tab and verify the publisher is
connected.


Changing the RabbitMQ ingestion password
Alert-ingestion is a component running in Tomcat that pulls notifications from RabbitMQ
and inserts them in to the Notification cache. The RabbitMQ login for this service is
ingestion with the default password of changeme. To change this password, you
must update both RabbitMQ and the alerts-ingestion configuration with a new matching
password.


Procedure


1. Log in to the RabbitMQ web-based management interface as admin.


2. Click the Admin tab and select ingestion from the list of RabbitMQ login users.


3. Click Update this user.


4. Enter the new password in both password fields.


5. Click Update User.


6. To change the password in alerts-ingestion:


a. Stop the Smarts Tomcat service by typing sm_service stop smarts-tomcat.


b. Using a text editor, open the file smarts/tomcat/webapps/alerts-
ingestion/WEB-INF/classes/rabbitmq-config.xml.


c. Find the password line that looks like this:


<property name="password" value="changeme" />


d. Replace changeme with the new password.


In this example, the password was changed to california:


<property name="password" value="california" />


e. Restart the Smarts Tomcat service by typing sm_service start smarts-
tomcat.


7. In the RabbitMQ interface, click the Connections tab and verify alerts-ingestion is
connected. It may take a few minutes for Tomcat to start and for alerts-ingestion to
connect.
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UI cannot display alerts or Smarts topology when CAS is enabled
Follow these steps when the Central Authentication Service is enabled and the UI is
unable to display information about alerts and objects in the Smarts topology.


Procedure


1. Verify the status of the Alerts EDAA, as described in Checking Alerts EDAA on page 5.


2. Verify the status of the Smarts EDAA, as described in Checking Smarts EDAA on page
5.


3. If Tomcat is running but queries to the EDAA result in the browser hanging, type this
command on the SAM server:


cd /opt/InCharge/SAM/smarts/bin
./runcmd_env.sh


4. In the runcmd_env.sh output:


a. If SM_CAS_SERVER exists, verify this entry includes the protocol, fully-qualified
domain name of the EMC M&R host, and the port number. Make sure there is
nothing after the port number (not even a "/").


b. If the https protocol is used, make sure the port is correct for https.


c. Verify SM_TOMCAT_SERVER has an URL for Tomcat that is part of the SAM
installation.


d. Make sure localhost and 127.0.0.1 are NOT in SM_CAS_SERVER or
SM_TOMCAT_SERVER entries. These environment variables must contain URLs
that reach services from outside the host machine.


Wrong CAS host name in runcmd_env.sh
The UI informs you when you entered an incorrect Central Authentication Service host
name in the runcmd_env.sh script.


This error message appears throughout the UI when you specify an incorrect host name
for CAS in runcmd_env.sh:


java.util.concurrent.ExecutionException:com.emc.asd.mashupengine.utils
.JSONException:A JSONObject text must begin with '{' at 1 [character 
2 line 1] 


Procedure


l Specify the correct CAS host name in the runcmd_env.sh script.


Services remain registered and running after an uninstall
If you did not stop all services before performing an uninstall, the services are still
running and using ports. If you do not want to reboot your system, you must manually
stop these services to allow other services to use these ports.


An uninstall only removes those services that were configured during the installation of
the software being uninstalled. If there are services configured by a second installation
on the same host or by manually invoking sm_service install, those services are
not removed.
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Follow these procedures to stop services:


l Stopping services on Linux on page 14


l Stopping services on Windows on page 15


Stopping services on Linux
Follow this procedure if you did not stop all services before performing an uninstall. This
procedure shows you examples of how to find the process IDs of the services that you
need to stop on Linux systems.


Procedure


1. Find the process ID for elasticsearch, a Java process running
org.elasticsearch.bootstrap.ElasticSearch
For example:


root      7223 10165  0 Jun05 ?        00:11:36 /opt/InCharge/SAM/
smarts/jre/bin/java -cp /opt/InCharge/SAM/smarts/toolbox/
elasticsearch/lib/elasticsearch-0.90.7.jar:/opt/InCharge/SAM/
smarts/toolbox/elasticsearch/lib/*:/opt/InCharge/SAM/smarts/
toolbox/elasticsearch/lib/sigar/* -Xms1g -Xmx1g -Xss256k -
Djava.awt.headless=true -XX:+UseParNewGC -XX:+UseConcMarkSweepGC -
XX:CMSInitiatingOccupancyFraction=75 -XX:
+UseCMSInitiatingOccupancyOnly -XX:+HeapDumpOnOutOfMemoryError -
Delasticsearch -Des.pidfile=/opt/InCharge/SAM/smarts/local/logs/
elasticsearch.pid -Des.foreground=yes -Des.path.home=/opt/
InCharge/SAM/smarts/toolbox/elasticsearch -Des.path.data=/opt/
InCharge/SAM/smarts/local/repos -Des.path.logs=/opt/InCharge/SAM/
smarts/local/logs -Des.path.conf=/opt/InCharge/SAM/smarts/conf/
elasticsearch org.elasticsearch.bootstrap.ElasticSearch


2. Find the process ID for Tomcat, a Java process running
org.apache.catalina.startup.Bootstrap
For example:


root     12495 10165  0 Jun05 ?        00:31:17 /opt/InCharge/SAM/
smarts/jre/bin/java -Xrs -Xms1g -Xmx3g -XX:PermSize=512m -XX:
+HeapDumpOnOutOfMemoryError -classpath /opt/InCharge/SAM/smarts/
tomcat/bin/bootstrap.jar:/opt/InCharge/SAM/smarts/tomcat/bin/
tomcat-juli.jar:/opt/InCharge/SAM/smarts/local/l10n/spool:/opt/
InCharge/SAM/smarts/local/l10n:/opt/InCharge/SAM/smarts/l10n -
Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager -
Djava.util.logging.config.file=/opt/InCharge/SAM/smarts/tomcat/
conf/logging.properties -Djava.endorsed.dirs=/opt/InCharge/SAM/
smarts/tomcat/endorsed -Dsmarts.remote.broker=localhost:426 -
Dcatalina.logdir=/opt/InCharge/SAM/smarts/local/logs/tomcat -
Dcatalina.base=/opt/InCharge/SAM/smarts/tomcat -
Dcatalina.home=/opt/InCharge/SAM/smarts/tomcat -
Djava.io.tmpdir=/opt/InCharge/SAM/smarts/tomcat/temp -
Djava.awt.headless=true -Dcom.smarts.disable_ci_jni=true -
Djava.security.egd=file:/dev/./urandom -
Dcom.emc.msa.dmt.clientconnect=/opt/InCharge/SAM/smarts/conf/
edaaClientConnect.conf -Dsmarts.cas.server=https://itops-
dev-121.lss.emc.com:58443 -Dcom.smarts.incoming_protocol=1,0 -
Dcom.smarts.outgoing_protocol=1,0 -Dcom.smarts.fips_mode=FALSE -
Dsmarts.tomcat.server=https://itops-dev-120.lss.emc.com:8443 
org.apache.catalina.startup.Bootstrap --ignoreme start


3. Find the process ID for RabbitMQ, an Erlang beam process running with -s rabbit
For example:


root      7221 10165  0 Jun05 ?        00:24:03 /opt/InCharge/SAM/
smarts/toolbox/OTP/erts-5.9.3.1/bin/beam.smp -W w -K true -A30 -P 


Article


14 Service Assurance Suite 9.4  Article







1048576 -- -root /opt/InCharge/SAM/smarts/toolbox/OTP -progname 
erl -- -home /root -- -pa /opt/InCharge/SAM/smarts/toolbox/
rabbitmq/ebin -noshell -noinput -s rabbit boot -sname rabbit@itops-
dev-120 -boot start_sasl -config /opt/InCharge/SAM/smarts/conf/rmq/
rabbitmq.config -kernel inet_default_connect_options 
[{nodelay,true}] -sasl errlog_type error -sasl sasl_error_logger 
false -rabbit error_logger {file,"/opt/InCharge/SAM/smarts/local/
logs/rabbit@itops-dev-120.log"} -rabbit sasl_error_logger 
{file,"/opt/InCharge/SAM/smarts/local/logs/rabbit@itops-dev-120-
sasl.log"} -rabbit enabled_plugins_file "/opt/InCharge/SAM/smarts/
conf/rmq/enabled_plugins" -rabbit plugins_dir "/opt/InCharge/SAM/
smarts/toolbox/rabbitmq/plugins" -rabbit plugins_expand_dir "/opt/
InCharge/SAM/smarts/local/repos/rmq/rabbit@itops-dev-120-plugins-
expand" -os_mon start_cpu_sup false -os_mon start_disksup false -
os_mon start_memsup false -mnesia dir "/opt/InCharge/SAM/smarts/
local/repos/rmq/rabbit@itops-dev-120" --ignoreme


4. Use the process IDs to kill these three processes: $ kill -9 7223 12495 7221


Stopping services on Windows
Follow this procedure if you did not stop all services before performing an uninstall.


Procedure


1. Access the Services Management Console to see which services are still registered
and running.


2. Stop the services from the Services Management Console.


3. Delete the SAM directory from \InCharge\SAM.


4. Manually remove the services using the command prompt tool name sc. For example:


a. sc delete ic-broker


b. sc delete smarts-tomcat


c. sc delete ic-sam-server-pres


Retrieving the current elasticsearch PID
You can monitor the resource consumption of elasticsearch using the Linux top -p
<pid> command. This procedure explains where to retrieve the current process ID of
elasticsearch.


Procedure


l To determine the current process ID of elasticsearch, view <SMARTSHOME>/local/
logs/elasticsearch.pid.


Ports that must be open between SAM and EMC M&R
Ensure that the firewall between the server hosting SAM and the servers hosting EMC
M&R (Watch4net) are open. EMC M&R collects data from the Smarts domain managers.
Configure the firewall settings to allow access across ports.


Ports in use with HTTP (no SSL encryption)


l Tomcat server in Service Assurance Manager (SAM): 8080


l Tomcat server in EMC M&R (Watch4net): 58080


l Smarts Broker: 426 (also used for SSL encryption)
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l Smarts License Server: 1744 (also used for SSL encryption)


l Elasticsearch: 9200


l RabbitMQ: 15672


Ports in use with HTTPS enabled (SSL encryption)


l Tomcat server in SAM: 8443


l Tomcat server in EMC M&R (Watch4net): 58443


l Smarts Broker: 426


l Smarts License Server: 1744


Article
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README

		Ericsson IMS Metrics File

		P/N 302-001-056 Rev 01



		———————————————————————————————————————————————————————————————–

		File Name Format

		The name of the file has the format <Type><StartDate>.<StartTime>-<EndTime>_<NodeName>_<UniqueId>, where:



		Type – Specifies whether the file contains measurement results for single or multiple NEs and/or granularity.



		A indicates single NE, single granularity

		B indicates multiple NEs, single granularity

		C indicates single NE, multiple granularity

		D indicates multiple NE, multiply granularity



		StartDate – Specifies the UTC date when the observation period began and is in the form YYYYMMDD.

		StartTime – Specifies the UTC time when the observation period began and is in the form HHMM.

		EndTime – Specifies the UTC time when the observation period ended and is in the form HHMM.

		NodeName – Specifies the unique node name.

		UniqueId – The SOI application name.



		An example file name looks like :

		A20120725.1000-1100_ tbsi-hmbg-de01-test_ims-ems-activation



		where:

		A – single application, single granularity period

		20120725 – is the date when the observation period began

		1000 – is the time when the observation period began

		1100 – is the time when the observation period end

		tbsi-hmbg-de01-test – is the node name

		ims-ems-activation – is the SOI application generating the report



		Time Format

		Times in the measurement result files are expressed in local time in YYYY-MM-DDThh:mm:ss.sssTZ format, where:



		YYYY – four-digit year

		MM – two-digit month (01 through 12)

		DD – two-digit day of month (01 through 31)

		hh – two digits of hour (00 through 23)

		mm – two digits of minute (00 through 59)

		ss.sss – two digits of second (00 through 59) and one digit representing a decimal fraction of a second

		TZ – time zone designator (+hh:mm / -hh:mm)



		This time format corresponds to the date and time format defined in the W3C specification of the XML Schema Part2: Data types second edition



		An example time stamp looks like:

		2012-07-25T10:00:00.000+02:00

		oPMF: (File format only DTD 3GPP TS 32.104 v3.5.0) – multiple counter can be placed in 1 mi-XML-element

		nPMF: (File format XSD or DTD 3GPP TS 32.401 v5.0.0) – always single counter placed in 1 mi-XML-element

		———————————————————————————————————————————————————————————————–
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CSCF



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

				cscf		A20121206.2140-2145_ppcscfhan10_Cscf		A.*Cscf		This file will contains counter that has file pattern type as "cscf"

				cscf2		A20121206.2140-2145_ppcscfhan10_Cscf2		A.*Cscf2

				cscfsipserver		A20121206.2140-2145_ppcscfhan10_CscfSipServer		A.*CscfSipServer

				cscfsipclient		A20121206.2140-2145_ppcscfhan10_CscfSipClient		A.*CscfSipClient





				Counter Name		File Pattern Type

				pcscfPaniAssertionFailedEmptyUsed		cscf

				pcscfPaniAssertionFailedDefaultUsed		cscf

				cscfCx3gppMAA		cscf

				cscfCx3gppMAR		cscf

				cscfTermASInvocationFailureSessionTerminated		cscf

				cscfOrigASInvocationFailureSessionTerminated		cscf

				cscfTermASInvocationFailureSessionContinued		cscf

				cscfOrigASInvocationFailureSessionContinued		cscf

				cscfFailureCauseCode		cscf

				cscfUnallocatedRoutingAttemptSuccess		cscf

				pcscfExpiredEmergencySessions		cscf

				cscfSuccessfulEmergencySessionForRegisteredUser		cscf

				cscfSuccessfulEmergencySessionForUnregisteredUser		cscf

				cscfFailedEmergencySessionForRegisteredUser		cscf

				cscfFailedEmergencySessionForUnregisteredUser		cscf

				cscfLRFNoTelephoneNumber		cscf

				cscfLRFErrorCalledNumber		cscf

				cscfLRFNationalCalledNumber		cscf

				cscfLRFInternationalCalledNumber		cscf

				cscfMlSoapErrorResponses		cscf

				cscfMlHttpNoResponses		cscf

				cscfMlHttpErrorResponses		cscf

				cscfMlHttpSuccesses		cscf

				cscfShUDRExperimentalResults		cscf

				cscfShUDRNoResponses		cscf

				cscfShUDRErrorResponses		cscf

				cscfShUDRSuccesses		cscf

				ecscfExpiredEmergencySessions		cscf

				pcscfRxSipSessionContDelayedAAA		cscf

				pcscfRxSipSessionContOnDiaError		cscf

				pcscfRxSipSessionContOnTimeout		cscf

				pcscfRxSipSessionContOnUnsuccAAA		cscf

				cscfRxDiaInvalidAnswers		cscf

				CscfRxDiaASA		cscf

				CscfRxDiaASR		cscf

				CscfRxDiaSTA		cscf

				CscfRxDiaSTR		cscf

				CscfRxDiaNotRecAAA		cscf

				CscfRxDiaAAA		cscf

				CscfRxDiaAAR		cscf

				cscfSmpIdNotFound		cscf

				cscfSmpConfirmedAuthorizationFailure		cscf

				cscfSmpEarlyAuthorizationFailure		cscf

				cscfSmpConfirmedAuthorizationSuccess		cscf

				cscfSmpEarlyAuthorizationSuccess		cscf

				cscfRegistrationEventNotificationsSendSuccessful		cscf

				cscfRegistrationEventReSubscriptionSuccessful		cscf

				cscfRegistrationEventReSubscriptionFailures		cscf

				cscfRegistrationEventSubscriptionSuccessful		cscf

				cscfRegistrationEventSubscriptionFailures		cscf

				cscfRxBearerAuthorizationFailures		cscf

				cscfRxBearerAuthSessionModSuccesses		cscf

				cscfRxBearerAuthSessionEstSuccesses		cscf

				cscfRxBearerAuthSessionModAttempts		cscf

				cscfRxBearerAuthSessionEstAttempts		cscf

				cscfRxMediaAuthorizationFailures		cscf

				cscfRxMediaAuthSessionModSuccesses		cscf

				cscfRxMediaAuthSessionEstSuccesses		cscf

				cscfRxMediaAuthSessionModAttempts		cscf

				cscfRxMediaAuthSessionEstAttempts		cscf

				cscfNpLdapErrors		cscf

				cscfNpLdapPortedResults		cscf

				cscfNpLdapAttempts		cscf

				cscfCCACreditNotApplicable		cscf

				cscfCCACreditLimitReached		cscf

				cscfCCAUserUnknown		cscf

				cscfCCAEndUserServiceDenied		cscf

				cscfCCAPermanentFailures		cscf

				cscfCCATransientFailures		cscf

				cscfCCAProtocolErrors		cscf

				cscfCCASuccess		cscf

				cscfCCR		cscf

				cscfAuthenticatedTrustedGateway		cscf

				cscfActiveUsers		cscf

				cscfUserAgentRejections		cscf

				cscfUnauthMsgSizes		cscf

				cscfCurrentStoredRecords		cscf

				cscfACARedirectIndication		cscf

				cscfACAPermanentFailure		cscf

				cscfACAProtocolErrors		cscf

				cscfACABackup		cscf

				cscfACASuccess		cscf

				cscfStatsCxRedirectionLoopDetected		cscf

				cscfStatsCxIllegalCommandCodeRequestRedirections		cscf

				cscfStatsCxUnableToDecodeRequestRedirections		cscf

				cscfStatsCxMultimediaAuthRequestRedirections		cscf

				cscfStatsCxLocationInfoRequestRedirections		cscf

				cscfStatsCxLocationUserRequestRedirections		cscf

				cscfStatsCxUserAuthorizationRequestRedirections		cscf

				cscfCxDeregisterAnswersErrUnableToComply		cscf

				cscfCxDeregisterAnswersErrInvalidAVPValue		cscf

				cscfCxDeregisterAnswersAvpUnsupported		cscf

				cscfCxDeregisterAnswersErrUserUnknown		cscf

				cscfCxUpdateDataAnswersErrUnableToComply		cscf

				cscfCxUpdateDataAnswersErrInvalidAVPValue		cscf

				cscfCxUpdateDataAnswersNotSupportedUserData		cscf

				cscfCxUpdateDataAnswersErrUserUnknown		cscf

				cscfCxUpdateDataAnswersSuccess		cscf

				cscfCxUpdateDataRequestReceived		cscf

				cscfCxLocQueryUnregisteredServices		cscf

				cscfCxLocQueryAvpUnsupporteds		cscf

				cscfCxLocQueryUnableToComplys		cscf

				cscfCxLocQueryPublicIdUnknowns		cscf

				cscfCxLocQueryNotRegistereds		cscf

				cscfCxLocQuerySuccesses		cscf

				cscfCxLocQuerySents		cscf

				cscfCxSelPullIdentitiesDontMatch		cscf

				cscfCxSelPullAvpUnsupporteds		cscf

				cscfCxSelPullAuthRejecteds		cscf

				cscfCxSelPullRoamNotAlloweds		cscf

				cscfCxSelPullUnableToComplys		cscf

				cscfCxSelPullPublicIdUnknowns		cscf

				cscfCxSelPullInitRegistrations		cscf

				cscfCxSelPullRegistereds		cscf

				cscfCxSelPullSents		cscf

				cscfCxCongestions		cscf

				cscfCxPullIdentitiesDontMatch		cscf

				cscfCxPullAvpUnsupporteds		cscf

				cscfCxPullUnableToComplys		cscf

				cscfCxPullPublicIdUnknowns		cscf

				cscfCxPullSuccesses		cscf

				cscfCxPutIdentitiesDontMatch		cscf

				cscfCxPullSents		cscf

				cscfCxPutAvpUnsupporteds		cscf

				cscfCxPutAlreadyRegistereds		cscf

				cscfCxPutUnableToComplys		cscf

				cscfCxPutPublicIdUnknowns		cscf

				cscfCxPutSuccesses		cscf

				cscfCxPutSents		cscf

				cscfScscfAssignments		cscf

				cscfFailedSessions		cscf

				cscfServiceInvokations		cscf

				cscfConcurrentSessions		cscf

				cscfPeakConcurrentSessions		cscf

				cscfExpiredSessions		cscf

				cscfRejectedReregistrations		cscf

				cscfRejectedRegistrations		cscf

				cscfACR		cscf

				cscfRegistrationEventNotificationsSendFailures		cscf

				cscfTelBgcfOrigInvocationFailure		cscf

				cscfTelBgcfOrigInvocationSuccess		cscf

				cscfTelBgcfTermInvocationSuccess		cscf

				cscfTelBgcfTermInvocationFailure		cscf

				cscfSuccessfulSessions		cscf

				cscfAcceptedRegistrations		cscf

				cscfAcceptedReregistrations		cscf

				cscfAcceptedDeregistrations		cscf

				cscfRejectedDeregistrations		cscf

				cscfCxDeregisterAnswersSuccess		cscf

				cscfCxDeregisterAnswersReceived		cscf

				cscfCxDeregisterRequestReceived		cscf

				cscfConcurrentRegistrations		cscf

				cscfPeakConcurrentRegistrations		cscf

				cscfExpiredRegistrations		cscf

				ecscfSuccessfulEmergencySessions		cscf

				ecscfFailedEmergencySessions		cscf

				ecscfEmergencyMethodNotAllowed		cscf

				cscfAuthAkaSuccessful		cscf

				cscfAuthAkaFailures		cscf

				cscfRejectedUnprotectedMessages		cscf

				scscfThirdPartyRegistrationFailure		cscf2

				scscfThirdPartyRegistrationSuccess		cscf2

				pcscfAcceptedDeregistrationsPerAccess		cscf2

				pcscfAttemptedDeregistrationsPerAccess		cscf2

				pcscfAcceptedReregistrationsPerAccess		cscf2

				pcscfAttemptedReregistrationsPerAccess		cscf2

				pcscfAcceptedRegistrationsPerAccess		cscf2

				pcscfAttemptedRegistrationsPerAccess		cscf2

				scscfRegEventNetworkDeregisteredNotificationsSendFailures		cscf2

				scscfRegEventNetworkDeregisteredNotificationsSendSuccessful		cscf2

				scscfSuccessfulEmergencySessions		cscf2

				scscfFailedEmergencySessions		cscf2

				cscfCicRequest		cscf2

				cscfCicEnumResponseMalformatted		cscf2

				cscfCicEnumResponseCic		cscf2

				cscfGnpSIPRequest		cscf2

				cscfGnpEnumResponseMalformatted		cscf2

				cscfGnpEnumResponseRnNpdi		cscf2

				cscfGnpEnumResponseRn		cscf2

				cscfGnpEnumResponseNpdi		cscf2

				scscfTerminatingMessageFailed		cscf2

				scscfTerminatingMessageSuccess		cscf2

				scscfOriginatingMessageFailed		cscf2

				scscfOriginatingMessageSuccess		cscf2

				cscfBlacklistedAuthenticationRequests		cscf2

				cscfSipDigestAuthenticationFailure		cscf2

				cscfSipDigestAuthenticationSuccess		cscf2

				scscfGibaFailure		cscf2

				scscfGibaSuccess		cscf2

				scscfNbaChallengeFailure		cscf2

				cscfNBAFailure		cscf2

				cscfNBASuccess		cscf2

				icmpStatsParameterProblemIns		cscf2

				icmpStatsDestinationUnreachableIns		cscf2

				icmpSummaryInMessages		cscf2

				cscfTerminatingInviteNoAsAttempts		cscf2

				scscfTerminatingInviteCancelledInEarlyDialog		cscf2

				scscfOriginatingInviteCancelledInEarlyDialog		cscf2

				scscfTerminatingInviteCancelledBeforeEarlyDialog		cscf2

				scscfOriginatingInviteCancelledBeforeEarlyDialog		cscf2

				scscfTerminatingInviteToAsAnswered		cscf2

				scscfOriginatingInviteToAsAnswered		cscf2

				scscfTerminatingInviteNoAsAnswered		cscf2

				scscfOriginatingInviteNoAsAnswered		cscf2

				cscfUeTerminatingInviteFailure		cscf2

				cscfUeTerminatingInviteSuccess		cscf2

				cscfUeOriginatingInviteFailure		cscf2

				cscfUeOriginatingInviteSuccess		cscf2

				scscfTerminatingSessionExpired		cscf2

				scscfOriginatingSessionExpired		cscf2

				icscfTransitSessionFailures		cscf2

				icscfTransitSessionAttempts		cscf2

				cscfOriginatingInviteNoAsAttempts		cscf2

				scscfAccumulatedTerminatingCallTime		cscf2

				scscfAccumulatedOriginatingCallTime		cscf2

				scscfTerminatingInviteNoAsFailed		cscf2

				scscfTerminatingInviteToAsFailed		cscf2

				scscfOriginatingInviteNoAsFailed		cscf2

				scscfOriginatingInviteToAsFailed		cscf2

				scscfAccumulatedTerminatingSessionEstablishmentTime		cscf2

				scscfAccumulatedOriginatingSessionEstablishmentTime		cscf2

				scscfTerminatingInviteNoAsAttempts		cscf2

				scscfTerminatingInviteSuccessfulEstablishedNoAs		cscf2

				scscfTerminatingInviteSuccessfulEstablishedToAs		cscf2

				cscfOriginatingInviteToAsAttempts		cscf2

				scscfOriginatingInviteNoAsAttempts		cscf2

				scscfOriginatingInviteSuccessfulEstablishedToAs		cscf2

				scscfOriginatingInviteSuccessfulEstablishedNoAs		cscf2

				cscfNotifyFailure		cscf2

				cscfNotifySuccess		cscf2

				cscfUeTerminatingReSubscribeSuccess		cscf2

				cscfUeTerminatingReSubscribeFailure		cscf2

				cscfUeOriginatingReSubscribeFailure		cscf2

				cscfUeOriginatingReSubscribeSuccess		cscf2

				cscfUeTerminatingSubscribeSuccess		cscf2

				cscfUeTerminatingSubscribeFailure		cscf2

				cscfUeOriginatingSubscribeSuccess		cscf2

				cscfUeOriginatingSubscribeFailure		cscf2

				scscfInviteFromOtherDomainSuccess		cscf2

				scscfInviteFromOtherDomainFailure		cscf2

				scscfInviteToOtherDomainSuccess		cscf2

				scscfInviteToOtherDomainFailure		cscf2

				icscfInviteFromOtherDomainSuccess		cscf2

				icscfInviteFromOtherDomainFailure		cscf2

				icscfInviteToOtherDomainSuccess		cscf2

				icscfInviteToOtherDomainFailure		cscf2

				cscfTerminatingInviteFromAsToAsAttempts		cscf2

				cscfInviteCommunicationFailure		cscf2

				cscfTerminatingInviteFromAsAttempts		cscf2

				cscfRegistrationsFailure		cscf2

				cscfDeregistrationsFailure		cscf2

				cscfOrginatingInviteToAsAttempts		cscf2

				cscfOriginatingInviteFromAsAttempts		cscf2

				cscfTerminatingInviteToAsAttempts		cscf2

				cscfOriginatingInviteFromAsToAsAttempts		cscf2

				cscfReregistrationsFailure		cscf2

				pcscfRegistrationsFromVisitingUsersSuccess		cscf2

				pcscfRegistrationsFromVisitingUsersFailure		cscf2

				scscfRegistrationsFromVisitingDomainsSuccess		cscf2

				scscfRegistrationsFromVisitingDomainsFailure		cscf2

				scscfGetsPriorityInviteFailure		cscf2

				scscfGetsPriorityInviteEstablishedSuccess		cscf2

				scscfPeakConcurrentUnregisteredUserProfiles		cscf2

				cscfPeakConcurrentRegisteredUserProfiles		cscf2

				scscfConcurrentUnregisteredUserProfiles		cscf2

				cscfConcurrentRegisteredUserProfiles		cscf2

				icscfNoMatchingScscf		cscf2

				scscfRegistrationEventShortenedNotificationsSendFailures		cscf2

				scscfRegistrationEventShortenedNotificationsSendSuccessful		cscf2

				scscfThirdPartyRegistrationFailureSessionTerminated		cscf2

				sipStatsUdpCongestions		cscfsipserver

				sipStatsTcpCongestions		cscfsipserver

				sipStatsByeIns		cscfsipserver

				sipStatsCancelIns		cscfsipserver

				sipStatsExtMethodIns		cscfsipserver

				sipStatsInviteIns		cscfsipserver

				sipStatsMessageIns		cscfsipserver

				sipStatsNotifyIns		cscfsipserver

				sipStatsOptionsIns		cscfsipserver

				sipStatsPublishIns		cscfsipserver

				sipStatsReferIns		cscfsipserver

				sipStatsRegisterIns		cscfsipserver

				sipStatsSubscribeIns		cscfsipserver

				sipSummaryOutResponses		cscfsipserver

				sipSummaryInRequests		cscfsipserver

				sipStatsAckIns		cscfsipserver

				sipStatsSuccessClassOuts		cscfsipserver

				sipStatsServerFailClassOuts		cscfsipserver

				sipStatsReqFailClassOuts		cscfsipserver

				sipStatsRedirClassOuts		cscfsipserver

				sipStatsInfoClassOuts		cscfsipserver

				sipStatsGlobalFailClassOuts		cscfsipserver

				sigcompDecompressionSuccesses		cscfsipserver

				sigcompDecompressionFailures		cscfsipserver

				sigcompCompressionSuccesses		cscfsipserver

				sigcompCompressionFailures		cscfsipserver

				sipSummaryServerTransactions		cscfsipserver

				sipSummaryInResponses		cscfsipclient

				sipSummaryOutRequests		cscfsipclient

				sipStatsNotifyOuts		cscfsipclient

				sipStatsMessageOuts		cscfsipclient

				sipStatsAckOuts		cscfsipclient

				sipStatsByeOuts		cscfsipclient

				sipStatsCancelOuts		cscfsipclient

				sipStatsInviteOuts		cscfsipclient

				sipStatsExtMethodOuts		cscfsipclient

				sipStatsOptionsOuts		cscfsipclient

				sipStatsPublishOuts		cscfsipclient

				sipStatsReferOuts		cscfsipclient

				sipStatsRegisterOuts		cscfsipclient

				sipStatsSubscribeOuts		cscfsipclient

				sipStatsReqTimeout		cscfsipclient

				sipStatsSuccessClassIns		cscfsipclient

				sipStatsStackCongestions		cscfsipclient

				sipStatsServerFailClassIns		cscfsipclient

				sipStatsRetryMessage		cscfsipclient

				sipStatsRetrySubscribe		cscfsipclient

				sipStatsRetryRegisters		cscfsipclient

				sipStatsRetryOptions		cscfsipclient

				sipStatsRetryInvites		cscfsipclient

				sipStatsRetryCancels		cscfsipclient

				sipStatsRetryByes		cscfsipclient

				sipStatsRetryRefer		cscfsipclient

				sipStatsRetryPublish		cscfsipclient

				sipStatsRetryNotify		cscfsipclient

				sipStatsRetryNonFinalResponses		cscfsipclient

				sipStatsRetryFinalResponses		cscfsipclient

				sipStatsRetryExtMethod		cscfsipclient

				sipStatsReqFailClassIns		cscfsipclient

				sipStatsRedirClassIns		cscfsipclient

				sipStatsInfoClassIns		cscfsipclient

				sipStatsGlobalFailClassIns		cscfsipclient

				sipSummaryNonSipMessages		cscfsipclient

				sipSummaryClientTransactions		cscfsipclient



The following regExp is the default pattern for each  counter family:
^A[0-9] *Cscf2*
^A[0-9] *Cscf*
^A[0-9] *Cscf2SipClient*
^A[0-9] *CscfSipServer*

Files name examples:
A20121206.2140-2145_ppcscfhan10_Cscf
A20121206.2140-2145_ppcscfhan10_Cscf2
A20121206.2140-2145_ppcscfhan10_CscfSipClient
A20121206.2140-2145_ppcscfhan10_CscfSipServer




HSS-SLF



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

				HSS-ISM		A20130213.2145-2150_pphss10_HSS-ISM		A20.*_HSS-ISM		This file will contains counter that has file pattern type as "HSS-ISM"

				HSS-SDA		A20130213.2145-2150_pphss10_HSS-SDA		A20.*_HSS-SDA

				HSS-SLF		A20130213.2145-2150_pphss10_HSS-SLF		A20.*_HSS-SLF





				Counter Name		File Pattern Type

				IsmAnsiMapAsreportSubscriberUnknownResponses		HSS-ISM

				IsmAnsiMapAsreportTimeoutResponses		HSS-ISM

				IsmAnsiMapAsreportSuccessResponses		HSS-ISM

				IsmAnsiMapAsreportRequests		HSS-ISM

				IsmAnsiMapAuthreqSubscriberUnknownResponses		HSS-ISM

				IsmAnsiMapAuthreqTimeoutResponses		HSS-ISM

				IsmAnsiMapAuthreqSuccessResponses		HSS-ISM

				IsmAnsiMapAuthreqRequests		HSS-ISM

				IsmMapSaiSubscriberUnknownResponses		HSS-ISM

				IsmMapSaiTimeoutResponses		HSS-ISM

				IsmMapSaiSuccessResponses		HSS-ISM

				IsmMapSaiRequests		HSS-ISM

				IsmMapAtiSubscriberUnknownResponses		HSS-ISM

				IsmMapAtiTimeoutResponses		HSS-ISM

				IsmMapAtiSuccessResponses		HSS-ISM

				IsmMapAtiRequests		HSS-ISM

				TotalNumberUnsuccessNonceNotAcceptable		HSS-ISM

				TotalNumberUnsuccessAuthWrongDigest		HSS-ISM

				TotalNumberNonceUseExceeded		HSS-ISM

				TotalNumberNonceTimeExpired		HSS-ISM

				TotalNumberDigestAuthChallengesIssued		HSS-ISM

				TotalNumberSuccessDigestAuth		HSS-ISM

				TotalNumberAuthRequestsWithoutCredentials		HSS-ISM

				CxQueryAnswersDiaErrIdentityNotRegistered		HSS-ISM

				TotalNumberOfNonceStored		HSS-ISM

				NumberNonceValuesReplaced		HSS-ISM

				TotalNumberOfPsiUsersUnregistered		HSS-ISM

				TotalNumberOfUsersWithPublicIdUnregistered		HSS-ISM

				TotalNumberOfPublicIdsUnregistered		HSS-ISM

				TotalNumberOfUsersRegistered		HSS-ISM

				TotalNumberOfPublicIdsRegistered		HSS-ISM

				TotalNumberWildcardedPUIsDefined		HSS-ISM

				TotalNumberWildcardedPSIsDefined		HSS-ISM

				TotalNumberOfPsiTelPublicIdsStored		HSS-ISM

				TotalNumberOfPsiSipPublicIdsStored		HSS-ISM

				TotalNumberOfPsiUsersStored		HSS-ISM

				TotalNumberOfPublicIdsBarred		HSS-ISM

				TotalNumberOfUsersBarred		HSS-ISM

				TotalNumberOfTelPublicIdsStored		HSS-ISM

				TotalNumberOfSipPublicIdsStored		HSS-ISM

				TotalNumberOfUsersStored		HSS-ISM

				TotalNumberOfSubscribersStored		HSS-ISM

				IsmExtDbDiscardedRequestsDueLackOfResources		HSS-ISM

				IsmExtDbSearchOverloadErrors		HSS-ISM

				IsmExtDbSearchTimeoutResponses		HSS-ISM

				IsmExtDbSearchErrorResponses		HSS-ISM

				IsmExtDbSearchSuccessResponses		HSS-ISM

				IsmExtDbSearchRequests		HSS-ISM

				IsmExtDbModifyOverloadErrors		HSS-ISM

				IsmExtDbModifyTimeoutResponses		HSS-ISM

				IsmExtDbModifyErrorResponses		HSS-ISM

				IsmExtDbModifySuccessResponses		HSS-ISM

				IsmExtDbModifyRequests		HSS-ISM

				IsmSoapProvNotifMessagesRefused		HSS-ISM

				IsmSoapProvNotifMessagesSuccess		HSS-ISM

				SihPushNotifAnswersSentDiaUnableToComply		HSS-ISM

				SihPushNotifAnswersSentDiaMissingAvp		HSS-ISM

				SihPushNotifAnswersSentDiaInvalidAvpValue		HSS-ISM

				SihPushNotifAnswersSentDiaErrEventNotSubscribed		HSS-ISM

				SihPushNotifAnswersSentDiaSuccess		HSS-ISM

				SihPushNotifRequestsReceived		HSS-ISM

				SihPushNotifSentNoAnswers		HSS-ISM

				SihPushNotifAnswersReceivedDiaProtocolError		HSS-ISM

				SihPushNotifAnswersReceivedDiaTransientFailure		HSS-ISM

				SihPushNotifAnswersReceivedDiaPermanentFailure		HSS-ISM

				SihPushNotifAnswersReceivedDiaInvalidAvpValue		HSS-ISM

				SihPushNotifAnswersReceivedDiaSuccess		HSS-ISM

				SihPushNotifRequestsSent		HSS-ISM

				SihSubscribeNotifAnswersDiaErrNoSuchSubscription		HSS-ISM

				SihSubscribeNotifAnswersDiaErrSessionUnknown		HSS-ISM

				SihSubscribeNotifAnswersDiaErrUnsubscriptionNotAllowed		HSS-ISM

				SihSubscribeNotifAnswersDiaInvalidAvpValue		HSS-ISM

				SihSubscribeNotifNoAnswers		HSS-ISM

				SihSubscribeNotifAnswersDiaTransientFailure		HSS-ISM

				SihSubscribeNotifAnswersDiaPermanentFailure		HSS-ISM

				SihSubscribeNotifAnswersDiaProtocolError		HSS-ISM

				SihSubscribeNotifAnswersDiaSuccess		HSS-ISM

				SihSubscribeNotifRequests		HSS-ISM

				SihUserDataAnswersDiaErrMultipleSessionLimitExceeded		HSS-ISM

				SihUserDataAnswersDiaErrSessionUnknown		HSS-ISM

				SihUserDataAnswersDiaErrSubscriptionNotAllowed		HSS-ISM

				SihUserDataAnswersDiaErrSessionCannotBeRead		HSS-ISM

				SihUserDataNoAnswers		HSS-ISM

				SihUserDataAnswersDiaProtocolError		HSS-ISM

				SihUserDataAnswersDiaTransientFailure		HSS-ISM

				SihUserDataAnswersDiaPermanentFailure		HSS-ISM

				SihUserDataAnswersDiaSuccess		HSS-ISM

				SihUserDataRequests		HSS-ISM

				ZxAuthDataAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				ZxAuthDataAnswersDiaErrSsoUnavailableForUser		HSS-ISM

				ZxAuthDataSsoNumberOfFailedNetworkIdComparisonFailed		HSS-ISM

				ZxAuthDataSsoNumberOfFailedRequests		HSS-ISM

				ZxAuthDataSsoNumberOfRequests		HSS-ISM

				ZxAuthDataAnswersDiaAvpOccursTooManyTimes		HSS-ISM

				ZxAuthDataAnswersDiaMissingAvp		HSS-ISM

				ZxAuthDataAnswersDiaErrAuthSchemeNotSupported		HSS-ISM

				ZxAuthDataAnswersDiaInvalidAvpValue		HSS-ISM

				ZxAuthDataAnswersDiaUserBlocked		HSS-ISM

				ZxAuthDataAnswersDiaAuthenticationRejected		HSS-ISM

				ZxAuthDataAnswersDiaUnableToComply		HSS-ISM

				ZxAuthDataAnswersDiaErrUserUnknown		HSS-ISM

				ZxAuthDataAnswersDiaSuccess		HSS-ISM

				ZxAuthDataRequests		HSS-ISM

				CxPutPull3gppAnswersDiaErrAssignmentType		HSS-ISM

				CxPutPull3gppAnswersDiaErrFeatureUnsupported		HSS-ISM

				CxPutPull3gppAnswersDiaErrIdentityAlreadyRegistered		HSS-ISM

				CxPutPull3gppAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxPutPull3gppAnswersDiaAvpOccursTooManyTimes		HSS-ISM

				CxPutPull3gppAnswersDiaInvalidAvpValue		HSS-ISM

				CxPutPull3gppAnswersDiaMissingAvp		HSS-ISM

				CxPutPull3gppAnswersDiaErrUserUnknown		HSS-ISM

				CxPutPull3gppAnswersDiaUnableToComply		HSS-ISM

				CxPutPull3gppAnswersDiaSuccessServerNotStored		HSS-ISM

				CxPutPull3gppAnswersDiaSuccess		HSS-ISM

				CxPutPull3gppRequests		HSS-ISM

				CxUpdateSubscrDataAnswersDiaPermanentFailure		HSS-ISM

				CxUpdateSubscrDataAnswersDiaTransientFailure		HSS-ISM

				CxUpdateSubscrDataAnswersDiaProtocolError		HSS-ISM

				CxUpdateSubscrDataAnswersDiaTooBusy		HSS-ISM

				CxUpdateSubscrDataAnswersDiaErrTooMuchData		HSS-ISM

				CxUpdateSubscrDataAnswersDiaErrNotSupportedUserData		HSS-ISM

				CxUpdateSubscrDataAnswersDiaErrUserUnknown		HSS-ISM

				CxUpdateSubscrDataAnswersDiaSuccess		HSS-ISM

				CxUpdateSubscrDataNoAnswers		HSS-ISM

				CxUpdateSubscrDataRequests		HSS-ISM

				CxDeregisterAnswersDiaTransientFailure		HSS-ISM

				CxDeregisterAnswersDiaProtocolError		HSS-ISM

				CxDeregisterAnswersDiaTooBusy		HSS-ISM

				CxDeregisterAnswersDiaErrUserUnknown		HSS-ISM

				CxDeregisterAnswersDiaSuccess		HSS-ISM

				CxDeregisterNoAnswers		HSS-ISM

				CxDeregisterRequests		HSS-ISM

				TotalNumberAuthData3gppWrongVectorTypeReceive		HSS-ISM

				CxAuthData3gppAnswersDiaInvalidAvpValue		HSS-ISM

				CxAuthData3gppAnswersDiaErrFeatureUnsupported		HSS-ISM

				CxAuthData3gppAnswersDiaAvpOccursTooManyTimes		HSS-ISM

				CxAuthData3gppAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxAuthData3gppAnswersDiaMissingAvp		HSS-ISM

				CxAuthData3gppResynchRequests		HSS-ISM

				CxAuthData3gppAnswersDiaUnableToComply		HSS-ISM

				CxAuthData3gppAnswersDiaErrAuthSchemeUnsupported		HSS-ISM

				CxAuthData3gppAnswersDiaErrUserUnknown		HSS-ISM

				CxAuthData3gppAnswersDiaSuccess		HSS-ISM

				CxAuthData3gppRequests		HSS-ISM

				CxAuthDataSsoNumberOfFailedNetworkIdComparisonFailed		HSS-ISM

				CxAuthDataSsoNumberOfFailedRequests		HSS-ISM

				CxAuthDataSsoNumberOfRequests		HSS-ISM

				CxAuthDataAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxAuthDataAnswersDiaMissingAvp		HSS-ISM

				CxAuthDataAnswersDiaInvalidAvpValue		HSS-ISM

				CxAuthDataAnswersDiaAuthenticationRejected		HSS-ISM

				CxAuthDataAnswersDiaUnableToComply		HSS-ISM

				CxAuthDataAnswersDiaErrUserUnknown		HSS-ISM

				CxAuthDataAnswersDiaMultiRoundAuth		HSS-ISM

				CxAuthDataAnswersDiaSuccess		HSS-ISM

				CxAuthDataRequests		HSS-ISM

				CxPutAnswersDiaInvalidAvpValue		HSS-ISM

				CxPutAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxPutAnswersDiaErrIdentityAlreadyRegistered		HSS-ISM

				CxPutAnswersDiaMissingAvp		HSS-ISM

				CxPutAnswersDiaUnableToComply		HSS-ISM

				CxPutAnswersDiaErrUserUnknown		HSS-ISM

				CxPutAnswersDiaSuccess		HSS-ISM

				CxPutRequests		HSS-ISM

				CxLocationQuery3gppAnswersDiaMissingAvp		HSS-ISM

				CxLocationQuery3gppAnswersAvpOccursTooManyTimes		HSS-ISM

				CxLocationQuery3gppAnswersDiaInvalidAvpValue		HSS-ISM

				CxLocationQuery3gppAnswersDiaErrFeatureUnsupported		HSS-ISM

				CxLocationQuery3gppAnswersDiaUnregisteredService		HSS-ISM

				CxLocationQuery3gppAnswersDiaUnableToComply		HSS-ISM

				CxLocationQuery3gppAnswersDiaErrUserUnknown		HSS-ISM

				CxLocationQuery3gppAnswersDiaErrIdentityNotRegistered		HSS-ISM

				CxLocationQuery3gppAnswersDiaSuccess		HSS-ISM

				CxLocationQuery3gppRegistrationAndCapabilitiesRequests		HSS-ISM

				CxLocationQuery3gppRequests		HSS-ISM

				CxLocationQueryAnswersDiaInvalidAvpValue		HSS-ISM

				CxLocationQueryAnswersDiaUnregisteredService		HSS-ISM

				CxLocationQueryAnswersDiaUnableToComply		HSS-ISM

				CxLocationQueryAnswersDiaErrUserUnknown		HSS-ISM

				CxLocationQueryAnswersDiaErrIdentityNotRegistered		HSS-ISM

				CxLocationQueryAnswersDiaSuccess		HSS-ISM

				CxLocationQueryRequests		HSS-ISM

				CxPullAnswersDiaInvalidAvpValue		HSS-ISM

				CxPullAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxPullAnswersDiaErrIdentityNotRegistered		HSS-ISM

				CxPullAnswersDiaMissingAvp		HSS-ISM

				CxPullAnswersDiaErrUserUnknown		HSS-ISM

				CxPullAnswersDiaUnableToComply		HSS-ISM

				CxPullAnswersDiaSuccess		HSS-ISM

				CxPullRequests		HSS-ISM

				CxQuery3gppAnswersDiaMissingAvp		HSS-ISM

				CxQuery3gppAnswersDiaInvalidAvpValue		HSS-ISM

				CxQuery3gppAnswersDiaErrFeatureUnsupported		HSS-ISM

				CxQuery3gppAnswersAvpOccursTooManyTimes		HSS-ISM

				CxQuery3gppAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxQuery3gppAnswersDiaTooBusy		HSS-ISM

				CxQuery3gppAnswersDiaAuthorizationRejected		HSS-ISM

				CxQuery3gppAnswersDiaErrRoamingNotAllowed		HSS-ISM

				CxQuery3gppAnswersDiaUnableToComply		HSS-ISM

				CxQuery3gppAnswersDiaErrUserUnknown		HSS-ISM

				CxQuery3gppAnswersDiaFirstRegistration		HSS-ISM

				CxQuery3gppAnswersDiaSubsequentRegistration		HSS-ISM

				CxQuery3gppAnswersDiaErrIdentityNotRegistered		HSS-ISM

				CxQuery3gppAnswersDiaSuccess		HSS-ISM

				CxQuery3gppRegistrationAndCapabilitiesRequests		HSS-ISM

				CxQuery3gppEmergencyRegistrationRequests		HSS-ISM

				CxQuery3gppRequests		HSS-ISM

				CxQueryAnswersDiaInvalidAvpValue		HSS-ISM

				CxQueryAnswersAvpOccursTooManyTimes		HSS-ISM

				CxQueryAnswersDiaErrIdentitiesDontMatch		HSS-ISM

				CxQueryAnswersDiaTooBusy		HSS-ISM

				CxQueryAnswersDiaAuthorizationRejected		HSS-ISM

				CxQueryAnswersDiaUnableToComply		HSS-ISM

				CxQueryAnswersDiaErrRoamingNotAllowed		HSS-ISM

				CxQueryAnswersDiaErrUserUnknown		HSS-ISM

				CxQueryAnswersDiaFirstRegistration		HSS-ISM

				CxQueryAnswersDiaSubsequentRegistration		HSS-ISM

				CxQueryRequests		HSS-ISM

				NumberOfPublicIdsRegisteredPerDomain		HSS-ISM

				HssSdaZhAuthDataAnswersDiaErrUserUnknown		HSS-SDA

				HssSdaZhAuthDataAnswersDiaUnableToComply		HSS-SDA

				HssSdaZhAuthDataAnswersDiaAvpOccursTooManyTimes		HSS-SDA

				HssSdaZhAuthDataAnswersDiaMissingAvp		HSS-SDA

				HssSdaZhAuthDataAnswersDiaSuccess		HSS-SDA

				HssSdaZhAuthDataResynchRequests		HSS-SDA

				HssSdaZhAuthDataRequests		HSS-SDA

				SdaMapAtiSubscriberUnknownResponses		HSS-SDA

				SdaMapAtiTimeoutResponses		HSS-SDA

				SdaMapAtiSuccessResponses		HSS-SDA

				SdaMapAtiRequests		HSS-SDA

				SdaExtDbDiscardedRequestsDueLackOfResources		HSS-SDA

				SdaExtDbSearchOverloadErrors		HSS-SDA

				SdaExtDbSearchTimeoutResponses		HSS-SDA

				SdaExtDbSearchErrorResponses		HSS-SDA

				SdaExtDbSearchSuccessResponses		HSS-SDA

				SdaExtDbSearchRequests		HSS-SDA

				SdaExtDbModifyOverloadErrors		HSS-SDA

				SdaExtDbModifyTimeoutResponses		HSS-SDA

				SdaExtDbModifyErrorResponses		HSS-SDA

				SdaExtDbModifySuccessResponses		HSS-SDA

				SdaExtDbModifyRequests		HSS-SDA

				SdaExtDbDeleteOverloadErrors		HSS-SDA

				SdaExtDbDeleteTimeoutResponses		HSS-SDA

				SdaExtDbDeleteErrorResponses		HSS-SDA

				SdaExtDbDeleteSuccessResponses		HSS-SDA

				SdaExtDbDeleteRequests		HSS-SDA

				SdaExtDbCreateOverloadErrors		HSS-SDA

				SdaExtDbCreateTimeoutResponses		HSS-SDA

				SdaExtDbCreateErrorResponses		HSS-SDA

				SdaExtDbCreateSuccessResponses		HSS-SDA

				SdaExtDbCreateRequests		HSS-SDA

				ShNotifNoAnswers		HSS-SDA

				ShNotifAnswersDiaPermanentFailure		HSS-SDA

				ShNotifAnswersDiaTransientFailure		HSS-SDA

				ShNotifAnswersDiaTooBusy		HSS-SDA

				ShNotifAnswersDiaProtocolError		HSS-SDA

				ShNotifAnswersDiaErrTooMuchData		HSS-SDA

				ShNotifAnswersDiaErrUserDataNotRecognized		HSS-SDA

				ShNotifAnswersDiaErrNoSubscriptionToData		HSS-SDA

				ShNotifAnswersDiaErrUserUnknown		HSS-SDA

				ShNotifAnswersDiaSuccess		HSS-SDA

				ShNotifRequestsNonTransparentData		HSS-SDA

				ShNotifRequestsTransparentData		HSS-SDA

				ShSubsNotifAnswersDiaErrSubscriptionToDataAbsent		HSS-SDA

				ShSubsNotifAnswersDiaInvalidAvpValue		HSS-SDA

				ShSubsNotifAnswersDiaUnableToComply		HSS-SDA

				ShSubsNotifAnswersDiaErrUserDataCannotBeNotified		HSS-SDA

				ShSubsNotifAnswersDiaErrDsaiNotAvailable		HSS-SDA

				ShSubsNotifAnswersDiaErrFeatureUnsupported		HSS-SDA

				ShSubsNotifAnswersDiaErrOperationNotAllowed		HSS-SDA

				ShSubsNotifAnswersDiaErrUserUnknown		HSS-SDA

				ShSubsNotifAnswersDiaMissingAvp		HSS-SDA

				ShSubsNotifAnswerNonTransparentDataDiaSuccess		HSS-SDA

				ShSubsNotifAnswersTransparentDataDiaSuccess		HSS-SDA

				ShSubsNotifRequests		HSS-SDA

				ShUpdateAnswersDiaPriorUpdateInProgress		HSS-SDA

				ShUpdateAnswersDiaErrUserDataCannotBeModified		HSS-SDA

				ShUpdateAnswersDiaInvalidAvpValue		HSS-SDA

				ShUpdateAnswersDiaMissingAvp		HSS-SDA

				ShUpdateAnswersDiaUnableToComply		HSS-SDA

				ShUpdateAnswersDiaErrTransparentDataOutOfSync		HSS-SDA

				ShUpdateAnswersDiaErrTooMuchData		HSS-SDA

				ShUpdateAnswersDiaErrDsaiNotAvailable		HSS-SDA

				ShUpdateAnswersDiaErrFeatureUnsupported		HSS-SDA

				ShUpdateAnswerDiaErrOperationNotAllowed		HSS-SDA

				ShUpdateAnswersDiaErrUserUnknown		HSS-SDA

				ShUpdateAnswersDiaSuccess		HSS-SDA

				ShUpdateRequests		HSS-SDA

				ShPullAnswersDiaInvalidAvpValue		HSS-SDA

				ShPullAnswersDiaAvpNotAllowed		HSS-SDA

				ShPullAnswersDiaMissingAvp		HSS-SDA

				ShPullAnswersDiaUnableToComply		HSS-SDA

				ShPullAnswersDiaErrDsaiNotAvailable		HSS-SDA

				ShPullAnswersDiaErrFeatureUnsupported		HSS-SDA

				ShPullAnswersDiaErrOperationNotAllowed		HSS-SDA

				ShPullAnswersDiaErrUserDataCannotBeRead		HSS-SDA

				ShPullAnswersDiaErrUserUnknown		HSS-SDA

				ShPullAnswersDiaAvpOccursTooManyTimes		HSS-SDA

				ShPullAnswersTransparentDataDiaSuccess		HSS-SDA

				ShPullAnswersNonTransparentDataDiaSuccess		HSS-SDA

				ShPullRequests		HSS-SDA

				TotalNumberOfApplicationServersStored		HSS-SDA

				TotalNumberOfPrivateIdRanges		HSS-SLF

				TotalNumberOfImsiRanges		HSS-SLF

				TotalNumberOfMsis		HSS-SLF

				TotalNumberOfPrivateIds		HSS-SLF

				TotalNumberOfImsis		HSS-SLF

				TotalNumberOfWildcardedPSIEntries		HSS-SLF

				TotalNumberOfMsis		HSS-SLF

				TotalNumberOfPublicIds		HSS-SLF

				TotalNumberOfProvisionedEntries		HSS-SLF

				HssSlfZhProxyAnswersProtocolError		HSS-SLF

				HssSlfZhProxyAnswersPerDest		HSS-SLF

				HssSlfZhProxyRequestsSendError		HSS-SLF

				HssSlfZhProxyRequestPerDest		HSS-SLF

				HssSlfZhAnswersDiaInvalidAvpValue		HSS-SLF

				HssSlfZhAnswersDiaRealmNotServed		HSS-SLF

				HssSlfZhAnswersDiaUnableToComply		HSS-SLF

				HssSlfZhAnswersDiaErrUserUnknown		HSS-SLF

				HssSlfZhAnswersDiaAvpNotAllowed		HSS-SLF

				HssSlfZhAnswersDiaMissingAvp		HSS-SLF

				HssSlfZhAnswersDiaSuccess		HSS-SLF

				HssSlfZhRequests		HSS-SLF

				HssSlfZhDiaCommandUnsupported		HSS-SLF

				HssSlfSWxProxyAnswersProtocolError		HSS-SLF

				HssSlfSWxProxyAnswersPerDest		HSS-SLF

				HssSlfSWxProxyRequestsSendError		HSS-SLF

				HssSlfSWxProxyRequestPerDest		HSS-SLF

				HssSlfSWxAnswersDiaRealmNotServed		HSS-SLF

				HssSlfSWxAnswersDiaInvalidAvpValue		HSS-SLF

				HssSlfSWxAnswersDiaUnableToComply		HSS-SLF

				HssSlfSWxAnswersDiaErrUserUnknown		HSS-SLF

				HssSlfSWxAnswersDiaAvpNotAllowed		HSS-SLF

				HssSlfSWxAnswersDiaMissingAvp		HSS-SLF

				HssSlfSWxAnswersDiaSuccess		HSS-SLF

				HssSlfSWxRequests		HSS-SLF

				HssSlfSWxDiaCommandUnsupported		HSS-SLF

				HssSlfRadiusAccClientInvalidServerAddresses		HSS-SLF

				HssSlfRadiusAccClientPacketsDropped		HSS-SLF

				HssSlfRadiusAccClientTimeouts		HSS-SLF

				HssSlfRadiusAccClientBadAuthenticators		HSS-SLF

				HssSlfRadiusAccClientResponses		HSS-SLF

				HssSlfRadiusAccClientRetransmissions		HSS-SLF

				HssSlfRadiusAccClientOffRequests		HSS-SLF

				HssSlfRadiusAccClientOnRequests		HSS-SLF

				HssSlfRadiusAccClientStopRequests		HSS-SLF

				HssSlfRadiusAccClientUpdateRequests		HSS-SLF

				HssSlfRadiusAccClientStartRequests		HSS-SLF

				HssSlfRadiusAccServTotalInvalidRequests		HSS-SLF

				HssSlfRadiusAccServTotalDupRequests		HSS-SLF

				HssSlfRadiusAccServTotalPacketsDropped		HSS-SLF

				HssSlfRadiusAccServTotalBadAuthenticators		HSS-SLF

				HssSlfRadiusAccServTotalMalformedRequests		HSS-SLF

				HssSlfRadiusAccServTotalResponses		HSS-SLF

				HssSlfRadiusAccServTotalOffRequests		HSS-SLF

				HssSlfRadiusAccServTotalOnRequests		HSS-SLF

				HssSlfRadiusAccServTotalStopRequests		HSS-SLF

				HssSlfRadiusAccServTotalUpdateRequests		HSS-SLF

				HssSlfRadiusAccServTotalStartRequests		HSS-SLF

				HssSlfRadiusAccServDupRequests		HSS-SLF

				HssSlfRadiusAccServPacketsDropped		HSS-SLF

				HssSlfRadiusAccServBadAuthenticators		HSS-SLF

				HssSlfRadiusAccServMalformedRequests		HSS-SLF

				HssSlfRadiusAccServResponses		HSS-SLF

				HssSlfRadiusAccServOffRequests		HSS-SLF

				HssSlfRadiusAccServOnRequests		HSS-SLF

				HssSlfRadiusAccServStopRequests		HSS-SLF

				HssSlfRadiusAccServUpdateRequests		HSS-SLF

				HssSlfRadiusAccServStartRequests		HSS-SLF

				S6aProxyAnswersProtocolError		HSS-SLF

				S6aProxyAnswersPerDest		HSS-SLF

				S6aProxyRequestsSendError		HSS-SLF

				S6aProxyRequestPerDest		HSS-SLF

				S6aAnswersDiaRealmNotServed		HSS-SLF

				S6aAnswersDiaInvalidAvpValue		HSS-SLF

				S6aAnswersDiaUnableToComply		HSS-SLF

				S6aAnswersDiaErrUnknownEpsSubscription		HSS-SLF

				S6aAnswersDiaAvpNotAllowed		HSS-SLF

				S6aAnswersDiaMissingAvp		HSS-SLF

				S6aAnswersDiaSuccess		HSS-SLF

				S6aRequests		HSS-SLF

				S6aDiaCommandUnsupported		HSS-SLF

				ShProxyAnswersProtocolError		HSS-SLF

				ShProxyAnswersPerDest		HSS-SLF

				ShProxyRequestsSendError		HSS-SLF

				ShProxyRequestPerDest		HSS-SLF

				ShAnswersDiaInvalidAvpValue		HSS-SLF

				ShAnswersDiaRealmNotServed		HSS-SLF

				ShAnswersDiaUnableToComply		HSS-SLF

				ShAnswersDiaErrUserUnknown		HSS-SLF

				ShAnswersDiaAvpNotAllowed		HSS-SLF

				ShAnswersDiaMissingAvp		HSS-SLF

				ShAnswersDiaSuccess		HSS-SLF

				ShRequests		HSS-SLF

				ShDiaCommandUnsupported		HSS-SLF

				ZxProxyAnswersProtocolError		HSS-SLF

				ZxProxyAnswersPerDest		HSS-SLF

				ZxProxyRequestsSendError		HSS-SLF

				ZxProxyRequestPerDest		HSS-SLF

				ZxAnswersDiaInvalidAvpValue		HSS-SLF

				ZxAnswersDiaRealmNotServed		HSS-SLF

				ZxAnswersDiaUnableToComply		HSS-SLF

				ZxAnswersDiaErrUserUnknown		HSS-SLF

				ZxAnswersDiaAvpNotAllowed		HSS-SLF

				ZxAnswersDiaMissingAvp		HSS-SLF

				ZxAnswersDiaSuccess		HSS-SLF

				ZxRequests		HSS-SLF

				ZxDiaCommandUnsupported		HSS-SLF

				CxProxyAnswersProtocolError		HSS-SLF

				CxProxyAnswersPerDest		HSS-SLF

				CxProxyRequestsSendError		HSS-SLF

				CxProxyRequestPerDest		HSS-SLF

				CxAnswersDiaRealmNotServed		HSS-SLF

				CxAnswersDiaInvalidAvpValue		HSS-SLF

				CxAnswersDiaUnableToComply		HSS-SLF

				CxAnswersDiaErrUserUnknown		HSS-SLF

				CxAnswersDiaAvpNotAllowed		HSS-SLF

				CxAnswersDiaMissingAvp		HSS-SLF

				CxAnswersDiaSuccess		HSS-SLF

				CxRequests		HSS-SLF

				CxDiaCommandUnsupported		HSS-SLF

				HssSlfDzAnswersDiaMissingAvp		HSS-SLF

				HssSlfDzAnswersDiaInvalidAvpValue		HSS-SLF

				HssSlfDzAnswersDiaUnableToComply		HSS-SLF

				HssSlfDzAnswersDiaErrUserUnknown		HSS-SLF

				HssSlfDzAnswersDiaAvpNotAllowed		HSS-SLF

				HssSlfDzAnswersDiaRealmNotServed		HSS-SLF

				HssSlfDzAnswersDiaSuccess		HSS-SLF

				HssSlfDzRequests		HSS-SLF

				HssSlfDzDiaCommandUnsupported		HSS-SLF

				DhAnswersDiaInvalidAvpValue		HSS-SLF

				DhAnswersDiaRealmNotServed		HSS-SLF

				DhAnswersDiaUnableToComply		HSS-SLF

				DhAnswersDiaErrUserUnknown		HSS-SLF

				DhAnswersDiaAvpNotAllowed		HSS-SLF

				DhAnswersDiaMissingAvp		HSS-SLF

				DhAnswersDiaSuccess		HSS-SLF

				DhRequests		HSS-SLF

				DhDiaCommandUnsupported		HSS-SLF

				DzxAnswersDiaInvalidAvpValue		HSS-SLF

				DzxAnswersDiaRealmNotServed		HSS-SLF

				DzxAnswersDiaUnableToComply		HSS-SLF

				DzxAnswersDiaErrUserUnknown		HSS-SLF

				DzxAnswersDiaAvpNotAllowed		HSS-SLF

				DzxAnswersDiaMissingAvp		HSS-SLF

				DzxAnswersDiaSuccess		HSS-SLF

				DzxRequests		HSS-SLF

				DzxDiaCommandUnsupported		HSS-SLF

				DxAnswersDiaRealmNotServed		HSS-SLF

				DxAnswersDiaInvalidAvpValue		HSS-SLF

				DxAnswersDiaUnableToComply		HSS-SLF

				DxAnswersDiaErrUserUnknown		HSS-SLF

				DxAnswersDiaAvpNotAllowed		HSS-SLF

				DxAnswersDiaMissingAvp		HSS-SLF

				DxAnswersDiaSuccess		HSS-SLF

				DxRequests		HSS-SLF

				DxDiaCommandUnsupported		HSS-SLF

				DiaAnswersAppUnsupported		HSS-SLF

				DiaRedirectAnswersPerDestinationServer		HSS-SLF







The following regExp is the default pattern for each  counter family:
^A[0-9] *SDA*
^A[0-9] *ISM*
^A[0-9] *SLF*

Files name examples:
A20130213.2145-2150_pphss10_HSS-SLF
A20130213.2145-2150_pphss10_HSS-SDA
A20130213.2145-2150_pphss10_HSS-ISM




IPWorks



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

				DNS		A20130216.2215-2230_idnshan10_DNS.xml		.*_DNS.*		This file will contains counter that has file pattern type as "DNS"

				ENUM		A20130216.2215-2315_idnshan10_ENUM.xml		.*_ENUM.*

				PLATFORM		A20130216.2215-2220_idnshan10_PLATFORM.xml		.*_PLATFORM.*





				Counter Name		File Pattern Type

				ipworksDnsServQueryReferral		DNS

				ipworksDnsServQueryNxrrset		DNS

				ipworksDnsServQueryNxdomain		DNS

				ipworksDnsServQueryRecursion		DNS

				ipworksDnsServEnumQueryRecursion		DNS

				ipworksDnsServQueryXfr		DNS

				ipworksDnsServQueryXfrFailure		DNS

				ipworksDnsServUpdateSuccess		DNS

				ipworksDnsServUpdateFailure		DNS

				ipworksDnsServUpdateForward		DNS

				ipworksDnsServUpdateRefused		DNS

				ipworksDnsServUpdateTotal		DNS

				ipworksDnsServTSIGSuccess		DNS

				ipworksDnsServTSIGFailure		DNS

				ipworksDnsServDNSSECSuccess		DNS

				ipworksDnsServDNSSECFailure		DNS

				ipworksDnsServASDNSSuccess		DNS

				ipworksDnsServASDNSFailure		DNS

				ipworksDnsServASDNSRefused		DNS

				ipworksDnsServASDNSTotal		DNS

				ipworksDnsServNotifyFailure		DNS

				ipworksDnsServNotifyTotal		DNS

				ipworksDnsServForwardFailure		DNS

				ipworksDnsServForwardTotal		DNS

				ipworksEnumCounterInvalidFormat		ENUM

				ipworksEnumCounterServerFailed		ENUM

				ipworksEnumCounterNameError		ENUM

				ipworksEnumCounterNotImplemented		ENUM

				ipworksEnumCounterRefused		ENUM

				ipworksEnumCounterSingleRoute		ENUM

				ipworksEnumCounterUnequippedRoute  		ENUM

				ipworksEnumCounterMultipleRoute		ENUM

				ipworksEnumCounterInsufficientDigits		ENUM

				ipworksEnumCounterTruncatedResponses		ENUM

				ipworksEnumCounterForwardedRequests		ENUM

				ipworksEnumCounterDBFailed		ENUM

				ipworksEnumCounterDBSearch		ENUM

				ipworksEnumCounterTotalFailed		ENUM

				ipworksDhcpv4CountBOOTPTotal		DHCP

				ipworksDhcpv4CountBOOTPRequests		DHCP

				ipworksDhcpv4CountBOOTPReplies		DHCP

				ipworksDhcpv4CountDHCPTotal		DHCP

				ipworksDhcpv4CountDHCPDiscovers		DHCP

				ipworksDhcpv4CountDHCPRequests		DHCP

				ipworksDhcpv4CountDHCPDeclines		DHCP

				ipworksDhcpv4CountDHCPReleases		DHCP

				ipworksDhcpv4CountDHCPInforms		DHCP

				ipworksDhcpv4CountDHCPOffers		DHCP

				ipworksDhcpv4CountDHCPAcks		DHCP

				ipworksDhcpv4CountDHCPNacks		DHCP

				ipworksDhcpv4UnknownMsgType		DHCP

				ipworksDhcpv4UnknownHardware		DHCP

				ipworksDhcpv4GarbledCHADDR		DHCP

				ipworksDhcpv4DDNSUpdateTotal		DHCP

				ipworksDhcpv4DDNSSent		DHCP

				ipworksDhcpv4DDNSRecv		DHCP

				ipworksDhcpv4DDNSSuccess		DHCP

				ipworksDhcpv4DDNSFailedError		DHCP

				ipworksDhcpv4DDNSRetryFail		DHCP

				ipworksDhcpv4Name		DHCP

				ipworksDhcpv4ActiveLeaseNum		DHCP

				ipworksDhcpv4ActiveLeasePercentage		DHCP

				ipworksDhcpv4ConfiguredLeaseNum		DHCP

				ipworksEnumCounterUnequipedRoute		ENUM

				radiusAuthServIdent		AAA

				radiusAuthServUpTime		AAA

				radiusAuthServResetTime		AAA

				radiusAuthServConfigReset		AAA

				radiusAuthServTotalAccessRequests		AAA

				radiusAuthServTotalInvalidRequests		AAA

				radiusAuthServTotalDupAccessRequests		AAA

				radiusAuthServTotalAccessAccepts		AAA

				radiusAuthServTotalAccessRejects		AAA

				radiusAuthServTotalAccessChallenges		AAA

				radiusAuthServTotalMalformedAccessRequests		AAA

				radiusAuthServTotalBadAuthenticators		AAA

				radiusAuthServTotalPacketsDropped		AAA

				radiusAuthServTotalUnknownTypes		AAA

				radiusAuthClientInvalidServerAddresses		AAA

				radiusAuthClientIdentifier		AAA

				radiusAuthServerInetAddressType		AAA

				radiusAuthServerInetAddress		AAA

				radiusAuthClientServerInetPortNumber		AAA

				radiusAuthClientExtRoundTripTime		AAA

				radiusAuthClientExtAccessRequests		AAA

				radiusAuthClientExtAccessRetransmissions		AAA

				radiusAuthClientExtAccessAccepts		AAA

				radiusAuthClientExtAccessRejects		AAA

				radiusAuthClientExtAccessChallenges		AAA

				radiusAuthClientExtMalformedAccessResponses		AAA

				radiusAuthClientExtBadAuthenticators		AAA

				radiusAuthClientExtPendingRequests		AAA

				radiusAuthClientExtTimeouts		AAA

				radiusAuthClientExtUnknownTypes		AAA

				radiusAuthClientExtPacketsDropped		AAA

				radiusAuthClientCounterDiscontinuity		AAA

				radiusAccServIdent		AAA

				radiusAccServUpTime		AAA

				radiusAccServResetTime		AAA

				radiusAccServConfigReset		AAA

				radiusAccServTotalRequests		AAA

				radiusAccServTotalInvalidRequests		AAA

				radiusAccServTotalDupRequests		AAA

				radiusAccServTotalResponses		AAA

				radiusAccServTotalMalformedRequests		AAA

				radiusAccServTotalBadAuthenticators		AAA

				radiusAccServTotalPacketsDropped		AAA

				radiusAccServTotalNoRecords		AAA

				radiusAccServTotalUnknownTypes		AAA

				radiusAccClientInvalidServerAddresses		AAA

				radiusAccClientIdentifier		AAA

				radiusAccServerInetAddressType		AAA

				radiusAccServerInetAddress		AAA

				radiusAccClientServerInetPortNumber		AAA

				radiusAccClientExtRoundTripTime		AAA

				radiusAccClientExtRequests		AAA

				radiusAccClientExtRetransmissions		AAA

				radiusAccClientExtResponses		AAA

				radiusAccClientExtMalformedResponses		AAA

				radiusAccClientExtBadAuthenticators		AAA

				radiusAccClientExtPendingRequests		AAA

				radiusAccClientExtTimeouts		AAA

				radiusAccClientExtUnknownTypes		AAA

				radiusAccClientExtPacketsDropped		AAA

				radiusAccClientCounterDiscontinuity		AAA

				ipworksRadiusServTotalDisconnectRequests		AAA

				ipworksRadiusServTotalFailedDisconnectRequests		AAA

				ipworksRadiusServTotalSuccessDisconnectRequests		AAA

				ipworksRadiusServTotalCoARequests		AAA

				ipworksRadiusServTotalFailedCoARequests		AAA

				ipworksRadiusServTotalSuccessCoARequests		AAA

				ipworksDiameterAAAActiveSTaSessionNumber		AAA

				ipworksDiameterAAASTaInitialAuthRequests		AAA

				ipworksDiameterAAASTaReAuthRequests		AAA

				ipworksDiameterAAASTaAAAInitialAbortSessionRequests		AAA

				ipworksDiameterAAASTaSessionTerminationRequests		AAA

				ipworksDiameterAAASTaEAPAKAPrimeAuthSuccessNumber		AAA

				ipworksDiameterAAASTaEAPAKAPrimeAuthFailedNumber		AAA

				ipworksDiameterAAAActiveS6bSessionNumber		AAA

				ipworksDiameterAAAS6bInitialAuthorizationRequests		AAA

				ipworksDiameterAAAS6bReAuthorizationRequests		AAA

				ipworksDiameterAAAS6bSessionTerminationRequests		AAA

				ipworksDiameterAAASWxFetchAuthVecRequests		AAA

				ipworksDiameterAAASWxFetchUserProfileRequests		AAA

				ipworksDiameterAAASWxRegistrationRequests		AAA

				ipworksDiameterAAASWxDeRegistrationRequest		AAA

				ipworksDiameterAAASWxUpdatePGWInfoRequest		AAA

				ipworksDiameterAAASWxRemovePGWInfoRequest		AAA

				ipworksAAAName		AAA

				ipworksAAAActiveLeaseNum		AAA

				ipworksAAAActiveLeasePercentage		AAA

				ipworksAAAConfiguredLeaseNum		AAA

				ncEstablished		CLF

				ncClosedByClf		CLF

				ncClosedByPeer		CLF

				ncRejected		CLF

				nrrRcvd		CLF

				nasaSuccessful		CLF

				nasaParameterMissing		CLF

				nasaClidError		CLF

				nasaSyntaxError		CLF

				nasaIpAddressError		CLF

				nasaIazError		CLF

				nasaSystemError		CLF

				nasaRemoteIdError		CLF

				nasaNetworkTypeError		CLF

				nasfSuccessful		CLF

				nasfParameterMissing		CLF

				nasfSyntaxError		CLF

				nasfClidError		CLF

				nasfIpAddressError		CLF

				nasfIazError		CLF

				nasfSystemError		CLF

				nasfRemoteIdError		CLF

				nasfNetworkTypeError		CLF

				rrrRcvd		CLF

				rasaSuccessful		CLF

				rasaParameterMissing		CLF

				rasaSyntaxError		CLF

				rasaIpAddressError		CLF

				rasaIazError		CLF

				rasaSystemError		CLF

				rasfSuccessful		CLF

				rasfParameterMissing		CLF

				rasfSyntaxError		CLF

				rasfIpAddressError		CLF

				rasfIazError		CLF

				rasfSystemError		CLF

				irSendAttempts		CLF

				irSendFailures		CLF

				irNotSent		CLF

				irrSuccessful		CLF

				irrParameterMissing		CLF

				irrSyntaxError		CLF

				irrClidError		CLF

				irrIpAddressError		CLF

				irrIazError		CLF

				irrSystemError		CLF

				irrUnknownError		CLF

				irrUndecodable		CLF

				hbSendAttempts		CLF

				hbSendFailures		CLF

				hbRcvd		CLF

				nacfActiveConnections		CLF

				nacfAvgNewIpAccessContextTime		CLF

				nacfAvgIpAccessContextReleaseTime		CLF

				scEstablished		CLF

				scClosedByClf		CLF

				scClosedByPeer		CLF

				scRejected		CLF

				soRcvd		CLF

				saSendAttempts		CLF

				saSendFailures		CLF

				skRcvd		CLF

				skSendAttempts		CLF

				skSendFailures		CLF

				srRcvd		CLF

				sdsaLocInfo		CLF

				sdsaDefLocInfo		CLF

				sdsaNullString		CLF

				sdsaLocInfo		CLF

				sdsfLocInfo		CLF

				sdsfDefLocInfo		CLF

				sdsfNullString		CLF

				sdsfLocInfo		CLF

				scRcvd		CLF

				scSendAttempts		CLF

				scRcvd		CLF

				sPulls		CLF

				sCopsPullNeeded		CLF

				sE2PullNeeded		CLF

				sCopsPullSent		CLF

				sE2PullSent		CLF

				spSuccessful		CLF

				spUnsuccessful		CLF

				spSystemError		CLF

				spUnconfirmed		CLF

				sce2Established		CLF

				sce2ClosedByClf		CLF

				sce2ClosedByPeer		CLF

				sce2Rejected		CLF

				sce2Failed		CLF

				liqReceived		CLF

				liqsfRespSuccessful		CLF

				liqsfRespError		CLF

				liqsfRespMissingAVP		CLF

				liqsfRespUserUnknown		CLF

				liqsfRespUnabletoComply		CLF

				liqsfRespUserDataNotAvail		CLF

				liqsfRespAVPNotAllowed		CLF

				liqsaRespSuccessful		CLF

				liqsaRespError		CLF

				liqsaRespMissingAVP		CLF

				liqsaRespUserUnknown		CLF

				liqsaRespUnabletoComply		CLF

				liqsaRespUserDataNotAvail		CLF

				liqsaRespAVPNotAllowed		CLF

				sbcActiveConnections		CLF

				sbcActiveConnectionse2		CLF

				sbcCopsLocQueryNotPulledProcessingTime		CLF

				sbcCopsLocQueryPulledProcessingTime		CLF

				sbcE2LocQueryNotPulledProcessingTime		CLF

				sbcE2LocQueryPulledProcessingTime		CLF

				pcEstablished		CLF

				pcClosedByClf		CLF

				pcClosedByPeer		CLF

				pcRejected		CLF

				Connection-relatedCounters		CLF

				ccEstablished		CLF

				ccClosedByClf		CLF

				ccClosedByPeer		CLF

				ccRejected		CLF

				pmiActiveConnections		CLF

				cmActiveConnections		CLF

				umiActiveConnections		CLF

				acEstablished		CLF

				acClosedByClf		CLF

				acClosedByPeer		CLF

				acRejected		CLF

				acFailed		CLF

				appSndAttempts		CLF

				appSndFailures		CLF

				appNotSent		CLF

				apprMessages		CLF

				apprDiameterSuccess		CLF

				apprErrors		CLF

				apprMissingAVP		CLF

				apprUnableToComply		CLF

				apprSystemUnavailable		CLF

				apprSyntaxError		CLF

				apprNonDecodable		CLF

				apprOtherErrors		CLF

				icriSndAttempts		CLF

				icriSndFailures		CLF

				icriNotSent		CLF

				icrirMessages		CLF

				icrirDiameterSuccess		CLF

				icrirErrors		CLF

				icrirMissingAVP		CLF

				icrirUnableToComply		CLF

				icrirSystemUnavailable		CLF

				icrirErrorUserKnown		CLF

				icrirSyntaxError		CLF

				icrirNonDecodable		CLF

				icrirOtherErrors		CLF

				e4pullReqReceived		CLF

				e4pullsaRespSuccessful		CLF

				e4pullsaRespError		CLF

				e4pullsaRespMissingAVP		CLF

				e4pullsaRespUserUnknown		CLF

				e4pullsaRespUnabletoComply		CLF

				e4pullsaRespUserDataNotAvail		CLF

				e4pullsaRespAVPNotAllowed		CLF

				e4pullsfRespSuccessful		CLF

				e4pullsfRespError		CLF

				e4pullsfRespMissingAVP		CLF

				e4pullsfRespUserUnknown		CLF

				e4pullsfRespUnabletoComply		CLF

				e4pullsfRespUserDataNotAvail		CLF

				e4pullsfRespAVPNotAllowed		CLF

				aracfE4PullNeeded		CLF

				aracfE4PullSent		CLF

				apSuccessful		CLF

				apUnsuccessful		CLF

				apSystemError		CLF

				apUnconfirmed		CLF

				aracfActiveConnections		CLF

				aracfProfilePushRoundtripTime		CLF

				aracfReleaseIpRoundtripTime		CLF

				e4pullNacfNotPulledProcessingTime		CLF

				e4pullNacfPullProcessingTime		CLF

				ucEstablished		CLF

				ucClosedByPbdf		CLF

				ucClosedByPeer		CLF

				ucRejected		CLF

				numberOfActiveAccessProfiles		CLF

				numberOfActiveQoSProfiles		CLF

				numberofATMIpContexts		CLF

				numberofGIGEIpContexts		CLF

				numberofCircuitIds		CLF

				numberofEcrs		CLF

				numberofLocationInfo		CLF

				numberofDslams		CLF

				numberofATMPals		CLF

				numberofGIGEPals		CLF

				numberofMULTIACCESSPals		CLF

				numberofVlans		CLF

				clfStartTimeStamp		CLF

				clfReadyTimeStamp		CLF

				clfShutdownRequestTimeStamp		CLF

				clfShutdownCompeteTimeStamp		CLF

				clfLastAliveTimeStamp		CLF

				iazStatus		CLF

				cliRcvd		PMAL

				cliSendAttemptsSuccessful		PMAL

				cliSendAttemptsUnsuccessful		PMAL

				cliSendFailed		PMAL

				PMALDeleteLocationInformationCounters		PMAL

				dliRcvd		PMAL

				dliSendAttemptsSuccessful		PMAL

				dliSendAttemptsUnsuccessful		PMAL

				dliSendFailed		PMAL

				uliRcvd		PMAL

				uliSendAttemptsSuccessful		PMAL

				uliSendAttemptsUnsuccessful		PMAL

				uliSendFailed		PMAL

				cpalRcvd		PMAL

				cpalSendAttemptsSuccessful		PMAL

				cpalSendAttemptsUnsuccessful		PMAL

				cpalSendFailed		PMAL

				dpalRcvd		PMAL

				dpalSendAttemptsSuccessful		PMAL

				dpalSendAttemptsUnsuccessful		PMAL

				dpalSendFailed		PMAL

				upalRcvd		PMAL

				upalSendAttemptsSuccessful		PMAL

				upalSendAttemptsUnsuccessful		PMAL

				upalSendFailed		PMAL

				cvcRcvd		PMAL

				cvcSendAttemptsSuccessful		PMAL

				cvcSendAttemptsUnsuccessful		PMAL

				cvcSendFailed		PMAL

				dvcRcvd		PMAL

				dvcSendAttemptsSuccessful		PMAL

				dvcSendAttemptsUnsuccessful		PMAL

				dvcSendFailed		PMAL

				cdiRcvd		PMAL

				cdiSendAttemptsSuccessful		PMAL

				cdiSendAttemptsUnsuccessful		PMAL

				cdiSendFailed		PMAL

				ddiRcvd		PMAL

				ddiSendAttemptsSuccessful		PMAL

				ddiSendAttemptsUnsuccessful		PMAL

				ddiSendFailed		PMAL

				ceiRcvd		PMAL

				ceiSendAttemptsSuccessful		PMAL

				ceiSendAttemptsUnsuccessful		PMAL

				ceiSendFailed		PMAL

				deiRcvd		PMAL

				deiSendAttemptsSuccessful		PMAL

				deiSendAttemptsUnsuccessful		PMAL

				deiSendFailed		PMAL

				gaicRcvd		PMAL

				gaicSendAttemptsSuccessful		PMAL

				gaicSendAttemptsUnsuccessful		PMAL

				gaicSendFailed		PMAL

				gapalRcvd		PMAL

				gapalSendAttemptsSuccessful		PMAL

				gapalSendAttemptsUnsuccessful		PMAL

				gapalSendFailed		PMAL

				gavciRcvd		PMAL

				gavciSendAttemptsSuccessful		PMAL

				gavciSendAttemptsUnsuccessful		PMAL

				gavciSendFailed		PMAL

				galidipcRcvd		PMAL

				galidipcSendAttemptsSuccessful		PMAL

				galidipcSendAttemptsUnsuccessful		PMAL

				galidipcSendFailed		PMAL

				gulacsRcvd		PMAL

				gulacsSendAttemptsSuccessful		PMAL

				gulacsSendAttemptsUnsuccessful		PMAL

				gulacsSendFailed		PMAL

				galiRcvd		PMAL

				galiSendAttemptsSuccessful		PMAL

				galiSendAttemptsUnsuccessful		PMAL

				galiSendFailed		PMAL

				GetAssociatedDSLAMCounters		PMAL

				gadRcvd		PMAL

				gadSendAttemptsSuccessful		PMAL

				gadSendAttemptsUnsuccessful		PMAL

				gadSendFailed		PMAL

				gaeRcvd		PMAL

				gaeSendAttemptsSuccessful		PMAL

				gaeSendAttemptsUnsuccessful		PMAL

				gaeSendFailed		PMAL

				ganvcRcvd		PMAL

				ganvcSendAttemptsSuccessful		PMAL

				ganvcSendAttemptsUnsuccessful		PMAL

				ganvcSendFailed		PMAL

				ulacRcvd		PMAL

				ulacSendAttemptsSuccessful		PMAL

				ulacSendAttemptsUnsuccessful		PMAL

				ulacSendFailed		PMAL

				ppInvalidCredential		PMAL

				ppInvalidOamUser		PMAL

				ppInsufficientAccessRights		PMAL

				ppSyntaxError		PMAL

				ppInvalidLocationInformation		PMAL

				ppInvalidPal		PMAL

				ppInvalidTz		PMAL

				ppInvalidIaz		PMAL

				ppInvalidDslam		PMAL

				ppInvalidEcr		PMAL

				ppInvalidVirtualCircuit		PMAL

				ppDeletionFailedDueToExistingLink		PMAL

				ppDatabaseAccessError		PMAL

				ppLicenseLimitReached		PMAL

				ppCommunicationFailure		PMAL

				ppEcrAlreadyLinkedToDslam		PMAL

				ppProvisioningBlocked		PMAL

				ppInternalError		PMAL

				ppDifferentEntrywithSameKeyExists		PMAL

				ppIdenticalDataExist		PMAL

				ppInvalidNetworkType		PMAL

				ppLicenseDoesNotExist		PMAL

				ppReferenceMismatch		PMAL

				ppInvalidVlan		PMAL

				ppInvalidAracfId		PMAL

				ppIncompleteDelete		PMAL

				smtRcvd		PMAL

				smtSentAttemptSuccessful		PMAL

				smtSentAttemptUnsuccessful		PMAL

				smtSentFailed		PMAL

				gmtsRcvd		PMAL

				gmtsSentAttemptSuccessful		PMAL

				gmtsSentAttemptUnsuccessful		PMAL

				gmtsSentFailed		PMAL

				pbpInvalidCredential		PMAL

				pbpInvalidOamUser		PMAL

				pbpInsufficientAccessRights		PMAL

				pbpSyntaxError		PMAL

				pbpMassTreatmentAlreadyInProgress		PMAL

				pbpCommunicationFailure		PMAL

				pbpInternalError		PMAL

				sccRcvd		PMAL

				sccSentAttemptSuccessful		PMAL

				sccSentAttemptUnsuccessful		PMAL

				sccSentFailed		PMAL

				gccRcvd		PMAL

				gccSentAttemptSuccessful		PMAL

				gccSentAttemptUnsuccessful		PMAL

				gccSentFailed		PMAL

				pccmInvalidCredential		PMAL

				pccmInvalidOamUser		PMAL

				pccmInsufficientAccessRights		PMAL

				pccmSyntaxError		PMAL

				pccmCommunicationFailure		PMAL

				pccmInternalError		PMAL

				pccmGetNodeConfigDataError		PMAL

				pccmSetNodeConfigDataError		PMAL

				pccmInvalidCommandFormat		PMAL

				pccmUnsupportedCommand		PMAL

				pccmInvalidProtocolFormat		PMAL

				pccmConfigMgmtBlocked		PMAL

				pccmDesignatedBufferExceeded		PMAL

				pccmInvalidCommandParameter		PMAL

				capRcvd		PMAL

				capSendAttemptsSuccessful		PMAL

				capSendAttemptsUnsuccessful		PMAL

				capSendFailed		PMAL

				uapRcvd		PMAL

				uapSendAttemptsSuccessful		PMAL

				uapSendAttemptsUnsuccessful		PMAL

				uapSendFailed		PMAL

				dapRcvd		PMAL

				dapSendAttemptsSuccessful		PMAL

				dapSendAttemptsUnsuccessful		PMAL

				dapSendFailed		PMAL

				dsRcvd		PMAL

				dsSendAttemptsSuccessful		PMAL

				dsSendAttemptsUnsuccessful		PMAL

				dsSendFailed		PMAL

				gapRcvd		PMAL

				gapSendAttemptsSuccessful		PMAL

				gapSendAttemptsUnsuccessful		PMAL

				gapSendFailed		PMAL

				cviRcvd		PMAL

				cviSendAttemptsSuccessful		PMAL

				cviSendAttemptsUnsuccessful		PMAL

				cviSendFailed		PMAL

				dviRcvd		PMAL

				dviSendAttemptsSuccessful		PMAL

				dviSendAttemptsUnsuccessful		PMAL

				dviSendFailed		PMAL

				gviRcvd		PMAL

				gviSendAttemptsSuccessful		PMAL

				gviSendAttemptsUnsuccessful		PMAL

				gviSendFailed		PMAL

				pppInvalidCredential		PMAL

				pppInsufficientAccessRights		PMAL

				pppSyntaxError		PMAL

				pppDatabaseAccessError		PMAL

				pppCommunicationFailure		PMAL

				pppProfileProvisioningBlocked		PMAL

				pppInternalError		PMAL

				pppUnrecognizedSubscriberID		PMAL

				pppUnrecognizedTypedAccessID		PMAL

				pppInvalidClid		PMAL

				pppInvalidRemoteID		PMAL

				pppInvalidNetworkType		PMAL

				pppEntryAlreadyExists		PMAL

				pppReferenceMismatch		PMAL

				pppDeletionFailedDueToExistingLink		PMAL

				pppDuplicateQoSProfile		PMAL

				spmtRcvd		PMAL

				spmtSentAttemptSuccessful		PMAL

				spmtSentAttemptUnsuccessful		PMAL

				spmtSentFailed		PMAL

				gpmtsRcvd		PMAL

				gpmtsSentAttemptSuccessful		PMAL

				gpmtsSentAttemptUnsuccessful		PMAL

				gpmtsSentFailed		PMAL

				ppbpInvalidCredential		PMAL

				ppbpInvalidOamUser		PMAL

				ppbpInsufficientAccessRights		PMAL

				ppbpSyntaxError		PMAL

				ppbpMassTreatmentAlreadyInProgress		PMAL

				ppbpCommunicationFailure		PMAL

				pbpInternalError		PMAL

				spcRcvd		PMAL

				spcSentAttemptSuccessful		PMAL

				spcSentAttemptUnsuccessful		PMAL

				spcSentFailed		PMAL

				gpcRcvd		PMAL

				gpcSentAttemptSuccessful		PMAL

				gpcSentAttemptUnsuccessful		PMAL

				gpcSentFailed		PMAL

				pcmInvalidCredential		PMAL

				pcmInvalidOamUser		PMAL

				pcmInsufficientAccessRights		PMAL

				pcmSyntaxError		PMAL

				pcmInternalError		PMAL

				pcmInvalidCommandFormat		PMAL

				pcmInvalidCommandParameter		PMAL

				couRcvd		PMAL

				couSendAttemptsSuccessful		PMAL

				couSendAttemptsUnsuccessful		PMAL

				couSendFailed		PMAL

				douRcvd		PMAL

				douSendAttemptsSuccessful		PMAL

				douSendAttemptsUnsuccessful		PMAL

				douSendFailed		PMAL

				gouRcvd		PMAL

				gouSendAttemptsSuccessful		PMAL

				gouSendAttemptsUnsuccessful		PMAL

				gouSendFailed		PMAL

				mouRcvd		PMAL

				mouSendAttemptsSuccessful		PMAL

				mouSendAttemptsUnsuccessful		PMAL

				mouSendFailed		PMAL

				poumInvalidCredential		PMAL

				poumInvalidOamUser		PMAL

				poumInsufficientAccessRights		PMAL

				poumSyntaxError		PMAL

				poumDatabaseAccessError		PMAL

				poumInternalError		PMAL

				loginRcvd		PMAL

				loginSentAttemptSuccessful		PMAL

				loginSentAttemptUnsuccessful		PMAL

				loginSentFailed		PMAL

				logoutRcvd		PMAL

				logoutSentAttemptSuccessful		PMAL

				logoutSentAttemptUnsuccessful		PMAL

				logoutSentFailed		PMAL

				refreshCredRcvd		PMAL

				refreshCredSentAttemptSuccessful		PMAL

				refreshCredSentAttemptUnsuccessful		PMAL

				refreshCredSentFailed		PMAL

				psInvalidCredential		PMAL

				psInvalidOamUser		PMAL

				psInsufficientAccessRights		PMAL

				psSyntaxError		PMAL

				psDatabaseAccessError		PMAL

				psMaxNumberOfOAMSessions		PMAL

				psInternalError		PMAL

				psAuthenticationFailure		PMAL

				httpRcvd		PMAL

				httpSentAttemptSuccessful		PMAL

				httpSentAttemptUnsuccessful		PMAL

				httpSentFailed		PMAL

				httpGetRcvd		PMAL

				httpGetSentAttemptSuccessful		PMAL

				httpGetSentAttemptUnsuccessful		PMAL

				httpGetSentFailed		PMAL

				actvieSessions		PMAL

				usersDefined		PMAL

				pmalStartTimeStamp		PMAL

				pmalReadyTimeStamp		PMAL

				pmalShutdownRequestTimeStamp		PMAL

				pmalShutdownCompleteTimeStamp		PMAL

				pmalLastAliveTimeStamp		PMAL



The following regExp is the default pattern for each  counter family:
^A[0-9] *DHCPv4*
^A[0-9] *AAA*
^A[0-9] *CLF*
^A[0-9] *PMAL*
^A[0-9] *PLATFORM*
^A[0-9] *ENUM*
^A[0-9] *DNS*

Files name examples:
A20130216.2215-2220_idnshan10_PLATFORM.xml
A20130216.2215-2230_idnshan10_DNS.xml
A20130216.2215-2315_idnshan10_ENUM.xml




TSP



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

				Diameter		A20130216.2150-2155_cscfhan10_Diameter_error_counters		A.*cscf.*_Diameter.*		This file will contains counter that has file pattern type as "Diameter"

				OamProvisioning		A20140420.1345-1350_pphss10_OamProvisioningCounterMJ		A.*cscf.*_OamProvisioning.*

				IPv4_MeassurementJob		A20130216.2150-2155_cscfhan10_IPv4_MeassurementJob		A.*cscf.*_IPv4.*

				PlatformMeasures		A20130216.2150-2155_cscfhan10_PlatformMeasures		A.*cscf.*_PlatformMeasures.*





				Counter Name		MTAS-TSP		HSS-TSP		CSCF-TSP		File Pattern type

				tsp.Cm.AverageResponseTime		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.Cm.NumberofFailedAuthentications		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.Cm.NumberofFailedOperations		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.Cm.NumberofOperations		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.Cm.NumberofUserSessions		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				MOsTransaction		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				AtomicTransaction		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				RollbackCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				CommitCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				StartCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				ActionCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				AbandonCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				CompareCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				DeleteCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				UpdateCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				RetrieveCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				CreateCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				AuthenticateCounter		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.login.FailureRate 		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.login.FailuresByUser		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.login.FailuresByHost		IMS-MTAS		IMS- HSS		IMS-CSCF		OamProvisioning

				tsp.ipv4.ipv4IfStatsOutBytes		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv4_MeassurementJob

				tsp.ipv4.ipv4IfStatsInBytes		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv4_MeassurementJob

				tsp.ipv4.ipv4IfStatsOutPackets		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv4_MeassurementJob

				tsp.ipv4.ipv4IfStatsInPackets		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv4_MeassurementJob

				tsp.ipv4.sacount 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv4_MeassurementJob

				tsp.ipv4.spcount		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv4_MeassurementJob

				CpuLoad		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				 MaxCpuLoad		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				MemUsed		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				MemFree		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				 MemUsage		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				MaxMemUsage		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				ProcessorUptime		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				ClusterUptime		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				DiskUsage		IMS-MTAS		IMS- HSS		IMS-CSCF		PlatformMeasures

				 tsp.ipv6.ipv6IfStatsInReceives 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				tsp.ipv6.ipv6IfStatsInHdrErrors 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInTooBigErrors 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInNoRoutes 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInAddrErrors 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInUnknownProtos 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInTruncatedPkts 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInDiscards 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInDelivers 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsOutForwDatagrams 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsOutRequests 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsOutDiscards 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsOutFragOKs 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				tsp.ipv6.ipv6IfStatsOutFragFails 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsOutFragCreates 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				tsp.ipv6.ipv6IfStatsReasmReqds 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsReasmOKs 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsReasmFails 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsInMcastPkts 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.ipv6IfStatsOutMcastPkts 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				 tsp.ipv6.tspIpv6IngressFailureRatio 		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				tsp.ipv6.tspIpv6EgressFailureRatio		IMS-MTAS		IMS- HSS		IMS-CSCF		IPv6_MeassurementJob

				tsp.diameter.malformedReceivedRequests		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.protocolErrorsAndPermanentFailures		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.cerReceivedFromUnknownPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.outgoingMessageDiscardedDueToCongestion		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.incomingMessageDiscardedDueToOverload		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.sentUnsuccessfulAnswerToPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.sentAnswerToPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.sentRequestToPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.receivedUnsuccessfulAnswerFromPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.receivedAnswerFromPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				tsp.diameter.receivedRequestFromPeer		IMS-MTAS		IMS- HSS		IMS-CSCF		Diameter

				MalformedReceivedRequests		IMS-MTAS						Diameter

				ProtocolErrorsAndPermanentFailures		IMS-MTAS						Diameter

				CerReceivedFromUnknownPeer		IMS-MTAS						Diameter

				OutgoingMessageDiscardedDueToCongestion		IMS-MTAS						Diameter

				IncomingMessageDiscardedDueToOverload		IMS-MTAS						Diameter

				SentUnsuccessfulAnswerToPeer		IMS-MTAS						Diameter

				SentAnswerToPeer		IMS-MTAS						Diameter

				SentRequestToPeer		IMS-MTAS						Diameter

				ReceivedUnsuccessfulAnswerFromPeer		IMS-MTAS						Diameter

				ReceivedAnswerFromPeer		IMS-MTAS						Diameter

				ReceivedRequestFromPeer		IMS-MTAS						Diameter



The following regExp is the default pattern for each  counter family:
^A[0-9] * DiameterMeasures*
^A[0-9] *IPv4*
^A[0-9] *PlatformMeasures*

Files name examples:
A20130216.2150-2155_cscfhan10_Diameter_error_counters
A20130216.2150-2155_cscfhan10_Diameter_traffic_counters
A20130216.2150-2155_cscfhan10_IPv4_MeassurementJob
A20130216.2150-2155_cscfhan10_PlatformMeasures
A20140420.1345-1350_pphss10_OamProvisioningCounterMJ



MRFP



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

						A20130830.1530-1545_1.xml		A.*xml





				Counter Name		File Pattern Type

				pmAal2ConnectionNo  		^A[0-9]*

				pmAbnormTermContexts  		^A[0-9]*

				pmAbnormTermTerminations  		^A[0-9]*

				pmAmrSeizures  		^A[0-9]*

				pmAmrWbSeizures  		^A[0-9]*

				pmAnncSessionCreateReqs  		^A[0-9]*

				pmAnncSessionCreateReqsFailed  		^A[0-9]*

				pmAnncSessions  		^A[0-9]*

				pmAoIpConnLatePktsRatio0  		^A[0-9]*

				pmAoIpConnLatePktsRatio1  		^A[0-9]*

				pmAoIpConnLatePktsRatio2  		^A[0-9]*

				pmAoIpConnLatePktsRatio3  		^A[0-9]*

				pmAoIpConnLatePktsRatio4  		^A[0-9]*

				pmAoIpConnLatePktsRatio5  		^A[0-9]*

				pmAoIpConnLatePktsRatio6  		^A[0-9]*

				pmAoIpConnMeasuredJitter0  		^A[0-9]*

				pmAoIpConnMeasuredJitter1  		^A[0-9]*

				pmAoIpConnMeasuredJitter2  		^A[0-9]*

				pmAoIpConnMeasuredJitter3  		^A[0-9]*

				pmAoIpConnMeasuredJitter3a  		^A[0-9]*

				pmAoIpConnMeasuredJitter3b  		^A[0-9]*

				pmAoIpConnMeasuredJitter3c  		^A[0-9]*

				pmAoIpConnMeasuredJitter4  		^A[0-9]*

				pmAoIpConnMeasuredJitter4a  		^A[0-9]*

				pmAoIpConnMeasuredJitter4b  		^A[0-9]*

				pmAoIpConnMeasuredJitter4c  		^A[0-9]*

				pmAoIpConnMeasuredJitter5  		^A[0-9]*

				pmAoIpConnMeasuredJitter5a  		^A[0-9]*

				pmAoIpConnMeasuredJitter5b  		^A[0-9]*

				pmAoIpConnMeasuredJitter5c  		^A[0-9]*

				pmAtmCnConnLatePktsRatio0  		^A[0-9]*

				pmAtmCnConnLatePktsRatio1  		^A[0-9]*

				pmAtmCnConnLatePktsRatio2  		^A[0-9]*

				pmAtmCnConnLatePktsRatio3  		^A[0-9]*

				pmAtmCnConnLatePktsRatio4  		^A[0-9]*

				pmAtmCnConnLatePktsRatio5  		^A[0-9]*

				pmAtmCnConnLatePktsRatio6  		^A[0-9]*

				pmAtmCnConnMeasuredJitter0  		^A[0-9]*

				pmAtmCnConnMeasuredJitter1  		^A[0-9]*

				pmAtmCnConnMeasuredJitter2  		^A[0-9]*

				pmAtmCnConnMeasuredJitter3  		^A[0-9]*

				pmAtmCnConnMeasuredJitter3a  		^A[0-9]*

				pmAtmCnConnMeasuredJitter3b  		^A[0-9]*

				pmAtmCnConnMeasuredJitter3c  		^A[0-9]*

				pmAtmCnConnMeasuredJitter4  		^A[0-9]*

				pmAtmCnConnMeasuredJitter4a  		^A[0-9]*

				pmAtmCnConnMeasuredJitter4b  		^A[0-9]*

				pmAtmCnConnMeasuredJitter4c  		^A[0-9]*

				pmAtmCnConnMeasuredJitter5  		^A[0-9]*

				pmAtmCnConnMeasuredJitter5a  		^A[0-9]*

				pmAtmCnConnMeasuredJitter5b  		^A[0-9]*

				pmAtmCnConnMeasuredJitter5c  		^A[0-9]*

				pmAtmRanConnLatePktsRatio0  		^A[0-9]*

				pmAtmRanConnLatePktsRatio1  		^A[0-9]*

				pmAtmRanConnLatePktsRatio2  		^A[0-9]*

				pmAtmRanConnLatePktsRatio3  		^A[0-9]*

				pmAtmRanConnLatePktsRatio4  		^A[0-9]*

				pmAtmRanConnLatePktsRatio5  		^A[0-9]*

				pmAtmRanConnLatePktsRatio6  		^A[0-9]*

				pmAtmRanConnMeasuredJitter0  		^A[0-9]*

				pmAtmRanConnMeasuredJitter1  		^A[0-9]*

				pmAtmRanConnMeasuredJitter2  		^A[0-9]*

				pmAtmRanConnMeasuredJitter3  		^A[0-9]*

				pmAtmRanConnMeasuredJitter3a  		^A[0-9]*

				pmAtmRanConnMeasuredJitter3b  		^A[0-9]*

				pmAtmRanConnMeasuredJitter3c  		^A[0-9]*

				pmAtmRanConnMeasuredJitter4  		^A[0-9]*

				pmAtmRanConnMeasuredJitter4a  		^A[0-9]*

				pmAtmRanConnMeasuredJitter4b  		^A[0-9]*

				pmAtmRanConnMeasuredJitter4c  		^A[0-9]*

				pmAtmRanConnMeasuredJitter5  		^A[0-9]*

				pmAtmRanConnMeasuredJitter5a  		^A[0-9]*

				pmAtmRanConnMeasuredJitter5b  		^A[0-9]*

				pmAtmRanConnMeasuredJitter5c  		^A[0-9]*

				pmAudioConferenceCreations  		^A[0-9]*

				pmAudioConferences  		^A[0-9]*

				pmAudioConfParticipantCreations  		^A[0-9]*

				pmAudioConfParticipants  		^A[0-9]*

				pmAudioConfParticipants  		^A[0-9]*

				pmAudioConfPartRejDueToCap  		^A[0-9]*

				pmAverageBwAmrAoipPtime20  		^A[0-9]*

				pmAverageBwAmrNbPtime20  		^A[0-9]*

				pmAverageBwAmrVoipPtime20  		^A[0-9]*

				pmAverageBwAmrVoipPtime40  		^A[0-9]*

				pmAverageBwAmrWbAoipPtime20  		^A[0-9]*

				pmAverageBwAmrWbNbPtime20  		^A[0-9]*

				pmAverageBwAmrWbVoipPtime20  		^A[0-9]*

				pmAverageBwAmrWbVoipPtime40  		^A[0-9]*

				pmAverageBwEfrAoipPtime20  		^A[0-9]*

				pmAverageBwEfrNbPtime20  		^A[0-9]*

				pmAverageBwEfrVoipPtime20  		^A[0-9]*

				pmAverageBwEfrVoipPtime40  		^A[0-9]*

				pmAverageBwG729Ptime10  		^A[0-9]*

				pmAverageBwG729Ptime20  		^A[0-9]*

				pmAverageBwG729Ptime30  		^A[0-9]*

				pmAverageBwG729Ptime40  		^A[0-9]*

				pmAverageBwGsmFrAoipPtime20  		^A[0-9]*

				pmAverageBwGsmFrNbPtime20  		^A[0-9]*

				pmAverageBwGsmHrAoipPtime20  		^A[0-9]*

				pmAverageBwGsmHrNbPtime20  		^A[0-9]*

				pmAverageBwInmarsatIuPtime20  		^A[0-9]*

				pmAverageFaultyMeasureRate  		^A[0-9]*

				pmAvMedStreamChanSetUpRate  		^A[0-9]*

				pmBgfSessions  		^A[0-9]*

				pmBitTransSucc  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyInstances  		^A[0-9]*

				pmBusyUnitsAmrWb  		^A[0-9]*

				pmBusyUnitsG729  		^A[0-9]*

				pmCallAttempts  		^A[0-9]*

				pmCallAttempts  		^A[0-9]*

				pmCallAttempts  		^A[0-9]*

				pmCallAttempts  		^A[0-9]*

				pmCallsWithRtpPacketLoss0  		^A[0-9]*

				pmCallsWithRtpPacketLoss0  		^A[0-9]*

				pmCallsWithRtpPacketLoss1  		^A[0-9]*

				pmCallsWithRtpPacketLoss1  		^A[0-9]*

				pmCallsWithRtpPacketLoss2  		^A[0-9]*

				pmCallsWithRtpPacketLoss2  		^A[0-9]*

				pmCallsWithRtpPacketLoss3  		^A[0-9]*

				pmCallsWithRtpPacketLoss3  		^A[0-9]*

				pmCallsWithRtpPacketLoss4  		^A[0-9]*

				pmCallsWithRtpPacketLoss4  		^A[0-9]*

				pmCallsWithRtpPacketLoss5  		^A[0-9]*

				pmCallsWithRtpPacketLoss5  		^A[0-9]*

				pmCallsWithRtpPacketLoss6  		^A[0-9]*

				pmCallsWithRtpPacketLoss6  		^A[0-9]*

				pmConnLatePktsRatio0  		^A[0-9]*

				pmConnLatePktsRatio0  		^A[0-9]*

				pmConnLatePktsRatio1  		^A[0-9]*

				pmConnLatePktsRatio1  		^A[0-9]*

				pmConnLatePktsRatio2  		^A[0-9]*

				pmConnLatePktsRatio2  		^A[0-9]*

				pmConnLatePktsRatio3  		^A[0-9]*

				pmConnLatePktsRatio3  		^A[0-9]*

				pmConnLatePktsRatio4  		^A[0-9]*

				pmConnLatePktsRatio4  		^A[0-9]*

				pmConnLatePktsRatio5  		^A[0-9]*

				pmConnLatePktsRatio5  		^A[0-9]*

				pmConnLatePktsRatio6  		^A[0-9]*

				pmConnLatePktsRatio6  		^A[0-9]*

				pmConnMeasuredJitter0  		^A[0-9]*

				pmConnMeasuredJitter0  		^A[0-9]*

				pmConnMeasuredJitter1  		^A[0-9]*

				pmConnMeasuredJitter1  		^A[0-9]*

				pmConnMeasuredJitter2  		^A[0-9]*

				pmConnMeasuredJitter2  		^A[0-9]*

				pmConnMeasuredJitter3  		^A[0-9]*

				pmConnMeasuredJitter3  		^A[0-9]*

				pmConnMeasuredJitter3a  		^A[0-9]*

				pmConnMeasuredJitter3a  		^A[0-9]*

				pmConnMeasuredJitter3b  		^A[0-9]*

				pmConnMeasuredJitter3b  		^A[0-9]*

				pmConnMeasuredJitter3c  		^A[0-9]*

				pmConnMeasuredJitter3c  		^A[0-9]*

				pmConnMeasuredJitter4  		^A[0-9]*

				pmConnMeasuredJitter4  		^A[0-9]*

				pmConnMeasuredJitter4a  		^A[0-9]*

				pmConnMeasuredJitter4a  		^A[0-9]*

				pmConnMeasuredJitter4b  		^A[0-9]*

				pmConnMeasuredJitter4b  		^A[0-9]*

				pmConnMeasuredJitter4c  		^A[0-9]*

				pmConnMeasuredJitter4c  		^A[0-9]*

				pmConnMeasuredJitter5  		^A[0-9]*

				pmConnMeasuredJitter5  		^A[0-9]*

				pmConnMeasuredJitter5a  		^A[0-9]*

				pmConnMeasuredJitter5a  		^A[0-9]*

				pmConnMeasuredJitter5b  		^A[0-9]*

				pmConnMeasuredJitter5b  		^A[0-9]*

				pmConnMeasuredJitter5c  		^A[0-9]*

				pmConnMeasuredJitter5c  		^A[0-9]*

				pmConnMeasuredJitter6  		^A[0-9]*

				pmConnMeasuredJitter6  		^A[0-9]*

				pmConnMeasuredJitter7  		^A[0-9]*

				pmConnMeasuredJitter7  		^A[0-9]*

				pmConnMeasuredJitter8  		^A[0-9]*

				pmConnMeasuredJitter8  		^A[0-9]*

				pmConnsOnRemoteSite  		^A[0-9]*

				pmConnsOnUnknownRemoteSite  		^A[0-9]*

				pmContextReqs  		^A[0-9]*

				pmContextReqs  		^A[0-9]*

				pmContextReqsRej  		^A[0-9]*

				pmContextReqsRejApplOverload  		^A[0-9]*

				pmContextReqsRejDpOverload  		^A[0-9]*

				pmContextReqsRejIntEthOverload  		^A[0-9]*

				pmContextReqsRejNpOverload  		^A[0-9]*

				pmContexts  		^A[0-9]*

				pmContexts  		^A[0-9]*

				pmDiscardedInboundFrames  		^A[0-9]*

				pmDiscardedOutboundFrames  		^A[0-9]*

				pmDnsQueryReqs  		^A[0-9]*

				pmDnsQueryReqsFailed  		^A[0-9]*

				pmDot1qTpVlanPortInDiscardsLink1  		^A[0-9]*

				pmDot1qTpVlanPortInDiscardsLink2  		^A[0-9]*

				pmDot1qTpVlanPortInFrames  		^A[0-9]*

				pmDot1qTpVlanPortOutFrames  		^A[0-9]*

				pmDpLoad  		^A[0-9]*

				pmEgressDiscardsByOverload  		^A[0-9]*

				pmEgressLoad  		^A[0-9]*

				pmEs  		^A[0-9]*

				pmEs  		^A[0-9]*

				pmEs  		^A[0-9]*

				pmEsp  		^A[0-9]*

				pmExtAnnouncementReqs  		^A[0-9]*

				pmExtAnnouncementReqsFailed  		^A[0-9]*

				pmExtConnLatePktsRatio0  		^A[0-9]*

				pmExtConnLatePktsRatio1  		^A[0-9]*

				pmExtConnLatePktsRatio2  		^A[0-9]*

				pmExtConnLatePktsRatio3  		^A[0-9]*

				pmExtConnLatePktsRatio4  		^A[0-9]*

				pmExtConnLatePktsRatio5  		^A[0-9]*

				pmExtConnLatePktsRatio6  		^A[0-9]*

				pmExtConnMeasuredJitter0  		^A[0-9]*

				pmExtConnMeasuredJitter1  		^A[0-9]*

				pmExtConnMeasuredJitter2  		^A[0-9]*

				pmExtConnMeasuredJitter3  		^A[0-9]*

				pmExtConnMeasuredJitter3a  		^A[0-9]*

				pmExtConnMeasuredJitter3b  		^A[0-9]*

				pmExtConnMeasuredJitter3c  		^A[0-9]*

				pmExtConnMeasuredJitter4  		^A[0-9]*

				pmExtConnMeasuredJitter4a  		^A[0-9]*

				pmExtConnMeasuredJitter4b  		^A[0-9]*

				pmExtConnMeasuredJitter4c  		^A[0-9]*

				pmExtConnMeasuredJitter5  		^A[0-9]*

				pmExtConnMeasuredJitter5a  		^A[0-9]*

				pmExtConnMeasuredJitter5b  		^A[0-9]*

				pmExtConnMeasuredJitter5c  		^A[0-9]*

				pmExtConnMeasuredJitter6  		^A[0-9]*

				pmExtConnMeasuredJitter7  		^A[0-9]*

				pmExtConnMeasuredJitter8  		^A[0-9]*

				pmFailedCallAttempts  		^A[0-9]*

				pmFailedCallAttempts  		^A[0-9]*

				pmFailedCallAttempts  		^A[0-9]*

				pmFailedCallAttempts  		^A[0-9]*

				pmFaultyMeasureRate  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmForcedRelease  		^A[0-9]*

				pmG711Seizures  		^A[0-9]*

				pmG722Seizures  		^A[0-9]*

				pmG729Seizures  		^A[0-9]*

				pmGcpNrOfReceivedMessages  		^A[0-9]*

				pmGcpNrOfSentMessages  		^A[0-9]*

				pmGcpSystemUpTime  		^A[0-9]*

				pmH248TransFaultsPend  		^A[0-9]*

				pmH248TransFaultsPend  		^A[0-9]*

				pmH248TransRelRetrans  		^A[0-9]*

				pmH248TransRelRetrans  		^A[0-9]*

				pmHdAudioRejDueToNoLicense  		^A[0-9]*

				pmHDelayVarBest10Pct  		^A[0-9]*

				pmHDelayVarBest1Pct  		^A[0-9]*

				pmHDelayVarBest50Pct  		^A[0-9]*

				pmHdVideoConfParticipants  		^A[0-9]*

				pmHdVideoConfPartRejDueToCap  		^A[0-9]*

				pmHdVoiceTranscodingReqs  		^A[0-9]*

				pmHdVoiceTranscodingReqsRej  		^A[0-9]*

				pmHdVoiceTransSess  		^A[0-9]*

				pmHdVoiceTransSess  		^A[0-9]*

				pmHdVoiceTransSessRejDueToCap  		^A[0-9]*

				pmHttpGetReqs  		^A[0-9]*

				pmHttpGetReqsFailedFileNotFound  		^A[0-9]*

				pmHttpGetReqsFailedOtherError  		^A[0-9]*

				pmI10ValAslr  		^A[0-9]*

				pmI10ValAsls  		^A[0-9]*

				pmI10ValErl  		^A[0-9]*

				pmI10ValPd  		^A[0-9]*

				pmI11ValAslr  		^A[0-9]*

				pmI11ValAsls  		^A[0-9]*

				pmI11ValErl  		^A[0-9]*

				pmI11ValPd  		^A[0-9]*

				pmI12ValAslr  		^A[0-9]*

				pmI12ValAsls  		^A[0-9]*

				pmI12ValErl  		^A[0-9]*

				pmI12ValPd  		^A[0-9]*

				pmI13ValAslr  		^A[0-9]*

				pmI13ValAsls  		^A[0-9]*

				pmI13ValErl  		^A[0-9]*

				pmI13ValPd  		^A[0-9]*

				pmI14ValAslr  		^A[0-9]*

				pmI14ValAsls  		^A[0-9]*

				pmI14ValErl  		^A[0-9]*

				pmI14ValPd  		^A[0-9]*

				pmI15ValAslr  		^A[0-9]*

				pmI15ValAsls  		^A[0-9]*

				pmI15ValErl  		^A[0-9]*

				pmI15ValPd  		^A[0-9]*

				pmI16ValAslr  		^A[0-9]*

				pmI16ValAsls  		^A[0-9]*

				pmI16ValErl  		^A[0-9]*

				pmI16ValPd  		^A[0-9]*

				pmI1ValAslr  		^A[0-9]*

				pmI1ValAsls  		^A[0-9]*

				pmI1ValErl  		^A[0-9]*

				pmI1ValPd  		^A[0-9]*

				pmI2ValAslr  		^A[0-9]*

				pmI2ValAsls  		^A[0-9]*

				pmI2ValErl  		^A[0-9]*

				pmI2ValPd  		^A[0-9]*

				pmI3ValAslr  		^A[0-9]*

				pmI3ValAsls  		^A[0-9]*

				pmI3ValErl  		^A[0-9]*

				pmI3ValPd  		^A[0-9]*

				pmI4ValAslr  		^A[0-9]*

				pmI4ValAsls  		^A[0-9]*

				pmI4ValErl  		^A[0-9]*

				pmI4ValPd  		^A[0-9]*

				pmI5ValAslr  		^A[0-9]*

				pmI5ValAsls  		^A[0-9]*

				pmI5ValErl  		^A[0-9]*

				pmI5ValPd  		^A[0-9]*

				pmI6ValAslr  		^A[0-9]*

				pmI6ValAsls  		^A[0-9]*

				pmI6ValErl  		^A[0-9]*

				pmI6ValPd  		^A[0-9]*

				pmI7ValAslr  		^A[0-9]*

				pmI7ValAsls  		^A[0-9]*

				pmI7ValErl  		^A[0-9]*

				pmI7ValPd  		^A[0-9]*

				pmI8ValAslr  		^A[0-9]*

				pmI8ValAsls  		^A[0-9]*

				pmI8ValErl  		^A[0-9]*

				pmI8ValPd  		^A[0-9]*

				pmI9ValAslr  		^A[0-9]*

				pmI9ValAsls  		^A[0-9]*

				pmI9ValErl  		^A[0-9]*

				pmI9ValPd  		^A[0-9]*

				pmIcmpInDestUnreachs  		^A[0-9]*

				pmIcmpInDestUnreachs  		^A[0-9]*

				pmIcmpInEchoReps  		^A[0-9]*

				pmIcmpInEchoReps  		^A[0-9]*

				pmIcmpInEchos  		^A[0-9]*

				pmIcmpInEchos  		^A[0-9]*

				pmIcmpInErrors  		^A[0-9]*

				pmIcmpInErrors  		^A[0-9]*

				pmIcmpInMsgs  		^A[0-9]*

				pmIcmpInMsgs  		^A[0-9]*

				pmIcmpInParamProbs  		^A[0-9]*

				pmIcmpInParamProbs  		^A[0-9]*

				pmIcmpInRedirects  		^A[0-9]*

				pmIcmpInRedirects  		^A[0-9]*

				pmIcmpInSrcQuenchs  		^A[0-9]*

				pmIcmpInSrcQuenchs  		^A[0-9]*

				pmIcmpInTimeExcds  		^A[0-9]*

				pmIcmpInTimeExcds  		^A[0-9]*

				pmIcmpOutDestUnreachs  		^A[0-9]*

				pmIcmpOutDestUnreachs  		^A[0-9]*

				pmIcmpOutEchoReps  		^A[0-9]*

				pmIcmpOutEchoReps  		^A[0-9]*

				pmIcmpOutEchos  		^A[0-9]*

				pmIcmpOutEchos  		^A[0-9]*

				pmIcmpOutErrors  		^A[0-9]*

				pmIcmpOutErrors  		^A[0-9]*

				pmIcmpOutMsgs  		^A[0-9]*

				pmIcmpOutMsgs  		^A[0-9]*

				pmIcmpOutParamProbs  		^A[0-9]*

				pmIcmpOutParmProbs  		^A[0-9]*

				pmIfInBroadcastPkts  		^A[0-9]*

				pmIfInBroadcastPkts  		^A[0-9]*

				pmIfInBroadcastPktsLink1  		^A[0-9]*

				pmIfInBroadcastPktsLink2  		^A[0-9]*

				pmIfInDiscards  		^A[0-9]*

				pmIfInDiscards  		^A[0-9]*

				pmIfInDiscardsLink1  		^A[0-9]*

				pmIfInDiscardsLink2  		^A[0-9]*

				pmIfInErrors  		^A[0-9]*

				pmIfInErrors  		^A[0-9]*

				pmIfInErrorsLink1  		^A[0-9]*

				pmIfInErrorsLink2  		^A[0-9]*

				pmIfInMulticastPkts  		^A[0-9]*

				pmIfInMulticastPkts  		^A[0-9]*

				pmIfInMulticastPktsLink1  		^A[0-9]*

				pmIfInMulticastPktsLink2  		^A[0-9]*

				pmIfInOctetsHi  		^A[0-9]*

				pmIfInOctetsHi  		^A[0-9]*

				pmIfInOctetsLink1Hi  		^A[0-9]*

				pmIfInOctetsLink1Lo  		^A[0-9]*

				pmIfInOctetsLink2Hi  		^A[0-9]*

				pmIfInOctetsLink2Lo  		^A[0-9]*

				pmIfInOctetsLo  		^A[0-9]*

				pmIfInOctetsLo  		^A[0-9]*

				pmIfInUcastPkts  		^A[0-9]*

				pmIfInUcastPkts  		^A[0-9]*

				pmIfInUcastPktsLink1  		^A[0-9]*

				pmIfInUcastPktsLink2  		^A[0-9]*

				pmIfInUnknownProtos  		^A[0-9]*

				pmIfInUnknownProtosLink1  		^A[0-9]*

				pmIfInUnknownProtosLink2  		^A[0-9]*

				pmIfOutBroadcastPkts  		^A[0-9]*

				pmIfOutBroadcastPkts  		^A[0-9]*

				pmIfOutBroadcastPktsLink1  		^A[0-9]*

				pmIfOutBroadcastPktsLink2  		^A[0-9]*

				pmIfOutDiscards  		^A[0-9]*

				pmIfOutDiscards  		^A[0-9]*

				pmIfOutDiscardsLink1  		^A[0-9]*

				pmIfOutDiscardsLink2  		^A[0-9]*

				pmIfOutErrors  		^A[0-9]*

				pmIfOutErrors  		^A[0-9]*

				pmIfOutErrorsLink1  		^A[0-9]*

				pmIfOutErrorsLink2  		^A[0-9]*

				pmIfOutMulticastPkts  		^A[0-9]*

				pmIfOutMulticastPkts  		^A[0-9]*

				pmIfOutMulticastPktsLink1  		^A[0-9]*

				pmIfOutMulticastPktsLink2  		^A[0-9]*

				pmIfOutOctetsHi  		^A[0-9]*

				pmIfOutOctetsHi  		^A[0-9]*

				pmIfOutOctetsLink1Hi  		^A[0-9]*

				pmIfOutOctetsLink1Lo  		^A[0-9]*

				pmIfOutOctetsLink2Hi  		^A[0-9]*

				pmIfOutOctetsLink2Lo  		^A[0-9]*

				pmIfOutOctetsLo  		^A[0-9]*

				pmIfOutOctetsLo  		^A[0-9]*

				pmIfOutUcastPkts  		^A[0-9]*

				pmIfOutUcastPkts  		^A[0-9]*

				pmIfOutUcastPktsLink1  		^A[0-9]*

				pmIfOutUcastPktsLink2  		^A[0-9]*

				pmIfStatsHCIpInMcastOctets  		^A[0-9]*

				pmIfStatsHCIpInMcastPkts  		^A[0-9]*

				pmIfStatsHCIpOutMcastOctets  		^A[0-9]*

				pmIfStatsHCIpOutMcastPkts  		^A[0-9]*

				pmIfStatsIpAddrErrors  		^A[0-9]*

				pmIfStatsIpInDiscards  		^A[0-9]*

				pmIfStatsIpInHdrErrors  		^A[0-9]*

				pmIfStatsIpInReceives  		^A[0-9]*

				pmIfStatsIpOutDiscards  		^A[0-9]*

				pmIfStatsIpOutRequests  		^A[0-9]*

				pmIfStatsIpUnknownProtos  		^A[0-9]*

				pmInAppLayerError  		^A[0-9]*

				pmInControlChunkAbnormal  		^A[0-9]*

				pmInControlChunkDiscards  		^A[0-9]*

				pmInControlChunks  		^A[0-9]*

				pmInDataChunkAbnormal  		^A[0-9]*

				pmInDataChunkDiscards  		^A[0-9]*

				pmInDataChunks  		^A[0-9]*

				pmInDiscPolicy  		^A[0-9]*

				pmInEsp  		^A[0-9]*

				pmIngressCorrupts15  		^A[0-9]*

				pmIngressErrorsInLine15  		^A[0-9]*

				pmIngressLoad  		^A[0-9]*

				pmInOctets  		^A[0-9]*

				pmInPacks  		^A[0-9]*

				pmInPassedPolicy  		^A[0-9]*

				pmIntEthIfBwLoad  		^A[0-9]*

				pmIpCnConnLatePktsRatio0  		^A[0-9]*

				pmIpCnConnLatePktsRatio1  		^A[0-9]*

				pmIpCnConnLatePktsRatio2  		^A[0-9]*

				pmIpCnConnLatePktsRatio3  		^A[0-9]*

				pmIpCnConnLatePktsRatio4  		^A[0-9]*

				pmIpCnConnLatePktsRatio5  		^A[0-9]*

				pmIpCnConnLatePktsRatio6  		^A[0-9]*

				pmIpCnConnMeasuredJitter0  		^A[0-9]*

				pmIpCnConnMeasuredJitter1  		^A[0-9]*

				pmIpCnConnMeasuredJitter2  		^A[0-9]*

				pmIpCnConnMeasuredJitter3  		^A[0-9]*

				pmIpCnConnMeasuredJitter3a  		^A[0-9]*

				pmIpCnConnMeasuredJitter3b  		^A[0-9]*

				pmIpCnConnMeasuredJitter3c  		^A[0-9]*

				pmIpCnConnMeasuredJitter4  		^A[0-9]*

				pmIpCnConnMeasuredJitter4a  		^A[0-9]*

				pmIpCnConnMeasuredJitter4b  		^A[0-9]*

				pmIpCnConnMeasuredJitter4c  		^A[0-9]*

				pmIpCnConnMeasuredJitter5  		^A[0-9]*

				pmIpCnConnMeasuredJitter5a  		^A[0-9]*

				pmIpCnConnMeasuredJitter5b  		^A[0-9]*

				pmIpCnConnMeasuredJitter5c  		^A[0-9]*

				pmIpFragCreates  		^A[0-9]*

				pmIpFragCreates  		^A[0-9]*

				pmIpFragFails  		^A[0-9]*

				pmIpFragFails  		^A[0-9]*

				pmIpFragOks  		^A[0-9]*

				pmIpFragOKs  		^A[0-9]*

				pmIpIfStatsHCInOctets  		^A[0-9]*

				pmIpIfStatsHCInOctets  		^A[0-9]*

				pmIpIfStatsHCInReceives  		^A[0-9]*

				pmIpIfStatsHCInReceives  		^A[0-9]*

				pmIpIfStatsHCOutOctets  		^A[0-9]*

				pmIpIfStatsHCOutOctets  		^A[0-9]*

				pmIpIfStatsHCOutTransmits  		^A[0-9]*

				pmIpIfStatsHCOutTransmits  		^A[0-9]*

				pmIpIfStatsInAddrErrors  		^A[0-9]*

				pmIpIfStatsInDiscards  		^A[0-9]*

				pmIpIfStatsInHdrErrors  		^A[0-9]*

				pmIpIfStatsInUnknownProtos  		^A[0-9]*

				pmIpIfStatsOutDiscards  		^A[0-9]*

				pmIpIfStatsOutFragCreates  		^A[0-9]*

				pmIpIfStatsReasmFails  		^A[0-9]*

				pmIpIfStatsReasmReqds  		^A[0-9]*

				pmIpInAddrErrors  		^A[0-9]*

				pmIpInAddrErrors  		^A[0-9]*

				pmIpInDelivers  		^A[0-9]*

				pmIpInDelivers  		^A[0-9]*

				pmIpInDiscards  		^A[0-9]*

				pmIpInDiscards  		^A[0-9]*

				pmIpInHdrErrors  		^A[0-9]*
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				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTotalSeizures  		^A[0-9]*

				pmTransmDmFramesRspToSabme  		^A[0-9]*

				pmTransmittedBpdu  		^A[0-9]*

				pmTransmittedFrames  		^A[0-9]*

				pmTxBwHi  		^A[0-9]*

				pmTxBwLo  		^A[0-9]*

				pmTxDiscHi  		^A[0-9]*

				pmTxDiscLo  		^A[0-9]*

				pmTxDiscPktsAf1Hi  		^A[0-9]*

				pmTxDiscPktsAf1Lo  		^A[0-9]*

				pmTxDiscPktsAf2Hi  		^A[0-9]*

				pmTxDiscPktsAf2Lo  		^A[0-9]*

				pmTxDiscPktsAf3Hi  		^A[0-9]*

				pmTxDiscPktsAf3Lo  		^A[0-9]*

				pmTxDiscPktsAf4Hi  		^A[0-9]*

				pmTxDiscPktsAf4Lo  		^A[0-9]*

				pmTxDiscPktsDfHi  		^A[0-9]*

				pmTxDiscPktsDfLo  		^A[0-9]*

				pmTxDiscPktsEfHi  		^A[0-9]*

				pmTxDiscPktsEfLo  		^A[0-9]*

				pmTxDiscPktsIcHi  		^A[0-9]*

				pmTxDiscPktsIcLo  		^A[0-9]*

				pmTxDiscPktsNoNextHopHi  		^A[0-9]*

				pmTxDiscPktsNoNextHopLo  		^A[0-9]*

				pmTxFramesHi  		^A[0-9]*

				pmTxFramesLo  		^A[0-9]*

				pmTxOctetsHi  		^A[0-9]*

				pmTxOctetsHi  		^A[0-9]*

				pmTxOctetsLo  		^A[0-9]*

				pmTxOctetsLo  		^A[0-9]*

				pmTxPauseFramesHi  		^A[0-9]*

				pmTxPauseFramesLo  		^A[0-9]*

				pmTxPktsAf1Hi  		^A[0-9]*

				pmTxPktsAf1Lo  		^A[0-9]*

				pmTxPktsAf2Hi  		^A[0-9]*

				pmTxPktsAf2Lo  		^A[0-9]*

				pmTxPktsAf3Hi  		^A[0-9]*

				pmTxPktsAf3Lo  		^A[0-9]*

				pmTxPktsAf4Hi  		^A[0-9]*

				pmTxPktsAf4Lo  		^A[0-9]*

				pmTxPktsDfHi  		^A[0-9]*

				pmTxPktsDfLo  		^A[0-9]*

				pmTxPktsEfHi  		^A[0-9]*

				pmTxPktsEfLo  		^A[0-9]*

				pmTxPktsHi  		^A[0-9]*

				pmTxPktsIcHi  		^A[0-9]*

				pmTxPktsIcLo  		^A[0-9]*

				pmTxPktsLo  		^A[0-9]*

				pmUas  		^A[0-9]*

				pmUas  		^A[0-9]*

				pmUas  		^A[0-9]*

				pmUasp  		^A[0-9]*

				pmUdpIfStatsInError  		^A[0-9]*

				pmUdpInDatagrams  		^A[0-9]*

				pmUdpInDatagrams  		^A[0-9]*

				pmUdpInErrors  		^A[0-9]*

				pmUdpInErrors  		^A[0-9]*

				pmUdpNoPorts  		^A[0-9]*

				pmUdpNoPorts  		^A[0-9]*

				pmUdpOutDatagrams  		^A[0-9]*

				pmUdpOutDatagrams  		^A[0-9]*

				pmUnsentIuaMessages  		^A[0-9]*

				pmUnsentQptmMessages  		^A[0-9]*

				pmUnsuccRetrmsOthFramesN200Times  		^A[0-9]*

				pmUnsuccRetrmsSabmeN200Times  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUnsuccSeizures  		^A[0-9]*

				pmUsedBandwidthForIpTransport  		^A[0-9]*

				pmUsedBandwidthForSiteIntIpTrans  		^A[0-9]*

				pmV17Conns  		^A[0-9]*

				pmV27terConns  		^A[0-9]*

				pmV29Conns  		^A[0-9]*

				pmVcBbe  		^A[0-9]*

				pmVcBbe  		^A[0-9]*

				pmVcEs  		^A[0-9]*

				pmVcEs  		^A[0-9]*

				pmVcSes  		^A[0-9]*

				pmVcSes  		^A[0-9]*

				pmVcUas  		^A[0-9]*

				pmVcUas  		^A[0-9]*

				pmVideoConferenceCreations  		^A[0-9]*

				pmVideoConferences  		^A[0-9]*

				pmVideoConfParticipantCreations  		^A[0-9]*

				pmVideoConfParticipants  		^A[0-9]*

				pmVideoConfParticipants  		^A[0-9]*

				pmVideoConfPartRejDueToCap  		^A[0-9]*

				pmVideoParticipants  		^A[0-9]*

				pmVideoPartRejDueToCap  		^A[0-9]*

				pmVoiceTranscodingReqs  		^A[0-9]*

				pmVoiceTranscodingReqsRej  		^A[0-9]*

				pmVoiceTransSess  		^A[0-9]*

				pmVoiceTransSess  		^A[0-9]*

				pmVoiceTransSessRejDueToCap  		^A[0-9]*

				pmVoIpConnLatePktsRatio0  		^A[0-9]*

				pmVoIpConnLatePktsRatio1  		^A[0-9]*

				pmVoIpConnLatePktsRatio2  		^A[0-9]*

				pmVoIpConnLatePktsRatio3  		^A[0-9]*

				pmVoIpConnLatePktsRatio4  		^A[0-9]*

				pmVoIpConnLatePktsRatio5  		^A[0-9]*

				pmVoIpConnLatePktsRatio6  		^A[0-9]*

				pmVoIpConnMeasuredJitter0  		^A[0-9]*

				pmVoIpConnMeasuredJitter1  		^A[0-9]*

				pmVoIpConnMeasuredJitter2  		^A[0-9]*

				pmVoIpConnMeasuredJitter3  		^A[0-9]*

				pmVoIpConnMeasuredJitter3a  		^A[0-9]*

				pmVoIpConnMeasuredJitter3b  		^A[0-9]*

				pmVoIpConnMeasuredJitter3c  		^A[0-9]*

				pmVoIpConnMeasuredJitter4  		^A[0-9]*

				pmVoIpConnMeasuredJitter4a  		^A[0-9]*

				pmVoIpConnMeasuredJitter4b  		^A[0-9]*

				pmVoIpConnMeasuredJitter4c  		^A[0-9]*

				pmVoIpConnMeasuredJitter5  		^A[0-9]*

				pmVoIpConnMeasuredJitter5a  		^A[0-9]*

				pmVoIpConnMeasuredJitter5b  		^A[0-9]*

				pmVoIpConnMeasuredJitter5c  		^A[0-9]*

				pmVoIpConnMeasuredJitter6  		^A[0-9]*

				pmVoIpConnMeasuredJitter7  		^A[0-9]*

				pmVoIpConnMeasuredJitter8  		^A[0-9]*



The following regExp is the default pattern for each  counter family:
^A[0-9] * 


Files name examples:
A20130830.1530-1545_1.xml



MTAS



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

				MtasCDiv		A20130429.0000-0005_asme-hmbg-de01-test_MtasCDiv		.*_MtasCDiv		This file will contains counter that has file pattern type as "MtasCDiv"

				MtasCharging		A20130429.0000-0005_asme-hmbg-de01-test_MtasCharging		.*_MtasCharging.*

				MtasComBarring		A20130429.0000-0005_asme-hmbg-de01-test_MtasComBarring		.*_MtasBarring.*

				MtasConf		A20130429.0000-0005_asme-hmbg-de01-test_MtasConf		.*_MtasConf.*





				Counter Name		File Pattern Type

				MalformedReceivedRequests		Diameter_error_counters

				ProtocolErrorsAndPermanentFailures		Diameter_error_counters

				CerReceivedFromUnknownPeer		Diameter_error_counters

				tsp.diameter.malformedReceivedRequests		Diameter_error_counters

				tsp.diameter.protocolErrorsAndPermanentFailures		Diameter_error_counters

				tsp.diameter.cerReceivedFromUnknownPeer		Diameter_error_counters

				OutgoingMessageDiscardedDueToCongestion		Diameter_traffic_counters

				IncomingMessageDiscardedDueToOverload		Diameter_traffic_counters

				SentUnsuccessfulAnswerToPeer		Diameter_traffic_counters

				SentAnswerToPeer		Diameter_traffic_counters

				SentRequestToPeer		Diameter_traffic_counters

				ReceivedUnsuccessfulAnswerFromPeer		Diameter_traffic_counters

				ReceivedAnswerFromPeer		Diameter_traffic_counters

				ReceivedRequestFromPeer		Diameter_traffic_counters

				tsp.diameter.outgoingMessageDiscardedDueToCongestion		Diameter_traffic_counters

				tsp.diameter.incomingMessageDiscardedDueToOverload		Diameter_traffic_counters

				tsp.diameter.sentUnsuccessfulAnswerToPeer		Diameter_traffic_counters

				tsp.diameter.sentAnswerToPeer		Diameter_traffic_counters

				tsp.diameter.sentRequestToPeer		Diameter_traffic_counters

				tsp.diameter.receivedUnsuccessfulAnswerFromPeer		Diameter_traffic_counters

				tsp.diameter.receivedAnswerFromPeer		Diameter_traffic_counters

				tsp.diameter.receivedRequestFromPeer		Diameter_traffic_counters

				tsp.ipv4.ipv4IfStatsOutBytes		IPv4_MeasurementJob

				tsp.ipv4.ipv4IfStatsInBytes		IPv4_MeasurementJob

				tsp.ipv4.ipv4IfStatsOutPackets		IPv4_MeasurementJob

				tsp.ipv4.ipv4IfStatsInPackets		IPv4_MeasurementJob

				tsp.Cm.AverageResponseTime		OamProvisioningCounterMJ

				tsp.Cm.NumberofFailedAuthentications		OamProvisioningCounterMJ

				tsp.Cm.NumberofFailedOperations		OamProvisioningCounterMJ

				tsp.Cm.NumberofOperations		OamProvisioningCounterMJ

				tsp.Cm.NumberofUserSessions		OamProvisioningCounterMJ

				MOsTransaction		OamProvisioningCounterMJ

				AtomicTransaction		OamProvisioningCounterMJ

				RollbackCounter		OamProvisioningCounterMJ

				CommitCounter		OamProvisioningCounterMJ

				StartCounter		OamProvisioningCounterMJ

				ActionCounter		OamProvisioningCounterMJ

				AbandonCounter		OamProvisioningCounterMJ

				CompareCounter		OamProvisioningCounterMJ

				DeleteCounter		OamProvisioningCounterMJ

				UpdateCounter		OamProvisioningCounterMJ

				RetrieveCounter		OamProvisioningCounterMJ

				CreateCounter		OamProvisioningCounterMJ

				AuthenticateCounter		OamProvisioningCounterMJ

				MtasCsiCapIndicationIn		MtasCsi

				MtasCsiCapRequestOut		MtasCsi

				MtasExtMrfcRequestNOk		MtasExtMrfc

				MtasExtMrfcRequestOk		MtasExtMrfc

				MtasExtMrfcInviteRejected		MtasExtMrfc

				MtasExtMrfcInviteOk		MtasExtMrfc

				MtasNumNormNoRules		MtasNumNorm

				MtasNumNormBadUri		MtasNumNorm

				MtasNumNormAttempt		MtasNumNorm

				MtasXdmsCcmpConfCreateOk		MtasXdms

				MtasXdmsCcmpConfCreateNOkI		MtasXdms

				MtasXdmsCcmpConfCreateNOkE		MtasXdms

				MtasXdmsCcmpConfRetrieveOk		MtasXdms

				MtasXdmsCcmpConfRetrieveNOkI		MtasXdms

				MtasXdmsCcmpConfRetrieveNOkE		MtasXdms

				MtasXdmsCcmpConfDeleteOk		MtasXdms

				MtasXdmsCcmpConfDeleteNOkI		MtasXdms

				MtasXdmsCcmpConfDeleteNOkE		MtasXdms

				MtasXdmsXcapUnSuppSdVer		MtasXdms

				MtasXdmsXcapPutOk		MtasXdms

				MtasXdmsXcapPutNOkI		MtasXdms

				MtasXdmsXcapPutNOkE		MtasXdms

				MtasXdmsXcapGetOk		MtasXdms

				MtasXdmsXcapGetNOkI		MtasXdms

				MtasXdmsXcapGetNOkE		MtasXdms

				MtasXdmsXcapDeleteOk		MtasXdms

				MtasXdmsXcapDeleteNOkI		MtasXdms

				MtasXdmsXcapDeleteNOkE		MtasXdms

				MtasXdmsCai3gUnSuppSdVer		MtasXdms

				MtasXdmsCai3gSetOk		MtasXdms

				MtasXdmsCai3gSetNOkI		MtasXdms

				MtasXdmsCai3gSetNOkE		MtasXdms

				MtasXdmsCai3gSessionTimeOut		MtasXdms

				MtasXdmsCai3gLogoutNOkI		MtasXdms

				MtasXdmsCai3gLogoutNOkE		MtasXdms

				MtasXdmsCai3gLoginOk		MtasXdms

				MtasXdmsCai3gLoginNOkI		MtasXdms

				MtasXdmsCai3gLoginNOkE		MtasXdms

				MtasXdmsCai3gGetOk		MtasXdms

				MtasXdmsCai3gGetNOkI		MtasXdms

				MtasXdmsCai3gGetNOkE		MtasXdms

				MtasXdmsCai3gDeleteOk		MtasXdms

				MtasXdmsCai3gDeleteNOkI		MtasXdms

				MtasXdmsCai3gDeleteNOkE		MtasXdms

				MtasXdmsCai3gCreateOk		MtasXdms

				MtasXdmsCai3gCreateNOkI		MtasXdms

				MtasXdmsCai3gCreateNOkE		MtasXdms

				MtasShUpdateOk		MtasShInterface

				MtasShUpdateNOkI		MtasShInterface

				MtasShUpdateNOkE		MtasShInterface

				MtasShSubsNotifOk		MtasShInterface

				MtasShSubsNotifNOkI		MtasShInterface

				MtasShSubsNotifNOkE		MtasShInterface

				MtasShResponse		MtasShInterface

				MtasShRedirectFailed		MtasShInterface

				MtasShRedirect		MtasShInterface

				MtasShPullOk		MtasShInterface

				MtasShPullNOkI		MtasShInterface

				MtasShPullNOkE		MtasShInterface

				MtasShNotifOk		MtasShInterface

				MtasShNotifNOkI		MtasShInterface

				MtasShNotifNOkE		MtasShInterface

				MtasSubsDataMgmtQueryReq		MtasSubsDataMgmt

				MtasSubsDataMgmtPurgeSub		MtasSubsDataMgmt

				MtasSubsDataMgmtPurgeReq		MtasSubsDataMgmt

				MtasSubsDataMgmtPurgeNOk		MtasSubsDataMgmt

				MtasSubsDataUpdateOk		MtasSubsData

				MtasSubsDataUpdateNOkI		MtasSubsData

				MtasSubsDataUpdateNOkE		MtasSubsData

				MtasSubsDataUnSuppSdVer		MtasSubsData

				MtasSubsDataReregOk		MtasSubsData

				MtasSubsDataReregNOkI		MtasSubsData

				MtasSubsDataReregNOkE		MtasSubsData

				MtasSubsDataRegTimeout		MtasSubsData

				MtasSubsDataParseFail		MtasSubsData

				MtasSubsDataNotificationOk		MtasSubsData

				MtasSubsDataNotificationNOkI		MtasSubsData

				MtasSubsDataNotificationNOkE		MtasSubsData

				MtasSubsDataInitialRegOk		MtasSubsData

				MtasSubsDataInitialRegNOkI		MtasSubsData

				MtasSubsDataInitialRegNOkE		MtasSubsData

				MtasSubsDataCachedPui		MtasSubsData

				MtasSubsDataDeregNOkI		MtasSubsData

				MtasSubsDataDeregNOkE		MtasSubsData

				MtasSubsDataCachedServRecord		MtasSubsData

				MtasSubsDataCachedPui		MtasSubsData

				MtasSubsDataAutoRegOk		MtasSubsData

				MtasSubsDataAutoRegNOkI		MtasSubsData

				MtasSubsDataAutoRegNOkE		MtasSubsData

				MtasMrfcSuccRegistration		MtasMrfc

				MtasMrfcRejectedRegistration		MtasMrfc

				MtasMrfcOverloadThresholdReached		MtasMrfc

				MtasMrfcInitiatedContextOk		MtasMrfc

				MtasMrfcInitiatedContextNOkI		MtasMrfc

				MtasMrfcInitiatedContextNOkE		MtasMrfc

				MtasMrfcInitiatedAnnOk		MtasMrfc

				MtasMrfcInitiatedAnnNOkI		MtasMrfc

				MtasMrfcLanguagesCnt		MtasMrfc

				MtasMrfcInitiatedAnnNOkE		MtasMrfc

				MtasMrfcContextTerminatedOk		MtasMrfc

				MtasChargingTermCca		MtasCharging

				MtasChargingTermAca		MtasCharging

				MtasChargingRttiOk		MtasCharging

				MtasChargingRttiNOkI		MtasCharging

				MtasChargingRttiNOkE		MtasCharging

				MtasChargingOrigCca		MtasCharging

				MtasChargingOrigAca		MtasCharging

				MtasChargingOnlineLicenseInvalid		MtasCharging

				MtasChargingOfflineLicenseInvalid		MtasCharging

				MtasChargingEmergencyCallNotification		MtasCharging

				MtasChargingCcrUpdateOk		MtasCharging

				MtasChargingCcrUpdateNOkI		MtasCharging

				MtasChargingCcrUpdateNOkE		MtasCharging

				MtasChargingCcrTermNOkI		MtasCharging

				MtasChargingCcrTermNOkE		MtasCharging

				MtasChargingCcrInitOk		MtasCharging

				MtasChargingCcrInitNOkI		MtasCharging

				MtasChargingCcrInitNOkE		MtasCharging

				MtasChargingCcrFailover		MtasCharging

				MtasChargingCcrEventNOkI		MtasCharging

				MtasChargingCcrEventNOkE		MtasCharging

				MtasChargingCcrEventOk		MtasCharging

				MtasChargingCcaUserUnknown		MtasCharging

				MtasChargingCcaUserServiceDenied		MtasCharging

				MtasChargingCcaTransientError		MtasCharging

				MtasChargingCcaProtocolError		MtasCharging

				MtasChargingCcaPermanentError		MtasCharging

				MtasChargingCcaLowBalanceIndication		MtasCharging

				MtasChargingCcaFinalUnitIndication		MtasCharging

				MtasChargingCcaCreditLimitReached		MtasCharging

				MtasChargingCcaCreditControlNA		MtasCharging

				MtasChargingBackupStopFail		MtasCharging

				MtasChargingBackupStop		MtasCharging

				MtasChargingBackupStartFail		MtasCharging

				MtasChargingBackupStart		MtasCharging

				MtasChargingBackupInterimFail		MtasCharging

				MtasChargingBackupInterim		MtasCharging

				MtasChargingBackupEventFail		MtasCharging

				MtasChargingBackupEvent		MtasCharging

				MtasChargingAcrStorageStopFail		MtasCharging

				MtasChargingAcrStorageStop		MtasCharging

				MtasChargingAcrStorageStartFail		MtasCharging

				MtasChargingAcrStorageStart		MtasCharging

				MtasChargingAcrStorageInterimFail		MtasCharging

				MtasChargingAcrStorageInterim		MtasCharging

				MtasChargingAcrStorageEventFail		MtasCharging

				MtasChargingAcrStorageEvent		MtasCharging

				MtasChargingAcrStopNOkI		MtasCharging

				MtasChargingAcrStopNOkE		MtasCharging

				MtasChargingAcrStartOk		MtasCharging

				MtasChargingAcrStartNOkI		MtasCharging

				MtasChargingAcrStartNOkE		MtasCharging

				MtasChargingAcrInterimOk		MtasCharging

				MtasChargingAcrInterimNOkI		MtasCharging

				MtasChargingAcrInterimNOkE		MtasCharging

				MtasChargingAcrFailover		MtasCharging

				MtasChargingAcrEventOk		MtasCharging

				MtasChargingAcrEventNOkI		MtasCharging

				MtasChargingAcrEventNOkE		MtasCharging

				MtasChargingAcaTransientError		MtasCharging

				MtasChargingAcaProtocolError		MtasCharging

				MtasChargingAcaPermanentError		MtasCharging

				MtasSccTermUnregCsFailedAttempt		MtasScc

				MtasSccTermUnregPsFailedAttempt		MtasScc

				MtasSccTermCsFailedAttempt		MtasScc

				MtasSccTermPsFailedAttempt		MtasScc

				MtasSccTermUnregPsSuccAttempt		MtasScc

				MtasSccTermUnregCsSuccAttempt		MtasScc

				MtasSccTermPsSuccAttempt		MtasScc

				MtasSccTermCsSuccAttempt		MtasScc

				MtasSccInitTermUnregSessNOkE		MtasScc

				MtasSccInitTermUnregSessNOkI		MtasScc

				MtasSccInitTermUnregSessOk		MtasScc

				MtasSccInitTermSessNOkE		MtasScc

				MtasSccInitTermSessNOkI		MtasScc

				MtasSccInitTermSessOk		MtasScc

				MtasSccCurrentTermSessionPs		MtasScc

				MtasSccCurrentTermSessionCs		MtasScc

				MtasSccInitOrigUnregSessCsNOkE		MtasScc

				MtasSccInitOrigUnregSessCsNOkI		MtasScc

				MtasSccInitOrigUnregSessCsOk		MtasScc

				MtasSccInitOrigSessCsNOkE		MtasScc

				MtasSccInitOrigSessCsNOkI		MtasScc

				MtasSccInitOrigSessCsOk		MtasScc

				MtasSccInitOrigUnregSessPsNOkE		MtasScc

				MtasSccInitOrigUnregSessPsNOkI		MtasScc

				MtasSccInitOrigUnregSessPsOk		MtasScc

				MtasSccInitOrigSessPsNOkE		MtasScc

				MtasSccInitOrigSessPsNOkI		MtasScc

				MtasSccInitOrigSessPsOk		MtasScc

				MtasSccCurrentOrigSessionCs		MtasScc

				MtasSccCurrentOrigSessionPs		MtasScc

				MtasWsNameDbGetOk		MtasWsNameDb

				MtasWsNameDbGetNOkI		MtasWsNameDb

				MtasWsNameDbGetNOkE		MtasWsNameDb

				MtasSipSccTermUnregRequestOverloadRej		MtasSip

				MtasSipSccTermUnregResponseOut		MtasSip

				MtasSipSccTermUnregResponseIn		MtasSip

				MtasSipSccTermUnregRequestOut		MtasSip

				MtasSipSccTermUnregRequestIn		MtasSip

				MtasSipSccTermRequestOverloadRej		MtasSip

				MtasSipSccTermResponseOut		MtasSip

				MtasSipSccTermResponseIn		MtasSip

				MtasSipSccTermRequestOut		MtasSip

				MtasSipSccTermRequestIn		MtasSip

				MtasSipSccOrigRequestOverloadRej		MtasSip

				MtasSipSccOrigResponseOut		MtasSip

				MtasSipSccOrigResponseIn		MtasSip

				MtasSipSccOrigRequestOut		MtasSip

				MtasSipSccOrigRequestIn		MtasSip

				MtasSipOrigUnregRequestOverloadRej		MtasSip

				MtasSipOrigUnregRequestOut		MtasSip

				MtasSipOrigUnregRequestIn		MtasSip

				MtasSipOrigUnregResponseOut		MtasSip

				MtasSipOrigUnregResponseIn		MtasSip

				MtasSipTermUnregResponseOut		MtasSip

				MtasSipTermUnregResponseIn		MtasSip

				MtasSipTermResponseOut		MtasSip

				MtasSipTermResponseIn		MtasSip

				MtasSipTermUnregRequestOverloadRej		MtasSip

				MtasSipTermUnregRequestOut		MtasSip

				MtasSipTermUnregRequestIn		MtasSip

				MtasSipTermRequestOverloadRej		MtasSip

				MtasSipTermRequestOut		MtasSip

				MtasSipTermRequestIn		MtasSip

				MtasSipSummaryServerTransactions		MtasSip

				MtasSipSummaryOutResponses		MtasSip

				MtasSipSummaryOutRequests		MtasSip

				MtasSipSummaryNonSipMessages		MtasSip

				MtasSipSummaryInResponses		MtasSip

				MtasSipSummaryInRequests		MtasSip

				MtasSipSummaryClientTransactions		MtasSip

				MtasSipPsiCoobResponse		MtasSip

				MtasSipPsiCoobRequest		MtasSip

				MtasSipPresenceResponse		MtasSip

				MtasSipPresenceRequestOverloadRej		MtasSip

				MtasSipPresenceRequest		MtasSip

				MtasSipPresencePollOk		MtasSip

				MtasSipPresencePollNOk		MtasSip

				MtasSipPresenceInvalid		MtasSip

				MtasSipOrigRequestOverloadRej		MtasSip

				MtasSipOrigRequestOut		MtasSip

				MtasSipOrigRequestIn		MtasSip

				MtasSipOrigResponseOut		MtasSip

				MtasSipOrigResponseIn		MtasSip

				MtasSipFuncPsiOverloadRej		MtasSip

				MtasSipCnameResponse		MtasSip

				MtasSipCnameRequest		MtasSip

				MtasSipCnamePollOk		MtasSip

				MtasSipCnamePollNOk		MtasSip

				MtasSipCnameInvalid		MtasSip

				MtasMrfpTransactPendToPeer		MtasH248

				MtasMrfpRetransmission		MtasH248

				MtasMrfpResponse		MtasH248

				MtasMrfpResourceUnavailFromPeer		MtasH248

				MtasMrfpProtocolErrorToPeer		MtasH248

				MtasMrfpProtocolErrorFromPeer		MtasH248

				MtasMrfpOverloadDetected		MtasH248

				MtasMrfpOkSubtractReq		MtasH248

				MtasMrfpOkSubtractReply		MtasH248

				MtasMrfpOkServiceChangeReq		MtasH248

				MtasMrfpOkServiceChangeReply		MtasH248

				MtasMrfpOkNotifyReq		MtasH248

				MtasMrfpOkNotifyReply		MtasH248

				MtasMrfpOkModifyReq		MtasH248

				MtasMrfpOkModifyReply		MtasH248

				MtasMrfpOkAuditReq		MtasH248

				MtasMrfpOkAuditReply		MtasH248

				MtasMrfpOkAddReq		MtasH248

				MtasMrfpOkAddReply		MtasH248

				MtasFuncFailover		MtasFunction

				MtasFuncSmallRestart		MtasFunction

				MtasLicensesMmtelExtendedXdmsRej		MtasLicenses

				MtasLicensesSessNOk		MtasLicenses

				MtasLicensesMultMedXdmsRej		MtasLicenses

				MtasLicensesMultMedSessModRej		MtasLicenses

				MtasFuncTcpConnections		MtasTraf

				MtasFuncOngoingSess		MtasTraf

				MtasFuncOngoingMobileSess		MtasTraf

				MtasFuncTermOrigUnregSessNOkE		MtasQos

				MtasFuncTermOrigUnregSessNOkI		MtasQos

				MtasFuncInitOrigUnregSessNOkE		MtasQos

				MtasFuncInitOrigUnregSessNOkI		MtasQos

				MtasFuncInitOrigUnregSessOk		MtasQos

				MtasFuncTermTermUnregSessNOkI		MtasQos

				MtasFuncTermTermUnregSessNOkE		MtasQos

				MtasFuncTermTermSessNOkI		MtasQos

				MtasFuncTermTermSessNOkE		MtasQos

				MtasFuncTermOrigSessNOkI		MtasQos

				MtasFuncTermOrigSessNOkE		MtasQos

				MtasFuncPsiUnknown		MtasQos

				MtasFuncPsiOk		MtasQos

				MtasFuncInitTermUnregSessOk		MtasQos

				MtasFuncInitTermUnregSessNOkI		MtasQos

				MtasFuncInitTermUnregSessNOkE		MtasQos

				MtasFuncInitTermSessOk		MtasQos

				MtasFuncInitTermSessNOkI		MtasQos

				MtasFuncInitTermSessNOkE		MtasQos

				MtasFuncInitOrigSessOk		MtasQos

				MtasFuncInitOrigSessNOkI		MtasQos

				MtasFuncInitOrigSessNOkE		MtasQos

				MtasCrInvAnnNOkI		MtasCr

				MtasCrInvAnnNOkE		MtasCr

				MtasCrInvAnnOk		MtasCr

				MtasCrInvNOkI		MtasCr

				MtasCrInvNOkE		MtasCr

				MtasCrInvOk		MtasCr

				MtasMediaResourceSiteSelectionFailed		MtasMediaResourceSite

				MtasMediaResourceSiteSelectionAttempt		MtasMediaResourceSite

				MtasHotlineDelayedNOkI		MtasHotline

				MtasHotlineDelayedNOkE		MtasHotline

				MtasHotlineDelayedOk		MtasHotline

				MtasHotlineInstantNOkI		MtasHotline

				MtasHotlineInstantNOkE		MtasHotline

				MtasHotlineInstantOk		MtasHotline

				MtasHotlineUnconditionalNOkI		MtasHotline

				MtasHotlineUnconditionalNOkE		MtasHotline

				MtasHotlineUnconditionalOk		MtasHotline

				MtasSdsCurrentImrnUsage		MtasSds

				MtasSdsCapInitDPNOkI		MtasSds

				MtasSdsCapInitDPNOkE		MtasSds

				MtasSdsCapInitDPOk		MtasSds

				MtasSrvccAttempt		MtasSrvcc

				MtasSrvccTransferNOkI		MtasSrvcc

				MtasSrvccTransferNOkE		MtasSrvcc

				MtasSrvccTransferOk		MtasSrvcc

				MtasDnmShortCodeNbrDialOk		MtasDnm

				MtasDnmShortCodeActualUriLookupNOk		MtasDnm

				MtasDnmLocalFormatRejectDialOutHomeArea		MtasDnm

				MtasDnmLocalFormatNpaLookupNOk		MtasDnm

				MtasDnmLocalFormatNbrDialOk		MtasDnm

				MtasNpEnumResponse		MtasNp

				MtasNpLookupAttempt		MtasNp

				MtasCatSignalNOkI		MtasCat

				MtasCatSignalNOkE		MtasCat

				MtasCatSignalOk		MtasCat

				MtasStodOk		MtasStod

				MtasStodAttempt		MtasStod

				MtasFsfsSuccAttempt		MtasFsfs

				MtasEctInitNOkI		MtasEct

				MtasEctInitNOkE		MtasEct

				MtasEctInitOk		MtasEct

				MtasGaSegmentedNumberOfAnnBreakDownFailures		MtasGa

				MtasGaNotFound		MtasGa

				MtasApReject		MtasAp

				MtasCpcRemoved		MtasCpc

				MtasCpcOverridden		MtasCpc

				MtasCpcAdded		MtasCpc

				MtasVideoFBSuccess		MtasVideoFB

				MtasVideoFBAttempt		MtasVideoFB

				MtasPxRejectedRequests		MtasPx

				MtasPxReceivedRequests		MtasPx

				MtasPxTermAsSuccessSessionEstablish		MtasPx

				MtasPxOrigAsSuccessSessionEstablish		MtasPx

				MtasPxTermNetworkSuccessSessionEstablish		MtasPx

				MtasPxOrigNetworkSuccessSessionEstablish		MtasPx

				MtasPxTermCommDuration		MtasPx

				MtasPxOrigCommDuration		MtasPx

				MtasPxSentRequests		MtasPx
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				MtasFcdDpOk		MtasFcd
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				MtasCcRetainedOrigRequests		MtasCc

				MtasCcSuspendedTermRequests		MtasCc

				MtasCcSuspendedOrigRequests		MtasCc

				MtasCcTotalDiscardedTermEntries		MtasCc

				MtasCcTotalDiscardedOrigEntries		MtasCc

				MtasCcRecallOk		MtasCc

				MtasCcRecallNOkI		MtasCc

				MtasCcRecallNOkE		MtasCc

				MtasCcnrTermSuccess		MtasCc

				MtasCcnrOrigSuccess		MtasCc

				MtasCcnrInvocationTermOk		MtasCc

				MtasCcnrInvocationTermNOkI		MtasCc

				MtasCcnrInvocationTermNOkE		MtasCc

				MtasCcnrInvocationOrigOk		MtasCc

				MtasCcnrInvocationOrigNOkI		MtasCc

				MtasCcnrInvocationOrigNOkE		MtasCc

				MtasCcnrIndicationTermNOkI		MtasCc

				MtasCcnrIndicationTermNOkE		MtasCc

				MtasCcnrIndicationOrigNOkI		MtasCc

				MtasCcnrIndicationOrigNOkE		MtasCc

				MtasCcbsTermSuccess		MtasCc

				MtasCcbsOrigSuccess		MtasCc

				MtasCcbsInvocationTermOk		MtasCc

				MtasCcbsInvocationTermNOkI		MtasCc

				MtasCcbsInvocationTermNOkE		MtasCc
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				MtasCcbsIndicationOrigNOkI		MtasCc

				MtasCcbsIndicationOrigNOkE		MtasCc
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				Mtas3ptyTerminationNOkI		Mtas3pty

				Mtas3ptyTerminationNOkE		Mtas3pty

				Mtas3ptyCreationOk		Mtas3pty

				Mtas3ptyCreationNOkI		Mtas3pty

				Mtas3ptyCreationNOkE		Mtas3pty

				MtasNaFailedAnnouncement		MtasNa

				MtasAocStartOk		MtasAoc

				MtasAocStartNOkI		MtasAoc

				MtasAocStartNOkE		MtasAoc

				MtasAocEndOk		MtasAoc

				MtasAocEndNOkI		MtasAoc

				MtasAocEndNOkE		MtasAoc

				MtasAocDuringOk		MtasAoc

				MtasAocDuringNOkI		MtasAoc

				MtasAocDuringNOkE		MtasAoc

				MtasUCacTermRejected		MtasCac

				MtasUCacOrigRejected		MtasCac

				MtasGCacTermRejected		MtasCac

				MtasGCacOrigRejected		MtasCac

				MtasCwUsed		MtasCw

				MtasCwTimeout		MtasCw

				MtasCwRejected		MtasCw

				MtasCwNumberOfAttempt		MtasCw

				MtasCwCancelled		MtasCw

				MtasCwAccepted		MtasCw

				MtasCpsVirtualCarrierCalls		MtasCps

				MtasCpsRealCarrierCalls		MtasCps

				MtasCsVirtualCarrierCalls		MtasCs

				MtasCsUndeterminedLocalCalls		MtasCs

				MtasCsRealCarrierCalls		MtasCs

				MtasCsFailed		MtasCs

				MtasCsDestinationDisallowed		MtasCs

				MtasDtmNotifyNOkI		MtasDtm

				MtasDtmNotifyNOkE		MtasDtm

				MtasDtmNotifyOk		MtasDtm

				MtasCBOCBBarred		MtasComBarring

				MtasCBICBBarred		MtasComBarring

				MtasCBFailedSegmentedAnnouncement		MtasComBarring

				MtasCBFailedAnnouncement		MtasComBarring

				MtasCBDIVBarred		MtasComBarring

				MtasCBACRRejected		MtasComBarring

				MtasAsIwInvSentDivAdd		MtasAsIw

				MtasAsIwInvRecHistAdd		MtasAsIw

				MtasAsIwDivInvRec		MtasAsIw

				MtasAbDialNOk		MtasAbDial

				MtasAbDialOk		MtasAbDial

				MtasSSCodesIntHotlineVmErr		MtasSSCodes

				MtasSSCodesIntHotlineVmNOkE		MtasSSCodes

				MtasSSCodesIntHotlineVmNOkI		MtasSSCodes

				MtasSSCodesIntHotlineVmOk		MtasSSCodes

				MtasSSCodesDeactHotlineVmErr		MtasSSCodes

				MtasSSCodesDeactHotlineVmNOkE		MtasSSCodes

				MtasSSCodesDeactHotlineVmNOkI		MtasSSCodes

				MtasSSCodesDeactHotlineVmOk		MtasSSCodes

				MtasSSCodesActHotlineVmErr		MtasSSCodes

				MtasSSCodesActHotlineVmNOkE		MtasSSCodes

				MtasSSCodesActHotlineVmNOkI		MtasSSCodes

				MtasSSCodesActHotlineVmOk		MtasSSCodes

				MtasSSCodesIntHotlineErr		MtasSSCodes

				MtasSSCodesIntHotlineNOkE		MtasSSCodes

				MtasSSCodesIntHotlineNOkI		MtasSSCodes

				MtasSSCodesIntHotlineOk		MtasSSCodes

				MtasSSCodesDeactHotlineErr		MtasSSCodes

				MtasSSCodesDeactHotlineNOkE		MtasSSCodes

				MtasSSCodesDeactHotlineNOkI		MtasSSCodes

				MtasSSCodesDeactHotlineOk		MtasSSCodes

				MtasSSCodesActHotlineErr		MtasSSCodes

				MtasSSCodesActHotlineNOkE		MtasSSCodes

				MtasSSCodesActHotlineNOkI		MtasSSCodes

				MtasSSCodesActHotlineOk		MtasSSCodes

				MtasSSCodesIntCfnlVmOk		MtasSSCodes

				MtasSSCodesIntCfnlVmNOkI		MtasSSCodes

				MtasSSCodesIntCfnlVmNOkE		MtasSSCodes

				MtasSSCodesIntCfnlVmErr		MtasSSCodes

				MtasSSCodesDeactCfnlVmOk		MtasSSCodes

				MtasSSCodesDeactCfnlVmNOkI		MtasSSCodes

				MtasSSCodesDeactCfnlVmNOkE		MtasSSCodes

				MtasSSCodesDeactCfnlVmErr		MtasSSCodes

				MtasSSCodesActCfnlVmOk		MtasSSCodes

				MtasSSCodesActCfnlVmNOkI		MtasSSCodes

				MtasSSCodesActCfnlVmNOkE		MtasSSCodes

				MtasSSCodesActCfnlVmErr		MtasSSCodes

				MtasSSCodesIntCfnlOk		MtasSSCodes

				MtasSSCodesIntCfnlNOkI		MtasSSCodes

				MtasSSCodesIntCfnlNOkE		MtasSSCodes

				MtasSSCodesIntCfnlErr		MtasSSCodes

				MtasSSCodesDeactCfnlOk		MtasSSCodes

				MtasSSCodesDeactCfnlNOkI		MtasSSCodes

				MtasSSCodesDeactCfnlNOkE		MtasSSCodes

				MtasSSCodesDeactCfnlErr		MtasSSCodes

				MtasSSCodesActCfnlOk		MtasSSCodes

				MtasSSCodesActCfnlNOkI		MtasSSCodes

				MtasSSCodesActCfnlNOkE		MtasSSCodes

				MtasSSCodesActCfnlErr		MtasSSCodes

				MtasSSCodesInvEctErr		MtasSSCodes

				MtasSSCodesInvEctNOkE		MtasSSCodes

				MtasSSCodesInvEctNOkI		MtasSSCodes

				MtasSSCodesInvEctOk		MtasSSCodes

				MtasSSCodesIntEctErr		MtasSSCodes

				MtasSSCodesIntEctNOkE		MtasSSCodes

				MtasSSCodesIntEctNOkI		MtasSSCodes

				MtasSSCodesIntEctOk		MtasSSCodes

				MtasSSCodesUnSuppSdVer		MtasSSCodes

				MtasSSCodesRevokeCcnrQueueOk		MtasSSCodes

				MtasSSCodesRevokeCcnrQueueNOkI		MtasSSCodes

				MtasSSCodesRevokeCcnrQueueNOkE		MtasSSCodes

				MtasSSCodesRevokeCcnrQueueErr		MtasSSCodes

				MtasSSCodesRevokeCcbsQueueOk		MtasSSCodes

				MtasSSCodesRevokeCcbsQueueNOkI		MtasSSCodes

				MtasSSCodesRevokeCcbsQueueNOkE		MtasSSCodes

				MtasSSCodesRevokeCcbsQueueErr		MtasSSCodes

				MtasSSCodesPinLocks		MtasSSCodes

				MtasSSCodesPinFaults		MtasSSCodes

				MtasSSCodesModPinOk		MtasSSCodes

				MtasSSCodesModPinNOkI		MtasSSCodes

				MtasSSCodesModPinNOkE		MtasSSCodes

				MtasSSCodesModPinErr		MtasSSCodes

				MtasSSCodesInvMcrOk		MtasSSCodes

				MtasSSCodesInvMcrNOkNoCall		MtasSSCodes

				MtasSSCodesInvMcrNOkMaxLength		MtasSSCodes

				MtasSSCodesInvMcrNOkI		MtasSSCodes

				MtasSSCodesInvMcrNOkE		MtasSSCodes

				MtasSSCodesInvMcrErr		MtasSSCodes

				MtasSSCodesInvMcidOk		MtasSSCodes

				MtasSSCodesInvMcidNOkNoCall		MtasSSCodes

				MtasSSCodesInvMcidNOkI		MtasSSCodes

				MtasSSCodesInvMcidNOkE		MtasSSCodes
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				MtasSSCodesInvDblNOkE		MtasSSCodes

				MtasSSCodesInvDblErr		MtasSSCodes

				MtasSSCodesIntTirOk		MtasSSCodes

				MtasSSCodesIntTirNOkI		MtasSSCodes

				MtasSSCodesIntTirNOkE		MtasSSCodes

				MtasSSCodesIntTirErr		MtasSSCodes

				MtasSSCodesIntTipOk		MtasSSCodes

				MtasSSCodesIntTipNOkI		MtasSSCodes

				MtasSSCodesIntTipNOkE		MtasSSCodes

				MtasSSCodesIntTipErr		MtasSSCodes

				MtasSSCodesIntOirOk		MtasSSCodes

				MtasSSCodesIntOirNOkI		MtasSSCodes

				MtasSSCodesIntOirNOkE		MtasSSCodes

				MtasSSCodesIntOirErr		MtasSSCodes

				MtasSSCodesIntOipOk		MtasSSCodes

				MtasSSCodesIntOipNOkI		MtasSSCodes

				MtasSSCodesIntOipNOkE		MtasSSCodes

				MtasSSCodesIntOipErr		MtasSSCodes

				MtasSSCodesIntOcbOk		MtasSSCodes

				MtasSSCodesIntOcbNOkI		MtasSSCodes

				MtasSSCodesIntOcbNOkE		MtasSSCodes

				MtasSSCodesIntOcbErr		MtasSSCodes

				MtasSSCodesIntMcrOk		MtasSSCodes

				MtasSSCodesIntMcrNOkI		MtasSSCodes

				MtasSSCodesIntMcrNOkE		MtasSSCodes

				MtasSSCodesIntMcrErr		MtasSSCodes

				MtasSSCodesIntFcdDpErr		MtasSSCodes

				MtasSSCodesIntFcdDpNOkE		MtasSSCodes

				MtasSSCodesIntFcdDpNOkI		MtasSSCodes

				MtasSSCodesIntFcdDpOk		MtasSSCodes

				MtasSSCodesIntDndCfVmErr		MtasSSCodes

				MtasSSCodesIntDndCfVmNOkE		MtasSSCodes

				MtasSSCodesIntDndCfVmNOkI		MtasSSCodes

				MtasSSCodesIntDndCfVmOk		MtasSSCodes

				MtasSSCodesIntDndCfErr		MtasSSCodes

				MtasSSCodesIntDndCfNOkE		MtasSSCodes

				MtasSSCodesIntDndCfNOkI		MtasSSCodes

				MtasSSCodesIntDndCfOk		MtasSSCodes

				MtasSSCodesIntDndCbErr		MtasSSCodes

				MtasSSCodesIntDndCbNOkE		MtasSSCodes

				MtasSSCodesIntDndCbNOkI		MtasSSCodes

				MtasSSCodesIntDndCbOk		MtasSSCodes

				MtasSSCodesIntDblOk		MtasSSCodes

				MtasSSCodesIntDblNOkI		MtasSSCodes

				MtasSSCodesIntDblNOkE		MtasSSCodes

				MtasSSCodesIntDblErr		MtasSSCodes

				MtasSSCodesIntCwOk		MtasSSCodes

				MtasSSCodesIntCwNOkI		MtasSSCodes

				MtasSSCodesIntCwNOkErr		MtasSSCodes

				MtasSSCodesIntCwNOkE		MtasSSCodes

				MtasSSCodesIntCnipOk		MtasSSCodes

				MtasSSCodesIntCnipNOkI		MtasSSCodes

				MtasSSCodesIntCnipNOkE		MtasSSCodes

				MtasSSCodesIntCnipErr		MtasSSCodes

				MtasSSCodesIntCfuVmOk		MtasSSCodes

				MtasSSCodesIntCfuVmNOkI		MtasSSCodes

				MtasSSCodesIntCfuVmNOkE		MtasSSCodes

				MtasSSCodesIntCfuVmErr		MtasSSCodes

				MtasSSCodesIntCfuOk		MtasSSCodes

				MtasSSCodesIntCfuNOkI		MtasSSCodes

				MtasSSCodesIntCfuNOkE		MtasSSCodes

				MtasSSCodesIntCfuErr		MtasSSCodes

				MtasSSCodesIntCfnrVmOk		MtasSSCodes

				MtasSSCodesIntCfnrVmNOkI		MtasSSCodes

				MtasSSCodesIntCfnrVmNOkE		MtasSSCodes

				MtasSSCodesIntCfnrVmErr		MtasSSCodes

				MtasSSCodesIntCfnrOk		MtasSSCodes

				MtasSSCodesIntCfnrNOkI		MtasSSCodes

				MtasSSCodesIntCfnrNOkE		MtasSSCodes

				MtasSSCodesIntCfnrErr		MtasSSCodes

				MtasSSCodesIntCfnrcOk		MtasSSCodes

				MtasSSCodesIntCfnrcNOkI		MtasSSCodes

				MtasSSCodesIntCfnrcNOkE		MtasSSCodes

				MtasSSCodesIntCfnrcErr		MtasSSCodes

				MtasSSCodesIntCfbVmOk		MtasSSCodes

				MtasSSCodesIntCfbVmNOkI		MtasSSCodes

				MtasSSCodesIntCfbVmNOkE		MtasSSCodes

				MtasSSCodesIntCfbVmErr		MtasSSCodes

				MtasSSCodesIntCfbOk		MtasSSCodes

				MtasSSCodesIntCfbNOkI		MtasSSCodes

				MtasSSCodesIntCfbNOkE		MtasSSCodes

				MtasSSCodesIntCfbErr		MtasSSCodes

				MtasSSCodesIntCDivAllOk		MtasSSCodes

				MtasSSCodesIntCDivAllNOkI		MtasSSCodes

				MtasSSCodesIntCDivAllNOkE		MtasSSCodes

				MtasSSCodesIntCDivAllErr		MtasSSCodes

				MtasSSCodesIntCcnrQueueOk		MtasSSCodes

				MtasSSCodesIntCcnrQueueNOkI		MtasSSCodes

				MtasSSCodesIntCcnrQueueNOkE		MtasSSCodes

				MtasSSCodesIntCcnrQueueErr		MtasSSCodes

				MtasSSCodesIntCcbsQueueOk		MtasSSCodes

				MtasSSCodesIntCcbsQueueNOkI		MtasSSCodes

				MtasSSCodesIntCcbsQueueNOkE		MtasSSCodes

				MtasSSCodesIntCcbsQueueErr		MtasSSCodes

				MtasSSCodesIntAcrOk		MtasSSCodes

				MtasSSCodesIntAcrNOkI		MtasSSCodes

				MtasSSCodesIntAcrNOkE		MtasSSCodes

				MtasSSCodesIntAcrErr		MtasSSCodes

				MtasSSCodesDefaultPinFaults		MtasSSCodes

				MtasSSCodesDeactTirOk		MtasSSCodes

				MtasSSCodesDeactTirNOkI		MtasSSCodes

				MtasSSCodesDeactTirNOkE		MtasSSCodes

				MtasSSCodesDeactTirErr		MtasSSCodes

				MtasSSCodesDeactTipOk		MtasSSCodes

				MtasSSCodesDeactTipNOkI		MtasSSCodes

				MtasSSCodesDeactTipNOkE		MtasSSCodes

				MtasSSCodesDeactTipErr		MtasSSCodes

				MtasSSCodesDeactOirOk		MtasSSCodes

				MtasSSCodesDeactOirNOkI		MtasSSCodes

				MtasSSCodesDeactOirNOkE		MtasSSCodes

				MtasSSCodesDeactOirErr		MtasSSCodes

				MtasSSCodesDeactOipOk		MtasSSCodes

				MtasSSCodesDeactOipNOkI		MtasSSCodes

				MtasSSCodesDeactOipNOkE		MtasSSCodes

				MtasSSCodesDeactOipErr		MtasSSCodes

				MtasSSCodesDeactOcbOk		MtasSSCodes

				MtasSSCodesDeactOcbNOkI		MtasSSCodes

				MtasSSCodesDeactOcbNOkE		MtasSSCodes

				MtasSSCodesDeactOcbErr		MtasSSCodes

				MtasSSCodesDeactMcrOk		MtasSSCodes

				MtasSSCodesDeactMcrNOkI		MtasSSCodes

				MtasSSCodesDeactMcrNOkE		MtasSSCodes

				MtasSSCodesDeactMcrErr		MtasSSCodes

				MtasSSCodesDeactFcdDpErr		MtasSSCodes

				MtasSSCodesDeactFcdDpNOkE		MtasSSCodes

				MtasSSCodesDeactFcdDpNOkI		MtasSSCodes

				MtasSSCodesDeactFcdDpOk		MtasSSCodes

				MtasSSCodesDeactDndCfVmErr		MtasSSCodes

				MtasSSCodesDeactDndCfVmNOkE		MtasSSCodes

				MtasSSCodesDeactDndCfVmNOkI		MtasSSCodes

				MtasSSCodesDeactDndCfVmOk		MtasSSCodes

				MtasSSCodesDeactDndCfErr		MtasSSCodes

				MtasSSCodesDeactDndCfNOkE		MtasSSCodes

				MtasSSCodesDeactDndCfNOkI		MtasSSCodes

				MtasSSCodesDeactDndCfOk		MtasSSCodes

				MtasSSCodesDeactDndCbErr		MtasSSCodes

				MtasSSCodesDeactDndCbNOkE		MtasSSCodes

				MtasSSCodesDeactDndCbNOkI		MtasSSCodes

				MtasSSCodesDeactDndCbOk		MtasSSCodes

				MtasSSCodesDeactDblOk		MtasSSCodes

				MtasSSCodesDeactDblNOkI		MtasSSCodes

				MtasSSCodesDeactDblNOkE		MtasSSCodes

				MtasSSCodesDeactDblErr		MtasSSCodes

				MtasSSCodesDeactCwOk		MtasSSCodes

				MtasSSCodesDeactCwNOkI		MtasSSCodes

				MtasSSCodesDeactCwNOkErr		MtasSSCodes

				MtasSSCodesDeactCwNOkE		MtasSSCodes

				MtasSSCodesDeactCnipOk		MtasSSCodes

				MtasSSCodesDeactCnipNOkI		MtasSSCodes

				MtasSSCodesDeactCnipNOkE		MtasSSCodes

				MtasSSCodesDeactCnipErr		MtasSSCodes

				MtasSSCodesDeactCfuVmOk		MtasSSCodes

				MtasSSCodesDeactCfuVmNOkI		MtasSSCodes

				MtasSSCodesDeactCfuVmNOkE		MtasSSCodes

				MtasSSCodesDeactCfuVmErr		MtasSSCodes

				MtasSSCodesDeactCfuOk		MtasSSCodes

				MtasSSCodesDeactCfuNOkI		MtasSSCodes

				MtasSSCodesDeactCfuNOkE		MtasSSCodes

				MtasSSCodesDeactCfuErr		MtasSSCodes

				MtasSSCodesDeactCfnrVmOk		MtasSSCodes

				MtasSSCodesDeactCfnrVmNOkI		MtasSSCodes

				MtasSSCodesDeactCfnrVmNOkE		MtasSSCodes

				MtasSSCodesDeactCfnrVmErr		MtasSSCodes

				MtasSSCodesDeactCfnrOk		MtasSSCodes

				MtasSSCodesDeactCfnrNOkI		MtasSSCodes

				MtasSSCodesDeactCfnrNOkE		MtasSSCodes

				MtasSSCodesDeactCfnrErr		MtasSSCodes

				MtasSSCodesDeactCfnrcOk		MtasSSCodes

				MtasSSCodesDeactCfnrcNOkI		MtasSSCodes

				MtasSSCodesDeactCfnrcNOkE		MtasSSCodes

				MtasSSCodesDeactCfnrcErr		MtasSSCodes

				MtasSSCodesDeactCfCondOk		MtasSSCodes

				MtasSSCodesDeactCfCondNOkI		MtasSSCodes

				MtasSSCodesDeactCfCondNOkE		MtasSSCodes

				MtasSSCodesDeactCfCondErr		MtasSSCodes

				MtasSSCodesDeactCfbVmOk		MtasSSCodes

				MtasSSCodesDeactCfbVmNOkI		MtasSSCodes

				MtasSSCodesDeactCfbVmNOkE		MtasSSCodes

				MtasSSCodesDeactCfbVmErr		MtasSSCodes

				MtasSSCodesDeactCfbOk		MtasSSCodes

				MtasSSCodesDeactCfbNOkI		MtasSSCodes

				MtasSSCodesDeactCfbNOkE		MtasSSCodes

				MtasSSCodesDeactCfbErr		MtasSSCodes

				MtasSSCodesDeactCDivAllOk		MtasSSCodes

				MtasSSCodesDeactCDivAllNOkI		MtasSSCodes

				MtasSSCodesDeactCDivAllNOkE		MtasSSCodes

				MtasSSCodesDeactCDivAllErr		MtasSSCodes

				MtasSSCodesDeactAcrOk		MtasSSCodes

				MtasSSCodesDeactAcrNOkI		MtasSSCodes

				MtasSSCodesDeactAcrNOkE		MtasSSCodes

				MtasSSCodesDeactAcrErr		MtasSSCodes

				MtasSSCodesCommandErr		MtasSSCodes

				MtasSSCodesAnnounceFault		MtasSSCodes

				MtasSSCodesActTirOk		MtasSSCodes

				MtasSSCodesActTirNOkI		MtasSSCodes

				MtasSSCodesActTirNOkE		MtasSSCodes

				MtasSSCodesActTirErr		MtasSSCodes

				MtasSSCodesActTipOk		MtasSSCodes

				MtasSSCodesActTipNOkI		MtasSSCodes

				MtasSSCodesActTipNOkE		MtasSSCodes

				MtasSSCodesActTipErr		MtasSSCodes

				MtasSSCodesActOirOk		MtasSSCodes

				MtasSSCodesActOirNOkI		MtasSSCodes

				MtasSSCodesActOirNOkE		MtasSSCodes

				MtasSSCodesActOirErr		MtasSSCodes

				MtasSSCodesActOipOk		MtasSSCodes

				MtasSSCodesActOipNOkI		MtasSSCodes

				MtasSSCodesActOipNOkE		MtasSSCodes

				MtasSSCodesActOipErr		MtasSSCodes

				MtasSSCodesActOcbOk		MtasSSCodes

				MtasSSCodesActOcbNOkI		MtasSSCodes

				MtasSSCodesActOcbNOkE		MtasSSCodes

				MtasSSCodesActOcbErr		MtasSSCodes

				MtasSSCodesActFcdDpErr		MtasSSCodes

				MtasSSCodesActFcdDpNOkE		MtasSSCodes

				MtasSSCodesActFcdDpNOkI		MtasSSCodes

				MtasSSCodesActFcdDpOk		MtasSSCodes

				MtasSSCodesActDndCfVmErr		MtasSSCodes

				MtasSSCodesActDndCfVmNOkE		MtasSSCodes

				MtasSSCodesActDndCfVmNOkI		MtasSSCodes

				MtasSSCodesActDndCfVmOk		MtasSSCodes

				MtasSSCodesActDndCfErr		MtasSSCodes

				MtasSSCodesActDndCfNOkE		MtasSSCodes

				MtasSSCodesActDndCfNOkI		MtasSSCodes

				MtasSSCodesActDndCfOk		MtasSSCodes

				MtasSSCodesActDndCbErr		MtasSSCodes

				MtasSSCodesActDndCbNOkE		MtasSSCodes

				MtasSSCodesActDndCbNOkI		MtasSSCodes

				MtasSSCodesActDndCbOk		MtasSSCodes

				MtasSSCodesActCwOk		MtasSSCodes

				MtasSSCodesActCwNOkI		MtasSSCodes

				MtasSSCodesActCwNOkErr		MtasSSCodes

				MtasSSCodesActCwNOkE		MtasSSCodes

				MtasSSCodesActCnipOk		MtasSSCodes

				MtasSSCodesActCnipNOkI		MtasSSCodes

				MtasSSCodesActCnipNOkE		MtasSSCodes

				MtasSSCodesActCnipErr		MtasSSCodes

				MtasSSCodesActCfuVmOk		MtasSSCodes

				MtasSSCodesActCfuVmNOkI		MtasSSCodes

				MtasSSCodesActCfuVmNOkE		MtasSSCodes

				MtasSSCodesActCfuVmErr		MtasSSCodes

				MtasSSCodesActCfuOk		MtasSSCodes

				MtasSSCodesActCfuNOkI		MtasSSCodes

				MtasSSCodesActCfuNOkE		MtasSSCodes

				MtasSSCodesActCfuErr		MtasSSCodes

				MtasSSCodesActCfnrVmOk		MtasSSCodes

				MtasSSCodesActCfnrVmNOkI		MtasSSCodes

				MtasSSCodesActCfnrVmNOkE		MtasSSCodes

				MtasSSCodesActCfnrVmErr		MtasSSCodes

				MtasSSCodesActCfnrOk		MtasSSCodes

				MtasSSCodesActCfnrNOkI		MtasSSCodes

				MtasSSCodesActCfnrNOkE		MtasSSCodes

				MtasSSCodesActCfnrErr		MtasSSCodes

				MtasSSCodesActCfnrcOk		MtasSSCodes

				MtasSSCodesActCfnrcNOkI		MtasSSCodes

				MtasSSCodesActCfnrcNOkE		MtasSSCodes

				MtasSSCodesActCfnrcErr		MtasSSCodes

				MtasSSCodesActCfCondOk		MtasSSCodes

				MtasSSCodesActCfCondNOkI		MtasSSCodes

				MtasSSCodesActCfCondNOkE		MtasSSCodes

				MtasSSCodesActCfCondErr		MtasSSCodes

				MtasSSCodesActCfbVmOk		MtasSSCodes

				MtasSSCodesActCfbVmNOkI		MtasSSCodes

				MtasSSCodesActCfbVmNOkE		MtasSSCodes

				MtasSSCodesActCfbVmErr		MtasSSCodes

				MtasSSCodesActCfbOk		MtasSSCodes

				MtasSSCodesActCfbNOkI		MtasSSCodes

				MtasSSCodesActCfbNOkE		MtasSSCodes

				MtasSSCodesActCfbErr		MtasSSCodes

				MtasSSCodesActAcrOk		MtasSSCodes

				MtasSSCodesActAcrNOkI		MtasSSCodes

				MtasSSCodesActAcrNOkE		MtasSSCodes

				MtasSSCodesActAcrErr		MtasSSCodes

				MtasIdPresFip		MtasIdPres

				MtasIdPresTirTempIdRest		MtasIdPres

				MtasIdPresTirTempIdPres		MtasIdPres

				MtasIdPresTirPerm		MtasIdPres

				MtasIdPresTirOverride		MtasIdPres

				MtasIdPresTirIdRestSome		MtasIdPres

				MtasIdPresTirIdRestAll		MtasIdPres

				MtasIdPresTirIdPres		MtasIdPres

				MtasIdPresTipIdRestSome		MtasIdPres

				MtasIdPresTipIdRestAll		MtasIdPres

				MtasIdPresTip		MtasIdPres

				MtasIdPresOirTempIdRest		MtasIdPres

				MtasIdPresOirTempIdPres		MtasIdPres

				MtasIdPresOirSscTempIdRest		MtasIdPres

				MtasIdPresOirSscTempIdPres		MtasIdPres

				MtasIdPresOirPerm		MtasIdPres

				MtasIdPresOirOverride		MtasIdPres

				MtasIdPresOirIdRestSome		MtasIdPres

				MtasIdPresOirIdRestAll		MtasIdPres

				MtasIdPresOirIdPres		MtasIdPres

				MtasIdPresOipIdRestSome		MtasIdPres

				MtasIdPresOipIdRestAll		MtasIdPres

				MtasIdPresOip		MtasIdPres

				MtasIdPresOCnipFailed		MtasIdPres

				MtasIdPresOCnip		MtasIdPres

				MtasIdPresCnipRestrictName		MtasIdPres

				MtasIdPresCnipPresentName		MtasIdPres

				MtasIdPresCnipNOkNotFound		MtasIdPres

				MtasIdPresCnipFailed		MtasIdPres

				MtasIdPresCnipAttempt		MtasIdPres

				MtasIdPresCnip		MtasIdPres

				MtasConfSchedTerminatedNOkE		MtasConf

				MtasConfSchedTerminatedNOkI		MtasConf

				MtasConfSchedParticipants		MtasConf

				MtasConfSchedActiveConferences		MtasConf

				MtasConfSchedAttempt		MtasConf

				MtasConfSchedDialInPinNOk		MtasConf

				MtasConfSchedDialInNOkE		MtasConf

				MtasConfSchedDialInNOkI		MtasConf

				MtasConfSchedDialInOk		MtasConf

				MtasConfCommDuration		MtasConf

				MtasConfTerminatedNOkI		MtasConf

				MtasConfTerminatedNOkE		MtasConf

				MtasConfParticipants		MtasConf

				MtasConfNoLicenseError		MtasConf

				MtasConfDialOutOk		MtasConf

				MtasConfDialOutNOkI		MtasConf

				MtasConfDialOutNOkE		MtasConf

				MtasConfCreationOk		MtasConf

				MtasConfCreationNOkI		MtasConf

				MtasConfCreationNOkE		MtasConf

				MtasConfActiveConferences		MtasConf

				MtasCDivNumberOfAttempt		MtasCDiv

				MtasCDivNumberOfCdivOk		MtasCDiv

				MtasCDivNumberOfCdivNotOk		MtasCDiv

				MtasCDivFailedAnnouncement		MtasCDiv

				MtasHoldInitiatedResumeOk		MtasHold

				MtasHoldInitiatedResume		MtasHold

				MtasHoldInitiatedHoldOk		MtasHold

				MtasHoldInitiatedHold		MtasHold

				MtasHoldFailedAnnouncement		MtasHold

				MtasMmtPxTermUnregResponseIn		MtasMmt

				MtasMmtPxTermUnregRequestOut		MtasMmt

				MtasMmtPxOrigUnregResponseIn		MtasMmt

				MtasMmtPxOrigUnregRequestOut		MtasMmt

				MtasMmtPxTermResponseIn		MtasMmt

				MtasMmtPxTermRequestOut		MtasMmt

				MtasMmtPxOrigResponseIn		MtasMmt

				MtasMmtPxOrigRequestOut		MtasMmt

				MtasMmtOrigUnregAsSuccessSessionEstablish		MtasMmt

				MtasMmtOrigUnregNetworkSuccessSessionEstablish		MtasMmt

				MtasMmtOrigUnregCommDuration		MtasMmt

				MtasMmtOrigUnregFailedAttemptCause		MtasMmt

				MtasMmtOrigUnregFailedAttempt		MtasMmt

				MtasMmtOrigUnregAnswered		MtasMmt

				MtasMmtOrigUnregSuccAttempt		MtasMmt

				MtasMmtTermOrigUnregSessNOkI		MtasMmt

				MtasMmtTermOrigUnregSessNOkE		MtasMmt

				MtasMmtInitOrigUnregSessNOkI		MtasMmt

				MtasMmtInitOrigUnregSessNOkE		MtasMmt

				MtasMmtInitOrigUnregSessOk		MtasMmt

				MtasMmtTermUnregNetworkSuccessSessionEstablish		MtasMmt

				MtasMmtTermUnregCommDuration		MtasMmt

				MtasMmtTermUnregAsSuccessSessionEstablish		MtasMmt

				MtasMmtTermNetworkSuccessSessionEstablish		MtasMmt

				MtasMmtTermCommDuration		MtasMmt

				MtasMmtTermAsSuccessSessionEstablish		MtasMmt

				MtasMmtOrigNetworkSuccessSessionEstablish		MtasMmt

				MtasMmtOrigCommDuration		MtasMmt

				MtasMmtOrigAsSuccessSessionEstablish		MtasMmt

				MtasMmtVideoStreamSetup		MtasMmt

				MtasMmtVideoStreamDropped		MtasMmt

				MtasMmtVideoStreamAdded		MtasMmt

				MtasMmtUnknownStreamSetup		MtasMmt

				MtasMmtUnknownStreamDropped		MtasMmt

				MtasMmtUnknownStreamAdded		MtasMmt

				MtasMmtTextStreamSetup		MtasMmt

				MtasMmtTextStreamDropped		MtasMmt

				MtasMmtTextStreamAdded		MtasMmt

				MtasMmtTermUnregSuccAttempt		MtasMmt

				MtasMmtTermUnregFailedAttemptCause		MtasMmt

				MtasMmtTermUnregFailedAttempt		MtasMmt

				MtasMmtTermUnregAnswered		MtasMmt

				MtasMmtTermTermUnregSessNOkI		MtasMmt

				MtasMmtTermTermUnregSessNOkE		MtasMmt

				MtasMmtTermTermSessNOkI		MtasMmt

				MtasMmtTermTermSessNOkE		MtasMmt

				MtasMmtTermSuccAttempt		MtasMmt

				MtasMmtTermOrigSessNOkI		MtasMmt

				MtasMmtTermOrigSessNOkE		MtasMmt

				MtasMmtTermFailedAttemptCause		MtasMmt

				MtasMmtTermFailedAttempt		MtasMmt

				MtasMmtTermAnswered		MtasMmt

				MtasMmtOrigSuccAttempt		MtasMmt

				MtasMmtOrigFailedAttemptCause		MtasMmt

				MtasMmtOrigFailedAttempt		MtasMmt

				MtasMmtOrigAnswered		MtasMmt

				MtasMmtMessageStreamSetup		MtasMmt

				MtasMmtMessageStreamDropped		MtasMmt

				MtasMmtMessageStreamAdded		MtasMmt

				MtasMmtInitTermUnregSessOk		MtasMmt

				MtasMmtInitTermUnregSessNOkI		MtasMmt

				MtasMmtInitTermUnregSessNOkE		MtasMmt

				MtasMmtInitTermSessOk		MtasMmt

				MtasMmtInitTermSessNOkI		MtasMmt

				MtasMmtInitTermSessNOkE		MtasMmt

				MtasMmtInitOrigSessOk		MtasMmt

				MtasMmtInitOrigSessNOkI		MtasMmt

				MtasMmtInitOrigSessNOkE		MtasMmt

				MtasMmtFaxStreamSetup		MtasMmt

				MtasMmtFaxStreamDropped		MtasMmt

				MtasMmtFaxStreamAdded		MtasMmt

				MtasMmtFailedAnnouncement		MtasMmt

				MtasMmtAudioStreamSetup		MtasMmt

				MtasMmtAudioStreamDropped		MtasMmt

				MtasMmtAudioStreamAdded		MtasMmt





The following regExp is the default pattern for each  counter family:
^A[0-9] *Mtas3pty
^A[0-9] *MtasAbDial
^A[0-9] *MtasAoc
^A[0-9] *MtasAp
^A[0-9] *MtasAsIw
^A[0-9] *MtasCac
^A[0-9] *MtasCat
^A[0-9] *MtasCc
^A[0-9] *MtasCDiv
^A[0-9] *MtasCharging
^A[0-9] *MtasComBarring
^A[0-9] *MtasConf
^A[0-9] *MtasCpc
^A[0-9] *MtasCps
^A[0-9] *MtasCr
^A[0-9] *MtasCs
^A[0-9] *MtasCsi
^A[0-9] *MtasCw
^A[0-9] *MtasDnm
^A[0-9] *MtasDtm
^A[0-9] *MtasEct
^A[0-9] *MtasExtMrfc
^A[0-9] *MtasFcd
^A[0-9] *MtasFsfs
^A[0-9] *MtasFunction
^A[0-9] *MtasGa
^A[0-9] *MtasH248
^A[0-9] *MtasHold
^A[0-9] *MtasHotline
^A[0-9] *MtasIdPres
^A[0-9] *MtasLicenses
^A[0-9] *MtasMediaResourceSite
^A[0-9] *MtasMmt
^A[0-9] *MtasMrfc
^A[0-9] *MtasNa
^A[0-9] *MtasNp
^A[0-9] *MtasNumNorm
^A[0-9] *MtasPx
^A[0-9] *MtasQos
^A[0-9] *MtasScc
^A[0-9] *MtasSds
^A[0-9] *MtasShInterface
^A[0-9] *MtasSip
^A[0-9] *OamProvisioningCounterMJ
^A[0-9] *Diameter_traffic_counters
^A[0-9] *Diameter_error_counters
^A[0-9] *IPv4_MeasurementJob
^A[0-9] *PlatformMeasures

Files name examples:
A20130429.0000-0005_asme-hmbg-de01-test_Mtas3pty
A20130429.0000-0005_asme-hmbg-de01-test_MtasAbDial
A20130429.0000-0005_asme-hmbg-de01-test_MtasAoc
A20130429.0000-0005_asme-hmbg-de01-test_MtasAp
A20130429.0000-0005_asme-hmbg-de01-test_MtasAsIw
A20130429.0000-0005_asme-hmbg-de01-test_MtasCac
A20130429.0000-0005_asme-hmbg-de01-test_MtasCat
A20130429.0000-0005_asme-hmbg-de01-test_MtasCc
A20130429.0000-0005_asme-hmbg-de01-test_MtasCDiv
A20130429.0000-0005_asme-hmbg-de01-test_MtasCharging
A20130429.0000-0005_asme-hmbg-de01-test_MtasComBarring
A20130429.0000-0005_asme-hmbg-de01-test_MtasConf
A20130429.0000-0005_asme-hmbg-de01-test_MtasCpc
A20130429.0000-0005_asme-hmbg-de01-test_MtasCps
A20130429.0000-0005_asme-hmbg-de01-test_MtasCr
A20130429.0000-0005_asme-hmbg-de01-test_MtasCs
A20130429.0000-0005_asme-hmbg-de01-test_MtasCsi
A20130429.0000-0005_asme-hmbg-de01-test_MtasCw
A20130429.0000-0005_asme-hmbg-de01-test_MtasDnm
A20130429.0000-0005_asme-hmbg-de01-test_MtasDtm
A20130429.0000-0005_asme-hmbg-de01-test_MtasEct
A20130429.0000-0005_asme-hmbg-de01-test_MtasExtMrfc
A20130429.0000-0005_asme-hmbg-de01-test_MtasFcd
A20130429.0000-0005_asme-hmbg-de01-test_MtasFsfs
A20130429.0000-0005_asme-hmbg-de01-test_MtasFunction
A20130429.0000-0005_asme-hmbg-de01-test_MtasGa
A20130429.0000-0005_asme-hmbg-de01-test_MtasH248
A20130429.0000-0005_asme-hmbg-de01-test_MtasHold
A20130429.0000-0005_asme-hmbg-de01-test_MtasHotline
A20130429.0000-0005_asme-hmbg-de01-test_MtasIdPres
A20130429.0000-0005_asme-hmbg-de01-test_MtasLicenses
A20130429.0000-0005_asme-hmbg-de01-test_MtasMediaResourceSite
A20130429.0000-0005_asme-hmbg-de01-test_MtasMmt
A20130429.0000-0005_asme-hmbg-de01-test_MtasMrfc
A20130429.0000-0005_asme-hmbg-de01-test_MtasNa
A20130429.0000-0005_asme-hmbg-de01-test_MtasNp
A20130429.0000-0005_asme-hmbg-de01-test_MtasNumNorm
A20130429.0000-0005_asme-hmbg-de01-test_MtasPx
A20130429.0000-0005_asme-hmbg-de01-test_MtasQos
A20130429.0000-0005_asme-hmbg-de01-test_MtasScc
A20130429.0000-0005_asme-hmbg-de01-test_MtasSds
A20130429.0000-0005_asme-hmbg-de01-test_MtasShInterface
A20130429.0000-0005_asme-hmbg-de01-test_MtasSip
A20130429.0000-0005_asme-hmbg-de01-test_MtasSnd
A20130429.0000-0005_asme-hmbg-de01-test_MtasSrvcc
A20130429.0000-0005_asme-hmbg-de01-test_MtasSSCodes
A20130429.0000-0005_asme-hmbg-de01-test_MtasStod
A20130429.0000-0005_asme-hmbg-de01-test_MtasSubsData
A20130429.0000-0005_asme-hmbg-de01-test_MtasSubsDataMgmt
A20130429.0000-0005_asme-hmbg-de01-test_MtasTraf
A20130429.0000-0005_asme-hmbg-de01-test_MtasVideoFB
A20130429.0000-0005_asme-hmbg-de01-test_MtasWsNameDb



SOI



				Legend

				File Pattern Type		Filename example		Default regex in installation		Remarks

						C20140421.0300-0305_solg-3242_ims-ems-activation.xml		C.*ims-ems-activation.xml







				Counter Name		File Pattern Type

				IdleTime.Sum		^C[0-9]*

				IdleTime.Max		^C[0-9]*

				ConcurrentRequest.Max		^C[0-9]*

				ConcurrentRequest.Mean		^C[0-9]*

				Up.Time		^C[0-9]*

				ResponseTime.Total.Max		^C[0-9]*

				ResponseTime.Total.95Percentile		^C[0-9]*

				ResponseTime.Total.75Percentile		^C[0-9]*

				ResponseTime.Total.Median		^C[0-9]*

				ResponseTime.Total.Min		^C[0-9]*

				ResponseTime.Total.Mean		^C[0-9]*

				RequestCount.Total		^C[0-9]*

				TransactionsPerSecond.Total.Max		^C[0-9]*

				TransactionsPerSecond.Total.Mean		^C[0-9]*

				ResponseTime.Success.Max		^C[0-9]*

				ResponseTime.Success.95Percentile		^C[0-9]*

				ResponseTime.Success.75Percentile		^C[0-9]*

				ResponseTime.Success.Median		^C[0-9]*

				ResponseTime.Success.Min		^C[0-9]*

				ResponseTime.Success.Mean		^C[0-9]*

				RequestCount.Success		^C[0-9]*

				TransactionsPerSecond.Success.Max		^C[0-9]*

				TransactionsPerSecond.Success.Mean		^C[0-9]*

				ResponseTime.Failed.Max		^C[0-9]*

				ResponseTime.Failed.95Percentile		^C[0-9]*

				ResponseTime.Failed.75Percentile		^C[0-9]*

				ResponseTime.Failed.Median		^C[0-9]*

				ResponseTime.Failed.Min		^C[0-9]*

				ResponseTime.Failed.Mean		^C[0-9]*

				RequestCount.Failed		^C[0-9]*

				TransactionsPerSecond.Failed.Max		^C[0-9]*

				TransactionsPerSecond.Failed.Mean		^C[0-9]*









The following regExp is the default pattern for each  counter family:
^C[0-9] * 


Files name examples:
C20140421.0300-0305_solg-3242_ims-ems-activation.xml
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README

		EMC® SolutionPack for Huawei iManager M2000 Counter Prerequisites

		P/N 302-001-456 Rev 01



		———————————————————————————————————————————————————————————————–

		File Name Format

		The name of the file has the format pmresult_<counter-group-id>_<granularity>_<StartTime>_<EndTime>.csv, where:



		counter-group-id is numerical representation for set of performance metrics

		granularity period is the time duration for which performance data is collected in minutes

		StartTime – Specifies the date and time when the observation period began and is in the form YYYYMMDDHHMM.

		EndTime – Specifies the date and time when the observation period ended and is in the form YYYYMMDDHHMM.



		An example file name looks like :

		pmresult_67109379_30_201302192130_201302192200.csv

		where:

		pmresult: performance log file name start with pmresult string

		67109379  – counter group id

		30 – granularity period in minute

		201302192130 – Start time in YYYYMMDDHHMM format

		201302192200 – end time  in YYYYMMDDHHMM format



		Time Format

		Times in the measurement result files are expressed in local time in YYYY-MM-DD hh:mm format, where:



		YYYY – four-digit year

		MM – two-digit month (01 through 12)

		DD – two-digit day of month (01 through 31)

		hh – two digits of hour (00 through 23)

		mm – two digits of minute (00 through 59)





		An example time stamp looks like:

		2013-02-19 21:30

		———————————————————————————————————————————————————————————————–



		Copyright © 2015 EMC Corporation. All rights reserved. Published in the USA.

		Published January, 2015



		EMC believes the information in this publication is accurate as of its publication date. The information is subject to change without notice.

		The information in this publication is provided as is. EMC Corporation makes no representations or warranties of any kind with respect to the information in this publication, and specifically disclaims implied warranties of merchantability or fitness for a particular purpose. Use, copying, and distribution of any EMC software described in this publication requires an applicable software license.

		EMC2, EMC, and the EMC logo are registered trademarks or trademarks of EMC Corporation in the United States and other countries. All other trademarks used herein are the property of their respective owners.

		For the most up-to-date regulatory document for your product line, go to EMC Online Support (https://support.emc.com).









Huawei M2000 File Types

		File name 		Object Name Example		Object Type

		pmresult_67109379_*.csv		RNC/BSC6900UCell:Label=PO230A1		obj1

		pmresult_67109377_*.csv

		pmresult_67109381_*.csv

		pmresult_67109471_*.csv

		pmresult_67109391_*.csv

		pmresult_67109365_*.csv

		pmresult_67109367_*.csv

		pmresult_67109368_*.csv

		pmresult_67109369_*.csv

		pmresult_67109372_*.csv

		pmresult_67109373_*.csv

		pmresult_67109376_*.csv

		pmresult_67109385_*.csv

		pmresult_67109390_*.csv

		pmresult_67109420_*.csv		RNC/BSC6900UMTSFunction:RNC		obj2

		pmresult_67109421_*.csv

		pmresult_67109446_*.csv

		pmresult_67109473_*.csv		RNC/NODEB:NodeB Name=POCNodeB1

		pmresult_67109519_*.csv		RNC/CNOPERATOR:CNNAME=0, CNINDEX=0		obj3

		pmresult_67109516_*.csv		"RNC/DPU:SRN=0, SN=9, BT=DPUB"
 AND
"BSC/DPU:Slot No.=11, Subrack No=0, Subsystem No.=0"		obj4

		pmresult_50331652_*.csv		RM190/NodeB:RM190/MocID:2/Operator:-1		obj5

		pmresult_1275069419_*.csv		BSC/GCELL:LABEL=RML190A, CellIndex=0, CGI=42601006F076D		obj6

		pmresult_1275072526_*.csv

		pmresult_1275072528_*.csv

		pmresult_1275072525_*.csv

		pmresult_1275072527_*.csv

		pmresult_1275071435_*.csv

		pmresult_1275072618_*.csv

		pmresult_1275071427_*.csv

		pmresult_1275071429_*.csv

		pmresult_1275072018_*.csv		BSC/BSCRPT:BSC





Huawei M2000 Metrics

		Counter Group ID		Counter ID		Counter Name		Counter DESCRIPTION

						Counter Group ID: 67109379

		67109379		67180498		VS.SHO.AttRLAdd		Number of Radio Link Addition Attempts in Soft Handover for Cell

				67180508		VS.SHO.AttRLDel		Number of Radio Link Deletion Attempts in Soft Handover for Cell

				67180499		VS.SHO.SuccRLAdd		Number of Successful Radio Link Additions in Soft Handover for Cell

				67180509		VS.SHO.SuccRLDel		Number of Successful Radio Link Deletions in Soft Handover for Cell

						Counter Group ID: 67109377

		67109377		67203416		VS.RAB.SFOccupy		Mean Number of SFs that Have Been Occupied (Let the SFs that Have Been Occupied a Unitary SF of 256) for Cell

						Counter Group ID: 67109381

		67109381		67189749		IRATHO.AttRelocPrepOutCS		Number of Preparation Attempts for CS Outgoing Inter-RAT Handover for Cell

				67189755		IRATHO.SuccOutCS		Number of Successful CS Outgoing Inter-RAT Handovers for Cell

						Counter Group ID: 67109471

		67109471		67192114		VS.HSUPA.RAB.AttEstab		Number of HSUPA RAB Establishment Attempts for Cell

				67192115		VS.HSUPA.RAB.SuccEstab		Number of Successful HSUPA RAB Establishments for Cell

				67203932		VS.HSUPA.MeanChThroughput		Mean Uplink Throughput of single HSUPA MAC-d Flow for Cell

				67203850		VS.HSUPA.UE.Mean.Cell		Average Number of HSUPA UEs in a Cell

				67202932		VS.HSDPA.UE.Mean.Cell		Average Number of HSDPA UEs in a Cell

						Counter Group ID: 67109391

		67109391		67202567		VS.LC.ULCreditUsed.Mean		Mean Usage of UL Credit for Cell

				67191165		VS.LC.ULCreditUsed.Max		Maximum Usage of UL Credit for Cell

				67202570		VS.LC.DLCreditUsed.Mean		Mean Usage of DL Credit for Cell

				67191167		VS.LC.DLCreditUsed.Max		Maximum Usage of DL Credit for Cell

				67199736		VS.Cell.UnavailTime		Cell Unavailability Duration

						Counter Group ID: 67109365

		67109365		67179345		RRC.AttConnEstab.CallReEst		Number of RRC Connection Requests for Cell (Call Re-Establishment)

				67179342		RRC.AttConnEstab.Detach		Number of RRC Connection Requests for Cell (Detach)

				67179338		RRC.AttConnEstab.EmgCall		Number of RRC Connection Requests for Cell (Emergency Call)

				67179340		RRC.AttConnEstab.IRATCCO		Number of RRC Connection Requests for Cell (Inter-RAT Cell Change Order)

				67179339		RRC.AttConnEstab.IRATCelRes		Number of RRC Connection Requests for Cell (Inter-RAT Cell Re-Selection)

				67195965		RRC.AttConnEstab.MBMSPtp		Number of RRC Connection Requests for Cell (MBMS PTP RB Request)

				67195964		RRC.AttConnEstab.MBMSRep		Number of RRC Connection Requests for Cell (MBMS Reception)

				67179332		RRC.AttConnEstab.OrgBkgCall		Number of RRC Connection Requests for Cell (Originating Background Call)

				67179329		RRC.AttConnEstab.OrgConvCall		Number of RRC Connection Requests for Cell (Originating Conversational Call)

				67179343		RRC.AttConnEstab.OrgHhPrSig		Number of RRC Connection Requests for Cell (Originating High Priority Signaling)

				67179331		RRC.AttConnEstab.OrgInterCall		Number of RRC Connection Requests for Cell (Originating Interactive Call)

				67179344		RRC.AttConnEstab.OrgLwPrSig		Number of RRC Connection Requests for Cell (Originating Low Priority Signaling)

				67179330		RRC.AttConnEstab.OrgStrCall		Number of RRC Connection Requests for Cell (Originating Streaming Call)

				67179333		RRC.AttConnEstab.OrgSubCall		Number of RRC Connection Requests for Cell (Originating Subscribed Traffic Call)

				67179341		RRC.AttConnEstab.Reg		Number of RRC Connection Requests for Cell (Registration)

				67179337		RRC.AttConnEstab.TmBkgCall		Number of RRC Connection Requests for Cell (Terminating Background Call)

				67179334		RRC.AttConnEstab.TmConvCall		Number of RRC Connection Requests for Cell (Terminating Conversational Call)

				67179346		RRC.AttConnEstab.TmHhPrSig		Number of RRC Connection Requests for Cell (Terminating High Priority Signaling)

				67179336		RRC.AttConnEstab.TmInterCall		Number of RRC Connection Requests for Cell (Terminating Interactive Call)

				67179347		RRC.AttConnEstab.TmLwPrSig		Number of RRC Connection Requests for Cell (Terminating Low Priority Signaling)

				67179335		RRC.AttConnEstab.TmStrCall		Number of RRC Connection Requests for Cell (Terminating Streaming Call)

				67179348		RRC.AttConnEstab.Unknown		Number of RRC Connection Requests for Cell (Terminating-Cause Unknown)

				67179633		VS.RRC.AttConnEstab.CellDCH		Number of RRC Connection Requests for Cell (UE Target State of CELL_DCH)

				67179649		VS.RRC.AttConnEstab.CellFACH		Number of RRC Connection Requests for Cell (UE Target State of CELL_FACH)

				67196198		VS.RRC.AttConnEstab.EDCH		Number of RRC Connection Attempts for UL Carried on E_DCH for Cell

				67196199		VS.RRC.AttConnEstab.HSDSCH		Number of RRC Connection Attempts for DL Carried on HS_DSCH for Cell

				73403798		VS.RRC.AttConnEstab.Msg		Number of RRC Connection Requests sent by the UE for cell

				67190586		VS.RRC.AttConnEstab.Sum		Number of Processed RRC Connection Requests for Cell

				67179473		RRC.SuccConnEstab.CallReEst		Number of Successful RRC Connection Setups for Cell (Call Re-Establishment)

				67179470		RRC.SuccConnEstab.Detach		Number of Successful RRC Connection Setups for Cell (Detach)

				67179466		RRC.SuccConnEstab.EmgCall		Number of Successful RRC Connection Setups for Cell (Emergency Call)

				67179468		RRC.SuccConnEstab.IRATCCO		Number of Successful RRC Connection Setups for Cell (Inter-RAT Cell Change Order)

				67179467		RRC.SuccConnEstab.IRATCelRes		Number of Successful RRC Connection Setups for Cell (Inter-RAT Cell Re-Selection)

				67195967		RRC.SuccConnEstab.MBMSPtp		Number of Successful RRC Connection Setups for Cell (MBMS PTP RB Request)

				67195966		RRC.SuccConnEstab.MBMSRep		Number of Successful RRC Connection Setups for Cell (MBMS Reception)

				67179460		RRC.SuccConnEstab.OrgBkgCall		Number of Successful RRC Connection Setups for Cell (Originating Background Call)

				67179457		RRC.SuccConnEstab.OrgConvCall		Number of Successful RRC Connection Setups for Cell (Originating Conversational Call)

				67179471		RRC.SuccConnEstab.OrgHhPrSig		Number of Successful RRC Connection Setups for Cell (Originating High Priority Signaling)

				67179459		RRC.SuccConnEstab.OrgInterCall		Number of Successful RRC Connection Setups for Cell (Originating Interactive Call)

				67179472		RRC.SuccConnEstab.OrgLwPrSig		Number of Successful RRC Connection Setups for Cell (Originating Low Priority Signaling)

				67179458		RRC.SuccConnEstab.OrgStrCall		Number of Successful RRC Connection Setups for Cell (Originating Streaming Call)

				67179461		RRC.SuccConnEstab.OrgSubCall		Number of Successful RRC Connection Setups for Cell (Originating Subscribed traffic Call)

				67179469		RRC.SuccConnEstab.Reg		Number of Successful RRC Connection Setups for Cell (Registration)

				67179299		RRC.SuccConnEstab.sum		Number of Successful RRC Connection Setups for Cell

				67179465		RRC.SuccConnEstab.TmBkgCall		Number of Successful RRC Connection Setups for Cell (Terminating Background Call)

				67179462		RRC.SuccConnEstab.TmConvCall		Number of Successful RRC Connection Setups for Cell (Terminating Conversational Call)

				67179474		RRC.SuccConnEstab.TmHhPrSig		Number of Successful RRC Connection Setups for Cell (Terminating High Priority Signaling)

				67179464		RRC.SuccConnEstab.TmItrCall		Number of Successful RRC Connection Setups for Cell (Terminating Interactive Call)

				67179475		RRC.SuccConnEstab.TmLwPrSig		Number of Successful RRC Connection Setups for Cell (Terminating Low Priority Signaling)

				67179463		RRC.SuccConnEstab.TmStrCall		Number of Successful RRC Connection Setups for Cell (Terminating Streaming Call)

				67179476		RRC.SuccConnEstab.Unkown		Number of Successful RRC Connection Setups for Cell (Terminating-Cause Unknown)

				67179298		VS.RRC.SetupConnEstab		Number of RRC Connection Setup Messages from RNC to UE for Cell

				67179634		VS.RRC.SuccConnEstab.CellDCH		Number of Successful RRC Connection Setups for Cell (UE Target State of CELL_DCH)

				67179650		VS.RRC.SuccConnEstab.CellFACH		Number of Successful RRC Connection Setups for Cell (UE Target State of CELL_FACH)

				67196200		VS.RRC.SuccConnEstab.EDCH		Number of Successful RRC Connection Setups for Cell (UL Carried on E_DCH)

				67190587		VS.RRC.SuccConnEstab.First		Number of Successful RRC Connection Setups with One RRC Connection Request Message from UE for Cell

				67196201		VS.RRC.SuccConnEstab.HSDSCH		Number of Successful RRC Connection Setups for Cell (DL Carried on HS_DSCH)

				67190588		VS.RRC.SuccConnEstab.Second		Number of Successful RRC Connection Setups with Two RRC Connection Request Messages from UE for Cell

				67190589		VS.RRC.SuccConnEstab.Third		Number of Successful RRC Connection Setups with Three RRC Connection Request Messages from UE for Cell

				73410490		VS.CellDCHUEs.PTT		Number of PTT UEs in Cell with RRC Connection State of CELL_DCH

				73410489		VS.CellFACHUEs.PTT		Number of PTT UEs in Cell with RRC Connection State of CELL_FACH

				73410505		VS.CellPCHUEs.PTT		Number of PTT UEs with RRC Connection State of CELL_PCH for Cell

				67195590		VS.RRC.AutoDsac.Num		Number of Automatic DSACs Triggered by Congestion on Iu Interface for Cell

				67179302		VS.RRC.ConnEstabTimeMax.CellDCH		Maximum Duration of RRC Connection Setup for Cell (UE Target State on CELL_DCH)

				73421887		VS.RRC.ConnEstabTimeMax.CellFACH		Maximum Duration of RRC Establishment Process on FACH for Cell

				67199510		VS.RRC.ConnEstabTimeMean.CellDCH		Average Duration of RRC Connection Setup for Cell (UE Target State on CELL_DCH)

				73439969		VS.RRC.ConnEstabTimeMean.CellFACH		Mean Duration of RRC Establishment Process on FACH for Cell

				67192607		VS.RRC.Estab.DRDIn		Number of RRC Connection Setup Attempts with DRD in for Cell

				67189400		VS.RRC.Estab.DRDOut.Att		Number of RRC Connection Setup Attempts with DRD out for Cell

				67189401		VS.RRC.Estab.DRDOut.Succ		Number of Successful RRC Connection Setups with DRD out for Cell

						Counter Group ID: 67109367

		67109367		67179521		VS.RRC.FailConnEstab.Cong		Number of RRC Connection Rejects Due to Network Congestion for Cell

				67190401		VS.RRC.FailConnEstab.NoReply		Number of RRC Connection Rejects Due to Timeout of RRC CONNECT SETUP COMPLETE for Cell

				67179524		VS.RRC.Rej.Code.Cong		Number of RRC Connection Rejects for Cell (Code Resource Congestion)

				67190405		VS.RRC.Rej.DLCE.Cong		Number of RRC Connection Rejects for Cell (DL CE Resource Congestion)

				67192609		VS.RRC.Rej.DLIUBBand.Cong		Number of RRC Connection Rejects for Cell (DL Iub Bandwidth Congestion)

				67193610		VS.RRC.Rej.DLPower.Cong		Number of RRC Connection Rejects for Cell (DL Power Congestion)

				73421493		VS.RRC.Rej.Redir.Dist		Number of Distance-Based RRC Redirections for Cell

				67189474		VS.RRC.Rej.Redir.InterRat		Number of RRC Connection Rejects during redirection between inter-RAT cells for cell

				67189473		VS.RRC.Rej.Redir.IntraRat		Number of RRC Connection Rejects during redirection between inter-frequency cells for cell

				67196031		VS.RRC.Rej.Redir.Service		Number of RRC Connection Rejects Due to Service-based RRC Redirection for Cell

				67179525		VS.RRC.Rej.RL.Fail		Number of RRC Connection Rejects Due to Radio Link Setup Failure for Cell

				67179300		VS.RRC.Rej.Sum		Number of RRC Connection Rejects for Cell

				67179527		VS.RRC.Rej.TNL.Fail		Number of RRC Connection Rejects for Cell (Transmission Setup Failure on Iub Interface )

				67190404		VS.RRC.Rej.ULCE.Cong		Number of RRC Connection Rejects for Cell (UL CE Resource Congestion)

				67192608		VS.RRC.Rej.ULIUBBand.Cong		Number of RRC Connection Rejects for Cell (UL Iub Bandwidth Congestion)

				67193609		VS.RRC.Rej.ULPower.Cong		Number of RRC Connection Rejects for Cell (UL Power Congestion)

						Counter Group ID: 67109368

		67109368		67196202		VS.HSPA.RAB.AttEstab.CS.Conv		Number of CS over HSPA RAB Establishment Attempts for Cell

				67196203		VS.HSPA.RAB.SuccEstab.CS.Conv		Number of Successful CS over HSPA RAB Establishments for Cell

				67204853		VS.HSPA.UE.Mean.CS.Conv.Cell		Number of CS over HSPA Users for Cell

				67192120		VS.RAB.AttEstabCS.AMRWB		Number of CS Wideband AMR Service RAB Establishment Attempts for Cell

				73394283		VS.RAB.AttEstabCS.AMRWB12.65		Number of CS 12.65kbit/s AMRWB service RAB establishment Attempts for cell

				73394282		VS.RAB.AttEstabCS.AMRWB14.25		Number of CS 14.25kbit/s AMRWB service RAB establishment Attempts for cell

				73394281		VS.RAB.AttEstabCS.AMRWB15.85		Number of CS 15.85kbit/s AMRWB service RAB establishment Attempts for cell

				73394280		VS.RAB.AttEstabCS.AMRWB18.25		Number of CS 18.25kbit/s AMRWB service RAB establishment Attempts for cell

				73394279		VS.RAB.AttEstabCS.AMRWB19.85		Number of CS 19.85kbit/s AMRWB service RAB establishment Attempts for cell

				73394278		VS.RAB.AttEstabCS.AMRWB23.05		Number of CS 23.05kbit/s AMRWB service RAB establishment Attempts for cell

				73394277		VS.RAB.AttEstabCS.AMRWB23.85		Number of CS 23.85kbit/s AMRWB service RAB establishment Attempts for cell

				73394285		VS.RAB.AttEstabCS.AMRWB6.60		Number of CS 6.60kbit/s AMRWB service RAB establishment Attempts for cell

				73394284		VS.RAB.AttEstabCS.AMRWB8.85		Number of CS 8.85kbit/s AMRWB service RAB establishment Attempts for cell

				67190457		VS.RAB.AttEstabCS.AMR.12.2		Number of CS 12.2kbit/s AMR Service RAB Establishment Attempts for Cell

				67179825		VS.RAB.AttEstabCS.Conv		Number of CS Conversational RAB Establishment Requests for Cell

				73393916		VS.RAB.AttEstabCS.Queue		Number of Queuing Attempts Due to Insufficient Resource in the CS RAB Assignment Establishment Procedure for Cell

				67179826		VS.RAB.AttEstabCS.Str		Number of CS Streaming RAB Establishment Requests for Cell

				67196232		VS.RAB.AttEstabCS.VPLimit		Number of 64kbit/s CS RAB Attempts Initiated in Cell Where 64kbit/s CS Conversational Service is Forbidden for Cell

				67179858		VS.RAB.AttEstab.AMR		Number of CS AMR Service RAB Establishment Attempts for Cell

				67190460		VS.RAB.AttEstCS.AMR.4.75		Number of CS 4.75kbit/s AMR Service RAB Establishment Attempts for Cell

				67190458		VS.RAB.AttEstCS.AMR.7.95		Number of CS 7.95kbit/s AMR Service RAB Establishment Attempts for Cell

				67179859		VS.RAB.AttEstCS.Conv.64		Number of CS Conversational RAB Establishment Attempts for Cell (Max DL Bit Rate is 64 kbit/s)

				73393918		VS.RAB.Estab.QueueTime.CS		Average Duration of a CS Queuing in the RAB Establishment Procedure for Cell

				67179860		VS.RAB.SuccEstabCS.AMR		Number of Successful CS AMR RAB Establishments for Cell

				67192121		VS.RAB.SuccEstabCS.AMRWB		Number of Successful CS Wideband AMR RAB Establishments for Cell

				73394292		VS.RAB.SuccEstabCS.AMRWB12.65		Number of CS 12.65kbit/s AMRWB service RAB successfully established for cell

				73394291		VS.RAB.SuccEstabCS.AMRWB14.25		Number of CS 14.25kbit/s AMRWB service RAB successfully established for cell

				73394290		VS.RAB.SuccEstabCS.AMRWB15.85		Number of CS 15.85kbit/s AMRWB service RAB successfully established for cell

				73394289		VS.RAB.SuccEstabCS.AMRWB18.25		Number of CS 18.25kbit/s AMRWB service RAB successfully established for cell

				73394288		VS.RAB.SuccEstabCS.AMRWB19.85		Number of CS 19.85kbit/s AMRWB service RAB successfully established for cell

				73394287		VS.RAB.SuccEstabCS.AMRWB23.05		Number of CS 23.05kbit/s AMRWB service RAB successfully established for cell

				73394286		VS.RAB.SuccEstabCS.AMRWB23.85		Number of CS 23.85kbit/s AMRWB service RAB successfully established for cell

				73394294		VS.RAB.SuccEstabCS.AMRWB6.60		Number of CS 6.60kbit/s AMRWB service RAB successfully established for cell

				73394293		VS.RAB.SuccEstabCS.AMRWB8.85		Number of CS 8.85kbit/s AMRWB service RAB successfully established for cell

				67190461		VS.RAB.SuccEstabCS.AMR.12.2		Number of Successful CS 12.2kbit/s AMR Service RAB Establishments for Cell

				67179827		VS.RAB.SuccEstabCS.Conv		Number of Successful CS Conversational RAB Establishments for Cell

				73393920		VS.RAB.SuccEstabCS.Queue		Number of Successful CS Establishment After Queuing for Cell

				67179828		VS.RAB.SuccEstabCS.Str		Number of Successful CS Streaming RAB Establishments for Cell

				67190464		VS.RAB.SuccEstCS.AMR.4.75		Number of Successful CS 4.75kbit/s AMR Service RAB Establishments for Cell

				67190462		VS.RAB.SuccEstCS.AMR.7.95		Number of Successful CS 7.95kbit/s AMR Service RAB Establishments for Cell

				67179861		VS.RAB.SuccEstCS.Conv.64		Number of Successful CS RAB Establishments for Cell (Max DL Bit Rate is 64 kbit/s)

						Counter Group ID: 67109369

		67109369		67179864		VS.RAB.FailEstabCS.Code.Cong		Number of Failed CS RAB Establishments for Cell (Code Congestion)

				67189494		VS.RAB.FailEstabCS.Cong		Number of Failed CS RAB Establishments for Cell (Congestion)

				67190407		VS.RAB.FailEstabCS.DLCE.Cong		Number of Failed CS RAB Establishments for Cell (DL CE Congestion)

				67192610		VS.RAB.FailEstabCS.DLIUBBand.Cong		Number of Failed CS RAB Establishments for Cell (DL Iub Bandwidth Congestion)

				67193612		VS.RAB.FailEstabCS.DLPower.Cong		Number of Failed CS RAB Establishments for Cell (DL Power Congestion)

				73393835		VS.RAB.FailEstabCS.IubFail		Number of Failed CS RAB Establishments for cell (Radio Link Configuration Failure)

				67193538		VS.RAB.FailEstabCS.PhyChFail		Number of Failed CS RAB Establishments for Cell(Physical channel failure of UE during the RB setup procedure)

				67193537		VS.RAB.FailEstabCS.RBCfgUnsup		Number of Failed CS RAB Establishments for Cell(Configuration unsupported of UE during the RB setup procedure)

				67193536		VS.RAB.FailEstabCS.RBIncCfg		Number of Failed CS RAB Establishments for Cell(Invalid configuration of UE during the RB setup procedure)

				67189495		VS.RAB.FailEstabCS.RNL		Number of Failed CS RAB Establishments for Cell (Radio Network Layer Cause)

				67189496		VS.RAB.FailEstabCS.TNL		Number of Failed CS RAB Establishments for Cell (Transmission Network Layer Cause)

				67190406		VS.RAB.FailEstabCS.ULCE.Cong		Number of Failed CS RAB Establishments for Cell (UL CE Congestion)

				67192611		VS.RAB.FailEstabCS.ULIUBBand.Cong		Number of Failed CS RAB Establishments for Cell (UL Iub Bandwidth Congestion)

				67193611		VS.RAB.FailEstabCS.ULPower.Cong		Number of Failed CS RAB Establishments for Cell (UL Power Congestion)

				67179830		VS.RAB.FailEstabCS.Unsp		Number of Failed CS RAB Establishments for Cell (Unsupported Capabilities)

				73393836		VS.RAB.FailEstabCS.UuFail		Number of Failed CS RAB Establishments for cell (Uu Interface Configuration Failure)

				67193539		VS.RAB.FailEstabCS.UuNoReply		Number of Failed CS RAB Establishments for Cell(No reply of UE during the RB setup procedure)

						Counter Group ID: 67109372

		67109372		67179924		VS.RAB.AttEstabPS.Bkg		Number of PS Background RAB Establishment Attempts for Cell

				67179921		VS.RAB.AttEstabPS.Conv		Number of PS Conversational RAB Establishment Attempts for Cell

				67179923		VS.RAB.AttEstabPS.Int		Number of PS Interactive RAB Establishment Attempts for Cell

				73394076		VS.RAB.AttEstabPS.PTT		Number of PTT Service Establishment Attempts for Cell

				73393917		VS.RAB.AttEstabPS.Queue		Number of Queuing Attempts Due to Insufficient Resource in the PS RAB Assignment Establishment Procedure for Cell

				67179922		VS.RAB.AttEstabPS.Str		Number of PS Streaming RAB Establishment Attempts for Cell

				73403809		VS.RAB.AttEstab.PSR99		Number of PS R99 RAB establishment Attempts for cell

				73393919		VS.RAB.Estab.QueueTime.PS		Average Duration of a PS Queuing in the RAB Establishment Procedure for Cell

				67196301		VS.RAB.SuccEstabPS.0kbps		Number of PS RABs Established Successfully at 0 kbit/s in the Best Cell

				67179928		VS.RAB.SuccEstabPS.Bkg		Number of Successful PS Background RAB Establishments for Cell

				67179925		VS.RAB.SuccEstabPS.Conv		Number of Successful PS Conversational RAB Establishments for Cell

				67179927		VS.RAB.SuccEstabPS.Int		Number of Successful PS Interactive RAB Establishments for Cell

				73394075		VS.RAB.SuccEstabPS.PTT		Number of Successful PTT Service Establishments for Cell

				73393921		VS.RAB.SuccEstabPS.Queue		Number of Successful PS Establishment After Queuing for Cell

				67179926		VS.RAB.SuccEstabPS.Str		Number of Successful PS Streaming RAB Establishments for Cell

				73403808		VS.RAB.SuccEstab.PSR99		Number of PS R99 RAB successfully established for cell

						Counter Group ID: 67109373

		67109373		67179967		VS.RAB.FailEstabPS.Code.Cong		Number of Failed PS RAB Establishments for Cell (Code Congestion)

				73394298		VS.RAB.FailEstabPS.Cong		Number of Failed PS RAB Establishments for Cell (Congestion)

				67190409		VS.RAB.FailEstabPS.DLCE.Cong		Number of Failed PS RAB Establishments for Cell (DL CE Congestion)

				67192612		VS.RAB.FailEstabPS.DLIUBBand.Cong		Number of Failed PS RAB Establishments for Cell (DL Iub Bandwidth Congestion)

				67193614		VS.RAB.FailEstabPS.DLPower.Cong		Number of Failed PS RAB Establishments for Cell (DL Power Congestion)

				73393837		VS.RAB.FailEstabPS.IubFail		Number of Failed PS RAB Establishments Due to Radio Link Configuration Failure for Cell

				67193542		VS.RAB.FailEstabPS.PhyChFail		Number of Failed PS RAB Establishments for Cell (Physical channel failure of UE during the RB setup procedure)

				67193541		VS.RAB.FailEstabPS.RBCfgUnsupp		Number of Failed PS RAB Establishments for Cell (Configuration unsupported of UE during the RB setup procedure)

				67193540		VS.RAB.FailEstabPS.RBIncCfg		Number of Failed PS RAB Establishments for Cell (UU interface invalid configuration)

				67189556		VS.RAB.FailEstabPS.RNL		Number of Failed PS RAB Establishments for Cell (Radio Network Layer Cause)

				67189557		VS.RAB.FailEstabPS.TNL		Number of Failed PS RAB Establishments for Cell (Transport Network Layer Cause)

				67190408		VS.RAB.FailEstabPS.ULCE.Cong		Number of Failed PS RAB Establishments for Cell (UL CE Congestion)

				67192613		VS.RAB.FailEstabPS.ULIUBBand.Cong		Number of Failed PS RAB Establishments for Cell (UL Iub Bandwidth Congestion)

				67193613		VS.RAB.FailEstabPS.ULPower.Cong		Number of Failed PS RAB Establishments for Cell (UL Power Congestion)

				67179930		VS.RAB.FailEstabPS.Unsp		Number of Failed PS RAB Establishments for Cell (Unsupported Capabilities)

				73393838		VS.RAB.FailEstabPS.UuFail		Number of Failed PS RAB Establishments Due to Uu Interface Configuration Failure for Cell

				67193543		VS.RAB.FailEstabPS.UuNoReply		Number of Failed PS RAB Establishments for Cell (No reply of UE during the RB setup procedure)

						Counter Group ID: 67109376

		67109376		73394073		VS.RAB.AbnormRelPS.PTT		Number of RABs Abnormally Released for PTT Services for Cell

				67180082		VS.RAB.AbnormRel.AMR		Number of CS AMR RABs Abnormally Released for Cell

				73403842		VS.RAB.AbnormRel.AMRWB		Number of CS AMRWB RABs Abnormally Released for cell

				67192207		VS.RAB.AbnormRel.AMRWB.12.65		Number of CS 12.65kbit/s WB AMR RABs Abnormally Released for Cell

				67192206		VS.RAB.AbnormRel.AMRWB.14.25		Number of CS 14.25kbit/s WB AMR RABs Abnormally Released for Cell

				67192205		VS.RAB.AbnormRel.AMRWB.15.85		Number of CS 15.85kbit/s WB AMR RABs Abnormally Released for Cell

				67192203		VS.RAB.AbnormRel.AMRWB.19.85		Number of CS 19.85kbit/s WB AMR RABs Abnormally Released for Cell

				67192202		VS.RAB.AbnormRel.AMRWB.23.05		Number of CS 23.05kbit/s WB AMR RABs Abnormally Released for Cell

				67192201		VS.RAB.AbnormRel.AMRWB.23.85		Number of CS 23.85kbit/s WB AMR RABs Abnormally Released for Cell

				67192209		VS.RAB.AbnormRel.AMRWB.6.6		Number of CS 6.6kbit/s WB AMR RABs Abnormally Released for Cell

				67192208		VS.RAB.AbnormRel.AMRWB.8.85		Number of CS 8.85kbit/s WB AMR RABs Abnormally Released for Cell

				67190467		VS.RAB.AbnormRel.AMR.12.2		Number of CS 12.2kbit/s AMR RABs Abnormally Released for Cell

				67190470		VS.RAB.AbnormRel.AMR.4.75		Number of CS 4.75kbit/s AMR RABs Abnormally Released for Cell

				67190469		VS.RAB.AbnormRel.AMR.5.9		Number of CS 5.9kbit/s AMR RABs Abnormally Released for Cell

				67190468		VS.RAB.AbnormRel.AMR.7.95		Number of CS 7.95kbit/s AMR RABs Abnormally Released for Cell

				73394051		VS.RAB.AbnormRel.AMR.RF		Number of CS AMR RABs abnormal release Due to RF Failure for cell

				67179778		VS.RAB.AbnormRel.CS		Number of CS RABs Abnormally Released for Cell

				67180083		VS.RAB.AbnormRel.CS64		Number of CS Conversational 64kbit/s RABs Abnormally Released for Cell

				73394052		VS.RAB.AbnormRel.CS64.RF		Number of CS Conversational 64kbit/s RABs abnormal released due to RF failure for cell

				67196204		VS.RAB.AbnormRel.CS.HSPA.Conv		Number of CS over HSPA RABs Abnormally Released for Cell

				67180080		VS.RAB.AbnormRel.CS.IuAAL2		Number of CS RABs Abnormally Released for Cell (Iu Interface AAL2 Link Failure)

				67190841		VS.RAB.AbnormRel.CS.OLC		Number of CS Domain RABs Released Due to Congestion for Cell

				67180067		VS.RAB.AbnormRel.CS.OM		need to be fixed.

				67180069		VS.RAB.AbnormRel.CS.Preempt		Number of CS RAB Release Attempts for Cell (RAB Preemption)

				67179777		VS.RAB.AbnormRel.CS.RF		Number of CS RABs Abnormally Released Due to RF for Cell

				67180077		VS.RAB.AbnormRel.CS.RF.SRBReset		Number of CS RABs Abnormally Released for Cell (Signaling RLC Reset)

				67189568		VS.RAB.AbnormRel.CS.RF.ULSync		Number of CS RABs Abnormally Released Due to RF for Cell (Uplink Synchronization Fail)

				67190505		VS.RAB.AbnormRel.CS.RF.UuNoReply		Number of CS RABs Abnormally Released Due to RF for Cell (Failure in the Radio Interface Procedure)

				67192597		VS.RAB.AbnormRel.CS.Str		Number of CS Streaming RABs Abnormally Released for Cell

				67180068		VS.RAB.AbnormRel.CS.UTRANgen		Number of CS RAB Abnormal Releases Triggered by RNC for Cell (UTRAN Cause)

				67179781		VS.RAB.AbnormRel.PS		Number of PS RABs Abnormally Released for Cell

				73403806		VS.RAB.AbnormRel.PSR99		Number of PS R99 RABs abnormally released for cell(Including RF Failure)

				73403805		VS.RAB.AbnormRel.PSR99.RF		Number of PS R99 RABs abnormally released Due to RF Failure for cell

				73393846		VS.RAB.AbnormRel.PS.BE		Number of RABs Abnormally Released for PS BE Services for Cell

				67191818		VS.RAB.AbnormRel.PS.CCH		Number of PS RABs Mapped on CCH Abnormally Released for Cell

				67192598		VS.RAB.AbnormRel.PS.Conv		Number of RABs Abnormally Released for PS Conversational Services for Cell

				73421886		VS.RAB.AbnormRel.PS.F2P		Number of call drops During the F2P State Transition for Cell

				67180081		VS.RAB.AbnormRel.PS.GTPULoss		Number of PS RABs Abnormally Released Due to GTPU Failure for Cell

				67190840		VS.RAB.AbnormRel.PS.OLC		Number of PS Domain RABs Released Due to Congestion for Cell

				67180074		VS.RAB.AbnormRel.PS.OM		THIS NEED TO BE FIXED

				73421883		VS.RAB.AbnormRel.PS.PCH		Number of Abnormally Released PS RABs that Are in CELL_PCH or URA_PCH State for Cell

				67180076		VS.RAB.AbnormRel.PS.Preempt		Number of PS RAB Abnormal Released Due to RAB Preemption for Cell

				67179780		VS.RAB.AbnormRel.PS.RF		Number of PS RABs Abnormally Released Due to RF for Cell

				67180078		VS.RAB.AbnormRel.PS.RF.SRBReset		Number of PS RABs Abnormally Released Due to Signaling RLC Reset for Cell

				67180079		VS.RAB.AbnormRel.PS.RF.TRBReset		Number of PS RABs Abnormally Released for Cell (Traffic RLC Reset)

				67189572		VS.RAB.AbnormRel.PS.RF.ULSync		Number of PS RABs Abnormally Released for Cell (Uplink Synchronization Failure)

				67190506		VS.RAB.AbnormRel.PS.RF.UuNoReply		Number of PS RABs Abnormally Released Due to RF for Cell (Failure in the Radio Interface Procedure)

				67192599		VS.RAB.AbnormRel.PS.Str		Number of RABs Abnormally Released for PS Streaming Services for Cell

				73394074		VS.RAB.NormRelPS.PTT		Number of RABs Normally Released for PTT Services for Cell

				67190518		VS.RAB.NormRel.AMR		Number of CS AMR RABs Normally Released for Cell(not including WB-AMR)

				73403843		VS.RAB.NormRel.AMRWB		Number of CS AMRWB RABs Normally Released for cell

				73403839		VS.RAB.NormRel.AMRWB.12.65		Number of CS 12.65kbps AMRWB RABs Normally Released for cell

				73403838		VS.RAB.NormRel.AMRWB.14.25		Number of CS 14.25kbps AMRWB RABs Normally Released for cell

				73403837		VS.RAB.NormRel.AMRWB.15.85		Number of CS 15.85kbps AMRWB RABs Normally Released for cell

				73403836		VS.RAB.NormRel.AMRWB.18.25		Number of CS 18.25kbps AMRWB RABs Normally Released for cell

				73403835		VS.RAB.NormRel.AMRWB.19.85		Number of CS 19.85kbps AMRWB RABs Normally Released for cell

				73403834		VS.RAB.NormRel.AMRWB.23.05		Number of CS 23.85kbit/s AMRWB RABs normally released in the best cell

				73403833		VS.RAB.NormRel.AMRWB.23.85		Number of CS 23.85kbps AMRWB RABs Normally Released for cell

				73403841		VS.RAB.NormRel.AMRWB.6.60		Number of CS 6.60kbps AMRWB RABs Normally Released for cell

				73403840		VS.RAB.NormRel.AMRWB.8.85		Number of CS 8.85kbps AMRWB RABs Normally Released for cell

				67179779		VS.RAB.NormRel.CS		Number of CS RABs Normally Released for Cell

				67191786		VS.RAB.NormRel.CS64		Number of CS 64 kbit/s Conversational RABs Normally Released for Cell

				67196205		VS.RAB.NormRel.CS.HSPA.Conv		Number of CS over HSPA RABs Normal Released for Cell

				67192600		VS.RAB.NormRel.CS.Str		Number of CS Streaming RABs Normally Released for Cell

				73393843		VS.RAB.NormRel.CS.UEGen		Number of CS RABs Normally Released for Cell (UE Generated Signaling Connection Release)

				67179782		VS.RAB.NormRel.PS		Number of PS RABs Normally Released for Cell

				73403807		VS.RAB.NormRel.PSR99		Number of PS R99 RAB successfully released for cell

				67196302		VS.RAB.NormRel.PS.0kbps.Timeout		Number of PS RABs at 0 kbit/s Released for Failure to Rate up in the Best Cell

				73393845		VS.RAB.NormRel.PS.BE		Number of RABs Normally Released for PS BE Services for Cell

				67191791		VS.RAB.NormRel.PS.CCH		Number of PS RABs Mapped on CCH Normally Released for Cell

				67192601		VS.RAB.NormRel.PS.Conv		Number of RABs Normally Released for PS Conversational Services for Cell

				73421882		VS.RAB.NormRel.PS.PCH		Number of Normally Released PS RABs that Are in CELL_PCH or URA_PCH State for Cell

				67192602		VS.RAB.NormRel.PS.Str		Number of RABs Normally Released for PS Streaming Services for Cell

				67191835		VS.RAB.NormRel.PS.UEGen		Number of PS RABs Normally Released for Cell (UE Signaling Connection Release)

				67196233		VS.RAB.NormRel.VPLimit		Number of CS VP RABs Released Due to VP Forbiddance for Cell

				67192977		VS.RAB.RelReqPS.BE.HSDPA.Cong.Copper		Number of HSDPA RABs Carrying Copper Users BE Traffic Released Due to Congestion for Cell

				67192975		VS.RAB.RelReqPS.BE.HSDPA.Cong.Golden		Number of HSDPA RABs Carrying Golden Users BE Traffic Released Due to Congestion for Cell

				67192976		VS.RAB.RelReqPS.BE.HSDPA.Cong.Silver		Number of HSDPA RABs Carrying Silver Users BE Traffic Released Due to Congestion for Cell

				67192980		VS.RAB.RelReqPS.BE.HSUPA.Cong.Copper		Number of HSUAP RABs Carrying Copper Users BE Traffic Released Due to Congestion for Cell

				67192978		VS.RAB.RelReqPS.BE.HSUPA.Cong.Golden		Number of HSUAP RABs Carrying Golden Users BE Traffic Released Due to Congestion for Cell

				67192979		VS.RAB.RelReqPS.BE.HSUPA.Cong.Silver		Number of HSUPA RABs Carrying Silver Users BE Traffic Released Due to Congestion for Cell

						Counter Group ID: 67109385

		67109385		67202982		VS.HSDPA.MaxRequiredPwr		Maximum Power Required by HS-DSCH for Cell

				67202984		VS.HSDPA.MeanRequiredPwr		Mean Power Required by HS-DSCH for Cell

				67202983		VS.HSDPA.MinRequiredPwr		Minimum Power Required by HS-DSCH for Cell

				73403758		VS.HSUPA.MaxRSEPS		Maximum Received Scheduled E-DCH Power Share for Cell

				73415859		VS.HSUPA.MeanRSEPS		Average Received Scheduled E-DCH Power Share for Cell

				73403760		VS.HSUPA.MinRSEPS		Minimum Received Scheduled E-DCH Power Share for Cell

				67199680		VS.MaxRTWP		Maximum Power of Totally Received Bandwidth for Cell

				67199682		VS.MaxTCP		Maximum Transmitted Power of Carrier for Cell

				67202900		VS.MaxTCP.NonHS		Maximum Non-HSDPA Transmitted Carrier Power for Cell

				67199617		VS.MeanRTWP		Mean Power of Totally Received Bandwidth for Cell

				67199618		VS.MeanTCP		Mean Transmitted Power of Carrier for Cell

				67202902		VS.MeanTCP.NonHS		Mean Non-HSDPA Transmitted Carrier Power for Cell

				67199681		VS.MinRTWP		Minimum Power of Totally Received Bandwidth for Cell

				67199683		VS.MinTCP		Minimum Transmitted Power of Carrier for Cell

				67202901		VS.MinTCP.NonHS		Minimum Non-HSDPA Transmitted Carrier Power for Cell

						Counter Group ID:-67109390

		67109390		67202894		VS.HSDPA.MeanChThroughput		Mean Downlink Throughput of single HSDPA MAC-d Flows for Cell

				67202894		VS.HSDPA.MeanChThroughput		Mean Downlink Throughput of single HSDPA MAC-d Flows for Cell

				67191162		VS.HSDPA.RAB.AbnormRel		Number of HSDPA RABs Abnormal Released for Cell

				67190704		VS.HSDPA.RAB.AttEstab		Number of HSDPA RAB Establishment Attempts for Cell

				67195509		VS.HSDPA.RAB.AttEstab.BE.Copper		Number of HSDPA RAB Establishment Attempts of BE Service for Copper Level User for Cell

				67195507		VS.HSDPA.RAB.AttEstab.BE.Golden		Number of HSDPA RAB Establishment Attempts of BE Service for Golden Level User for Cell

				67195508		VS.HSDPA.RAB.AttEstab.BE.Silver		Number of HSDPA RAB Establishment Attempts of BE Service for Silver Level User for Cell

				67191164		VS.HSDPA.RAB.NormRel		Number of HSDPA RABs Normal Released for Cell

				67190705		VS.HSDPA.RAB.SuccEstab		Number of Successful HSDPA RAB Establishments for Cell

				67195512		VS.HSDPA.RAB.SuccEstab.BE.Copper		Number of Successful HSDPA RAB Establishments of BE Service for Copper Level User for Cell

				67195510		VS.HSDPA.RAB.SuccEstab.BE.Golden		Number of Successful HSDPA RAB Establishments of BE Service for Golden Level User for Cell

				67195511		VS.HSDPA.RAB.SuccEstab.BE.Silver		Number of Successful HSDPA RAB Establishments of BE Service for Silver Level User for Cell

				67202932		VS.HSDPA.UE.Mean.Cell		Average Number of HSDPA UEs in a Cell

						Counter Group ID:-67109420

		67109420		67174689		VS.RRC.AttConnEstab.CellDCH.RNC		Number of RRC Connection Requests for RNC (UE Target State of CELL_DCH)

				67174705		VS.RRC.AttConnEstab.CellFACH.RNC		Number of RRC Connection Requests for RNC (UE Target State of CELL_FACH)

				67174449		VS.RRC.AttConnEstab.Msg.RNC		Total Number of RRC Connection Requests Received by RNC

				67174450		VS.RRC.AttConnEstab.RNC		Number of RRC Connection Requests Processed by RNC

				67174691		VS.RRC.SuccConnEstab.CellDCH.RNC		Number of Successful RRC Connection Establishments on CELL_DCH

				67174706		VS.RRC.SuccConnEstab.CellFACH.RNC		Number of Successful RRC Connection Establishments on CELL_FACH

				67174452		VS.RRC.SuccConnEstab.RNC		Number of Successful RRC Connection Establishments for RNC

						Counter Group ID:-67109421

		67109421		67190072		VS.RRC.AttConnRel.Cong.RNC		Number of RRC Connection Releases due to Congestion for RNC

				67190076		VS.RRC.AttConnRel.DSCR.RNC		Number of RRC Connection Releases due to Re-establishment Reject for RNC

				67174641		VS.RRC.AttConnRel.Norm.RNC		Number of RRC Connection Releases due to Normal Event for RNC

				67190073		VS.RRC.AttConnRel.Preempt.RNC		Number of RRC Connection Releases due to Preemption for RNC

				67190075		VS.RRC.AttConnRel.ReEstRej.RNC		Number of RRC Connection Releases due to Directed Signaling Connection Re-establishment for RNC

				67174454		VS.RRC.AttConnRel.RNC		Number of RRC Connection Releases for RNC

				67174647		VS.RRC.AttConnRel.Unspec.RNC		Number of RRC Connection Releases due to Unspecified Causes for RNC

				67190074		VS.RRC.AttConnRel.UsrInact.RNC		Number of RRC Connection Releases due to User Inactivity for RNC

				73421937		VS.RRC.AttConRel.SCRI.DF2P.NoReply.RNC		Number of RRC Releases Due to Failure in the UE State Transition to CELL_PCH Triggered by Signaling Connection Release Indication

						Counter Group ID:-67109446

		67109446		67199432		VS.SHO.AS.1.RNC		Mean Number of UEs with One Radio Link for RNC

				67199433		VS.SHO.AS.2Softer.RNC		Mean Number of UEs with Two Combined Radio Links for RNC

				67199434		VS.SHO.AS.2Soft.RNC		Mean Number of UEs with Two Uncombined Radio Links for RNC

				67199437		VS.SHO.AS.3Soft2Softer.RNC		Mean Number of UEs with Three Radio Links and Two Combined for RNC

				67199435		VS.SHO.AS.3Softer.RNC		Mean Number of UEs with Three Combined Radio Links for RNC

				67199436		VS.SHO.AS.3Soft.RNC		Mean Number of UEs with Three Uncombined Radio Links for RNC

				67203933		VS.SHO.AS.4.RNC		Mean Number of UEs with Four Radio Links for RNC

				67203934		VS.SHO.AS.5.RNC		Mean Number of UEs with Five Radio Links for RNC

				67203935		VS.SHO.AS.6.RNC		Mean Number of UEs with Six Radio Links for RNC

				67175266		VS.SHO.Att.RNC		Number of Soft Handovers Initiated by RNC for RNC

				67175283		VS.SHO.Drop.RNC		Number of Call Drops Due to Soft Handover Failures for RNC

				67175267		VS.SHO.Succ.RNC		Number of Successful Soft Handovers Initiated by RNC for RNC

				67175268		VS.SoHO.Att.RNC		Number of Softer Handovers Initiated by RNC for RNC

				67175269		VS.SoHO.Succ.RNC		Number of Successful Softer Handovers Initiated by RNC for RNC

						Counter Group ID:-67109473

		67109473		67192135		VS.IUB.DL.Cong.Num		Number of Iub DL Congestions

				67203855		VS.IUB.DL.Cong.Time		Duration of Iub DL Congestion

				67192134		VS.IUB.UL.Cong.Num		Number of Iub UL Congestions

				67203854		VS.IUB.UL.Cong.Time		Duration of Iub UL Congestion

				VS.NodeB.Ratio.of.UnavailTime.OM		VS.NodeB.Ratio.of.UnavailTime.OM		VS.NodeB.Ratio.of.UnavailTime.OM

				67203853		VS.NodeB.UnavailTime		Duration of NodeB Unavailability

						Counter Group ID: 67109519

		67109519		67204835		VS.AMR.Erlang.Equiv.PLMN.RNC		Equivalent Erlang of CS AMR Service for RNC per Operator

				67203962		VS.CSLoad.Erlang.Equiv.PLMN.RNC		Equivalent CS Erlang for RNC per Operator

				67192511		VS.CSLoad.MaxErlang.Equiv.PLMN.RNC		Maximum equivalent CS Erlang for RNC per Operator

				67204147		VS.HSDPAPSLoad.DLThruput.PLMN.RNC		Downlink PS HSDPA Traffic for RNC per Operator

				67193016		VS.HSDPAPSLoad.MaxDLThruput.PLMN.RNC		Maximum Downlink PS HSDPA Traffic for RNC per Operator

				67193019		VS.HSUPAPSLoad.MaxULThruput.PLMN.RNC		Maximum Uplink PS HSUPA Traffic for RNC per Operator

				67204148		VS.HSUPAPSLoad.ULThruput.PLMN.RNC		Uplink PS HSUPA Traffic for RNC per Operator

				67204149		VS.MBMSPSLoad.DLThruput.PLMN.RNC		Downlink PS MBMS Traffic for RNC per Operator

				67193022		VS.MBMSPSLoad.MaxDLThruput.PLMN.RNC		Maximum Downlink PS MBMS Traffic for RNC per Operator

				73394023		VS.PSLoad.MaxThruput.PLMN.RNC		Maximum Total Throughout of UL and DL PS Services per Operator for RNC

				73410502		VS.PSLoad.Thruput.PLMN.RNC		Average Total Throughput of UL and DL PS Services per Operator for RNC

				67204840		VS.PS.CellDchUEs.PLMN		Number of Cell_DCH UEs in PS Domain for RNC per Operator

				73440109		VS.PS.CellFachUEs.PLMN		Number of Cell_FACH UEs in PS Domain for RNC per Operator

				67204146		VS.R99PSLoad.DLThruput.PLMN.RNC		Downlink PS R99 Traffic for RNC per Operator

				67193013		VS.R99PSLoad.MaxDLThruput.PLMN.RNC		Maximum Downlink PS R99 Traffic for RNC per Operator

				67193010		VS.R99PSLoad.MaxULThruput.PLMN.RNC		Maximum Uplink PS R99 Traffic for RNC per Operator

				67204145		VS.R99PSLoad.ULThruput.PLMN.RNC		Uplink PS R99 Traffic for RNC per Operator

				67204836		VS.VP.Erlang.Equiv.PLMN.RNC		Equivalent Erlang of 64kbit/s CS Service for RNC per Operator

						Counter Group ID: 67109516

		67109516		67194743		VS.DPU.CPULOAD.MAX		HR9760:Maximum CPU Usage of the DPU

				67204463		VS.DPU.CPULOAD.MEAN		AR9760:Average CPU Usage of the DPU

				67204464		VS.DPU.CPULOAD.OVER		TR9760a:Rate of the Period in Which the CPU Usage of the DPU Exceeds the Alarm Threshold

						Counter Group ID: 50331652

		50331652		50332559		VS.LC.ULCreditAvailable.Shared		Number of UL CEs configured for a shared group

				50342561		VS.LC.ULMax.LicenseGroup.Shared		Maximum number of shared UL CEs consumed by an operator

				50342568		VS.LC.ULMin.LicenseGroup.Shared		VS.LC.ULMin.LicenseGroup.Shared

						Counter Group ID: 1275069419

		1275069419		1276071424		CELL.SERV.RATE		TR373:Cell Availability

				1276071423		CELL.SERV.OOS		R373:Cell Out-of-Service Duration

						Counter Group ID: 1275072526

		1275072526		1279178417		DOWN.RLC.BLK.TOTAL		L9101:Total Number of Downlink GPRS RLC Data Blocks

				1279178418		DOWN.CS1.RLC.BLK		L9102:Total Number of Downlink RLC Data Blocks Using CS1

				1279178419		DOWN.CS2.RLC.BLK		L9103:Total Number of Downlink RLC Data Blocks Using CS2

				1279178420		DOWN.CS3.RLC.BLK		L9104:Total Number of Downlink RLC Data Blocks Using CS3

				1279178421		DOWN.CS4.RLC.BLK		L9105:Total Number of Downlink RLC Data Blocks Using CS4

				1279178422		DOWN.CS1.RLC.BLK.VALID.TOTAL		L9106:Total Number of Valid RLC Downlink Data Blocks Using CS1

				1279178423		DOWN.CS2.RLC.BLK.VALID.TOTAL		L9107:Total Number of Valid RLC Downlink Data Blocks Using CS2

				1279178424		DOWN.CS3.RLC.BLK.VALID.TOTAL		L9108:Total Number of Valid RLC Downlink Data Blocks Using CS3

				1279178425		DOWN.CS4.RLC.BLK.VALID.TOTAL		L9109:Total Number of Valid RLC Downlink Data Block Using CS4

				1279178432		DOWN.GPRS.TBF.CS.UPGRADE		L9116:Number of Coding Scheme Upgrades on Downlink GPRS TBF

				1279178433		DOWN.GPRS.TBF.CS.DEGRADE		L9117:Number of Coding Scheme Degrades on Downlink GPRS TBF

				1279178434		DOWN.RLC.SIG.BLK		L9118:Number of Downlink GPRS RLC Control Blocks

				1279178435		DOWN.RLC.NULL.BLK		L9119:Number of Downlink GPRS RLC Dummy Blocks

				1279178436		DL.GPRS.TOTAL.TBF		L9120:Total Number of Downlink GPRS TBFs

				1279178437		DOWN.TOTAL.GPRS.TBF.EXIST.PERIOD		L9121:Total Duration of Downlink GPRS TBFs

				1279178426		DOWN.CS1.RLC.BLK.RESEND.RATE		RL9110:Retransmission Rate of RLC Downlink Data Block Using CS1

				1279178427		DOWN.CS2.RLC.BLK.RESEND.RATE		RL9111:Retransmission Rate of RLC Downlink Data Block Using CS2

				1279178428		DOWN.CS3.RLC.BLK.RESEND.RATE		RL9112:Retransmission Rate of RLC Downlink Data Block Using CS3

				1279178429		DOWN.CS4.RLC.BLK.RESEND.RATE		RL9113:Retransmission Rate of RLC Downlink Data Block Using CS4

				1279178438		DOWN.RLC.GPRS.BLK.RETRAN.RATE		RL9122:Retransmission Rate of Downlink GPRS RLC Data Blocks

				1279178430		DOWN.RLC.AVG.THRPUT.RATE		TL9114:Average Throughput of Downlink GPRS RLC

				1279178431		DOWN.RLC.SGL.TBF.AVG.THRPUT		TL9115:Average Payload of Single Downlink GPRS TBF

				1279178439		DOWN.RLC.GPRS.BLK.THROUGHPUT		TL9123:Throughput of Downlink GPRS RLC Data Blocks

						Counter Group ID: 1275072528

		1275072528		1279180452		DOWN.TOTAL.EGPRS.TBF.EXIST.PERIOD		L9336:Total Duration of Downlink EGPRS TBFs

				1279180454		DOWN.RLC.EGPRS.BLK.THROUGHPUT		TL9338:Throughput of Downlink EGPRS RLC Data Blocks

						Counter Group ID: 1275072525

		1275072525		1279177436		UP.TOTAL.GPRS.TBF.EXIST.PERIOD		L9020:Total Duration of Uplink GPRS TBFs

				1279177439		UP.RLC.GPRS.BLK.THROUGHPUT		TL9023:Throughput of Uplink GPRS RLC Data Blocks

						Counter Group ID: 1275072527

		1275072527		1279179451		UP.TOTAL.EGPRS.TBF.EXIST.PERIOD		L9235:Total Duration of Uplink EGPRS TBFs

				1279179453		UP.RLC.EGPRS.BLK.THROUGHPUT		TL9237:Throughput of Uplink EGPRS RLC Data Blocks

						Counter Group ID: 1275071435

		1275071435		1278087419		CELL.KPI.SD.REQ		K3000:SDCCH Seizure Requests

				1278087420		CELL.KPI.SD.CONGEST		K3001:Failed SDCCH Seizures due to Busy SDCCH

				1278087421		CELL.KPI.SD.SUCC		K3003:Successful SDCCH Seizures

				1278087422		CELL.KPI.SD.TRAF.ERL		K3004:Traffic Volume on SDCCH

				1278087423		CELL.KPI.SD.AVAIL.NUM		K3005:Available SDCCHs

				1278087424		CELL.KPI.SD.CFG.NUM		K3006:Configured SDCCHs

				1278087430		CELL.KPI.TCH.ASS.REQ.TRAF		K3010A:TCH Seizure Requests (Traffic Channel)

				1278087434		CELL.KPI.TCH.HO.REQ.TRAF		K3010B:TCH Seizure Requests in TCH Handovers (Traffic Channel)

				1278087431		CELL.KPI.TCH.ASS.CONG.TRAF		K3011A:Failed TCH Seizures due to Busy TCH (Traffic Channel)

				1278087435		CELL.KPI.TCH.HO.CONGEST.TRAF		K3011B:Failed TCH Seizures in TCH Handovers due to Busy TCH (Traffic Channel)

				1278087433		CELL.KPI.TCH.STATIC.DROPS.TRAF		K3012A:Call Drops on TCH in Stable State (Traffic Channel)

				1278087437		CELL.KPI.TCH.HO.DROPS.TRAF		K3012B:Call Drops in TCH Handovers (Traffic Channel)

				1278087432		CELL.KPI.TCH.ASS.SUCC.TRAF		K3013A:Successful TCH Seizures (Traffic Channel)

				1278087436		CELL.KPI.TCH.HO.SUCC.TRAF		K3013B:Successful TCH Seizures in TCH handovers (Traffic Channel)

				1278087438		CELL.KPI.TCH.TRAF.ERL.TRAF		K3014:Traffic Volume on TCH

				1278087439		CELL.KPI.TCH.AVAIL.NUM		K3015:Available TCHs

				1278087440		CELL.KPI.TCH.CFG.NUM		K3016:Configured TCHs

				1278087425		CELL.KPI.TCH.REQ.SIG		K3020:TCH Seizure Requests (Signaling Channel)

				1278087426		CELL.KPI.TCH.CONG.SIG		K3021:Failed TCH Seizures due to Busy TCH (Signaling Channel)

				1278087428		CELL.KPI.TCH.DROPS.SIG		K3022:Call Drops on TCH (Signaling Channel)

				1278087427		CELL.KPI.TCH.SUCC.SIG		K3023:Successful TCH Seizures (Signaling Channel)

				1278087429		CELL.KPI.TCH.TRAF.ERL.SIG		K3024:Traffic Volume on TCH (Signaling Channel)

				1278087445		CELL.KPI.TCHH.TRAF.ERL		K3034:TCHH Traffic Volume

				1278087447		CELL.KPI.TCH.SUCC		K3040:Successful TCH Seizures

				1278087443		CELL.TCH.OVERFLOW.RATE		K3041:TCH Congestion Rate (Overflow)

				1278087444		CELL.TCH.SEIZ.SUCC.RATE		K3043:TCH Seizure Success Rate

				1278087448		CELL.KPI.TCH.CONGESTION.RATE		K3045:Congestion Rate on TCH (All Channels Busy)

				1278087417		CELL.KPI.IMM.ASS.REQ		K3100:Immediate Assignment Requests

				1278087418		CELL.KPI.IMM.ASS.CMD		K3101:Immediate Assignment Commands

				1278087441		CELL.KPI.DUBAND.HO.REQ		K3170:Dual-Band Handover Requests

				1278087449		CELL.KPI.DUBAND.HO.FAIL		K3173F:Failed Dual-Band Handovers

				1278087442		CELL.KPI.DUBAND.HO.SUCC		K3173:Successful Dual-Band Handovers

				1278079421		CELL.TRX.CFG.AVAIL.RATE		RK3255:TRX Usability

				1278087451		CELL.KPI.TCH.SUCC.SIG.TCHF		RM3176:Successful TCH Seizures (Signaling Channel) (TCHF)

				1278087453		CELL.KPI.TCH.ASS.SUCC.TRAF.TCHF		RM3178:Successful TCH Seizures (Traffic Channel) (TCHF)

				1278087455		CELL.KPI.TCH.HO.SUCC.TRAF.TCHF		RM3179:Successful TCH Seizures in TCH Handovers (Traffic Channel) (TCHF)

				1278087450		CELL.KPI.TCH.SUCC.SIG.TCHH		RM3276:Successful TCH Seizures (Signaling Channel) (TCHH)

				1278087452		CELL.KPI.TCH.ASS.SUCC.TRAF.TCHH		RM3278:Successful TCH Seizures (Traffic Channel) (TCHH)

				1278087454		CELL.KPI.TCH.HO.SUCC.TRAF.TCHH		RM3279:Successful TCH Seizures in TCH Handovers (Traffic Channel) (TCHH)

						Counter Group ID: 1275072618

		1275072618		1279270417		SAMPLE.TIMES.PDCH		R9301:Sampling Times of PDCH Measurement

				1279270440		SAMPLE.NUM.ALL.AVAIL.PDCH.ALLOC.TIME		R9324:Total Allocated Seizure Duration of All Available PDCHs

				1282411892		GPRS.PDCH.NUM.WITH.UL.GPRS.TBF		R9387:Number of GPRS PDCHs carrying uplink GPRS TBFs

				1282411893		GPRS.PDCH.NUM.WITH.DL.GPRS.TBF		R9388:Number of GPRS PDCHs carrying downlink GPRS TBFs

				1282411896		EGPRS.PDCH.NUM.WITH.UL.GPRS.TBF		R9391:Number of EGPRS PDCHs carrying uplink GPRS TBFs

				1282411897		EGPRS.PDCH.NUM.WITH.DL.GPRS.TBF		R9392:Number of EGPRS PDCHs carrying downlink GPRS TBFs

						Counter Group ID: 1275071427

		1275071427		1282448080		CELL.INTRABSC.OUTCELL.HO.REQ.TCH		CH3109A:Number of Outgoing Internal Inter-Cell Handover Requests(TCH)

				1278079527		CELL.INTRABSC.OUTCELL.HO.REQ		CH310:Number of Outgoing Internal Inter-Cell Handover Requests

				1282448081		CELL.INTRABSC.OUTCELL.HO.CMD.TCH		CH3119A:Number of Outgoing Internal Inter-Cell Handover Commands(TCH)

				1278079531		CELL.INTRABSC.OUTCELL.HO.CMD		CH311:Number of Outgoing Internal Inter-Cell Handover Commands

				1282448082		CELL.INTRABSC.OUTCELL.HO.FAIL.TCH		CH3129A:Number of Failed Outgoing Internal Inter-Cell Handovers(TCH)

				1278079532		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP		CH312C:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired)

				1278079533		CELL.INTRABSC.OUTCELL.HO.FAIL.RECONN.SUCC		CH312D:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Reconnection to Old Channels)

				1278079529		CELL.INTRABSC.OUTCELL.HO.FAIL		CH312:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers

				1278079528		CELL.INTRABSC.OUTCELL.HO.SUCC		CH313:Number of Successful Outgoing Internal Inter-Cell Handovers

				1278079468		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP.SD.NOT.INCLUDE.DR		H3120C:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired) (SDCCH) (Excluding Directed Retry)

				1278079473		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP.DR		H3121C:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired) (Directed Retry)

				1278079471		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP.TCHF.TRAF.NOT.INCLUDE.DR		H3127Ca:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired) (TCHF) (Traffic Channel)

				1278079469		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP.TCHF.SIG.NOT.INCLUDE.DR		H3127Cb:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired) (TCHF) (Signaling Channel)

				1278079472		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP.TCHH.TRAF.NOT.INCLUDE.DR		H3128Ca:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired) (TCHH) (Traffic Channel)

				1278079470		CELL.INTRABSC.OUTCELL.HO.FAIL.EXP.TCHH.SIG.NOT.INCLUDE.DR		H3128Cb:Number of Unsuccessful Outgoing Internal Inter-Cell Handovers (Timer Expired) (TCHH) (Signaling Channel)

				1278079530		CELL.INTRABSC.OUTCELL.HO.SUCC.RATE		TH313:Success Rate of Outgoing Internal Inter-Cell Handovers

						Counter Group ID: 1275071429

		1275071429		1282448083		CELL.INTERBSC.OUTCELL.HO.REQ.TCH		CH3309A:Number of Outgoing External Inter-Cell Handover Requests(TCH)

				1278081556		CELL.INTERBSC.OUTCELL.HO.REQ		CH330:Outgoing External Inter-Cell Handover Requests

				1282448084		CELL.INTERBSC.OUTCELL.HO.CMD.TCH		CH3319A:Number of Outgoing External Inter-Cell Handover Commands(TCH)

				1278081558		CELL.INTERBSC.OUTCELL.HO.CMD		CH331:Outgoing External Inter-Cell Handover Commands

				1282448085		CELL.INTERBSC.OUTCELL.HO.FAIL.TCH		CH3329A:Number of Failed Outgoing External Inter-Cell Handovers(TCH)

				1278081565		CELL.INTERBSC.OUTCELL.HO.FAIL.T8.EXP		CH332C:Failed Outgoing External Inter-Cell Handovers (T8 Expired)

				1278081562		CELL.INTERBSC.OUTCELL.HO.FAIL.RECONN.SUCC		CH332D:Failed Outgoing External Inter-Cell Handovers (Reconnection to Old Channels)

				1278081563		CELL.INTERBSC.OUTCELL.HO.FAIL.MSC.CLR		CH332H:Failed Outgoing External Inter-Cell Handovers (Clear Commands Sent By MSC)

				1278081561		CELL.INTERBSC.OUTCELL.HO.FAIL.REQ.REJ		CH332K:Failed Outgoing External Inter-Cell Handovers (Handover Request Rejected)

				1278081564		CELL.INTERBSC.OUTCELL.HO.FAIL.T7.EXP		CH332L:Failed Outgoing External Inter-Cell Handovers (T7 Expiry)

				1278081559		CELL.INTERBSC.OUTCELL.HO.FAIL		CH332:Failed Outgoing External Inter-Cell Handovers

				1278081557		CELL.INTERBSC.OUTCELL.HO.SUCC		CH333:Successful Outgoing External Inter-Cell Handovers

						Counter Group ID: 1275072018

		1275072018		1278670480		BSCRPT.SD.CALL.DROPS		ZCM30:Call Drops on SDCCH per BSC

				1278670526		BSCRPT.A.CLR.REQ.TCH.TRAF.HO		ZCM339B:Call Drops in TCH Handovers (Traffic Channel) per BSC

				1278670522		BSCRPT.TCH.TRAF.CH.CALL.DROP		ZCM36D:Call Drops on TCH in Stable State (Traffic Channel) per BSC

				1278670476		BSCRPT.KPI.SD.REQ		ZK3000:SDCCH Seizure Requests per BSC

				1278670477		BSCRPT.KPI.SD.CONG		ZK3001:Failed SDCCH Seizures due to Busy SDCCH per BSC

				1278670478		BSCRPT.KPI.SD.SUCC		ZK3003:Successful SDCCH Seizures per BSC

				1278670508		BSCRPT.KPI.TCH.ASS.REQ.TRAF		ZK3010A:TCH Seizure Requests (Traffic Channel) per BSC

				1278670509		BSCRPT.KPI.TCH.ASS.CONG.TRAF		ZK3011A:Failed TCH Seizures due to Busy TCH (Traffic Channel) per BSC

				1278670511		BSCRPT.KPI.TCH.ASS.SUCC.TRAF		ZK3013A:Successful TCH Seizures (Traffic Channel) per BSC

				1278670525		BSCRPT.KPI.TCH.HO.SUCC.TRAF		ZK3013B:Successful TCH Seizures in TCH Handovers (Traffic Channel) per BSC

				1278670532		BSCRPT.KPI.TCH.TRAF.ERL.TRAF		ZK3014:Traffic Volume on TCH (Traffic Channel) per BSC

				1278670491		BSCRPT.KPI.TCH.REQ.TIMES.SIG		ZK3020:TCH Seizure Requests (Signaling Channel) per BSC

				1278670504		BSCRPT.KPI.TCH.DROPS.SIG		ZK3022:Call Drops on TCH (Signaling Channel) per BSC

				1278670492		BSCRPT.KPI.TCH.CONGEST.TIMES.SIG		ZK3021:Failed TCH Seizures due to Busy TCH (Signaling Channel) per BSC

				1278670493		BSCRPT.KPI.TCH.SUCC.TIMES.SIG		ZK3023:Successful TCH Seizures (Signaling Channel) per BSC

				1278670506		BSCRPT.KPI.TCH.TRAF.ERL.SIG		ZK3024:Traffic Volume on TCH (Signaling Channel) per BSC
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CHAPTER 1


Release Notes


These release notes contain supplemental information about EMC® M&R. Topics include:


l Revision history.......................................................................................................6
l Product description................................................................................................. 6
l EMC M&R trial licenses............................................................................................6
l New platform features and changes........................................................................ 6
l Installation .............................................................................................................6
l Troubleshooting and getting help............................................................................7
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Revision history
Use this table to review the revisions made to this document.


Revision Date Description


01 June 2014 GA release of EMC M&R 6.4


02 September 2014 GA release of EMC M&R 6.4u1


03 January 2015 GA release of EMC M&R 6.5u1


Product description
EMC® M&R delivers enterprise and carrier-class cross-domain performance and service
level management that transforms data into actionable information, helping assure the
delivery of business services. It provides an end-to-end solution for performance
management of your IT infrastructure, a key component of operations support systems
(OSS). By analyzing the performance of the entire infrastructure, including networks,
servers, applications, storage, and data centers, it enables organizations to consolidate
performance management to a single solution for lower cost of ownership.


EMC M&R trial licenses
Understand how EMC M&R trial licenses work with SolutionPacks.


SolutionPacks distributed with core software have a 30-day free evaluation period. If you
plan to use the software longer than 30 days, you must install a SolutionPack license
before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


New platform features and changes
Review the EMC M&R Release Notes (302-001-669) for the latest information about the
EMC M&R platform features and changes, including known issues and fixed problems.
You can find this document on the EMC Online Support website.


Installation
See the EMC® M&R (Watch4net®) Version Installation and Configuration Guide
(302-001-500) for instructions on installing the EMC M&R platform. You can find this
document on the EMC Online Support website.
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Troubleshooting and getting help
For product information and assistance, you can contact EMC Technical Support.


Procedure


l For documentation, videos, release notes, software updates, or information about
EMC products, go to EMC Online Support at https://support.emc.com.


l For technical support, go to EMC Online Support and click Service Center.


You must have a valid support agreement to open a service request.


l Contact your EMC sales representative for details about obtaining a valid support
agreement or with questions about your account.
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CHAPTER 2


Service Assurance Suite SolutionPacks


This chapter includes the following topics:


l SolutionPack features........................................................................................... 10
l New SolutionPack features and changes............................................................... 13
l Fixed problems......................................................................................................15
l Known problems and limitations........................................................................... 15
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SolutionPack features
The EMC M&R platform provides various Service Assurance Suite SolutionPacks to help
you monitor your network, applications, and infrastructure.


SA Suite SolutionPack Description


SolutionPack for Alcatel-Lucent 5620 SAM This SolutionPack collects data from the Alcatel-
Lucent 5620 Service Aware Manager platform and
provides various types of reports on performance,
health, and utilization.


SolutionPack for Acme Packet SBC This SolutionPack monitors and reports on
performance and utilization information as well as
inventory for all Acme Packet devices.


SolutionPack for Aruba Wi-Fi This SolutionPack provides the performance
reports for the Aruba Wi-Fi controller, station, and
Access Points. It collects and interprets data across
multiple Aruba devices and performs resource
grouping and mathematical calculations to help
you evaluate performance.


SolutionPack for Avaya Aura This SolutionPack reports on health statistics for
the Avaya Aura Communication Manager call
servers.


SolutionPack for BGP This SolutionPack provides analytics on BGP
(Border Gateway Protocol) routers and neighbors,
traffic on links, and exception reports on down or
flapping links.


SolutionPack for Blue Coat PacketShaper This SolutionPack monitors most Blue Coat
PacketShaper devices to provide real-time views of
your wide area network traffic, including the top
ten busiest WAN traffic classes.


SolutionPack for Check Point Firewall This SolutionPack provides unified monitoring of
all the Check Point devices distributed in a network
with firewall capabilities.


SolutionPack for Cisco Firewall This SolutionPack provides unified monitoring of
all the Cisco ASA/PIX devices distributed in the
network.


SolutionPack for Cisco VoIP This SolutionPack reports on voice quality,
availability and VoIP performance and provides
status and metrics for service level measurement.


SolutionPack for Cisco Wi-Fi This SolutionPack monitors and creates reports for
the most common Cisco Wi-Fi Access Points. It
reports on Controllers and Access Points that
include inventory views, real-time performance
views, and historical performance.


SolutionPack for EMC Network Configuration
Manager


This SolutionPack provides a wide spectrum of
reports regarding NCM application servers and
device servers. You can quickly determine
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SA Suite SolutionPack Description


inventory and assets, compliance, and all changes
being made to any NCM application servers.


SolutionPack for EMC Smarts This SolutionPack notifies your operators of real-
time network events and displays the root cause
and impact of the event. Historical event data is
available as well. When the SolutionPack for EMC
Smarts is configured to work with the Service
Assurance Manager, the network operator can view
and manage notifications from the EMC M&R
Operations interface.


SolutionPack for Ericsson eNodeB This SolutionPack is a mobile network
management solution designed to generate reports
that show key metrics and key performance
indicators (KPIs) for Ericsson eNodeB nodes.


SolutionPack for Ericsson IMS CSCF This SolutionPack monitors all signaling from end-
users to services and other networks in the IP
Multimedia Subsystem. It provides comprehensive
performance information about CSCF


SolutionPack for Ericsson IMS HSS SLF This SolutionPack reports on the information in the
HSS, the central IMS user database, including user
registration and user subscription.


SolutionPack for Ericsson IMS IPWorks This SolutionPack collects and reports on data
related to the ENUM (Telephone Number Mapping)
and DNS (Domain Name System) functions in an
IMS network as well as equipment related
measurements such as CPU and memory
utilization, disk capacity, system load, and
interface statistics.


SolutionPack for Ericsson IMS MRFP This SolutionPack reports on the performance of
various Resource Function Processor (MRFP)
services and functions, VMRFP (Visited Media
Resource Function Processor), MRFP Association,
Interactive Messaging, and the IP system. It also
reports on plug-in units, IP interfaces, Gigabit
Ethernet, Ethernet Switch module ports, and Et
Resource.


SolutionPack for Ericsson IMS MTAS This SolutionPack monitors the Multimedia
Telephony Application Server (MMTel AS), the
Scheduled Conference Application Server (Conf
AS), and the Service Centralization and Continuity
Application Server (SCC AS).


SolutionPack for Ericsson IMS SOI This SolutionPack reports on SOI (ServiceOn
Integrator) performance information in the IP
Multimedia subsystem. It measures request counts
and response time and transactions per second
from the SOI to other interfaces.


SolutionPack for Ericsson IMS TSP This SolutionPack monitors and collects
performance measurement data, such as disk
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SA Suite SolutionPack Description


usage, IPv4 statistics, CPU load, cluster and system
uptime, and diameter related measurements.


SolutionPack for Ericsson MGW This SolutionPack is a mobile network
management solution designed to generate reports
that show key metrics and key performance
indicators (KPIs) for Ericsson MGW (Media
Gateway).


SolutionPack for Ericsson RNC This SolutionPack is a mobile network
management solution designed to generate reports
that show key metrics and key performance
indicators (KPIs) for Ericsson RNC (Radio Network
Controller).


SolutionPack for Ericsson SGSN This SolutionPack is a mobile network
management solution designed to generate reports
that show key metrics and key performance
indicators (KPIs) for Ericsson SGSN (Serving GPRS
Support Node) nodes.


SolutionPack for Huawei iManager M2000 This SolutionPack monitors the performance of the
mobile network managed by Huawei iManager
M2000.


SolutionPack for ip.access nano3G Small
Cell


Note


Runs on Linux EMC M&R only.


This SolutionPack is a mobile network
management solution designed to generate reports
that show key metrics and key performance
indicators (KPIs) for the ip.access nano3G access
points (cells) and the ip.access controllers.


SolutionPack for Juniper Firewall This SolutionPack collects and interprets data
across multiple Juniper ASA devices, and performs
resource grouping and mathematical calculations
to make performance information available.


SolutionPack for Juniper RPM This SolutionPack provides unified monitoring of
all probes running on routers and switches
distributed across a network.


SolutionPack for Juniper QoS This SolutionPack monitors QoS-enabled Juniper
devices to help you evaluate and improve the
network performance of critical applications.


SolutionPack for Microsoft System Center
Operations Manager (SCOM)


This SolutionPack provides an integrated
experience for the management of Microsoft
Windows systems and the discovery of their
workloads across platforms in the data center.


SolutionPack for Microsoft SQL Server This SolutionPack provides the unified monitoring
of Microsoft SQL databases using SQL queries
targeted at servers. It provides key information for
database administrators, such as server host
performance, database availability, and deadlocks.


SolutionPack for MPLS This SolutionPack provides visibility into MPLS
(Multiprotocol Label Switching) virtual private
networks (VPNs). It analyzes how MPLS VPNs are
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SA Suite SolutionPack Description


configured and utilized, from both a real-time and
historical perspective.


SolutionPack for Oracle MySQL Database This SolutionPack provides management
capabilities typically found in database-centric
tools along with management support from other
technologies. You can measure client activity by
reporting on data from your database tier
alongside your business logic and presentation
tiers.


SolutionPack for Optical Wavelength
Services


This SolutionPack discovers and monitors TMF864-
compliant Element Management Systems.


SolutionPack for Riverbed SteelHead This SolutionPack provides unified monitoring of
all Riverbed SteelHead appliances distributed in a
network.


SolutionPack for Traffic Flows This SolutionPack provides reports that give you a
clear understanding of your IT network traffic. It
generates network traffic reports that highlight Key
Performance Indicators (such as Router CPU and
Processor Memory Used and the most active
network devices and applications) to help you
better understand their impact on your Datacenter
network.


SolutionPack for Transaction This SolutionPack helps you measure the
performance of your network by providing
transactions that return key performance
indicators.


SolutionPack for UPS This SolutionPack provides unified monitoring of
all the UPS devices distributed in the network. It
provides key reports to help you manage the
performance and availability of your backup power
sources.


New SolutionPack features and changes
This release includes the following new features and changes.


New SolutionPacks


SolutionPack for Alcatel-Lucent 5620 SAM


SolutionPack for Blue Coat PacketShaper


SolutionPack for BGP


SolutionPack for Check Point Firewall


SolutionPack for Cisco Firewall


SolutionPack for Ericsson eNodeB


SolutionPack for Ericsson MGW


SolutionPack for Ericsson RNC
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SolutionPack for Ericsson SGSN


SolutionPack for Huawei iManager M2000


SolutionPack for ip.access nano3G Small Cell


SolutionPack for Juniper Firewall


SolutionPack for Juniper RPM


SolutionPack for Juniper QoS


SolutionPack for MPLS


SolutionPack for Optical Wavelength Services


SolutionPack for Riverbed SteelHead


New EMC M&R features supporting Service Assurance Suite
When EMC M&R and the SolutionPack for EMC Smarts are deployed with Service
Assurance Manager, you can now access the following from the EMC M&R interface:


l Notifications


l Reports:


n EMC Smarts Geography: shows the location on the map having Smarts network
devices.


n Physical Inventory by Device Group: provides a list of device groups based on the
device's vendor.


n Physical Inventory by IP Network: provides a list of devices configured over the IP
networks.


l IP Configuration Manager settings such as polling and thresholds


l Discovery and topology settings for underlying domain managers


The Maintenance Manager:


l Lets you add and manage past and future maintenance on devices


l Provides an API for adding and removing maintenance on devices


l Enables you to group multiple devices by a single maintenance name


The Outage Manager:


l Provides an interface and process for specifying devices and time ranges when in
maintenance


l Computes the availability times and percentages when devices are placed in
maintenance


l Provides an interface for reports to take advantage of the Outage Manager and to
correctly compute availability statistics


For information on how to exclude maintenance period data from the totals in a graph or
a table report, see the Excluding Planned Maintenance Periods from Report Totals article.


The Geo-map functionality provides:


l Online and offline support with automatic device positioning


l Ability to show all discovered devices with icons based on their appropriate device
type


l Ability to zoom-in and zoom-out


l Availability status indication displayed for devices


l Topology (WAN links) display


Service Assurance Suite SolutionPacks


14 EMC M&R 6.5u1  Release Notes for Service Assurance Suite







l Device name and model display


l Critical alerts and breaches display


l Device group names


The EMC Smarts Failover System now supports the failover of the services used to
communicate between Service Assurance Manager and EMC M&R platform. The EMC
Smarts Failover System User Guide provides more information.


The new Send to SAM filter action sends performance alerts collected by the EMC M&R
interface to the Smarts SAM console for further analysis and processing by the Smarts
domain managers. These alerts display in the Notification View of the EMC M&R interface.


Fixed problems


Issue
number


Component Problem description Workaround/Resolution


654735 SolutionPack
for EMC
Smarts


VirtualCenter instances are missing from


Report Library > EMC Smarts ESM >


Inventory > VCenters.


To view the VirtualCenter instances, navigate to


Explore > Network and click the VirtualCenter
row in the table.


Known problems and limitations
At the time of release, the following known problems and limitations exist. When
applicable, a workaround for the issue is documented.


Issue
number


Component Problem description Workaround/Resolution


EMC-3283 Incorrect
version of
CUCM
bundled in
EMC M&R
6.5u1


The Cisco Unified Communication
Manager SolutionPack should not be
installed due to some known issues.


For further information, please contact EMC Customer
Support.


EMC-3284 Incorrect
version of
CUCM
bundled in
EMC M&R
6.5u1


NSN GGSN SolutionPack should not
be part of EMC M&R 6.5u1.


For further information, please contact EMC Customer
Support.


654772 All pre-6.4
SolutionPack
s


After installing a SolutionPack, the
Report Library node does not appear
in the tree in the EMC M&R 6.4
platform.


SolutionPacks that were created on older versions of the EMC
M&R platform require that you manually install the generic
reports module to view the Report Library. To do this, run
these commands from the host:


l /opt/APG/bin/manage-modules install
generic-reports


l /opt/APG/bin/manage-modules.sh service
restart all
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Issue
number


Component Problem description Workaround/Resolution


When you re-login to the EMC M&R interface, the Report
Library appears.


616770 SolutionPack
for Acme
Packet SBC


This SolutionPack only supports these
SNMP tables:


l apCombinedSessionAgentStatsTa
ble


l apSigRealmStatsTable


This is working as designed.
If you use the alternate SNMP table
apSipSessionAgentStatsTable, which has the same data as
apCombinedSessionAgentStatsTable, this SolutionPack does
not work. EMC M&R is expecting the unique performance
records from apCombinedSessionAgentStatsTable.


651959 SolutionPack
for Acme
Packet SBC


Received warnings in the
SolutionPack log files.


This occurs because the collector uses an older API in some
cases instead of a new API. No impact on product
functionality.


651960 SolutionPack
for Acme
Packet SBC


Some graphs under Registration
statistics did not display data.


N/A


SASP-154 SolutionPack
for Alcatel-
Lucent 5620
SAM


The Performance, Health & OAM
reports and HTTPS support were not
fully tested.


N/A


SASP-457 SolutionPack
for Alcatel-
Lucent 5620
SAM


The legend and description of


Memory/Buffer > Allocated
Memory Usage > Used report
require updating.


N/A


SASP-458 SolutionPack
for Alcatel-
Lucent 5620
SAM


The reports load slowly. This can happen in a large customer environment that does
not have a dedicated database, Stream collector, and front-
end server.


SASP-532 SolutionPack
for Alcatel-
Lucent 5620
SAM and
SolutionPack
for Huawei
iManager
M2000


Unable to delete Stream collector
error log files from Windows 2012
host.


There is no impact on data collection.


651913 SolutionPack
for Avaya
Aura


The Phone Registration Summary
report shows unregistered phones
during a period of time.


This is working as designed. The report shows unregistered
phone details which may not be expected by some users.


651865 SolutionPack
for Avaya
Aura


An uninitialized value within
@ossiDump error appears in several


log files.


Ignore the error: no impact on product functionality.


652077 SolutionPack
for Cisco VoIP


The Time interval option did not
display or was not collected during
the SolutionPack install.


There is no option to increase the time-out in the EMC M&R
Console. To increase the SNMP timeout value, edit the snmp-
polling-distribution.xml file under C:\Program
Files\APG\Collecting\SNMP-Collector\cisco-
voip-cucm\conf and restart the collector-manager
cisco-voip-cucm service.
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Issue
number


Component Problem description Workaround/Resolution


652091 SolutionPack
for Cisco VoIP


Additions to the SolutionPack
installation instructions.


Verify that the user apg has the right permission to access


the folder. Also, do not create the CDR repository in the root
directory.


654738 SolutionPack
for Cisco VoIP


After completing a SolutionPack for
Cisco VoIP upgrade, the EMC M&R
platform logs indicate that the
upgrade was a success but when you
log in to the M&R console and


navigate to Administration, you are
asked to re-enter Cisco Unified
Communications Manager (CUCM)
information.


You must enter this information for this SolutionPack to
connect to CUCM. After this connection is made, data is
populated in to the reports of the SolutionPack.


616721 SolutionPack
for EMC
Network
Configuration
Manager


The device servers do not appear. When the device server is a Windows host, only remote shell
collection is done. You must complete certain prerequisites
on the remote Windows host for the Remote Shell Collector to
work, as described in the APG Remote Collector Administration
Guide in /opt/APG/Doc of your EMC M&R instance.


The Remote Shell Collector uses the Windows Remote
Management Shell WinRM to poll the remote Windows hosts.
Make sure the Remote Management Shell WinRM is installed
on the EMC M&R server and all Windows hosts being polled
by the Remote Shell Collector.


654752 SolutionPack
for EMC
Network
Configuration
Manager


Additions to the EMC M&R platform
upgrade procedure in the EMC M&R
(Watch4net) Installation and
Configuration Guide


1. Complete all the upgrade tasks before the Updating
SolutionPackBlocks task in the EMC M&R Platform Update
chapter.


2. Navigate to Administration > Centralized
Management > Logical Overview > Collecting >


Collector Manager:emc-ncm collector.


3. Click Stop.


4. Log in to the M&R server.


5. For Linux, navigate to /opt/APG/Collecting/
FailOver-Filter/emc-ncm/tmp-backend/


6. For Windows, navigate to Program Files\APG
\Collecting\FailOver-Filter\emc-ncm\tmp-
backend


7. Delete all files from this Linux or Windows location.


8. Continue with the upgrade tasks by updating the
SolutionPackBlocks for this SolutionPack.


SASP-590 SolutionPack
for EMC
Network
Configuration
Manager


The Device List table report in EMC
Network Configuration Manager >


Network Reports > Network
Reports per NCM instance > <NCM
IP> > Reports per Network >


<Network Name> > Inventory and


You can hide this column in Edit mode.
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Issue
number


Component Problem description Workaround/Resolution


Asset always displays zero in the Last
h/w Revision column.


SASP-597 SolutionPack
for EMC
Network
Configuration
Manager


Additional steps are required for the
Certificate Monitoring reports to work
on the 9.4 NCM server. You must add
the certificate from the voyence-
ssl.keystore file in the NCM


server to the keystore file in the EMC
M&R server. If not, the logs show a
certificate and communication error
and the Certificate Monitoring reports
are empty.


On the NCM server, do the following:


1. Navigate to /etc/voyence.conf
2. Run $JAVA_HOME/bin/keytool -export -


keystore $VOYENCE_HOME/conf/voyence-
ssl.keystore -alias selfsigned -file
<filename1>


3. When prompted for a password, click Enter.


4. Run $JAVA_HOME/bin/keytool -export -
keystore $VOYENCE_HOME/conf/voyence-
ssl.keystore -alias selfsigned-ip -file
<filename2>


5. When prompted for a password, click Enter.


On the EMC M&R server, do the following:


1. Run <EMC M&R_JAVA LOC>/bin/keytool -
import -keystore "<EMC M&R_JAVA
LOC>/lib/security/cacerts" -file
<filename1> -alias selfsigned1
Examples of <EMC M&R_JAVA LOC> are /opt/APG/
Java/Sun-JRE/8.0u25 (for Linux) and C:\Program
Files\APG\Java\Sun-JRE\8.0u25 (for Windows)


2. Type "changeit" for the password.


3. Run <EMC M&R_JAVA_LOC>>/bin/keytool -
import -keystore "<EMC M&R_JAVA
LOC>>/lib/security/cacerts" -file
<filename2> -alias selfsigned2


4. Restart all EMC M&R services.


SASP-599 SolutionPack
for EMC
Network
Configuration
Manager


When the SolutionPack for EMC
Network Configuration Manager is
connected to a standalone
application server and remote
database, the Deployment Topology
reports show the database IP address
under the Application Server Name
instead of the Application Server IP
Address.


N/A


SASP-560 SolutionPack
for EMC
Network
Configuration
Manager


In the Deployment Topology report,
the Application Server Name shows
the IP address instead of the host
name of the server.


N/A


652594 SolutionPack
for EMC
Smarts


Popping out the Notifications view in
Internet Explorer 9 or 10 with


Disable compatibility mode
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Issue
number


Component Problem description Workaround/Resolution


compatibility mode on can cause an
error to display.


654519 SolutionPack
for EMC
Smarts


In the Heatmap, some nodes are
represented by the grey color, but
legend does not list grey.
Available values are accessed as
green, red, or yellow. If a device is no
longer in the topology, it may appear
as grey before being removed from
the report. If a polling interval returns
an UNKNOWN available status, the


device may also show as grey.


N/A


654565 SolutionPack
for EMC
Smarts


When you double click on a


notification in the Details screen,
tabs appear that pertain to each
Source domain that received the
notification. Each tab shows the tree
view of the affected objects topology
in that domain.
When you select tabs for certain
notifications, the following exception
is thrown:


JavaScriptException:
TypeError: Cannot read
property "Relation" from
undefined (#202) in at line
number 202.


An example of this is when you have a
Cable instance notification from the
ESM and IP servers. By double
clicking on this Cable instance
notification, the <ESM Server Name>
and <IP Server Name> tabs appear.
When you select the <ESM Server
Name> tab, the above exception is
thrown.


N/A


654725 SolutionPack
for EMC
Smarts


The server tools do not show their on-
going progress in a popup in the user
interface.


This is working as designed. Server tools run in the
background and will only inform you when they are finished.


654769 SolutionPack
for EMC
Smarts


There is approximately 5% increase in
the CPU with the addition of the
Console-
Mashups::mashupengine and
Console-Views::dojoviews
web applications that are deployed in
Tomcat where the core EMC M&R is
installed.
These web applications do not
increase the Heap memory.


N/A
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Issue
number


Component Problem description Workaround/Resolution


654791 SolutionPack
for EMC
Smarts


The Browse Details Property panel
throws an error when you click on a
child node with the percentage (%)
character in its name.


1. Access the URL http://<M&R_host>:58080/
mashupengine


2. From Manage Service on the left, click Open Mashup.


3. In the Open Mashup Dialog, type common_utils for


the Mashup-name.


4. In the function decodeNameFromEDAAString (line
number 354), delete the prefix decodeURIComponent.


5. Save the mashup.


654841 SolutionPack
for EMC
Smarts


SolutionPack for EMC Smarts views do
not render properly in IE 9:


l Topology maps launched from


any notification on the Object
Details window throw an error.


l Clicking on any child node in


Explore > Network > Any Class >


Browse Details throws an error.


l When you select the wrench
icon and then pop-out from


Operations > Notifications, a
new window launches without
any notifications.


N/A


EMP-3127 SolutionPack
for EMC
Smarts


This issue pertains to a device with
multiple map types, specifically the
Application Relationship Map type.
The first time you select a map type
for this device from the drop-down
menu, the Application Relationship
map appears instead of the selected
map.


Select the same map type again and the map appears for the
specified map type.


SASP-533 SolutionPack
for EMC
Smarts


There are duplicate devices in


Dashboard > Network > Service
Summary.


N/A


SASP-536 SolutionPack
for EMC
Smarts


The hypervisor availability needs
refinement. It shows thousands of
legends.


N/A


SASP-539 SolutionPack
for EMC
Smarts


The top level description is missing


from Network Summary > Details
by Device Type.


N/A


SASP-540 SolutionPack
for EMC
Smarts


Router and switch are the only device


types appearing in Network
Summary > Details by Device Type.


N/A


Service Assurance Suite SolutionPacks


20 EMC M&R 6.5u1  Release Notes for Service Assurance Suite







Issue
number


Component Problem description Workaround/Resolution


SASP-545 SolutionPack
for EMC
Smarts


The Availability graph chart is missing


from Network Summary > Details
by Device Type > Routers.


N/A


SASP-554 SolutionPack
for EMC
Smarts


Empty node is created under the


Currently Active Events per Device
Type Events report. This happens for
events not specific to a device. As a
result, Device and Device Type are
empty. Events are listed when you
further drill down in the tree.


N/A


SASP-561 SolutionPack
for Ericsson
eNodeB


On Windows hosts, you cannot
change the default directories that
store the raw and processed
performance management XML files.


You must accept the default directories during installation.


651306 ReportPack
for Ericsson
IMS IPWorks


The units of the disk-related metrics
(such as, dskTotal, dskAvail,
dskUsed) are expressed in kilobytes.


These metrics appear as kilobytes in
the reports of the ReportPack for
Ericsson IMS IPWorks.


N/A


651307 ReportPack
for Ericsson
IMS IPWorks


EMC M&R implements the formula for
multiple metrics as follows:
(spatial.Sum(A)+
(spatial.Sum(B))/T, where EMC


M&R randomly picks up any period of
metric A or metric B. The
implementation should be:
(spatial.Sum(A)/T) +
(spatial.Sum(B)/T), where EMC


M&R uses the T (period) of the
respective counter.


N/A


651314 ReportPack
for Ericsson
IMS MRS
MRFP


In the GigabitEthernet reports, which
computes data without ethernet
headers, the ET_HEADER value is 22
due to the unavailability of the site
data for verification. Based on the
availability of VLAN headers, the
ET_HEADER value is either 22 or 18.
The ET_HEADER value is one of the
following:


l l 22 if the VLAN headers are
present.


l l 18 if the VLAN headers are NOT
present.


N/A


SASP-562 SolutionPack
for Ericsson
RNC


On Windows hosts, you cannot
change the default directories that


You must accept the default directories during installation.
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Issue
number


Component Problem description Workaround/Resolution


store the raw and processed
performance management XML files.


SASP-104 SolutionPack
for Huawei
iManager
M2000


The Stream collector does not collect
the cellfreq property of the obj1


type.


N/A


SASP-233 SolutionPack
for Huawei
iManager
M2000


None of the metrics use
math.spatial sum in their


formulas.


N/A


SASP-325 SolutionPack
for Huawei
iManager
M2000


The default data directory that you
accept during installation is not
created in a distributed system. When
reconfiguring the SolutionPack on a
virtual machine, the default data
directory is removed when empty.


N/A


SASP-350 SolutionPack
for Huawei
iManager
M2000


If you specified a directory without the
correct access permissions in which
to move the processed performance
files, the Stream collector throws an
exception saying that the directory is
not found. It should state that the
directory does not have the right
access permissions to perform the
move post processing action.


Make sure the apg user has read/write permissions on the


directory or if using another user, make sure that user is in the
same UNIX permissions group as the apg user.


SASP-354 SolutionPack
for Huawei
iManager
M2000


The report computation can take a
considerable amount of time.


Since the front-end server performs the calculations, key
performance indicators take a long time to compute. For
reports with a high number of KPIs, pre-compute and pre-
aggregate to avoid this issue.


SASP-356 SolutionPack
for Huawei
iManager
M2000


When you reconfigure the
SolutionPack with the certificate
option on Windows EMC M&R
platforms, source data files are not
written to the specified path. The
Stream collector does not throw an
error.


The Stream collector did not restart correctly after
reconfiguration. Restart the Stream collector.


653062 SolutionPack
for Microsoft
SCOM


The following warning appears when
collection is taking too much time and
the collector skips a polling cycle:


WARNING -- [2014-08-16 
03:44:54 IST] -- m::c(): 
Error during the
SQL collect!
java.lang.NullPointerException
 
at 
com.watch4net.apg.v2.collector
.plugins.sqlcollector.i.a(Sour
ceFile:51)
at 


If this happens often, increase the polling period. This
increase will depend on the size and capabilities of your
SCOM SQL server.
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number


Component Problem description Workaround/Resolution


com.watch4net.apg.v2.collector
.plugins.sqlcollector.i.b(Sour
ceFile:152)
at 
com.watch4net.apg.v2.collector
.plugins.sqlcollector.e.f(Sour
ceFile:214)
at 
com.watch4net.apg.v2.collector
.plugins.sqlcollector.e.i(Sour
ceFile:291)
at 
com.watch4net.apg.v2.collector
.plugins.sqlcollector.e.comput
e(SourceFile:89)
at 
com.watch4net.async6.Evaluator
Task.computeWithMDC(EvaluatorT
ask.java:176)
at 
com.watch4net.async6.Evaluator
Task.run(EvaluatorTask.java:
158)
at 
java.util.concurrent.ThreadPoo
lExecutor
$Worker.runTask(ThreadPoolExec
utor.java:895) 
at 
java.util.concurrent.ThreadPoo
lExecutor
$Worker.run(ThreadPoolExecutor
.java:918) 
at 
java.lang.Thread.run(Thread.ja
va:662)


SND-1466 SolutionPack
for Optical
Wavelength
Services


Data collection may fail for a few CTPs
because the Coriant Intelligent
Network Manager is throwing an
exception when sending a CTP
request for a valid PTP.


N/A


SASP-87 SolutionPack
for
Transaction


The Property Tagging filter is not
returning the Unit % value for


DigestMatch.


N/A


EMP-2120 SolutionPack
for
Transaction


Some fields in the SolutionPack for
Transaction windows require
additional information in the pop-ups.


HTTP Transaction: Only use the Cookies field for a
sequence of defined HTTP transactions. In this field, type the
ID of the transaction that was ran earlier in the sequence. The


Transaction ID appears in the Main Parameters window of


the transaction in the Transaction Collector Configuration
Management interface.


SIP Transaction: The Pause Duration field is the time delay
between the remote address sending the first OK message
and the BYE message.


FTP Transaction: If the Upload a file Command Type is


used, then the Local File Name field is mandatory. Specify a
local file to upload. This supports a regular expression


(regexp). If Command Type is Retrieve File/Directory, then


the Remote Target field is mandatory. Specify the resource
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Issue
number


Component Problem description Workaround/Resolution


on the remote FTP server for command execution. Verify the


Remote Target has enough space for the file or directory


that is being retrieved. MD5 Hash is optional. The value can
be populated with the expected MD5 checksum value for the
specified file. For Upload, the hash is calculated before
uploading the file on the FTP server. For Retrieve File/Directory
over a single file, the checksum is calculated once the file
download completes. No hash validation is performed on
Retrieve File/Directory over a directory or during a Delete.
Similarly to the hash attribute, the match attribute allows you
to specify a regex to match against the content of a specified
file.


SFTP Transaction: You can perform authentication by
setting a password in the configuration file or specifying a


private-key attribute to indicate the path to the file
containing the private key used to connect to the server.
When using the private-key attribute, you can specify a
passphrase to decrypt ProcType: 4, ENCRYPTED,DES-CBC,
DES-EDE3-CBC, AES-128-CBC, AES-192-CBC, and AES-256-
CBC.


For more information about these transactions, see the APG
Transaction Collector Administration Guide in the /APG/Doc
folder of your installation path.


EMP-2121 SolutionPack
for
Transaction


Data collection is not running or does
not start and the latest reports are not
available.


The file system where the EMC M&R platform is installed may
be out of space. To check the file system utilization, do the
following:
Linux:


1. Run the #df -k command.


2. Check the available file system space for /opt/APG.


Windows:


l Check the available file system space by going to Start >


Computer.


Note


Always identify the SolutionPacks whose directories consume
the most space and refer to their respective SolutionPack
documentation to see if you can remove any logs or
temporary data. Alternatively, you can increase the size of the
file system in which a SolutionPack is writing data.
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CHAPTER 1


System Requirements for EMC M&R


This chapter includes the following topics:


l Revision history.....................................................................................................12
l Operating system requirements.............................................................................12
l Database requirements for EMC M&R.................................................................... 12
l Browser requirements........................................................................................... 13
l Supported mobile devices.....................................................................................13
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Revision history
Use this table to review the revisions made to this document.


Revision Date Description


01 January 2015 GA release of EMC M&R 6.5u1


Operating system requirements
The following operating systems are supported for production.


Table 1 Supported operating systems


Operating system Version


Red Hat Enterprise Linux l 5, 64-bit


l 6, 64-bit


CentOS Linux l 5, 64-bit


l 6, 64-bit


SUSE Linux Enterprise Server (SLES) 11, 64-bit


Microsoft Windows l Server 2008 R2


l Server 2012


l Server 2012 R2


Note


vApp installations require VMware. Hyper-V, or any other virtual environment, is not
supported for vApp installations.


Database requirements for EMC M&R
EMC M&R supports these relational database management systems.


Table 2 Supported relational database management systems


Relational database
management systems


Version Notes


MySQL 5.5 EMC M&R ships with MySQL 5.5. Existing customers
may continue to use MySQL 5.0 in their EMC M&R
installations.


Oracle Database Enterprise
Edition


10G or
later


Ensure that the EMC M&R server and its operating
system satisfy the database engine requirements.
Consult the Oracle website for more information.
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Table 2 Supported relational database management systems (continued)


Relational database
management systems


Version Notes


For a distributed EMC M&R scenario, the server with
the EMC M&R back-end components must satisfy
the database engine requirements.


Datastore N/A Datastore is an internal database.


Browser requirements
For the following browsers, support varies.


Table 3 Supported browsers


Browser Version Operating system Notes


Google Chrome Latest Windows, Linux Full support


Internet Explorer 8 Windows Minimal Browse
mode


Internet Explorer 9, 10, 11 Windows Full support


Mozilla Firefox Latest Windows, Linux Full support


Apple Safari Latest Mac OS X and iOS Full support


Minimal Browse mode is for report viewing and browsing. It can display tables, including
interactive tables, and graphs that are not interactive. Topology maps are not supported.


Full support includes report viewing and browsing, plus support for interactive tables and
graphs, topology maps, and administration tasks (user management, enrichment GUI,
alerting GUI, and so on).


Supported mobile devices
To manage the application and view reports, you can use any of the supported mobile
devices.


Table 4 Supported mobile devices


Device Version Operating system Notes


Apple iPhone Latest Mac iOS Using EMC M&R iPhone client
from AppStore


Apple iPad Latest Mac iOS Using EMC M&R iPad client
from AppStore
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CHAPTER 2


Installation


This chapter includes the following topics:


l Explanation of name changes................................................................................16
l Options for standard installation...........................................................................16
l Installing EMC M&R platform on UNIX....................................................................17
l Installing EMC M&R platform on Windows Server...................................................18
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Explanation of name changes
The procedures in this guide are applicable when installing or upgrading EMC products
based on EMC M&R version 6.5u1 software artifacts.


EMC M&R may be used instead of EMC Watch4net in EMC product suites that use version
6.5u1 as their underlying monitoring and reporting platform. The procedures in this guide
are applicable for installations and upgrades of version 6.5u1 software or higher. Install
setup file names may vary depending upon which products are licensed. For example,


l Watch4net download filenames may have this syntax: setup-linux-x86_65u1-
v64.sh or setup-win65u1-v64.exe


l Product suite download filenames may have this syntax:
EMC_MnR_6.5.1_Linux_64-bit_Setup_File.sh or
EMC_MnR_6.5.1_Linux_64-bit_Setup_File.exe.


Options for standard installation
You have several options when you perform a binary installation of the EMC M&R
platform.


The EMC M&R platform infrastructure consists of three types of hosts:


l Frontend host


l Backend host (Primary and Additional)


l Collector host


Note


You can have only one Primary Backend host. You can add Additional Backend hosts to
scale out a deployment.


The EMC M&R platform binary installation package supports the following installation
options.


Default (UNIX) or Recommended Modules (Windows) installation
To install all of the modules in the EMC M&R platform binary installation package, use
this option.


You can use this option on a single host and enable it to serve as a Frontend, Backend,
and Collector host. You can customize this host further by manually adding or removing
specific modules.


Host-specific installations
To install software only on a specific host (Frontend, Backend or Collector host), use the
same EMC M&R platform binary installation package and select the type of host to install.


Minimal (UNIX) or Base Installation (Windows)
To install the minimum modules required for any host type, use this option. You can
customize this host by manually adding specific modules.


Installation
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Installing EMC M&R platform on UNIX
You can install the EMC M&R platform on supported UNIX hosts. This procedure
specifically uses the Linux installation procedure as an example.


Before you begin


l When you install EMC M&R platform on a UNIX server, assign executable permissions
to the installation script.


l Ensure that you have a login with root privileges to run the installer.


l Download the installation package to a directory on the server, such as /temp.


Procedure


1. Locate the installation package.


2. Navigate to where the EMC M&R platform is located.


3. Change the permissions of the installer.


For example, for the Linux 64-bit executable, type:


chmod +x EMC_MnR_6.5.1_Linux_64-bit_Setup_File.sh
4. Run the installer from the directory.


Example:


./EMC_MnR_6.5.1_Linux_64-bit_Setup_File.sh
5. Read and accept the End User License Agreement.


6. Accept the default installation directory of /opt/APG or type another location.


7. Accept the default user account name of apg or type another name.


8. Accept the default location of service scripts of /etc/init.d or type another
location.


9. Accept the default base directory of/etc for runlevel scripts or type another base
directory.


10.Depending on the host purpose, select one of the following options:


Option Description


Default Installs recommended modules available in the binary installation
package. You can use this option on a single host, which enables it to
serve as a Frontend, Backend and Collector host. To customize this host
further, manually add or remove specific modules.


Frontend Installs web services and front end applications.


Backend Installs the database and backend services.


Collector Installs base modules to perform data collection and enrichment.


Minimal Installs the minimal modules required for any host type. To customize this
host further, manually add specific modules.
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Installing EMC M&R platform on Windows Server
You can install the EMC M&R platform on supported Windows Server hosts.


Before you begin


l Ensure that you have a login with system administrator privileges to run the installer.


l Download the installation package to a folder on the server, such as \temp.


Procedure


1. Locate the installation package.


2. Double-click the setup file, for example: EMC_MnR_6.5.1_Windows_64-
bit_Setup_File.exe


3. Click Next on the Welcome screen.


4. Read and accept the End User License Agreement. Click I Agree.


5. Select the Destination Folder:


a. Change the drive to a Windows non-root drive.


b. Maintain the default folder structure (Program Files\APG).


c. Click Next.


6. Depending on the host purpose, select one of the following options:


Option Description


Recommended
Modules


Installs all recommended modules available in the binary
installation package. You can use this option on a single
host, which enables it to serve as a Frontend, Backend and
Collector host. To customize this host further, manually add
or remove specific modules.


Frontend Modules Installs web services and front end applications.


Backend Modules Installs the database and backend services.


Collector Modules Installs base modules to perform data collection and
enrichment.


Base Installation Installs the minimal modules required for any host type. To
customize this host further, manually add specific modules.


7. Click Install.


8. When the installation is complete, click Next.


9. To close the installer, click Finish.


Installation
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CHAPTER 3


Configuration


This chapter includes the following topics:


l Starting the EMC M&R platform services from the command line........................... 20
l Starting the EMC M&R platform services on Windows............................................ 20
l Verifying if the EMC M&R platform services are running......................................... 21
l Configuring the user process limits for the Linux installation................................. 23
l Logging in to the User Interface............................................................................. 23
l Connecting to Centralized Management................................................................ 24
l Confirm configuration settings and register remote servers................................... 24
l Licensing Operations.............................................................................................25
l Log in with administrator credentials.....................................................................26
l View license information....................................................................................... 26
l Upload a new license file.......................................................................................26
l Delete licenses......................................................................................................27
l Synchronize licenses on multiple hosts.................................................................27
l Troubleshooting licensing problems......................................................................28
l Permanent license stops working after host reconfiguration.................................. 28
l Users are locked out .............................................................................................28
l Module does not start or has no license ............................................................... 30
l Where to find the latest SolutionPack software......................................................31
l Installing a SolutionPack.......................................................................................31
l Reviewing reports..................................................................................................32
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Starting the EMC M&R platform services from the command line
After you install EMC M&R platform, start required services.


Before you begin


l Before you start EMC M&R platform services, ensure the library search path is correct
on the server that hosts EMC M&R platform. This requirement applies to the libaio
package on Linux.


l Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the EMC M&R platform application uses instead of root.


Procedure


l Type the command for your operating system from the bin directory of the
installation:


Operating system Command


UNIX ./manage-modules.sh service start all


Windows manage-modules.cmd service start all


Results


The platform displays a list of services.


Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Example:


* Starting 'topology-mapping-service Default'... [ OK ]
* Starting 'webservice-gateway Default'... [ OK ]
* Starting 'mysql Default'... [ OK ]
* Starting 'alerting-backend Default'... [ OK ]
* Starting 'backend Default'... [ OK ]
* Starting 'collector-manager Default'... [ OK ]
* Starting 'collector-manager Generic-SNMP'... [ OK ]
* Starting 'collector-manager Load-Balancer'... [ OK ]
* Starting 'collector-manager emc smarts'... [ OK ]
* Starting 'event-processing-manager emc smarts'... [ OK ]
* Starting 'tomcat Default'... [ OK ]
* Starting 'task-scheduler Default'... [ OK ]


Starting the EMC M&R platform services on Windows
After installing EMC M&R platform on Windows, you can start all required services from a
Windows desktop.


Before you begin


Make sure you have logged in with system administrator credentials to manage services.
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Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Procedure


1. From the application server's desktop, select Start > Administrative Tools > Services.


2. Right-click each service and click Start, in this order:


l APG Topology Mapping Service


l APG Topology Service


l APG Webservice Gateway


l APG MySQL


l APG Alerting Backend


l APG Backend


l APG Collector Manager (Generic RSC)


l APG Collector Manager (Generic-SNMP)


l APG Collector Manager (Load-Balancer)


l APG Event Processing Manager (Alert-Consolidation)


l APG Tomcat


l APG Task Scheduler


Verifying if the EMC M&R platform services are running
Verify the EMC M&R platform services are running on each host by obtaining the status.


Before you begin


Ensure that you have a login with root, APG, or system administrator privileges. The user
apg is the account that the EMC M&R platform application uses instead of root.
Procedure


1. Type the command for your operating system from the bin directory of the EMC M&R
platform installation:


Operating system Command


UNIX ./manage-modules.sh service status all
Windows manage-modules.cmd service status all


2. Verify that each service has a status of running in the output.


Results


Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Example:


* Checking 'topology-mapping-service Default'... [ running ]
* Checking 'webservice-gateway Default'... [ running ]
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* Checking 'mysql Default'... [ running ]
* Checking 'alerting-backend Default'... [ running ]
* Checking 'backend Default'... [ running ]
* Checking 'collector-manager Default'... [ running ]
* Checking 'collector-manager Generic-SNMP'... [ running ]
* Checking 'collector-manager Load-Balancer'... [ running ]
* Checking 'collector-manager emc smarts'... [ running ]
* Checking 'event-processing-manager emc smarts'... [ running ]
* Checking 'tomcat Default'... [ running ]
* Checking 'task-scheduler Default'... [ running ]


Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.


Before you begin


Ensure that you have logged in with root or APG privileges to check the log files.


Procedure


l Look for log files in these /opt/APG/ directory paths.


The list of available log files will vary depending upon choices made during
installation. (Collector, Backend, Frontend, Default, or Minimal installations will
generate different sets of log files.)


Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log


Troubleshooting service start-up problems on Windows
Check the log files when services do not start.


Before you begin


Ensure that you have logged in with system administrator credentials to check the log
files.


Procedure


l Look for log files in these C:\Program Files\APG directory paths.


The list of available log files will vary depending upon choices made during
installation. (Collector, Backend, Frontend, Default, or Minimal installations will
generate different sets of log files.)


Databases\MySQL\Default\data\[SERVER NAME].err.
Backends\Alerting-Backend\Default\logs\alerting-0-0.log
Backends\APG-Backend\Default\logs\cache-0-0.log
Collecting\Collector-Manager\Default\logs\collecting-0-0.log
Web-Servers\Tomcat\Default\logs\service.log
Tools\Task-Scheduler\Default\logs\scheduler-0-0.log
Tools\Webservice-Gateway\Default\logs\gateway-0-0.log
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Configuring the user process limits for the Linux installation
Increase the user process limits for the user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.


Before you begin


l Make sure you have a login with root privileges.


l The EMC M&R platform installed on a server running Red Hat Enterprise Linux 6,
CentOS Linux 6, or SUSE Linux Enterprise Server (SLES) 11.


l The name specified for the user account during the installation.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. Type the following commands from the bin directory of the installation to restart the
services:


./manage-modules.sh service stop all


./manage-modules.sh service start all
5. Type the following command to verify the changes:


su apg -c 'ulimit -n -u'


Logging in to the User Interface
Log in to view reports or test user access.


Procedure


1. Open a browser, and then type the URL.


Example: http://<Frontend-hostname>:58080/APG
2. Log in.


a. Type the login credentials.


The default username is admin. The default password is changeme.


b. Click Sign In.


After you finish


You are automatically logged off after four hours.
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Connecting to Centralized Management
Connect to the server so that you can access Centralized Management to install and
administer SolutionPacks.


Centralized Management is one of the multiple web applications available in EMC M&R
platform.


Procedure


1. Open a browser.


2. Type http://<serverIP:port>/centralized-management.


The serverIP is the fully qualified hostname or IP address of the server where EMC M&R
platform runs.


The port is the port number of the server.


Example:


http://myHost.emc.com:58080/centralized-management
3. Log in.


a. Default username is admin.


b. Default password is changeme.


c. Click Sign In.


After you finish


You are automatically logged off after four hours.


Confirm configuration settings and register remote servers
Confirm configuration settings for the Frontend server after you first log in. In a multi-host
environment, you must also register remote servers with the Frontend server and confirm
those configuration settings too.


Before you begin


After you first log in with administrator credentials for core software, you must confirm the
configuration settings for the Frontend server. If you install additional servers after
installing the Frontend server (for example, collectors, backend server, and so forth), you
must register each of them on the Frontend server.


Procedure


1. In the Servers Configuration window, click Save to accept the predefined values for
the Frontend server. Fields that are blank must remain blank.


2. To register additional servers, log into Centralized Management and click
Configuration > Register a Server.


3. Complete the fields and click Save.


For detailed information about the entries, click Documentation and view the
Centralized Management Guide or check the online help available from the User
Interface.
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Licensing Operations
Use Centralized Management user interface to perform licensing management
operations.


These operations include uploading, verifying, deleting, and synchronizing licenses.


Trial licenses
Your software can include all trial licenses or a combination of permanent and trial
licenses.


Licenses that you purchase are permanent. Other software comes with trial licenses.


Trial licenses let you test features in the UI and perform some initial configurations before
full purchase. Trial licenses typically last for 30 days after the installation time. You
cannot copy or regenerate a trial license in the product.


If all of your licenses are trial licenses, including the core software license that includes
the Web Portal feature, the software can lock out all users from accessing the UI when the
trial expires.


License duration
Permanent licenses do not expire. Trial licenses have expiration dates, typically 30 days
after the installation date.


When trial licenses expire, module license checks fail and the modules stop working. If
the Web Portal module fails, you cannot access the product.


Because the License Management UI operates behind the Web Portal module, you must
upload your permanent license file or extended trials before the 30-day license for the
core features expires. Otherwise, the UI locks and you cannot upload the license file.


License purchase
To convert a feature from a trial license into a permanently licensed feature, you need to
purchase a license.


To initiate the purchase of a license for a SolutionPack, visit EMC Online Support using
the following URL:


https://support.emc.com/servicecenter/createSR/


On the page that appears, submit a service request to EMC. Include the SolutionPack
name that you want to purchase.


When all purchasing transactions are complete, EMC sends you instructions for
downloading a regenerated license file for your site that includes the newly purchased
software license. Download the file to a local server, and then follow instructions in 
Upload a new license file on page 26 to upload the new license file.


Note


Until the license is purchased and the new license file is obtained and uploaded, the
SolutionPack is inoperable, unless the 30-day trial license is still in effect.
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Log in with administrator credentials
You must have administrator credentials to perform license management operations.


Procedure


1. Access EMC M&R platform software by typing the following URL in a web browser:


http://frontend-hostname:58080/centralized-management


where frontend-hostname is the server where the frontend module is installed.


The login page opens.


2. Log in with a user account that has administrator credentials.


The Centralized Management UI opens to the Physical Overview page.


3. In the navigation tree in the left pane, click Licenses Management.


The Licenses Listing page opens. Notice the Upload and Synchronize operational
commands at the top of the page.


View license information
You can view license information in two ways. One method displays licenses by host. The
other one shows a centralized view of all licenses.


Procedure


1. Log in with administrator credentials.


2. To view active licenses on a physical host, navigate to Administration > Centralized
Management > Physical Overview > host-name.


3. Click the Licenses tab.


The Licenses tab displays active licenses on that host. It also indicates whether
licenses are permanent or trial, the expiration date for trials, and additional license
properties, if applicable.


4. To view a consolidated list of licenses for all hosts, and to perform license
management operations, in the navigation tree in the left pane, click Licenses
Management.


The Licenses Listing page opens showing all licenses on all servers.
Notice the ELMS permanent license, showing all features included in the license and
the license serial number. Also notice the Upload and Synchronize commands at the
top of the page.


This table displays Information for ELMS licenses related to product name for the
license, SWID (software ID), and serial numbers.


Upload a new license file
To add a new license to your system, such as a newly purchased SolutionPack license,
upload a new license file.


Before you begin


1. Purchase the required licenses.


Configuration


26 EMC M&R 6.5u1  Installation and Configuration Guide







2. Download the new license file to a local server, as directed by EMC during the
purchase process.


When you upload a license file, the new file affects all servers capable of using the
licenses.


Procedure


1. Log in to the Centralized Management UI in ViPR SRM using the following URL:


http://frontend-hostname:58080/centralized-management
2. In the navigation pane, select Licenses Management.


3. Click Upload at the top of the page.


The License Upload dialog appears.


4. Click Browse and locate the new license file that you downloaded.


5. Click OK.


The system extracts the licenses and displays them in the table on the Licenses
Listing pane.


6. When the License Upload Complete dialog appears, click OK, and then click Continue.


The new license automatically affects all servers capable of using the license.


7. Delete the trial licenses that correspond to newly licensed features, if any.


To delete a trial license, see Delete licenses on page 27.


Delete licenses
You can select and delete specific licenses or delete all licenses. A delete action affects
all servers that use the license.


After you install a permanent license, delete the trial licenses that are covered by the
permanent license.


Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management
2. In the navigation pane, select Licenses Management.


3. In the Licenses Listing table, select one or more license check boxes.


4. Click Delete.


The Delete command appears below the table. It is dimmed until you select at least
one license.


The system deletes the selected license from all available servers.


Synchronize licenses on multiple hosts
The Synchronize action ensures that all remote hosts have licenses based on those
available on the Centralized Management host.


Certain situations might cause licenses to become out of sync. For example, if a remote
host is unavailable when you perform an upload or a delete operation, those operations
would not be propagated to the offline server. Another example is if you add a new server
to your configuration, the new server would need licensing information.
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Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management
2. In the navigation pane, select Licenses Management.


3. Click Synchronize at the top of the page.


The system synchronizes the licenses on all remote hosts.


Troubleshooting licensing problems
You can resolve common licensing problems.


Permanent license stops working after host reconfiguration
If you change the configuration of a host, for example, by adding interfaces, removing
interfaces, or changing the operating system, your permanent license might stop working.
If your license does not work, obtain a new host ID and request a new permanent license.


Before you begin


Ensure that you have a login with root, APG, or system administrator privileges to perform
this task. The user apg is the account that the application uses instead of root.


Procedure


1. Log in to the operating system command line on the host server.


2. To obtain the new host ID, run one of the following operating system commands:


Operating system Command


UNIX /opt/APG/bin/manage-licenses.sh host-id


Windows C:\Program Files\APG\bin\manage-licenses.cmd host-
id


The command output is the new host ID.


3. Copy the host ID information to the clipboard or to a text file.


4. To obtain the new license, go to the EMC support site using the following URL:


https://support.emc.com/servicecenter/createSR/


The Create a Service Request page opens.


5. Submit a service request to EMC, asking for a new permanent license file for a new
host. Paste the new host ID into the request.


6. When EMC sends you the new license file, follow the procedure in Upload a new
license file on page 26.


Users are locked out
If the license for the core software features expires, the system locks users out of the UI.


To recover from this scenario:
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1. Obtain a license file with permanent licenses.


2. Install the new license file from the command line. Install license file from the
command line on page 29


3. Restart the Tomcat service. See Restart Tomcat service on page 29.


4. Log in and perform the following tasks:


a. Reinstall the new license file from the Centralized Management UI.


b. Delete the expired trial licenses.


See Reinstall license file and delete trial licenses after lockout on page 30.


Install license file from the command line
You can install a license file from the command line if you are locked out of the UI. Always
use the UI unless you are locked out.


Before you begin


l Ensure that you have an OS account with root, APG, or system administrator
privileges. The application uses the apg account, rather than root.


l Acquire a new license file from EMC and download it to a local server. To request a
new license file, create a Service Request on EMC Online Support.


Procedure


1. Log in to the server where the core software is installed.


2. Copy the new, valid license file to this same server. The file is a .zip file.


3. At the OS command line, navigate to the bin directory.


4. Install the license file using one of the following commands appropriate to your OS:


Operating
System


Command


UNIX ./manage-licenses.sh install download_path/license.zip


Windows manage-licenses.cmd install download_path\license.zip


Note


The command installs the license file on this server only.


Restart Tomcat service
If the Web Portal license expires, you might need to restart the Tomcat service.


Before you begin


1. Install the new license file using operating system commands.


2. Ensure that the library search path is correct on the server that is the host for the core
software. This requirement applies to the libstdc package on a Solaris server and
the libaio package on a LINUX server.


It is only necessary to restart the Tomcat service when the license for a web application,
such as the Web Portal, expires.
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Procedure


1. Log in to the server where the ViPR SRM core software is installed.


2. At the OS command line, navigate to the bin directory.


3. Run one of the following commands appropriate to the OS:


Operating System Command


UNIX ./manage-modules.sh service restart tomcat


Windows manage-modules.cmd service restart tomcat


The command output starts like this:


* Starting 'tomcat Default'... [ OK ]


Reinstall license file and delete trial licenses after lockout
After you install a permanent license file on the command line, you need to reinstall that
file using the Centralized Management UI to make the license visible in the UI and
available for distribution to other remote servers. You also need to delete the expired trial
licenses.


Procedure


1. Open a browser and log in to Centralized Management using the following URL:


http://frontend-hostname:58080/centralized-management
2. In the navigation pane, select Licenses Management.


3. Click Upload at the top of the page.


The License Upload dialog appears.


4. Click Browse and locate the new license file.


5. Click OK.


The system extracts the licenses and displays them in the table on the Licenses
Listing pane.


6. When the License Upload Complete dialog appears, click OK, and then click Continue.


The new license automatically affects all servers capable of using the license.


7. In the License Listing table, select all expired trial licenses by clicking the appropriate
check boxes.


8. Click Delete.


The Delete command appears at the bottom of the page, below the table of licenses.


The delete action automatically affects all available servers.


Module does not start or has no license
If a component reports that it has no license or does not start, verify the licenses on the
physical host.


Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management
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2. Navigate to Physical hosts > host-name > Licenses.


The page shows all licenses active on this local host.


3. Inspect the Expiration column for the termination date of each license.


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC support website http://support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation.


l Look for additional SolutionPack-specific installation instructions on the EMC
Community Network (ECN) or the EMC Support website. For example, more detailed
information may be found in Service Assurance Suite SolutionPack Articles available
from the EMC support website or from the EMC Community Network. Many
SolutionPacks have read me files embedded in the software. You can find these after
you install the SolutionPack by navigating to Centralized Management >
SolutionPacks. Expand the tree and click on the SolutionPack to open the Properties
page where the document is listed.


Procedure


1. Log in and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SOLUTIONPACK CENTER.


4. Select the SolutionPack in the Browse and Install SolutionPacks screen.


5. Read the summary information and click Install.


6. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.
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7. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


8. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


After you finish


After the installation is complete, select Centralized Management > SolutionPack to verify
the installed SolutionPack.


Reviewing reports
After you install a new release or migrate to a new release, check the reports to ensure
that the data appears properly.


Before you begin


If the collector configuration changed, you can manually run the scheduled tasks in
Administration > Centralized-Management > Scheduled Tasks > Database to speed up the
report generation process. Wait at least two polling cycles before manually running the
scheduled tasks.


To view your report:


Procedure


1. Navigate to User Interface > SolutionPacks or User Interface > ReportPacks depending
upon which features you have installed.


2. Click the SolutionPack or ReportPack you want to view.


Results


It may take several polling cycles to display all relevant information.
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CHAPTER 4


EMC M&R Platform Update


This chapter includes the following topics:
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l Update all SolutionPacks and other components.................................................. 42
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l Update individual SolutionPacks or other components..........................................45


EMC M&R Platform Update     33







Planning the upgrade
The procedures needed to upgrade to EMC M&R platform version 6.5.x vary depending
upon the version you have installed.


In earlier versions of Watch4net documentation, the term, "migration" described how to
move from one "point" release to the next. (For example, from 6.2 to 6.3.) The terms,
"upgrade" or "update," described how to move from one software update bundle to the
next. (For example, 6.3u1 to 6.3u2.)


In these procedures, a single term, "upgrade," describes all migration or update
activities.


If you have: Task:


Watch4net version 6.1.x 1. Migrate to version 6.2.x as described in the EMC
Watch4net Migration Guide available from EMC Online
Support.


2. Migrate from version 6.2.x to version 6.3.x as described
in the The EMC Watch4net Version 6.3 Installation and
Configuration Guide.


3. EMC M&R upgrade workflow on page 35


Watch4net version 6.2.x 1. Migrate to version 6.3.x as described in the EMC M&R
(Watch4net) Installation and Configuration Guide.


2. EMC M&R upgrade workflow on page 35


EMC M&R (Watch4net)
version 6.3.x


1. EMC M&R upgrade workflow on page 35


EMC M&R 6.4.x and
higher versions


1. EMC M&R upgrade workflow on page 35


Preparing the environment for the upgrade
Verify and document the current status of the environment before starting the upgrade
process. This will help you assess the success of the upgrade.


Engage EMC Support to resolve any observed issues prior to proceeding with the
upgrade. This will aid in understanding the success of the upgrade.


l Use your current backup software to perform backups of the EMC M&R environment
before starting the upgrade .


l Look for blank reports and graphs. Determine if blank reports are cause by collection
errors. Resolve any issues or document them for later follow up.


l Look for broken links. Resolve any issues or document them for later follow up


l Validate that End-to-End topology is working. Resolve any issues.


l Rename your old Default ReportPack if you are using a legacy default reportpack. A
newer version of the Default ReportPack template may be installed during the
upgrade, and you will need to delete the old one after checking your reports. Rename
the existing Default ReportPack to make it easier to distinguish between the old and
new versions. To rename it, click Administration > ReportPacks and edit the name of
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the default ReportPack (for example, Default ReportPack (olderversion)).
Click Save.


l Use the ViPR SRM Deployment Planner to determine sizing based on the set of
Service Assurance Suite SolutionPacks you want to install.


n 1. Download the ViPR SRM Deployment Planner from support.emc.com/
downloads/34247_ViPR-SRM


2. For additional details about determining configuration size, refer to EMC
Service Assurance Suite SolutionPack Performance and Scalability Guidelines
available on the EMC Support online website.


l Review the existing backend and databases. Check Report Library > EMC M&R
(Watch4net) Health > Module Performance > Databases


n Check backend thresholds to verify that you have room to accommodate new
sizing


n Add additional backends and databases as required (The metric count should not
exceed 1 million.)


n Refer to the Watch4net Database Split v1.2 document for help if you need to
manually move data to redistribute the metrics.


EMC M&R upgrade workflow
You can upgrade the EMC M&R platform in a Linux, Windows, or mixed operating system
environment. Ensure you back up all servers before starting the upgrade process.


Ensure new software is downloaded to all EMC M&R servers
If you have enabled Online Update for your system, the automatic update process has
already downloaded and distributed new EMC M&R modules to each server. You do still
have to run the launch-update script to upgrade the modules. Automated Online Update
of EMC M&R Software on page 61 provides information about configuring your
deployment to use the online update feature.


Upgrade workflow


1. Update module-manager on each server. Updating module-manager for Linux
operating systems on page 37 or Updating module-manager for Windows  on page
38


2. Update core modules by running the update script on each server. Preparing for an
update in a Linux environment  on page 36 or Preparing for an update in a Windows
environment  on page 38


3. Update all components on page 40


4. Verifying if the EMC M&R platform services are running on page 21


5. Removing an obsolete Default ReportPack on page 41


Mixed operating system deployments
To update a mixed-operating system deployment (non-vApp Linux and Windows), you
must perform the steps for single operating system deployments separately, once on
each platform.


One server must be the server that is hosting Centralized Management. For example, a
Linux deployment with one Windows collector would required updating the Linux
machine hosting Centralized Management and updating the Windows machine where the
collector is running.
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Preparing for an update in a Linux environment
Before you can update the EMC M&R platform in your Linux environment, you must
complete certain tasks and run the setup script.


Before you begin


l Identify the servers that you plan to upgrade and back up all necessary files.


l Ensure that a login with root credentials is available.


l If you have not enabled Online Update, download the Linux install binary files from
your product page on the EMC support website. (For example, for Service Assurance
Suite downloads, EMC_MnR_6.5.1_Linux_64-bit_Setup_File.sh. For
Watch4net downloads, setup-linux-x86_65u1-v64.sh.) http://
support.emc.com.


Note


If you have enabled Online Update for your system, the automatic update process has
already downloaded and distributed the modules to each server. You can skip this binary
file install process. Automated Online Update of EMC M&R Software on page 61
provides information about enabling and configuring Online Update.


Procedure


1. Use a tool such as SCP to upload the setup script to a temporary directory on every
server that you plan to upgrade.


2. Log in to the server as root.


3. Navigate to the temporary directory and make the setup script executable.


For example, chmod +x EMC_MnR_6.5.1_Linux_64-bit_Setup_File.sh
4. Run the setup script for your product. For example, ./


EMC_MnR_6.5.1_Linux_64-bit_Setup_File.sh
5. Answer the questions as directed. For example, accept the EULA and use the defaults


for the installation directory and the package installation.


Results


Your system is now prepared for an update.


After you finish


Run the setup script on each Linux server that you want to upgrade.


Before starting core software services, ensure the library search path is correct on the
server hosting the core software. This requirement applies to the libaio package on
Linux. To verify the path:


1. Log in as root and run the following command: ldconfig -v | grep -i
libaio


Output similar to the following should display:


libaio.so.1.0.0 -> libaio.so.1.0.0
libaio.so.1 -> libaio.so.1.0.1


If no output (or incorrect output) is returned, install the latest libaio package form the OS
vendor.
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Updating module-manager for Linux operating systems
Ensure the latest version of the module-manager module is installed before running
the launch-update script.


The launch-update script is delivered through the module-manager, so update the
module-manager module first.


Procedure


1. Type the command to update module-manager from the EMC M&R /bin directory.


<INSTALL_DIR>/bin/manage-modules.sh update module-manager
Example:


./opt/APG/bin/manage-modules.sh update module-manager


Updating core modules in a Linux environment
Update core modules using the launch-update script.


During this step, you will update the core modules on all of the servers where the EMC
M&R software is deployed. Core modules must be updated prior to any others, and they
must be updated from the command line using the launch-update script. If the script
fails for any reason, re-run it to resume the update.


The update process detects if any manual edits were made to the SolutionPack files. If a
manually edited file is compatible with the new version of the SolutionPack, it will be
reused and the system will display a message to let you know. If a manually edited file is
not compatible with the new version of the SolutionPack, the system will back up the file
and display a warning message that indicates the name and location of the incompatible
file. The backed up files are saved in their current directory with the following format:
<file-name>-old-<version>_<date>.<ext>
Messages about an incompatible tmsconfig file can safely be ignored.


The system does not check files that were not were not included with the SolutionPacks.


Note


Run the launch-update script on collector hosts before running it on the primary


backend host. This will maintain the synchronization between the topology service and
topology mapping service.


Procedure


1. Navigate to <install directory>/Tools/Module-Manager/1.7/bin.


2. Change the permissions for the launch-update.sh script:


chmod u+x launch-update.sh
3. Run ./launch-update.sh


You can run this script on multiple servers at the same time.


4. Review the modules that will be updated and the SolutionPacks that will be
reconfigured. At the Proceed? prompt, press Enter to launch the update.


The script starts updating modules. Let the script run uninterrupted. Once completed,
the script lists which modules and SolutionPacks were updated and reconfigured
successfully.
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5. To see the list of modules that were updated, issue this command: ./manage-
modules.sh list installed
All modules except block-type modules are updated by the script. Block-type modules
will be updated later from Centralized Management.


Preparing for an update in a Windows environment
Before you can update the EMC M&R platform in your Windows environment, you must
complete certain tasks and run the setup executable.


Before you begin


l Identify the servers that you plan to upgrade and back up all necessary files.


l Ensure that login credentials with System Administrator permissions are available.


l If you have not enabled Online Update, download the Windows install binary setup
script from the EMC support website. (For example, for Service Assurance Suite
downloads, EMC_MnR_6.5.1_Windows_64-bit_Setup_File.exe. For
Watch4net downloads, setup-win64-v65u1.exe.) http://support.emc.com.


l Place the Windows installation binary setup script in a temporary folder on every
server that you plan to upgrade.


Note


If you have enabled Online Update for your system, the automatic update process has
already downloaded and distributed the modules to each server. You can skip ths binary
file install process. Automated Online Update of EMC M&R Software on page 61
provides information about enabling and configuring Online Update.


Procedure


1. Locate the setup executable file for your product.


2. Double-click the executable file for your product. For example,
EMC_MnR_6.5.1_Windows_64-bit_Setup_File.exe.


3. Click Next.


4. Read and accept the End User License Agreement. Click I Agree.


5. Press Enter to accept the default installation folder of C:\Program Files\APG, or
specify a different directory.


6. Press OK to install the new packages in the C:\Program Files\APG\Tools
\Module-Repository directory.


Your system is now prepared for update.


After you finish


Repeat these steps for each Windows server you want to upgrade.


Updating module-manager for Windows
Ensure the latest version of the module-manager module is installed before running
the launch-update script.


The launch-update script is delivered through the module-manager, so update the
module-manager module first.
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Procedure


1. Stop all of the services by typing the following command from the C:\Program
Files\APG\bin directory: manage-modules.cmd service stop all
Use Windows Task Manager to verify that all of the APG services have stopped. Wait a
few minutes for the services to stop, and then manually stop any services that are in
the "Stopping" state.


2. Type the command to update module-manager from the EMC M&R bin.


<INSTALL_DIR>\bin\manage-modules.cmd update module-manager
Example:


c:\Program Files\APG\bin\manage-modules.cmd update module-manager


Updating core modules in a Windows environment
Update EMC M&R foundation (core modules) using the launch-update script.


During this step, you will update the core modules on all of the servers where the EMC
M&R software is deployed. Core modules must be updated prior to any others, and they
must be updated from the command line using the launch-update script. If the script
fails for any reason, re-run it to resume the update.


The update process detects if any manual edits were made to the SolutionPack files. If a
manually edited file is compatible with the new version of the SolutionPack, it will be
reused and the system will display a message to let you know. If a manually edited file is
not compatible with the new version of the SolutionPack, the system will back up the file
and display a warning message that indicates the name and location of the incompatible
file. The backed up files are saved in their current directory with the following format:
<file-name>-old-<version>_<date>.<ext>
Messages about an incompatible tmsconfig file can safely be ignored.


The system does not check files that were not were not included with the SolutionPacks.


Note


Run the launch-update script on collector hosts before running it on the primary


backend host. This will maintain the synchronization between the topology service and
topology mapping service.


Procedure


1. Navigate to <install directory>\Tools\Module-Manager\1.7\bin.


2. Run launch-update.cmd
3. Review the modules that will be updated and the SolutionPacks that will be


reconfigured. At the Proceed? prompt, press Enter to launch the update.


The script starts updating modules. Let the script run uninterrupted. Once completed,
the script lists which modules and SolutionPacks were updated and reconfigured
successfully.


4. To see the list of modules that were updated, issue this command from the c:
\Program Files\APG\bin path: manage-modules.cmd list installed
All modules except block-type modules are updated by the script. Block-type modules
will be updated later from Centralized Management.
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After you finish


You must manually remove the older version of Java after a Windows upgrade.


Deleting old Java files after Windows update
When upgrading from older versions of EMC M&R, there is an error on startup due to a file
in the previous Java version folder not getting deleted after running the launch-update
script.


Before you begin


After the launch-update script runs, the Windows collector indicates successful
update of the Java module. But the older version of Java may not be removed. If the old
version remains, you must manually remove the Java directory as described in this
message:


Some files were left behind after the update of Java...
Please manually remove directory 7.0u67 from the path 'C:\Program 
Files\APG\Java\Sun-JRE\7.0u67’


Update all components
Update SolutionPacks and all other components to the latest software version.


Procedure


1. Navigate to the Installed SolutionPacks page: http://<Frontend IP
address>:58080/centralized-management/#/sp


2. Click the Update All Components button in the top-right corner of the page.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
Carefully review the selections to make sure the configuration details for the
components and SolutionPacks are correct. When you have finished configuring a
component, click Next to move onto the next component. After you have configured
every component on the list, click Next.


4. The Confirmation window opens and lists all of the components that will be updated.
Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update.
Do not close the browser window during this step.
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Checking the status of remote host services
The remote host services should start automatically after an upgrade. Check the services
status and restart them manually if not running.


Before you begin


Check that all services have started on each of the hosts. Navigate to Centralized
Management > Host Services. Select Show all entries. Verify that the status for each
service is Started.


If a service did not start automatically after completing the upgrade, restart the service
manually.


Procedure


1. Navigate to Centralized Management > Physical Overview.


2. Select the Frontend server or the server where Centralized Management is running.
Click Services.


Locate the stopped service and click its name to open the Service Status for the
instance.


3. Click Start.


If successful, the Service Status changes to Started. If the service does not start,
review the log to determine the cause. The issue may be a misconfigured option that
can be resolved by reconfiguring the SolutionPack settings and manually starting the
service again.


Removing an obsolete Default ReportPack
After an upgrade, you may see duplicate nodes in the navigation tree. Delete the obsolete
Default ReportPack to remove the duplicate nodes.


When you install or update the Report block of any SolutionPack, a generic-report module
installs a default ReportPack template. This process does not remove or update an
existing default ReportPack, and you may see duplicate node entries in the navigation
tree as a result.


Procedure


1. Check the new reports after installing or updating a SolutionPack. Ensure any
scheduled reports or pre-generated reports are set up to use the new Default
ReportPack template before deleting the old one.


You can find the list of scheduled reports and pre-generated reports by accessing
Scheduled Reports in the User Interface or by viewing Physical Overview > Tasks >
report-scheduling or Centralized Management > Scheduled Tasks > report-scheduling.


2. In the User Interface, select Administration.


3. Expand ReportPacks.


4. Expand the Default ReportPack and click the date to access the current default
ReportPack.


5. If you see two Default ReportPacks in the pane, select the older one for deletion.


Newer default ReportPacks show a version number associated with the release, for
example, 3.5.0.0.
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6. Click Delete.


7. Click Save.


Validating the environment
After upgrading your system, verify the operational status.


Before you begin


Procedure


1. Look for blank reports and graphs.


Determine whether blank reports are caused by collection errors. Resolve issues or
document them for later follow up.


2. Look for broken links. Resolve issues or document them for later follow up.


3. Validate that End-to-End topology is working. Resolve any issues.


Update SolutionPacks and other components
Learn how to update SolutionPacks and other components that Online Update has
downloaded from the EMC Update server to the Module Repository on the Centralized
Management (CM) server.


Refer to the Automate the Download of Updates article for details about Online Update.


The product provides several options for updating SolutionPacks and other components:


l Update all of the SolutionPacks and other components with a single click


l Update all of the SolutionPacks with a single click


l Update all of the other components with a single click


l Update individual SolutionPacks or other components


The update process detects if any manual edits were made to the SolutionPack files. If a
manually edited file is compatible with the new version of the SolutionPack, it will be
reused and the system will display a message to let you know. If a manually edited file is
not compatible with the new version of the SolutionPack, the system will back up the file
and display a warning message that indicates the name and location of the incompatible
file. The system does not check files that were not were not included with the
SolutionPack.


Update all SolutionPacks and other components
You can update all of your installed SolutionPacks and other components with a single
click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Update All Components button in the top-right corner of the page.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.
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l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.


4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update all SolutionPacks
You can update all of your installed SolutionPacks with a single click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Select All button located below the SolutionPacks table, and then click the
Update button.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update all other components
You can update all of your other installed components with a single click.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2. Click the Select All button located below the Other Components table, and then click
the Update button.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.


Update individual SolutionPacks or other components
You can easily update individual SolutionPacks or other components.


Procedure


1. Navigate to the SolutionPacks page: http://<Frontend IP address>:
58080/centralized-management/#/sp


2.
In the SolutionPacks table or the Other Components table, click the update icon 
for the SolutionPack or component that you want to update.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
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4. When you have finished configuring a component, click Next to move onto the next
component. After you have configured every component on the list, click Next.


5. Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


6. Review the update details for each component.
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CHAPTER 5


Uninstallation


This chapter includes the following topics:


l Overview............................................................................................................... 48
l Stopping EMC M&R platform services on a UNIX server..........................................48
l Uninstalling EMC M&R platform from a UNIX server............................................... 48
l Stopping EMC M&R platform services on a Windows server................................... 48
l Uninstalling EMC M&R platform from a Windows server.........................................49
l Uninstalling a SolutionPack...................................................................................49
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Overview
You can uninstall a SolutionPack and uninstall EMC M&R platform from a UNIX or
Windows server.


Stop the EMC M&R platform services before uninstalling EMC M&R platform.


Stopping EMC M&R platform services on a UNIX server
Use the manage-modules.sh service stop command to stop a specific EMC M&R
platform service or to stop all EMC M&R platform services on a UNIX server.


Before you begin


Make sure you have logged in with root or APG privileges.


Note


The list of services varies depending upon which type of installation was performed, for
example, vApp, collector, backend, frontend, and so forth.


Procedure


l Type manage-modules.sh service stop <service_name> from the bin directory
of the installation to stop a specific EMC M&R platform service.


This example shows how to stop all EMC M&R platform services:


./manage-modules.sh service stop all 


Uninstalling EMC M&R platform from a UNIX server
Use the manage-modules.sh service remove all command to uninstall all EMC
M&R platform services.


Before you begin


Make sure you have a login with root privileges.


Procedure


1. Type manage-modules.sh service remove all from the /opt/APG/bin
directory to uninstall all EMC M&R platform services.


2. Type rm -rf /opt/APG to remove the installation directory.


Stopping EMC M&R platform services on a Windows server
Use this procedure to stop EMC M&R platform services from the Windows desktop.


Before you begin


Make sure you have logged in with system administrator credentials to manage services.
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Note


The list of services varies depending upon which type of installation was performed, for
example, vApp, collector, backend, frontend, and so forth.


Procedure


1. Type manage-modules.cmd service stop <service_name> from the bin
directory of the installation to stop a specific EMC M&R platform service.


This example shows how to stop all EMC M&R platform services:


./manage-modules.cmd service stop all 


Uninstalling EMC M&R platform from a Windows server
Use the manage-modules.cmd service remove all command to remove all EMC
M&R platform services from a Windows server.


Before you begin


Make sure you have logged in with system administrator credentials.


Procedure


1. Type manage-modules.cmd service remove all from the C:\Program Files
\APG\bin folder to uninstall all EMC M&R platform services.


2. Use the Windows Control Panel to uninstall EMC M&R platform.


a. Click Start > Control Panel > Programs.


b. Click Uninstall a program.


c. Select the Watch4net Solutions APG and click Uninstall.


Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall that
SolutionPack from the server.


Procedure


1. Log in with administrator credentials for EMC M&R platform and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select the SolutionPack that you want to uninstall in the Installed SolutionPacks
screen.


5. In the Properties area, click Trashcan icon for each instance of the SolutionPackBlock
and click Remove.
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CHAPTER 6


Troubleshooting


This chapter includes the following topics:


l Troubleshooting service start-up problems on UNIX...............................................52
l Troubleshooting service start-up problems on Windows........................................ 52
l SSL certificates..................................................................................................... 52
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Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.


Before you begin


Ensure that you have logged in with root or APG privileges to check the log files.


Procedure


l Look for log files in these /opt/APG/ directory paths.


The list of available log files will vary depending upon choices made during
installation. (Collector, Backend, Frontend, Default, or Minimal installations will
generate different sets of log files.)


Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log


Troubleshooting service start-up problems on Windows
Check the log files when services do not start.


Before you begin


Ensure that you have logged in with system administrator credentials to check the log
files.


Procedure


l Look for log files in these C:\Program Files\APG directory paths.


The list of available log files will vary depending upon choices made during
installation. (Collector, Backend, Frontend, Default, or Minimal installations will
generate different sets of log files.)


Databases\MySQL\Default\data\[SERVER NAME].err.
Backends\Alerting-Backend\Default\logs\alerting-0-0.log
Backends\APG-Backend\Default\logs\cache-0-0.log
Collecting\Collector-Manager\Default\logs\collecting-0-0.log
Web-Servers\Tomcat\Default\logs\service.log
Tools\Task-Scheduler\Default\logs\scheduler-0-0.log
Tools\Webservice-Gateway\Default\logs\gateway-0-0.log


SSL certificates
Generally, EMC products are distributed with a self-signed SSL certificate. If you receive
an SSL certificate error or a blank pane when you are attempting to access content served
by a data source, resolve the issue by doing one of the following procedures.


SSL certificate error examples on page 53 provides a list of sample errors.


Temporary resolution
Accept the certificate exception temporarily: Troubleshooting an SSL certificate error:
Accepting the exception on page 53.
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Permanent resolution
Add an SSL certificate to your truststore to permanently prevent the exceptions from
appearing.


You can: Perform:


Install the self-signed SSL certificate
that is provided with the EMC product
using an Internet Explorer browser.


Installing a self-signed SSL certificate from an
Internet Explorer browser on page 54


Install the self-signed SSL certificate
that is provided with the EMC product
using a Chrome or Firefox browser.


1. Export the self-signed SSL certificate to
save it to the export location: Exporting an
SSL certificate from an Internet Explorer
browser on page 55


2. Importing an SSL certificate into your
truststore on page 54


Import an exported SSL certificate that
you or another administrator prepared.


Importing an SSL certificate into your
truststore on page 54


If you need to prepare an SSL certificate to share with other users, use: Exporting an SSL
certificate from an Internet Explorer browser on page 55.


SSL certificate error examples
The SSL certificate error or a blank pane appears because the certificate is self-signed
and it is not added as an exception or into the truststore yet. For example, if you are
attempting to access content served by a data source, a blank pane appears when you
select views under SolutionPacks.


Chrome error examples


This site's security certificate is not trusted!


Or, a blank pane.


Firefox error example


This Connection is Untrusted


Internet Explorer error examples


There is a problem with this website's security certificate.


Content was blocked because it was not signed by a valid security 
certificate.


Troubleshooting an SSL certificate error: Accepting the exception
An SSL certificate error appears in your browser.


To resolve this issue,


Procedure


l Accept the exception.


Steps may vary for your browser. For example, for Internet Explorer, click Continue to
this website (not recommended).


Troubleshooting


SSL certificate error examples     53







This temporary solution causes the exception to be ignored for the current browser
session, but the exception reappears if you open another browser tab or window.


Installing a self-signed SSL certificate from an Internet Explorer browser
Install the self-signed SSL certificate that is provided with the EMC product to prevent
certificate exception errors.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Click Continue to this website (not recommended) in the browser window.


2. Click the red Certificate Error indicator next to the address bar.


3. In the Untrusted Certificate window, select View certificates.


4. In the Certificate dialog box, in the General tab, click Install Certificate.


5. Follow the instructions in the Certificate Import Wizard.


a. Select the Place all certificates in the following store setting to add the certificate
to your truststore.


6. In the Certificate dialog box, in the General tab, click OK.


After you finish


Refresh the browser window.


Importing an SSL certificate into your truststore
Import an SSL certificate into your truststore to prevent certificate exception errors.


Procedure


l Import the certificate using one of the following procedures:


n Importing an SSL certificate in Chrome on page 54


n Importing an SSL certificate in Firefox on page 55


n Importing an SSL certificate in Internet Explorer on page 55


Importing an SSL certificate in Chrome
For Chrome, use this procedure to import the certificate into your truststore.


The following procedure is for Chrome version 28.0.1500.95. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Settings > Show advanced settings.


2. Scroll down and select HTTP/SSL > Manage Certificates.


3. In the Trusted Root Certification Authorities tab, click Import.


4. Follow the instructions in the Certificate Import Wizard to import the certificate.


5. Click OK in Internet options.


6. Refresh the browser window.


Troubleshooting


54 EMC M&R 6.5u1  Installation and Configuration Guide







Importing an SSL certificate in Firefox
For Firefox, use this procedure to import the certificate into your truststore.


The following procedure is for Firefox version 23.0. The steps may vary slightly depending
on your browser version.


Procedure


1. Go to Firefox > Options > Options.


2. Click Advanced.


3. In the Certificates tab, click View Certificates.


4. Click Import.


5. Locate the certificate file and click Open.


6. Click Save.


7. Click OK in Certificate Manager.


8. Refresh the browser window.


Importing an SSL certificate in Internet Explorer
For Internet Explorer, use this procedure to import the certificate into your truststore.


The following procedure is for Internet Explorer version 9.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Go to Tools > Internet options.


2. In the Content tab, click Certificates.


3. Select the Trusted Root Certification Authorities tab.


4. Click Import.


5. Follow the instructions in the Certificate Import Wizard to import the certificate.


6. Click OK in Internet options.


7. Refresh the browser window.


Exporting an SSL certificate from an Internet Explorer browser
Use this procedure to export a self-signed SSL certificate, so that you can either import
the resulting exported certificate into your truststore or share it with other users.


The following procedure is for Internet Explorer version 10.0. The steps may vary slightly
depending on your browser version.


Procedure


1. Access the host for which you want to export the SSL certificate from the browser.


For example: https://<myHostname>.emc.com
2. Select Continue to this website (not recommended) in the There is a problem with


this website's security certificate window.


3. Click the red Certificate Error indicator next to the address bar.


4. In the Untrusted Certificate window, select View certificates.


5. In the Certificate dialog box, select the Details tab and ensure that the Show field is
set to All. Click Copy to File.
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6. In the Certificate Export Wizard,


a. Click Next in the Welcome screen.


b. Click Next to accept the default DER encoded binary X.509 setting in the Export File
Format screen.


c. Browse to the location where you want to save the certificate.


d. Specify the certificate file name and click Save.


e. In the File name field, ensure that the location and the certificate file name are
correct. Click Next.


f. Click Finish.


g. Click OK when The export was successful appears.


7. In the Certificate dialog box, click OK in the Details tab.


8. Share the resulting exported SSL certificate with other users to use.
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APPENDIX A


Available Modules


This appendix includes the following topics:


l Available modules.................................................................................................58
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Available modules
Each type of installation (Default, Minimal, Frontend, Backend, or Collector) installs a set
of core modules. These module installations then trigger additional modules to be
installed. For the full list of modules that are installed, issue the manage-modules.sh
list installed or manage-modules.cmd list installed command from
the /bin folder in your installation path.


Table 5 Version 6.5u1 available modules


Module Name Version Install type


Administration-Tool v1.3u1 Default / Frontend / Backend


alert-consolidation v3.6 Default / Backend


Alerting-Backend v3.8u1 Default / Backend


Alerting-Frontend v3.8u1 Default / Frontend


APG-Backend v5.8 Default / Backend


Centralized-Management v2.4u1 Default / Frontend


Collector-Manager (emc-watch4net-
health)


5.6 Default / Frontend


Compliance-Backend (generic-
compliance)


v3.5u1??? Default / Backend


Device-Discovery v3.4u1 Default / Frontend


APG-Diagnostic-Tools v6.0 Default / Frontend / Backend / Collector


APG-Frontend v6.5u1 Default / Frontend


Frontend-Report-Generator v6.5u1 Default / Frontend


Frontend-Search v6.5u1 Default / Frontend


Frontend-WS v6.5u1 Default / Frontend


generic-rsc v3.6.1 Default / Collector


generic-snmp v3.6.1 Default / Collector


generic-topology v3.6.1 Default / Backend


License-Manager v5.4 Default / Minimal / Frontend / Backend /
Collector


load-balancer-arbiter v3.6.1 Default / Backend


Maps-Service v2.0 Default / Frontend


Mib-Browser v6.5u1 Default / Frontend


Module-Manager v1.7u1 Default / Minimal / Frontend / Backend /
Collector


MySQL v5.5.36 Default / Backend / Database


MySQL-Maintenance-Tool v1.4 Default / Backend
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Table 5 Version 6.5u1 available modules (continued)


Module Name Version Install type


APG-Property-Store v2.0 Default / Frontend / Database


Task-Scheduler v1.6u1 Default / Backend


Tomcat 6.0.43 Default / Frontend


Topology v1.7 Default / Backend


Topology-Service v1.2u1 Default / Backend


Webservice-Gateway v2.0 Default / Minimal / Frontend / Backend /
Collector
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Available modules     59







Available Modules


60 EMC M&R 6.5u1  Installation and Configuration Guide







APPENDIX B


Automated Online Update of EMC M&R Software


This chapter includes the following topics:


l Online Update overview........................................................................................ 62
l Configuring server settings for online updates.......................................................62
l Enabling the online update task............................................................................ 62
l Running the online update task manually..............................................................63
l Online Update Status............................................................................................ 63
l Online Update History........................................................................................... 64
l Disabling the online update task...........................................................................64
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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
EMC M&R components from the EMC Update server to the Module Repository on the
Centralized Management (CM) server. In a multi-server environment, the downloaded
modules are distributed to all of the remote servers managed by the CM server.


Configuring server settings for online updates
Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click Configuration > Online Update .


4. Ensure that you are on the Settings tab.


5. By default, online update uses the EMC Online Support username and password
specified under Configuration > EMC Support. If you want to use different credentials,
click Override Support Credentials. These credentials are used only for online update.


6. Click the  icon to test connectivity to the update server.


The  icon indicates that connectivity to the server has been established.


The  icon indicates that connectivity to the server failed.


7. Click Save.


Enabling the online update task
Enable the Online Update task to download the latest updates from the EMC Update
server automatically.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Enable.


Note


By default, this task is set to run once everyday at 12AM. You can customize the task
schedule by editing the configuration file.
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Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Run Now.


Online Update Status
The Online Update Status tab indicates whether or not the last online update check was
successful, provides the date and time of the last successful check, and lists any updates
that are available for download.


Figure 1  Online Update Status


If a major update of the EMC M&R platform is detected, the Status tab includes a Major
Update Status section that describes the version that is available, provides a link to the
upgrade documentation, and includes a Start Download button.
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Figure 2  Online Update Status with a major version update detected


Downloading a major update
You can use Online Update to download a major version of the EMC M&R platform. You
should only download a major version if you intend to immediately complete the full
upgrade process.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Click Configuration > Online Update.


4. Click the Status tab.


5. Click Start Download. When the download is finished, the Download State will change
from "Not Downloaded" to "Complete."


6. Complete the upgrade process as described in the upgrade documentation.


Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.


The History tab also allows you to search the download history for a particular component
name or version number.


Disabling the online update task
You can disable the Online Update task if you prefer to manually download the updates
from the EMC Update server.


Procedure


1. Click Administration.
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2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Disable.
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This appendix includes the following topics:
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l Verifying the appliance deployment ......................................................................70
l Log onto the appliance ......................................................................................... 70
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Virtual Appliance installation for EMC M&R
You can deploy EMC M&R as a virtual appliance (vApp) in a vSphere or vCloud
environment, as an alternative to the standard installation.


A virtual appliance (vApp) is a software solution composed of one or more virtual
solutions that is packaged by an appliance vendor and can be deployed, managed, and
maintained as a unit.


vApps are distributed using Open Virtualization Format (OVF) files. Depending on your
environment requirements, two types of OVF installations are available to install the EMC
M&R platform:


l Four VM vApp installation - Distributes EMC M&R platform components across four
VMs (Frontend, Primary Backend, Additional Backend, Collector). The appliances in
this installation are pre-configured to communicate with each other, offering an out-
of-the-box configuration that can function in smaller environments. You can further
scale and extend the environment by installing additional virtual appliances using
the one VM vApp installation.


l One VM vApp installation - Has the potential to install any of the EMC M&R platform
components in a single VM. This can be used to either install a single, consolidated
VM with all components for evaluation purposes, or to add additional Backend or
Collector appliances to extend or scale the environment created using the four VM
vApp installation.


Note


The vApp deployment should be used only for new installations. If you need to upgrade
an existing installation, use the standard binary setup script or executable to migrate to a
newer release. The vApp deployment support was not available prior to the EMC M&R 6.3
release.


Deploying an appliance
You can deploy an appliance from an OVF file using a vSphere Client.


Before you begin


l An administrator login with root privileges


l vCenter location where you are deploying the appliance


l Data store you can use for deployment


l Static IP address to assign to your appliance


l Gateway


l Netmask


l DNS Servers


Procedure


1. Open vSphere Client and connect to the vCenter Server that manages your VMware
environment.


2. From the File menu, select Deploy OVF Template.


3. In the Source step, browse to the location of the YourOVFfile.ovf file.


Example file path: /opt/ovf/YourOVFfile_OVFxx.ovf
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Example URL: http://myHost.emc.com/ovf/snapshot/92/
YourOVFfile_OVFxx.ovf


4. Click Next.


To minimize the deployment time, deploy the appliance within the same local area
network (LAN) shared by your VMware ESX/ESXi servers. The deployment time is
approximately 5 to 15 minutes. Deployment across a WAN can take 2 hours or more.


5. In the OVF Template Details step, review the details of the loaded .ovf file and click
Next.


6. In the End User License Agreement step, review the license agreement. Click Accept
and then click Next to continue.


7. In the Name and Location step:


a. Type a Name for the appliance.


b. Specify an Inventory Location for the appliance within your VMware
environment.


c. Click Next.


8. In the Host/Cluster step, select a host or cluster where the appliance will run and click
Next.


9. In the Resource Pool step, select a resource pool associated with the host or cluster
where the appliance will run and click Next.


Note


This step is required only if the host or cluster contains a predefined resource pool.


10.In the Datastore step, select a datastore to hold the appliance images and click Next.


11.In the Disk Format step, select the storage space provisioning method and click Next.


Option Description


Thin provisioned format On-demand expansion of available storage, used for
newer data store file systems.


Thick provisioned format Appliance storage that is allocated immediately and
reserved as a block.


Note


The Thin provisioned format option is recommended when the vApp is deployed in a
high performance environment.


12.In the Network Mapping step, select a destination network that has an IP Pool
associated with it and click Next.


13.Provide the values of the properties as defined in the Virtual Appliance Properties
table and click Next.


14.In the Ready to Complete step, review the list of properties for the appliance and click
Finish.


A status bar appears in the vSphere Client showing the deployment progress.


15.After deployment is complete, click Close in the Deployment Completed Successfully
dialog box.
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Starting the appliance
Start the appliance using vSphere after deployment. The appliance may take up to 20
minutes to start the first time. You can monitor the progress on the vSphere console.


Procedure


1. In the vSphere Client, right-click the appliance name.


2. Select Power > Power On.


The status appears in the Recent Tasks bar.


Verifying the appliance deployment
After deploying the appliance, verify that it is working.


Procedure


1. In the vSphere client, navigate to the VMs and Templates view.


2. From the configured resource pool, find the resource pool you selected for the
appliance.


The new appliance is listed under the resource pool.


3. In the console, log in to the appliance with the credentials you defined during the
deployment.


4. Verify the services.


Log onto the appliance
Using a browser, you can access the appliance to view and manage your applications as
well as develop applications.


Procedure


1. Open a web browser.


2. Browse to the appliance at http://<Frontend-hostname>:58080/APG.


hostname is the fully qualified domain name of your host.


A security-related dialog box may appear asking you to accept a security certificate
from EMC. Accept the certificate or allow a security exception for and continue. To
eliminate this message from appearing, install a Certificate Authority-signed SSL
certificate.


3. Enter the default username and password.


Passwords
Use passwords to control access to the appliance.


Table 6 Default usernames and passwords


Environment Username and password


Web-based console accessed in a browser admin/changeme Ensure that you


change this password.
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Table 6 Default usernames and passwords  (continued)


Environment Username and password


Linux guest OS appliance console accessed through
SSH or vSphere


root/Changeme1!


If you set the appliance console password while you deployed the OVF, the password that
you entered is the default password.


Passwords must conform to the following requirements.:


l Be at least eight characters and no more than 40 characters


l Contain at least one numeric character


l Contain at least one uppercase and one lowercase character


l Contain at least one non-alphanumeric character such as # or !


l Cannot contain the single quote character (') because it is a delimiter for the
password string


Note


These requirements do not apply to the Linux passwords.


Installing a SolutionPack
After you log in as an administrator, you can install a SolutionPack from Centralized
Management.


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC support website http://support.emc.com.


l Make sure the core modules, such as the Module-Manager, are up-to-date on all
servers since not all module dependencies are validated during the SolutionPack
installation.


l Look for additional SolutionPack-specific installation instructions on the EMC
Community Network (ECN) or the EMC Support website. For example, more detailed
information may be found in Service Assurance Suite SolutionPack Articles available
from the EMC support website or from the EMC Community Network. Many
SolutionPacks have read me files embedded in the software. You can find these after
you install the SolutionPack by navigating to Centralized Management >
SolutionPacks. Expand the tree and click on the SolutionPack to open the Properties
page where the document is listed.


Procedure


1. Log in and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SOLUTIONPACK CENTER.


4. Select the SolutionPack in the Browse and Install SolutionPacks screen.


5. Read the summary information and click Install.
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6. Select the components to install.


a. Type the instance name.


b. Select the server in one or more list boxes. For example, select the server in the
Data collection and Reports list boxes.


c. Click Next.


7. For each list box you select, a screen appears.


a. Click Next after you complete each screen.


b. Click Install after you complete the last screen.


The installation process begins.


8. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


After you finish


After the installation is complete, select Centralized Management > SolutionPack to verify
the installed SolutionPack.


Reviewing reports
After you install a new release or migrate to a new release, check the reports to ensure
that the data appears properly.


Before you begin


If the collector configuration changed, you can manually run the scheduled tasks in
Administration > Centralized-Management > Scheduled Tasks > Database to speed up the
report generation process. Wait at least two polling cycles before manually running the
scheduled tasks.


To view your report:


Procedure


1. Navigate to User Interface > SolutionPacks or User Interface > ReportPacks depending
upon which features you have installed.


2. Click the SolutionPack or ReportPack you want to view.


Results


It may take several polling cycles to display all relevant information.
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Restoring Modules to their Previous Version


This appendix includes the following topics:


l Restoring modules workflow................................................................................. 74
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l Restoring modules................................................................................................ 75
l Starting the EMC M&R platform services from the command line........................... 77
l Starting the EMC M&R platform services on Windows............................................ 78
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Restoring modules workflow
If you need to, you can revert to the previous version of EMC M&R platform after an
update. If the software is installed on multiple servers, you need to perform the restore
process on each server.


Restoring the modules does not restore them to their exact state prior to an upgrade. The
reason is that during the update process, some modules may modify their data files to
work for newer version. Once the data files are modified, they cannot revert to their
previous state.


The Module-Manager cannot be restored to its previous version. The 6.5.x version of
Module Manager is fully compatible with version 6.4.x and can be used in its place.


Make sure you have a login with root or system administrator privileges to restore
modules.


For single host or multiple host deployments:


1. Listing restorable modules on page 74


2. Restoring modules on page 75


3. Start the EMC M&R platform services: Starting the EMC M&R platform services from
the command line on page 20 or Starting the EMC M&R platform services on
Windows on page 20


Listing restorable modules
Use the manage-modules.sh list restorable command to list all modules that
can be restored.


Before you begin


Make sure you have a login with root or system administrator privileges to restore
modules.


Procedure


l Type the command for your operating system from the EMC M&R platform installation
directory:


Operating system Command


UNIX
<INSTALL_DIR>/bin/manage-modules.sh list restorable [--
match="<module>"]


Windows
<INSTALL_DIR>\bin\manage-modules.cmd list restorable [--
match="<module>"]


To determine if the module has more than one version to restore, specify the --
match option. For example:


/opt/APG/bin/manage-modules.sh list restorable --match="frontend"


When you view the output, record the order in which the modules display. You will
need to use the order later when you restore the modules.
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This partial Linux sample output indicates modules that can be restored.


Available Restore Points:


   Identifier                Instance               Version Date
   ------------------------- ---------------------- ------- 
--------------------
 * variable-handling-filter  Generic-SNMP           v1.8u3  
11/26/13 9:00:30 AM
 * property-tagging-filter   Generic-SNMP           v2.5u1  
11/26/13 8:57:46 AM
 * frontend-report-generator Default                v6.2u3  
11/26/13 8:38:01 AM
 * collector-manager         emc-smarts             v5.3u2  
11/26/13 8:31:29 AM
 * event-processing-manager  emc-smarts             v1.2u3  
11/26/13 8:32:29 AM


Restoring modules
Restore modules to their previous version.


Before you begin


l Identify all modules that can be restored by using the manage-modules.sh list
restorable command.


l Make sure you have a login with root or system administrator privileges to restore
modules.


Restore the modules in the order in which they displayed, starting from first to last. To
avoid dependency issues, restore the main components or managers before their sub-
components. For example, restore the Event Processing Manager before its sub-
component, Event Property Tagger. Refer to the Module Manager documentation for more
complete information about module rollback. This document is in the documentation
directory of the installation path (for example, /opt/APG/Doc).


Procedure


1. Type the command for your operating system from the EMC M&R platform installation
directory:


Operating system Command


UNIX
<INSTALL_DIR>/bin/manage-modules.sh restore 
<module_identifier> [<module_instance>]


Windows
<INSTALL_DIR>\bin\manage-modules.cmd restore 
<module_identifier> [<module_instance>]


2. Answer any questions.


This Linux sample output shows that the administration-tool module has been
restored to its previous version.


opt/APG/manage-modules.sh restore administration-tool
Starting restoration of administration-tool Default v1.0u2...
 * Gathering information...
 * Issuing a rollback will overwrite all existing files - except 
the data ones - and replace them with their previous versions, 
including configuration files.
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 * The module 'Administration-Tool' will now be restored in 
'/opt/APG/Tools/Administration-Tool/Default'.
 ! WARNING: The targeted directory already exists. This will 
overwrite existing files in this directory.
 ? Continue? [y]es, [n]o > y
 * Restoring files...
Restoration complete.


manage-modules.sh restore command
Use the manage-modules.sh restore command to revert modules to their previous
version after an update. Type the command for your operating system from the bin
directory of your EMC M&R platform installation directory.


Description
The manage-modules.sh restore command enables you to revert to the
previous version of EMC M&R platform after an update. For UNIX, specify manage-
modules.sh restore. For Window, specify manage-modules.cmd restore.


To look up the identifier and module instance name, use the manage-modules.sh
list restorable command.


Syntax
manage-modules.sh restore <module_identifier>
[ <module_instance> ] [ <version> ]


Options


module_identifier


The identifier value of the installed module.


module_instance


The unique name of the module. Omit this value if only one instance is installed since
the command will use it as the default. If multiple instances exist, specify the
instance you want to restore.
The identifier and instance values form a unique key to refer to the module.


version


The version number to which the module should be restored. Omit this value if only
one previous version exists.


In this Linux example, the following command restores the Collector-Manager from 6.5.x
to 6.4.x. Since only one previous version exists, the version option is omitted.


<INSTALL_DIR>/bin/manage-modules.sh update collector-manager
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In this Windows example, the following command restores the variable-handling-filter
from 6.5.x to 6.4.x. Since only one previous version exists, the version option is
omitted.


<INSTALL_DIR>\bin\manage-modules.cmd restore variable-handling-filter 
generic-snmp


In this Linux example, the following command restores the frontend-ws to version 6.4.


./manage-modules.sh restore frontend-ws apg-ws 6.4


./manage-modules.sh update mib-browser mymib_browser2


Starting the EMC M&R platform services from the command line
After you install EMC M&R platform, start required services.


Before you begin


l Before you start EMC M&R platform services, ensure the library search path is correct
on the server that hosts EMC M&R platform. This requirement applies to the libaio
package on Linux.


l Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the EMC M&R platform application uses instead of root.


Procedure


l Type the command for your operating system from the bin directory of the
installation:


Operating system Command


UNIX ./manage-modules.sh service start all


Windows manage-modules.cmd service start all


Results


The platform displays a list of services.


Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Example:


* Starting 'topology-mapping-service Default'... [ OK ]
* Starting 'webservice-gateway Default'... [ OK ]
* Starting 'mysql Default'... [ OK ]
* Starting 'alerting-backend Default'... [ OK ]
* Starting 'backend Default'... [ OK ]
* Starting 'collector-manager Default'... [ OK ]
* Starting 'collector-manager Generic-SNMP'... [ OK ]
* Starting 'collector-manager Load-Balancer'... [ OK ]
* Starting 'collector-manager emc smarts'... [ OK ]
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* Starting 'event-processing-manager emc smarts'... [ OK ]
* Starting 'tomcat Default'... [ OK ]
* Starting 'task-scheduler Default'... [ OK ]


Starting the EMC M&R platform services on Windows
After installing EMC M&R platform on Windows, you can start all required services from a
Windows desktop.


Before you begin


Make sure you have logged in with system administrator credentials to manage services.


Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Procedure


1. From the application server's desktop, select Start > Administrative Tools > Services.


2. Right-click each service and click Start, in this order:


l APG Topology Mapping Service


l APG Topology Service


l APG Webservice Gateway


l APG MySQL


l APG Alerting Backend


l APG Backend


l APG Collector Manager (Generic RSC)


l APG Collector Manager (Generic-SNMP)


l APG Collector Manager (Load-Balancer)


l APG Event Processing Manager (Alert-Consolidation)


l APG Tomcat


l APG Task Scheduler


Restoring Modules to their Previous Version


78 EMC M&R 6.5u1  Installation and Configuration Guide





		Contents

		Figures

		Tables

		System Requirements for EMC M&R

		Revision history

		Operating system requirements

		Database requirements for EMC M&R

		Browser requirements

		Supported mobile devices



		Installation

		Explanation of name changes

		Options for standard installation

		Installing EMC M&R platform on UNIX

		Installing EMC M&R platform on Windows Server



		Configuration

		Starting the EMC M&R platform services from the command line

		Starting the EMC M&R platform services on Windows

		Verifying if the EMC M&R platform services are running

		Troubleshooting service start-up problems on UNIX

		Troubleshooting service start-up problems on Windows



		Configuring the user process limits for the Linux installation

		Logging in to the User Interface

		Connecting to Centralized Management

		Confirm configuration settings and register remote servers

		Licensing Operations

		Trial licenses

		License duration

		License purchase



		Log in with administrator credentials

		View license information

		Upload a new license file

		Delete licenses

		Synchronize licenses on multiple hosts

		Troubleshooting licensing problems

		Permanent license stops working after host reconfiguration

		Users are locked out

		Install license file from the command line

		Restart Tomcat service

		Reinstall license file and delete trial licenses after lockout



		Module does not start or has no license

		Where to find the latest SolutionPack software

		Installing a SolutionPack

		Reviewing reports



		EMC M&R Platform Update

		Planning the upgrade

		Preparing the environment for the upgrade

		EMC M&R upgrade workflow

		Mixed operating system deployments



		Preparing for an update in a Linux environment

		Updating module-manager for Linux operating systems

		Updating core modules in a Linux environment



		Preparing for an update in a Windows environment

		Updating module-manager for Windows

		Updating core modules in a Windows environment



		Update all components

		Checking the status of remote host services

		Removing an obsolete Default ReportPack

		Validating the environment

		Update SolutionPacks and other components

		Update all SolutionPacks and other components

		Update all SolutionPacks

		Update all other components

		Update individual SolutionPacks or other components



		Uninstallation

		Overview

		Stopping EMC M&R platform services on a UNIX server

		Uninstalling EMC M&R platform from a UNIX server

		Stopping EMC M&R platform services on a Windows server

		Uninstalling EMC M&R platform from a Windows server

		Uninstalling a SolutionPack



		Troubleshooting

		Troubleshooting service start-up problems on UNIX

		Troubleshooting service start-up problems on Windows

		SSL certificates

		SSL certificate error examples

		Troubleshooting an SSL certificate error: Accepting the exception

		Installing a self-signed SSL certificate from an Internet Explorer browser

		Importing an SSL certificate into your truststore

		Exporting an SSL certificate from an Internet Explorer browser





		Available Modules

		Available modules



		Automated Online Update of EMC M&R Software

		Online Update overview

		Configuring server settings for online updates

		Enabling the online update task

		Running the online update task manually

		Online Update Status

		Downloading a major update



		Online Update History

		Disabling the online update task



		Virtual Appliance Installation

		Virtual Appliance installation for EMC M&R

		Deploying an appliance

		Starting the appliance

		Verifying the appliance deployment

		Log onto the appliance

		Passwords



		Installing a SolutionPack

		Reviewing reports



		Restoring Modules to their Previous Version

		Restoring modules workflow

		Listing restorable modules

		Restoring modules

		manage-modules.sh restore command



		Starting the EMC M&R platform services from the command line

		Starting the EMC M&R platform services on Windows







